Contents

Retaining and disposing of archived data .................................................. 111
Partitioning a Native Archive database ..................................................... 116
Adding Native Archive supplemental language support ............................. 123

Chapter 6 Configuring Mapped Folders
Introduction to mapped folders................................................................ 126
Mapped folder concepts ........................................................................... 126
Viewing the list of mapped folders .......................................................... 141
Creating and associating mapped folders ............................................... 142
Modifying mapped folder properties ....................................................... 145
Copying mapped folders ........................................................................ 148
Deleting mapped folders ....................................................................... 148
Best practices for configuring Legal Hold mapped folders ...................... 149
Best practices for using mapped folders with EmailXtender archives ...... 149
Examples of using mapped folders.......................................................... 151

Chapter 7 Configuring Worker Servers and Worker Groups
Introduction to Servers and Groups Node.................................................. 158
Viewing Workers and their roles ............................................................ 158
Viewing or editing Worker properties ..................................................... 159
Controlling Workers ............................................................................. 162
Tuning Worker Server job access to servers ........................................... 163
Configuring Worker groups ................................................................... 166

Chapter 8 Configuring Applications and Web Services
Introduction .......................................................................................... 172
Editing global settings for applications and Web services...................... 173
Editing settings for Retrieval Web service .............................................. 178
Auditing search operations ..................................................................... 178
Editing settings for Shortcut Web service and mobile restore ............... 187
Editing settings for EMC SourceOne Web Search application ............... 190
Editing settings for EMC SourceOne Web Search server ...................... 197
Index Validation ..................................................................................... 205

Chapter 9 Managing Organizational Policies
Introduction .......................................................................................... 216
Creating Organizational Policies ............................................................ 216
Editing organizational policies ............................................................... 217
Pausing organizational policies ............................................................. 218
Stopping organizational policies ............................................................ 218
Deleting organizational policies ............................................................. 219

Chapter 10 Managing Jobs
About creating jobs ............................................................................... 222
Viewing the list of jobs .......................................................................... 222
Refreshing a view .................................................................................. 224
Delay in start of Journaling jobs ............................................................ 224
Adjusting a job list when the display limit is reached ......................... 224
Specifying maximum number of jobs to display .................................. 224
Viewing job details ............................................................................... 225
Using a different job view ..................................................................... 228
Customizing a job view ................................................................. 228
Controlling jobs ......................................................................... 237

Chapter 11 Common and email-specific best practices
Best practices for data retention and disposal ............................... 242
Common guidelines for specifying archive location paths ............ 243
Optimizing Native Archive index performance .......................... 245
Best practices for setting the volume size ................................. 248
Best practices for selecting indexing of nested attachments ......... 249
Best practices for selecting archive folder organization options .. 249
Best practices for tuning job access to servers ......................... 251
Being aware of interaction between EMC SourceOne tasks and other scheduled tasks ................................................. 252
Best practices in email identity management .............................. 252
Best practices for using rules in email activities ....................... 254
Best practices for setting date formats on Workers processing Domino content ......................................................... 255
When best to use LDAP queries to select data sources ............. 255
Best practices for deploying shortcuts ....................................... 259
Best practices for using Legal Hold folders ......................... 264
Understanding historical archiving from Sent or Sent Items ...... 264
Improving Office 365 journaling performance by increasing target folders used ....................................................... 264
Optimizing EMC SourceOne Search behavior for use with Office 365 content ......................................................... 265
Recommendations for improving User Delete performance ....... 265
Best Practices for using mapped folders with EmailXtender archives .... 266
Best practices for using Shortcut - Historical or Archive - Historical activities to process EmailXtender data .... 266

Chapter 12 Using Job Logs
Introduction to job logs ............................................................... 270
Enabling and disabling job logging ........................................... 270
Viewing job logs .................................................................... 271
Where to find job logs .............................................................. 271
Understanding information in the job log ................................. 271
Computing mailbox reduction from email activities ................. 275

Chapter 13 Maintaining EMC SourceOne
Daily Maintenance Tasks (common and email-specific) .......... 278
Performing a backup of an EMC SourceOne system ............... 282
Restoring an EMC SourceOne system after backup ............... 291
Maintaining the EMC SourceOne databases (common) ............. 292
Infrequent Maintenance Tasks (common and email-specific) .... 306

Chapter 14 Troubleshooting EMC SourceOne
Troubleshooting content processing problems ....................... 318
Troubleshooting EMC SourceOne server network problems ...... 323
Troubleshooting search problems .......................................... 325
Troubleshooting OWA shortcut problems (email-specific) ....... 329
Troubleshooting Journal activities with Office 365 content ....... 331
Troubleshooting User Delete issues ........................................ 331
Chapter 15 Configuring CTA Integration
Enabling CTA integration ................................................................. 336
Managing CTA server consoles ...................................................... 336

Part 2 Email Management Specific Information

Chapter 16 Configuring Email Management Activities
Introduction to activities ................................................................. 342
Adding activities to an organizational policy ................................. 347
Activity Type ............................................................................... 347
Data Source Types ....................................................................... 348
Select Data Sources .................................................................... 348
Journaling Method ....................................................................... 362
Group Options ............................................................................. 362
Item Types .................................................................................. 364
Folders ...................................................................................... 367
User Created Folders .................................................................. 370
Dates .......................................................................................... 370
Attachments Filter ...................................................................... 373
Message Types Filter .................................................................. 374
Properties .................................................................................. 375
Message Size Filter .................................................................... 376
Mapped Folder(s) ....................................................................... 377
Shortcut Options ........................................................................ 382
Post Processing .......................................................................... 382
Business Components ............................................................... 384
Delete Options .......................................................................... 385
Scheduling Activities .................................................................. 386
Select Worker Group ................................................................. 391
Activity Name ............................................................................ 392
Editing activities in an organizational policy ............................... 392
Controlling activities ................................................................. 393
Deleting activities from an organizational policy ....................... 396

Chapter 17 PST and NSF Processing Activities
PST processing activities ............................................................... 398
NSF processing activities ............................................................. 420

Chapter 18 Shortcut Activities
Introduction to shortcuts .............................................................. 434
Considerations and limitations when using shortcuts .................. 438
Prerequisites for shortcutting messages ...................................... 439
Customizing shortcut replacement text ...................................... 439
Shortcut - Historical activity ...................................................... 444
Update Shortcuts - Historical & User Directed Archive activity ...... 444
Restore Shortcuts - Historical & User Directed Archive activity ... 445

Chapter 19 Using Journal Activities
Using Journal activities with different content types ................. 448
Using Journal activities with Microsoft Exchange ...................... 448
<table>
<thead>
<tr>
<th>Chapter 20</th>
<th>Using the Journal Activity for Office 365 Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of using journal activity with Office 365 content</td>
<td>454</td>
</tr>
<tr>
<td>Journaling for Office 365 content configuration sequence</td>
<td>457</td>
</tr>
<tr>
<td>Configuring SMTP support for Office 365 journaling</td>
<td>457</td>
</tr>
<tr>
<td>Using the Journal activity to process Office 365 messages</td>
<td>459</td>
</tr>
<tr>
<td>Configuring Exchange Online premium journaling</td>
<td>467</td>
</tr>
<tr>
<td>Maintaining and Troubleshooting Office 365 journaling</td>
<td>469</td>
</tr>
<tr>
<td>Modifying EMC SourceOne Search behavior for use with Office 365 content</td>
<td>473</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 21</th>
<th>Processing Exchange Public Folder Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of using Microsoft Exchange public folder activities</td>
<td>480</td>
</tr>
<tr>
<td>Configuring public folder archiving and shortcutting</td>
<td>481</td>
</tr>
<tr>
<td>Creating an Archive - Microsoft Exchange Public Folder activity</td>
<td>483</td>
</tr>
<tr>
<td>Creating a Shortcut - Microsoft Exchange Public Folder activity</td>
<td>485</td>
</tr>
<tr>
<td>Creating a Restore Shortcuts - Microsoft Exchange Public Folder activity</td>
<td>486</td>
</tr>
<tr>
<td>Summary of creating a Delete - Microsoft Exchange Public Folder activity</td>
<td>487</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 22</th>
<th>User-Directed Archiving Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>About UDA support</td>
<td>492</td>
</tr>
<tr>
<td>Introduction</td>
<td>493</td>
</tr>
<tr>
<td>Main steps to configure user-directed archiving</td>
<td>494</td>
</tr>
<tr>
<td>Configuring community archive or personal archive</td>
<td>495</td>
</tr>
<tr>
<td>Considerations and limitations</td>
<td>496</td>
</tr>
<tr>
<td>Archive - User Directed Archive activity</td>
<td>497</td>
</tr>
<tr>
<td>Delete - User Directed Archive activity</td>
<td>498</td>
</tr>
<tr>
<td>Shortcut - User Directed Archive activity</td>
<td>498</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 23</th>
<th>Using Email Management Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule concepts</td>
<td>500</td>
</tr>
<tr>
<td>Best practices for using rules</td>
<td>501</td>
</tr>
<tr>
<td>Creating rules</td>
<td>504</td>
</tr>
<tr>
<td>Archiving messages which do not match any rules</td>
<td>519</td>
</tr>
<tr>
<td>Editing rules</td>
<td>519</td>
</tr>
<tr>
<td>Copying and pasting rules</td>
<td>519</td>
</tr>
<tr>
<td>Deleting rules</td>
<td>520</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 24</th>
<th>Configuring User Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to User Delete</td>
<td>522</td>
</tr>
<tr>
<td>Considerations and limitations - User Delete</td>
<td>524</td>
</tr>
<tr>
<td>How User Delete works in the mail client</td>
<td>526</td>
</tr>
<tr>
<td>How User Delete works in SourceOne Search</td>
<td>527</td>
</tr>
<tr>
<td>User Delete configuration</td>
<td>529</td>
</tr>
<tr>
<td>Using the Folder Conversion utility</td>
<td>531</td>
</tr>
<tr>
<td>Configuring index throttling for User Delete</td>
<td>536</td>
</tr>
<tr>
<td>Configuring mapped folders for User Delete</td>
<td>538</td>
</tr>
<tr>
<td>Configuring Workers for User Delete</td>
<td>539</td>
</tr>
<tr>
<td>Disabling external address resolution in IBM Lotus Domino</td>
<td>539</td>
</tr>
<tr>
<td>Configuring SourceOne Search for User Delete</td>
<td>540</td>
</tr>
<tr>
<td>Configuring Journal activities for User Delete</td>
<td>542</td>
</tr>
<tr>
<td>Configuring archive and shortcut activities for User Delete</td>
<td>543</td>
</tr>
</tbody>
</table>
Contents

Configuring the Delete - User Initiated Delete activity ......................... 544
Troubleshooting the address cache for User Delete .............................. 545
Viewing detailed job logs for User Delete.......................................... 546

Glossary
As part of an effort to improve its product lines, EMC periodically releases revisions of its software and hardware. Therefore, some functions described in this document might not be supported by all versions of the software or hardware in use. The product release notes provide the most up-to-date information about product features.

Contact your EMC technical support professional if a product does not function properly or does not function as described in this document.

**Note:** This document was accurate at publication time. Go to EMC Online Support (https://support.emc.com) to ensure that you are using the latest version of this document.

**Purpose**

This document includes information about administering EMC SourceOne Email Management.

**Audience**

This document is part of the EMC® SourceOne™ Email Management documentation set, and is intended for use by EMC SourceOne Email Management system administrators who are processing email, Microsoft SharePoint or file content.

**Revision history**

The following table presents the revision history of this document.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>April 30, 2015</td>
<td>First release of the EMC SourceOne Email Management 7.2 Administration Guide.</td>
</tr>
</tbody>
</table>

**Related documentation**

The SourceOne documentation set includes the following publications:

**EMC SourceOne Product Guides**

- *EMC SourceOne Products Compatibility Guide*
- *EMC SourceOne Products Security Configuration Guide*

**EMC SourceOne Discovery Manager**

- *EMC SourceOne Discovery Manager Installation and Administration Guide*
- *EMC SourceOne Discovery Manager Localized Product Release Notes*
- *EMC SourceOne Discovery Manager Quick Reference Cards*
- *EMC SourceOne Discovery Manager Release Notes*
- *EMC SourceOne Discovery Manager Desktop User Guide*
Conventions used in this document

EMC uses the following conventions for special notices.

**Note:** A note presents information that is important, but not hazard-related.

**CAUTION**

A caution contains information essential to avoid data loss or damage to the system or equipment.
Typographical conventions

EMC uses the following type style conventions in this document:

<table>
<thead>
<tr>
<th>Table 2 Typographical conventions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normal</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Bold:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Italic:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Courier:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Courier bold:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Courier italic:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>&lt;&gt;</td>
</tr>
<tr>
<td>[]</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>{}</td>
</tr>
<tr>
<td>...</td>
</tr>
</tbody>
</table>

Where to get help

EMC support, product, and licensing information can be obtained as follows:

**Product information**

For documentation, release notes, software updates, or information about EMC products, go to EMC Online Support at [https://support.emc.com/](https://support.emc.com/).

**Technical support**

For technical support, go to EMC online support and select Support. On the Support page, you will see several options, including one to create a service request. Note that to open a service request, you must have a valid support agreement. Contact your EMC sales representative for details about obtaining a valid support agreement or with questions about your account.
Online communities
Visit EMC Community Network at https://community.EMC.com/ for peer contacts, conversations, and content on product support and solutions. Interactively engage online with customers, partners, and certified professions for all EMC products.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the user publications. Send your opinions of this document to DPAD.Doc.Feedback@emc.com.
This section contains EMC SourceOne information that applies to all content types, including email, SharePoint, and file content.

“Part 2 Email Management Specific Information” on page 339 contains email-specific information.

The following sections in this part contain information for all content types.

- “EMC SourceOne Overview” on page 15 provides an overview of the EMC SourceOne products.
- “Planning and Initializing Content Processing” on page 23 describes the initial configuration and creation tasks you need to perform for the EMC SourceOne system.
- “Using the EMC SourceOne Console” on page 35 introduces how to use the administrative functions within the EMC SourceOne console.
- “Connecting Archives” on page 43 describes how to connect the one or more archives you will be using to the EMC SourceOne system.
- “Configuring Archives” on page 51 describes how to configure the archives you use with EMC SourceOne.
- “Configuring Mapped Folders” on page 125 describes how to configure mapped folders for the EMC SourceOne archives.
- “Configuring Worker Servers and Worker Groups” on page 157 describes how to configure workers in the EMC SourceOne environment.
- “Configuring Applications and Web Services” on page 171 describes how to configure application and web settings in the EMC SourceOne environment.
- “Managing Organizational Policies” on page 215 describes how to configure and manage policies.
- “Managing Jobs” on page 221 describes how to configure and manage jobs.
- “Common and email-specific best practices” on page 241 describes both common and email-specific best practices.
- “Using Job Logs” on page 269 describes how to use job logs.
- “Maintaining EMC SourceOne” on page 277 describes both common and email-specific maintenance tasks to perform with EMC SourceOne.
- “Troubleshooting EMC SourceOne” on page 317 describes both common and email-specific tasks to diagnose and resolve common processing and performance issues.
- “Configuring CTA Integration” on page 335 describes the integration of EMC Cloud Tiering Appliance (CTA) with EMC SourceOne Email Management.
CHAPTER 1
EMC SourceOne Overview

This section provides an overview of EMC SourceOne. The following topics are included in this section:

- Introduction to EMC SourceOne
- EMC SourceOne system overview
- EMC SourceOne user roles
- Guide to using the documentation
- Other products used with EMC SourceOne
Introduction to EMC SourceOne

EMC SourceOne is an enterprise solution you can use to archive content from email, file, and Microsoft SharePoint servers and can help you comply with legal requirements for archiving.

EMC SourceOne archives and organizes content from Microsoft Exchange (Office 365 and local servers), IBM Lotus Domino, and SMTP mail servers, as well as from SharePoint servers and file servers. Archived content is stored in the EMC SourceOne Native Archive.

The types of content you can process depends on what EMC SourceOne products you are using:

- Email content can be processed when you use EMC SourceOne Email Management.
- SharePoint content can be processed when you add EMC SourceOne for Microsoft SharePoint to an existing Email Management environment.
- File content can be processed when you add EMC SourceOne for File Systems to an existing Email Management environment.
- Existing EmailXtender 4.8 SP1 archives can also be read by EMC SourceOne.

These components appear in this figure.

![EMC SourceOne system overview](Figure 1 EMC SourceOne system overview)
EMC SourceOne system overview

You archive content, such as SharePoint documents, Domino or Exchange email messages, or files from various sources by creating EMC SourceOne activities. Activities are used to perform most EMC SourceOne processing, such as archiving messages. You create activities in the EMC SourceOne console. After an activity is created, EMC SourceOne work units, called jobs are created from that activity to run on one or more computers within the EMC SourceOne system, called Worker Servers. Information about activities, jobs, and other components is stored within the activity database.

The following steps summarize how EMC SourceOne components work together to archive content:

1. An activity is created by the EMC SourceOne administrator using the EMC SourceOne console. An example of an activity would be the Journaling activity, which can be used to archive messages from a mail server, such as an Exchange or Domino mail server.

2. After an activity is created, the activity is stored in the activity database. Jobs are generated automatically to perform the work of the activity and those jobs are stored in the activity database as well.

3. Periodically, Worker Servers check the activity database for jobs they can perform (not all Workers may be configured to perform all jobs). If a matching job is found, that job is then run on the Worker Server.

EMC SourceOne system components

This section provides a more in-depth view of the EMC SourceOne system components already discussed and introduces additional lower-level components. This figure displays the relationship between the EMC SourceOne components.
Content sources

EMC SourceOne can archive content from multiple sources, such as a SharePoint server, a file server, or a mail server. Supported mail server sources include Exchange or Domino mail servers, as well as SMTP mail servers or Instant Messaging proxy servers.

Refer to “Part 2 Email Management Specific Information” on page 339 for information about EMC SourceOne email management capabilities.

Refer to the *EMC SourceOne for Microsoft SharePoint Administration Guide* for information about SharePoint content archiving capabilities.

Refer to the *EMC SourceOne for File Systems Administration Guide* for information about file archiving capabilities.

Content archives

EMC SourceOne allows you to transparently manage and archive content using a wide array of storage devices, such as EMC Centera or EMC Symmetrix.

You can use EMC SourceOne to manage content archived in any of the following types of archives:

- **EMC SourceOne Native Archive**
  
  The Native Archive is a scalable and flexible archive technology that is shipped with EMC SourceOne. The Native Archive can be configured to use a single computer, or more typically, to use many computers. The computers that are used as part of the Native Archive are referred to as Native Archive Servers.

  You configure the Native Archive by configuring each of the Native Archive Servers to perform one or more server roles. These roles are: archive server, index server, search server, and retrieval server. This allows you to have the flexibility of having more servers for processing roles that you will use often and fewer servers for roles you will use less frequently.

- **EmailXtender 4.8 SP1 archive**
  
  You can access messages archived by EmailXtender 4.8 SP1, but you cannot add messages to this archive using EMC SourceOne.

EMC SourceOne console

The EMC SourceOne administrator uses the EMC SourceOne console to configure and manage the EMC SourceOne system. The EMC SourceOne console is implemented as a Microsoft Management Console (MMC) 3.0 snap-in.

EMC SourceOne Web services

The EMC SourceOne Web services enable EMC SourceOne to support Web-based components, such as Search, the Outlook Web Access (OWA) mail client, the Domino Web Access (DWA) mail client, and others.

Client applications

Client applications that work with EMC SourceOne include IBM Lotus Notes, Microsoft Outlook, and others.
Client services

Client services that work with EMC SourceOne include the Microsoft Outlook Web Access (OWA) mail client, the IBM Domino Web Access (DWA) mail client, and others.

**EMC SourceOne user roles**

EMC SourceOne can be used in several ways by several types of users. Each of these users may have one or more roles, from an EMC SourceOne search user role to an EMC SourceOne administrator role. Depending on the size of the organization, each role may be assigned to a different individual or several roles may be assigned to a single individual. The following list describes the primary EMC SourceOne user roles:

- **Compliance manager** - Defines regulatory compliance across the organization. The compliance manager defines corporate content policies, such as how long content is to be retained. Consult these policies when configuring the EMC SourceOne system.

- **Email user** - Views, composes, and manages their messages using an email client, such as Notes or Outlook. The email user may search the EMC SourceOne archives for messages, or if they are an Outlook user, select individual messages they receive to be archived by EMC SourceOne.

- **SharePoint user** - Views and manages SharePoint documents. The SharePoint user may search the EMC SourceOne archives for documents using the Archive Search available in the SharePoint Search portal.

- **File user** - Views and manages files. The file user may search the EMC SourceOne archives for files using EMC SourceOne Search.

- **EMC SourceOne administrator** - Manages and maintains the EMC SourceOne installation after it is installed. This person performs maintenance and management tasks and customizes the system as needed for their environment. This person may also be the Domino server, Exchange server, or SharePoint server administrator.

- **EMC SourceOne installer** - Performs the initial installation and configuration of the EMC SourceOne system. This person is often also the EMC SourceOne administrator.

- **EMC SourceOne legal compliance user** - Uses EMC SourceOne Search capabilities to comply with legal requirements for archiving or discovery. Usually, this person will use the EMC SourceOne Search capabilities as a starting point and may also make use of more specialized search products. Refer to “Other products used with EMC SourceOne” on page 22 for a list of other search products that can be used with EMC SourceOne.

- **EMC SourceOne Search user** - Is someone who uses EMC SourceOne Search capabilities to find content archived by EMC SourceOne. SharePoint users may also use the Archive Search available in the SharePoint Search portal. Refer to “Other products used with EMC SourceOne” on page 22 for a list of other search products that can be used with EMC SourceOne.

**Guide to using the documentation**

To use the documentation, you need to know what books are available to you, and which of those you need to perform your role in the organization.
Overview of the EMC SourceOne Email Management documentation set

The Email Management documentation is composed of the following books.

- **EMC SourceOne Email Management Installation Guide**
  Describes how to plan for and install EMC SourceOne software, including email management and archiving software. This book also contains platform information for use when installing other EMC SourceOne products, such as EMC SourceOne for Microsoft SharePoint or EMC SourceOne for File Systems.

- **EMC SourceOne Email Management Administration Guide** (this book)
  Describes how to use, configure, troubleshoot, and manage the Email Management software. Most of the content of this book is also available in the EMC SourceOne Console online help.

  This guide is separated into the following parts:

  - “Part 1 Common Information” on page 13 describes topics of use to email management, SharePoint archiving, and file archiving administrators.
  - “Part 2 Email Management Specific Information” on page 339 describes topics that are specific to Email Management.

  After you have installed Email Management, you can also install products to perform Microsoft SharePoint and File content as well.

  Refer to the documentation for those products for more details:
  - EMC SourceOne for Microsoft SharePoint
  - EMC SourceOne for File Systems

- **EMC SourceOne Search User Guide**
  Describes how to use Search to search for content that has been archived. Most of the content of this book is also available in the Search online help.

- **EMC SourceOne In Place Migration Administration Guide**
  Describes how to perform an in place migration of EMC EmailXtender data to Email Management.

- **EMC SourceOne Email Management Release Notes**
  Describes supplemental information about Email Management.

- **EMC SourceOne Localized Product Release Notes**
  Describes supplemental localization information about the EMC SourceOne product language support, including email management, SharePoint archiving, and file archiving.

- **EMC SourceOne Products Compatibility Guide**
  Describes the components, operating systems, and products that are supported for use with EMC SourceOne products.
Selecting what to read based on your role

The documentation for EMC SourceOne is intended for several audiences with several roles. Read the portions intended for the roles you perform in your organization.

Refer to the roles in this table for a list of what portions of the documentation to read.

Table 3  Guide to using the documentation by role

<table>
<thead>
<tr>
<th>If your role is ...</th>
<th>Read the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>All roles</td>
<td>All EMC SourceOne product users need to read this section which provides an introduction to the EMC SourceOne products and introduces key concepts.</td>
</tr>
<tr>
<td>Email, SharePoint, or file content end user</td>
<td>End users do not need to read the EMC SourceOne documentation. However, the EMC SourceOne product administrator needs to provide an overview of the EMC SourceOne product features being used that impact end users. For example, if shortcuts are enabled, the administrator needs to explain the local shortcutting policy to end users.</td>
</tr>
</tbody>
</table>
| Compliance manager               | Compliance managers need to be aware of the settings of the EMC SourceOne system that have to do with the corporate compliance policies and know how to review and change the settings. Refer to the following sections for this information:  
  • “Planning and Initializing Content Processing” on page 23.  
  • “Connecting Archives” on page 43.  
  • “Using the EMC SourceOne Console” on page 35.  
  • “Configuring Archives” on page 51.  
  • “Configuring Mapped Folders” on page 125. |
| EMC SourceOne administrator       | Email Management administrators can determine what portions of this guide to read based on what content is being archived at their site.  
  “Part 1 Common Information” on page 13 is to be read by all administrators.  
  “Part 2 Email Management Specific Information” on page 339 is to be read by administrators where email content is being archived.  
  If other EMC SourceOne products are installed, the administrator needs to read the administration documentation for those products as well. |
| EMC SourceOne installer           | Users who install Email Management need to read the following:  
  • To perform an installation, refer to the EMC SourceOne Email Management Installation Guide which describes how to install the Email Management software.  
  • To perform certain initial configuration and creation tasks to have a fully functional Email Management system, refer to “Planning and Initializing Content Processing” on page 23.  
  • If other EMC SourceOne products are to be installed, the administrator needs to read the installation documentation for those products as well.  
  • If migrating data from an EmailXtender installation, refer to the EMC SourceOne In Place Migration Administration Guide. |
| EMC SourceOne legal compliance user | Users who want to perform searches of messages in the Email Management archive for the purposes of compliance with email policies and regulations can use Discovery Manager if it is available. Refer to the EMC SourceOne Discovery Manager User Guide for more information. |
| EMC SourceOne search user         | Users who want to perform searches for messages in the Email Management archive can refer to the online help within Search or read the EMC SourceOne Search User Guide. |
Other products used with EMC SourceOne

The following list contains EMC products you can use to enhance the capabilities of your Email Management system.

- **EMC SourceOne for Microsoft SharePoint**
  Adds support for Microsoft SharePoint archiving to the Email Management system.

- **EMC SourceOne for File Systems**
  Adds support for file archiving to the Email Management system.

- **EMC SourceOne Discovery Manager**
  EMC SourceOne Discovery Manager provides collection, hold, and export capabilities in response to a regulatory notice or corporate policy request for email archived by Email Management or EmailXtender. Discovery Manager is a separate, chargeable application option to Email Management.

- **EMC SourceOne Offline Access**
  The Offline Access client application (Offline Access) provides a seamless experience to the user when retrieving shortcut messages in Outlook. Also, you can configure Offline Access to cache messages on users’ hard drives so that users can retrieve messages when they are not connected to the network.

- **EMC SourceOne Kazeon eDiscovery**
  Kazeon eDiscovery is an EMC product that enables organizations to efficiently and cost-effectively classify, manage, and retrieve data.

- **EMC EmailXtender**
  An email archiving solution. Archives created by EmailXtender can be read using Email Management.

- **EMC SourceOne In Place Migration Services**
  A separate toolset you can purchase to perform an in place migration of EmailXtender data to Email Management.

- **EMC DiskXtender for Windows**
  DiskXtender for Windows is an EMC product that allows you to extend the capacity of EMC SourceOne Email Management storage by automatically writing Email Management archives to other storage media and network devices.

- **EMC Email Supervisor**
  Email Supervisor enables an organization to monitor inbound and outbound email for compliance with corporate policies, as well as NASD regulations and governance mandates for email archived by Email Management or EmailXtender. Email Supervisor is an add-on product in the EMC SourceOne family.
CHAPTER 2
Planning and Initializing Content Processing

This section describes how to plan and perform the initial configuration of the various parts of the EMC SourceOne software. The following topics are included in this section:

◆ Overview of the initialization tasks ................................................................. 24
◆ Verify and configure the environment for EMC SourceOne .......................... 24
◆ Initialize the archive ....................................................................................... 32
◆ Associate mapped folders with the archive ................................................... 33
◆ Review supported mail environments ............................................................. 33
◆ Create policies and activities ......................................................................... 33
Overview of the initialization tasks

After EMC SourceOne has been installed, there are initialization tasks that need to be performed before you can archive content from a SharePoint server or an email server. These tasks occur in the following order.

1. Verify that the software environment on the Worker Servers and the Master Server are configured correctly for EMC SourceOne.
2. Initialize an archive that will contain the content to be archived.
3. Create the mapped folders used to access the content in the archive.
4. Review, and if required modify, the list of supported mail systems in the Global Settings dialog box of the EMC SourceOne console to ensure that they match your environment.
5. Create the policies and activities (and email rules if used) that will be used to archive content.

Verify and configure the environment for EMC SourceOne

Verify that the software environment on the Worker Servers, the Master Server, and the Native Archive Servers are configured correctly for EMC SourceOne. Specifically, verify that the following tasks have been performed.

- If antivirus software is installed on a Worker Server, a Master Server, or a Native Archive Server, verify that the antivirus software is configured to work with EMC SourceOne.
- If EMC SourceOne is being used with Exchange, verify that the Exchange Active Directory environment is configured to work with EMC SourceOne.
- If Exchange PST files will be processed by EMC SourceOne in an Exchange resource forest Active Directory configuration, verify that any needed additional tasks have been performed.
- Review the network ports that are used by EMC SourceOne to make sure they do not conflict with other applications used by your organization.
- Verify that all computers in the environment are synchronized to make sure there are no timing issues.

Configure antivirus software, if used

The following antivirus software can be used with EMC SourceOne software.

- Symantec® Norton AntiVirus® Corporate Edition
- McAfee® VirusScan® Enterprise

This list of antivirus software is not exhaustive. Other antivirus software packages may also work.

When using antivirus software with EMC SourceOne and archiving content from a mail server, install the antivirus software on the mail server, such as a Lotus Domino mail server, or a Microsoft Exchange mail server.
Be aware that messages that contain viruses may cause errors and not be processed. For example, if a shortcut activity is run against a message containing a virus, an error is generated indicating “Shortcut failed”. This is intended behavior, as EMC SourceOne does not shortcut messages containing a virus. If possible, do not install antivirus software on the Master Server, Worker Servers, or Native Archive Servers. If company policy requires you to install antivirus software on the EMC SourceOne servers, configure that software as described in the following sections.

Configuring antivirus software on a mail server using EMC SourceOne

When antivirus software is installed on a Domino or Exchange mail server, the antivirus software may remove infected messages in the one or more EMC SourceOne journaling mailboxes (databases) for that mail server, resulting in that message not being archived.

**Note:** If you have antivirus software that is causing issues with the EMC SourceOne software, please contact EMC Technical Support.

Configuring antivirus software on an EMC SourceOne Master Server, Worker Server, or Native Archive Server

It is recommended that antivirus software be installed on the mail server and not on an Master Server, Worker Server, or Native Archive Server. Using antivirus software on an EMC SourceOne server can impact the performance of EMC SourceOne and cause processing problems.

When antivirus software is installed on an EMC SourceOne server, the antivirus software may remove or modify infected messages while they are being processed by EMC SourceOne.

If your environment requires that antivirus software be installed on the EMC SourceOne servers, configure the antivirus software as follows to avoid problems with the EMC SourceOne software.

For Master Servers, Worker Servers or Native Archive Servers:

- Disable virus scanning on any Exchange or Domino email clients, such as Microsoft Outlook or Lotus Notes, that are installed on the EMC SourceOne server.
- Disable SMTP scanning on the EMC SourceOne server.
- Disable virus scanning on the directories and subdirectories where the EMC SourceOne software is installed or that the EMC SourceOne software uses. This includes:
  - The directory and subdirectories where the EMC SourceOne software is installed.
  - The Native Archive work directory and subdirectories.
  - The Native Archive message center directory and subdirectories.
  - The Native Archive folder volume directory and subdirectories.
  - The Native Archive index directory and subdirectories.
- If processing Office 365 email (Exchange Online) content, those processing directories. These directories are:
Planning and Initializing Content Processing

- Any source folder used by the EMC SourceOne File Mover agent. This is typically the SMTP drop directory used by IIS.
- Any target folder used by the EMC SourceOne File Mover agent. These folders are defined by the administrator.
- The Journaling issues folder used by the EMC SourceOne File Mover agent. This folder is defined by the administrator.

Refer to “Using the Journal Activity for Office 365 Content” on page 453 for more information about these folders.

This is the simplest and easiest way to protect EMC SourceOne from potential antivirus software problems.

Configuring EMC SourceOne for an Exchange Active Directory environment

EMC SourceOne works with Exchange servers that are installed in several Active Directory environments. In all cases, EMC SourceOne requires that all the Exchange servers be installed in the same Exchange organization.

The following table lists the types of Exchange Active Directory configurations, and how EMC SourceOne supports each.

<table>
<thead>
<tr>
<th>Active Directory forest configuration</th>
<th>EMC SourceOne configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Single Forest</strong></td>
<td>Single or multiple domains in a single forest are supported by EMC SourceOne as described in the EMC SourceOne Email Management Installation Guide.</td>
</tr>
<tr>
<td>A single Active Directory forest containing one or more domains. Each domain contains one or more Exchange servers. A common global address list (GAL) is used for all domains. This is the simplest topology and is recommended by Microsoft in the document Active Directory Forest Topologies.</td>
<td></td>
</tr>
<tr>
<td><strong>Multiple Forests (Exchange Resource Forest)</strong></td>
<td>Only Offline Access is to be installed in the forests not containing the Exchange server. All EMC SourceOne components must be installed in the same Active Directory forest as the Exchange server. Refer to the EMC SourceOne Email Management Installation Guide for information about installing these components.</td>
</tr>
<tr>
<td>Multiple Active Directory forests are used. One forest is dedicated to running Exchange and hosting Exchange mailboxes. The user accounts associated with the mailboxes are contained in one or more other separate forests. This configuration is also referred to as a Dedicated Exchange Forest configuration.</td>
<td></td>
</tr>
<tr>
<td><strong>Multiple Forests (Exchange Cross-Forest)</strong></td>
<td>Not supported by EMC SourceOne. Only the Exchange Resource Forest configuration is supported for multiple Active Directory forests.</td>
</tr>
<tr>
<td>Multiple Active Directory forests are used. Each forest contains an Exchange server and the user accounts for users of that Exchange server. This configuration has several disadvantages and requires extensive synchronization of active directory objects across forests and requires replication of other data.</td>
<td></td>
</tr>
</tbody>
</table>
For more information about Exchange and Active Directory configurations, consult the following Microsoft documentation:

- *Active Directory Forest Topologies*
- *Planning to Deploy Exchange in a Multiple Forest Environment.*

**Configuring Exchange PST processing across Active Directory forests**

The procedure for processing PST files differs depending on whether you are processing within a single Active Directory forest or across multiple forests.

To process Microsoft Exchange PST files within a single Active Directory forest, use EMC SourceOne.

To process PST files that are spread across multiple forests, you need to perform additional tasks prior to performing the tasks in “PST and NSF Processing Activities” on page 397 as described in the following sections.

**Selecting an option for multiple forest PST processing**

In an Exchange resource forest configuration, user accounts and user computers exist in one or more forests, referred to as user forests, and the Exchange server and EMC SourceOne exist in the resource forest.

This means that the Worker Server needs to be able to access not only EMC SourceOne components in the resource forest, but also PST files and mail accounts on computers in a user forest. There are two options for accessing PST files to perform PST operations in an Exchange resource forest configuration:

- Move the PST files to be processed from the user forest to a network share in the resource forest.
- Configure a Worker Server specifically to process PST files in the user forest as a user in the user forest.

**Option 1: Move PST files to a share in the resource forest**

If the PST files to be processed are in a known location, move these files to a network share within the resource forest. Refer to the *EMC SourceOne Email Management Installation Guide* for information about how to configure the permissions for accessing PST files on such a share using EMC SourceOne.

Moving the files into the resource forest allows the Worker Server to access these files without performing any additional configuration of EMC SourceOne.

If the PST files are not in a known location, or you cannot move them into the resource forest for other reasons, then you must use the option described in the following section.
Option 2: configure Worker to run under the identity of a user in the user forest

Use this option to process PST files in a resource forest configuration if the location of the PST files is unknown or the PST files cannot be moved from the user forest to the resource forest.

Using this option, the Worker Server is configured to work solely with PST files and runs as a user in the user forest so that it can access the PST files in the user forest. Other non-PST activities cannot be run by this Worker Server after it has been configured to process files in a user forest.

Perform the tasks in the following sections to configure the Worker Server.

**Before installing the Worker Server to process PST files**

Prior to installing the Worker Server for remote user forest PST processing, perform the following tasks.

1. In Active Directory, select or create a service account that is a user in the user forest. Be sure this user account has adequate access permissions to enumerate the computers or shares containing the PST files in the user forest.
2. In Active Directory, create a security group and add the user you created in step 1 to that group.
3. Assign SQL permissions to the user account you created in step 1. These permissions are described in the *EMC SourceOne Email Management Installation Guide*.
4. Add the user account you selected or created in step 1 from the user forest to the local administrators group on the Worker Server computer.
5. Log in to the Worker as the user from the user forest as described in step 1.
6. Create the Outlook profile as described in the *EMC SourceOne Email Management Installation Guide*.
   
   The Outlook profile must be configured to use an account that has adequate permissions to open PST files and enumerate the GAL (Global Address List). Also, verify that the profile can open the owner mailboxes it needs to access. Refer to the *EMC SourceOne Email Management Installation Guide* for more information about the permissions needed by the EMCSourceOne Outlook profile.
7. Install the Worker Server.

**Installing the Worker Server**

Perform the following steps to install the Worker Server to process PST files in the user forest.

1. Verify that all the tasks described in “Before installing the Worker Server to process PST files” on page 28 have been completed.
2. Install the Worker on a computer in the Exchange Resource forest as described in the *EMC SourceOne Email Management Installation Guide*.
   a. When prompted by the install to configure the service account, specify the user from the user forest that you selected or created.
   b. When prompted by the install, specify the security group in which you placed that user account. This is the security group you selected or created.
3. After you have completed the installation and rebooted the server, confirm in the event log (or in the service control manager) that the dispatcher service started successfully. If the dispatcher service does not start, review the previous steps to make sure no errors were made.

4. Configure the PST file processing Worker Server.

**Configuring the Worker Server**

After the Worker Server is installed, configure it using the EMC SourceOne console.

Perform the following steps.

1. Verify that the Worker Server was installed.

2. Select the types of activities that the Worker Server is permitted to perform. These activities are to only include one or more of the following PST activities:
   
   - Archive – Personal Mail Files
   - Find – Microsoft Office Outlook .PST
   - Migrate – Microsoft Office Outlook .PST

   Refer to “Configuring Worker Servers and Worker Groups” on page 157 for information about how to select the activity types a Worker Server will support.

3. If the Migrate – Microsoft Office Outlook .PST activity is to be used, verify that the user account has permissions that allow it to open the target mailboxes used to migrate the shortcut messages.

**Configuring SourceOne Search to work across forests**

This configuration is only necessary if you want to permit users to run the EMC SourceOne Search application within the resource forest and search, retrieve, and shortcut messages in the user forest.

To allow users to use Search to search, retrieve, and shortcut messages in the user forest within the Exchange resource forest, the Search user must log in as a remote user from the user forest. A remote user prefixes their username with the remote domain from the user forest, for example, MyRemoteDomain\MyUsername.

Perform the following steps to enable the ability to specify a remote domain when logging in to Search.

1. On each Worker Server in the resource forest on which the Web services software is installed, select Administrative Tools > Computer Management from the Start menu. The Computer Management application appears.

2. Expand the Services and Applications node in the navigation pane on the left side to display the Internet Information Services node.

3. Expand the Internet Information Services node to display the Web Sites node.

4. Expand the Web Sites node to display the Default Web Site node.

5. Expand the Default Web Site node to display the SearchWS node.

7. Select the ASP.NET tab. On this tab, click Edit Configuration. The ASP.NET Configuration Settings page appears.

8. In the Application settings area, select the ExSearchConfig.UseResourceForest key and click Edit. An unnamed dialog box appears.

9. Change the displayed value from false to true and click OK. The unnamed dialog closes.

10. Click Apply on the ASP.NET Configuration Settings page to apply the change to the system.

11. Click OK to close the ASP.NET Configuration Settings page.

12. Click OK to close the Search WS Properties page.

13. Select Exit from the File menu on the Computer Management application to close that application.

Reviewing network ports used

A variety of network ports are used by EMC SourceOne and by other components of your content archiving environment. This section lists the ports used by EMC SourceOne and the ports typically used by other common components in your environment.

Check these lists of ports to make sure there are no conflicts with other software on your system. If there is conflict, contact your network administrator to determine which ports to change.
For a more complete list of port number assignments used for various purposes, consult the following documents that are available on the World Wide Web:

- The *Internet Assigned Numbers Authority list*
- The Microsoft document *Service overview and network port requirements for the Windows Server system*

The following table lists the network ports used by or with EMC SourceOne.

Table 5  EMC SourceOne network ports

<table>
<thead>
<tr>
<th>Port number</th>
<th>Protocol/used by</th>
<th>Port usage</th>
</tr>
</thead>
</table>
| 80          | HTTP             | Used by:
|             |                  | • EMC SourceOne Web services.  
|             |                  | • Web browsers to connect to Web sites.  
|             |                  | • Outlook Web Access client applications to connect to a front end Exchange server.  
|             |                  | • Domino Web Access client applications to connect to a Domino server.  
|             |                  | Port 8080 is an accepted alternate for port 80 for most uses. |
| 389         | LDAP             | Used by EMC SourceOne to support LDAP queries. Also used by LDAP client applications to access an LDAP server. |
| 443         | HTTPS            | Used by:
|             |                  | • EMC SourceOne Web services.  
|             |                  | • Web browsers connecting securely to Websites.  
|             |                  | • Secure Outlook Web Access client applications to connect to a front end Exchange server.  
|             |                  | • Domino Web Access client applications to securely connect to a Domino server.  
|             |                  | • EMC SourceOne console to access the CTA console. |
| 636         | Secure LDAP      | Used by EMC SourceOne to support LDAP queries. Also used by secure LDAP client applications to access a directory service. |
| 8080        | HTTP             | An alternate HTTP port for port 80. Refer to the description of port 80 for usage information. |
| 1024 - 65535| EMC SourceOne (DCOM) | EMC SourceOne makes use of DCOM. DCOM communicates using port numbers chosen at random in the range of 1024 to 65535. |

The following table lists other common network ports used by messaging components.

Table 6  Other common network ports (page 1 of 2) (page 1 of 2)

<table>
<thead>
<tr>
<th>Port number</th>
<th>Protocol/used by</th>
<th>Port usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>SMTP</td>
<td>Used by POP3 or IMAP client applications to send SMTP messages.</td>
</tr>
<tr>
<td>110</td>
<td>POP3</td>
<td>Used by POP3 client applications to download messages from mail servers.</td>
</tr>
<tr>
<td>119</td>
<td>NNTP</td>
<td>Used by NNTP client applications to access news group servers.</td>
</tr>
</tbody>
</table>
Verify that all computers are synchronized

Ensure that the system time for all Windows computers in the EMC SourceOne system (Master, Worker, archive server, database server, SharePoint servers, and so on) are synchronized. Typically, this is done using the Windows Time Service. This service continually synchronizes the system time of all computers with an authoritative computer (typically the domain controller).

Initialize the archive

After installing EMC SourceOne, you need to connect one or more archives to EMC SourceOne. These archives may already be configured, or may need to be configured.

“Connecting Archives” on page 43 describes how to connect archives to EMC SourceOne.

“Configuring Archives” on page 51 describes how to configure the archives you have connected and create archive folders within the archive.
Associate mapped folders with the archive

After connecting and configuring the archive, associate mapped folders with archive folders in the archive to use it. Mapped folders allow you to handle content in the same way, regardless of what type of archive is used.

“Configuring Mapped Folders” on page 125 describes how to associate mapped folders with folders in the archive.

Review supported mail environments

Review, and if required modify, the list of supported mail systems in the Global Settings dialog box of the EMC SourceOne console to ensure that they match your environment.

This list controls which mail system processing activities are displayed in the EMC SourceOne console. For more information about modifying settings on the Global Settings dialog box, refer to “Editing global settings for applications and Web services” on page 173.

Create policies and activities

After you have performed the previous initialization tasks, you can create policies and activities to cause content to be processed. Policies must be created to contain activities before the activities can be created.

- Refer to “Managing Organizational Policies” on page 215 for information about how to create a policy.
- Refer to “Configuring Email Management Activities” on page 341 for information about how to create email management activities. When you create an email activity, you also select rules that are used to select the messages to be processed by the activity. Refer to “Using Email Management Rules” on page 499 for information about how to create rules within activities.
- Refer to the EMC SourceOne for Microsoft SharePoint Administration Guide for information about how to create SharePoint content processing activities.
- Refer to the EMC SourceOne for File Systems Administration Guide for information about how to create file content processing activities.
Planning and Initializing Content Processing
CHAPTER 3
Using the EMC SourceOne Console

This section describes how to use the EMC SourceOne console to manage the EMC SourceOne system. Topics include:

- Introduction ............................................................................................................ 36
- Starting the EMC SourceOne console ................................................................. 36
- Overview of the EMC SourceOne console ......................................................... 37
- Working with an MMC snap-in ............................................................................ 38
- Sequence of tasks for a new installation ............................................................ 40
Introduction

Use the EMC SourceOne console to configure and manage the following.

- **Archives** — Connect archives to EMC SourceOne, in preparation for associating mapped folders with archive folders.
- **Native Archive folders** — Create archive folders in the Native Archive, view the list of archive folders, and view archive folder properties.
- **Mapped folders** — Create mapped folders and associate them with archive folders in archives, view the list of mapped folders, and view mapped folder properties.
- **Application and Web server settings** — Specify email environments, specify a URL for shortcut resolution (Exchange), and set search defaults.
- **Policies** — Create organization policies to group related activities, view the list of policies, view the activities in a policy, edit policies, delete policies.
- **Activities** — Configure email management activities to:
  - Journal and archive email in real-time for Microsoft Exchange, IBM Lotus Domino, and internet (SMTP) mail. This journaling and archiving is not done as soon as email is received by the mail server, but at regular intervals when the mail server is checked for new messages.
  - Archive email from selected mailboxes, PST files, and NSF files, based on a schedule.
  - Search for PST files across a network.
  - Shortcut messages.
  - Update shortcuts.
- **Rules** — Create rules to filter email messages, view the list of rule criteria used, edit rules, and delete rules.
- **Jobs** — View and filter the list of jobs, and control the status of jobs.
- **Worker Servers** — View a list of Workers, specify the types of jobs each Worker can run, specify the polling time, and control the status of Workers.
- **Worker Groups** — Create Worker groups to group Worker Servers, view the list of Worker groups, and view Worker group properties.

Starting the EMC SourceOne console

Complete the following procedure to start the EMC SourceOne console.

1. Perform one of the following steps:
   - On the desktop, double-click the **EMC SourceOne Console** icon.
   - On the **Start** menu, click the icon **EMC SourceOne Console**.
   - Select **Start > All Programs > EMC SourceOne Console > EMC SourceOne Console**.
2. In a Domino and Notes environment, the first time you start the EMC SourceOne console, the **Enter Password** dialog box appears. Enter the Notes password, then click **OK**.

![Enter Password](image)

**Figure 3** Enter Password

On subsequent uses of the console, the login will happen automatically if the password is correct and has not changed.

**Loading the EMC SourceOne console as an MMC snap-in on a 64-bit system**

The Microsoft Management Console (MMC) snap-in for the EMC SourceOne console does not appear in the default 64-bit MMC snap-in list on 64-bit systems because the EMC SourceOne console is a 32-bit application.

Perform the following steps to load the EMC SourceOne console snap-in within the MMC snap-in listing.

1. Start the console by typing **MMC -32** at the command line or in the **Start > Run** dialog box.

2. Add the EMC SourceOne console snap-in.

**Overview of the EMC SourceOne console**

The EMC SourceOne console has three main areas and are listed as follows.

- **Tree (left pane)** — Displays expanded nodes.
- **Results pane (center top)** — Displays items when you select a node.
  
  When you select an item in the results pane, the bottom half of that pane may display details or additional items.

- **Actions pane (right)** — Displays the actions you can perform on a selected node in the tree pane, or a selected item in the results pane. The Actions pane may display actions for the tree pane and the results pane simultaneously. You can hide the Actions pane, and use the Action menu or right-click menus instead.
Using the EMC SourceOne Console

Working with an MMC snap-in

The EMC SourceOne console is a Microsoft Management Console (MMC 3.0) snap-in. You can perform the following actions in the EMC SourceOne console in the same way you would in other MMC snap-ins.

The following actions are performed differently in the EMC SourceOne console than in the MMC 3.0 console.

**Note:** You cannot add other snap-ins to the EMC SourceOne console.

Viewing, expanding, or collapsing nodes in the tree pane

You can view, expand, or collapse the nodes shown in the tree pane.

The nodes and subnodes are described in “Sequence of tasks for a new installation” on page 40.

Expanding nodes

To expand the EMC SourceOne node in the tree pane, click the plus sign (+) next to the node. The subnodes are listed in the tree pane, below the EMC SourceOne node.
Viewing nodes

When you click a node in the tree pane, the results pane list displays either subnodes or contents of the node.

The columns shown vary according to the type of item.

Collapsing nodes

To collapse a node, in the tree pane, click the minus sign (-) next to the node.

Sorting columns

In an MMC snap-in, sort rows of data according to a specific column.

Clicking a column header toggles between ascending and descending order, indicated by the small triangle.

Adding or removing columns

The following actions are performed differently in the EMC SourceOne console than in the MMC 3.0 console.

Perform the following steps to add or remove columns in the results pane.

1. Select Action > View > Add/Remove Columns.

2. To add columns, in the Choose Columns dialog box, select the checkbox for each column you want to add. The available columns depend on the node you are viewing.
Using the EMC SourceOne Console

Figure 6  Choose columns — Jobs

The results pane updates immediately.

3. To remove columns, in the Choose Columns dialog box, clear the checkbox for each column you want to remove.

The results pane updates immediately.

Rearranging columns

The following actions are performed differently in the EMC SourceOne console than in the MMC 3.0 console.

Drag the column header left or right to a new location. Red arrows indicate where to drop the column header.

Refreshing the view

Perform one of the following steps to refresh the list in the results pane.

1. Press F5.

2. In the Actions pane, click the Refresh icon.

Sequence of tasks for a new installation

The order in which you use the nodes for a new installation is different than the order in which they appear in the console.

The following table describes the nodes in the order in which you use them for a new installation.

Table 7  Sequence of tasks for a new installation  (page 1 of 2)

<table>
<thead>
<tr>
<th>Node</th>
<th>Subnodes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Connections</td>
<td></td>
<td>Use to connect archives (Native Archive and EmailXtender 4.x archive) to EMC SourceOne.</td>
</tr>
</tbody>
</table>
### Table 7 Sequence of tasks for a new installation (page 2 of 2)

<table>
<thead>
<tr>
<th>Node</th>
<th>Subnodes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Native Archive</td>
<td>Server Configuration:</td>
<td>Use this node to:</td>
</tr>
<tr>
<td></td>
<td>• Archive</td>
<td>• Assign roles to Native Archive Servers.</td>
</tr>
<tr>
<td></td>
<td>• Index</td>
<td>• Configure Native Archive Servers.</td>
</tr>
<tr>
<td></td>
<td>• Search</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Retrieval</td>
<td></td>
</tr>
<tr>
<td>Archive Folders</td>
<td></td>
<td>Use to create folders in Native Archive for archiving.</td>
</tr>
<tr>
<td>Mapped Folders</td>
<td></td>
<td>Use to create EMC SourceOne mapped folders and associate them with archive folders.</td>
</tr>
<tr>
<td>Servers and Groups</td>
<td></td>
<td>Servers. Use to configure roles (job types) for Worker Servers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Worker Groups. Use to create Worker groups to contain Worker Servers.</td>
</tr>
<tr>
<td>Application</td>
<td></td>
<td>Use to specify settings for applications and Web services, including search defaults and the URL used for shortcut resolution.</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operations</td>
<td>PST Groups</td>
<td>Use to create groups of:</td>
</tr>
<tr>
<td></td>
<td>• Machines for PST discovery</td>
<td>• Machines for PST discovery</td>
</tr>
<tr>
<td></td>
<td>• PST files for PST archiving</td>
<td>• PST files for PST archiving</td>
</tr>
<tr>
<td></td>
<td>NSF Groups</td>
<td>Use to create groups of NSF files for NSF archiving.</td>
</tr>
<tr>
<td>Organizational</td>
<td></td>
<td>Use to create and manage policies and activities.</td>
</tr>
<tr>
<td>Policies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operations</td>
<td>Job Management</td>
<td>Use to monitor jobs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Using the EMC SourceOne Console
CHAPTER 4
Connecting Archives

This section describes how to connect an archive for use with EMC SourceOne. Topics include:

◆ Introduction ............................................................................................................. 44
◆ Prerequisites ......................................................................................................... 44
◆ Viewing list of archives ..................................................................................... 44
◆ Adding an archive connection .......................................................................... 45
◆ Modifying archive connection properties ....................................................... 50
◆ Deleting an archive connection ....................................................................... 50
Introduction

After you have installed the EMC SourceOne system and archiving software you are planning to use with EMC SourceOne, you need to use the EMC SourceOne console to connect the EMC SourceOne system to the one or more archives as described in this section.

Prerequisites

Before connecting archives, those archives must exist and contain one or more folders. Archive folders are created differently for each type of archive:

- EmailXtender 4.8 SP1 archive folders
- EMC SourceOne archive folders

After you have connected the one or more archives, you then need to configure those archives if they are not already configured.

Viewing list of archives

To view a list of archives in the EMC SourceOne console, select the Archive Connections node. The Archive Connections area appears.

The Archive Connections area lists the name and type of the archive connections that have been added, if any.

The following list describes the available types of archives:

- Native Archive — An EMC SourceOne Native Archive.
- EmailXtender 4.x — An EMC EmailXtender 4.8 SP1 archive.
- In Place Migrated Native Archive — An EMC SourceOne Native Archive to be used when performing In place migration.

EMC SourceOne does not automatically detect archives and add them to the connection list. Only those archives that are explicitly added are listed.
Adding an archive connection

Complete the following procedure to add an archive connection.

1. In the EMC SourceOne console, select the Archive Connections node.
2. Select Action > New Archive Connection.
3. On the General page of the New Archive Connection wizard, specify the name and type of the new archive connection.

![New Archive Connection wizard General page](image)

Figure 7  New Archive Connection wizard General page

a. In the Name field, type a unique name for the archive connection as you want it to appear in the Archive Connections list.

b. (Optional) In the Description field, type a description for the new archive connection.

c. In the Type field, select the type of archive (EmailXtender 4.x, In Place Migrated Native Archive, or Native Archive).

d. Click Next.

The next page displayed by the New Archive Connection wizard depends on the type of archive you selected.

4. Continue to one of the following topics, depending on the type of archive you selected previously:

- If you are adding a connection to an EmailXtender archive, refer to “Adding an EmailXtender 4.x archive” on page 46.

- If you are adding a connection to either a Native Archive or an In Place Migrated Native Archive, refer to “Adding a Native Archive or In Place Migrated Native Archive” on page 49.
Adding an EmailXtender 4.x archive

The following sections outline the phases of adding an EmailXtender 4.x archive.

EmailXtender 4.x Server Configuration page

On the EmailXtender 4.x Server Configuration page of the New Archive Connection wizard, specify an EmailXtender 4.x server and provide the username of the EmailXtender 4.x service account.

Perform the following tasks to configure EmailXtender 4.x archive.

1. In the Server field, enter or select the name of the EmailXtender 4.x server. EmailXtender 4.x servers are automatically detected and added to this list box. If the EmailXtender server you want to use is not listed, you can add it manually using the Add button.

2. If needed, perform one or more of the following tasks on the servers in the list:
   - To add a server to the list, click Add. The Server Configuration dialog box appears.
   - To edit a server in the list, select the server from the list and click Edit. The Server Configuration dialog box appears.
   - To remove a server from the list, select the server from the list and click Remove.

3. Click Next.

4. Continue by configuring folders.
Adding or modifying EmailXtender server configuration information

Use the Server Configuration dialog box to add or modify EmailXtender server configurations for use with EMC SourceOne.

Figure 9 EmailXtender 4.x Server Configuration dialog box

Complete the following steps in the Server Configuration dialog box

1. In the 4.x Administrator Name field, enter or modify the name of the EmailXtender service account.

2. Select the database to use by doing either of the following:
   - Select the Database Server and Name option and click the Browse button to select the value for the Database Server field. After the database server is selected, enter the name of the database in the Database Name field.
     
     When specifying the database server for an archive connection, you can specify either the database server name, such as MyDBServer, if you are using the default database instance, or a specific database instance with the database server name, such as MyDBServer\SourceOne.

   - Select the Datasource Name option and then enter the data source name in the DSN field.

3. Click OK to complete adding or modifying the server configuration. The Server Configuration dialog box closes.

4. If you added a new server, the name of the server is listed on the EmailXtender 4.x Server Configuration page.

5. Click Next.

EmailXtender 4.x Folder Configuration page

The EmailXtender 4.x Folder Configuration page of the New Archive Connection wizard lists all the archive folders for the EmailXtender 4.x server that you specified on the EmailXtender 4.x Server Configuration page.

Specify the EmailXtender 4.x archive folders that will be available for mapping to EMC SourceOne mapped folders, using one of the following options:
Connect all server folders (default). Makes all EmailXtender 4.x archive folders available for mapping to mapped folders.

- Aggregate selections in single virtual folder. Allows you to select specific EmailXtender 4.x archive folders and group them into a virtual archive folder. The virtual archive folder will be available for mapping to mapped folders.

1. Perform one of the following steps:
   - Make all EmailXtender 4.x archive folders available for mapping in EMC SourceOne by selecting **Show all server folders**.

   ![Show all server folders — EmailXtender 4.x Folder Configuration page](image)

   - Specify certain EmailXtender 4.x archive folders and group them into a virtual archive folder:
     a. Select **Aggregate selections in single virtual folder**.
     b. In the **Folder name** field, type a unique name for the new virtual archive folder.
     c. In the list of EmailXtender 4.x archive folders, select the folders you want to add to the virtual archive folder.
Adding an archive connection

2. Click Finish.

The new EmailXtender 4.x archive connection appears in the Archive Connections list.

Adding a Native Archive or In Place Migrated Native Archive

Perform the following steps using the Native Archive Configuration page of the New Archive Connection wizard when adding either a Native Archive or an In Place Migrated Native Archive.

1. To add the archive, you specify the SQL server and the name of the EMC SourceOne archive database, as follows:
Connecting Archives

1. Click **Browse**.
2. Locate and select the SQL server containing the Native Archive databases to be used.
   - The **Database Server** field displays the selected database server.
   - When specifying the database server for an archive connection, you can specify either the database server name, such as `MyDBServer`, if you are using the default database instance, or a specific database instance with the database server name, such as `MyDBServer\SourceOne`.
3. In the **Database Name** field, type the name of the instance of the EMC SourceOne archive database to be used, for example, `EMCSourceOneArchive`.
4. Click **Finish**.
   - The new archive connection now appears in the Archive Connections list.

### Modifying archive connection properties

Perform the following steps to modify the properties for an archive connection.

1. In the EMC SourceOne console, select the **Archive Connections** node.
2. In the **Archive Connections** area, select the connection you want to modify.
3. Select **Action > Properties**.
4. In the **Edit Archive Connection** wizard, edit the fields.
   - **Note:** You cannot edit the **Name** or **Type** fields.

### Deleting an archive connection

Perform the following steps to delete a connection from the Archive Connections list.

1. In the EMC SourceOne console, select the **Archive Connections** node.
2. In the Archive Connections area, select the connection you want to delete.
3. Select **Action > Delete**.
   - **Note:** The archive is deleted from the Archive Connections list, but not from the EMC SourceOne database.
CHAPTER 5
Configuring Archives

This section describes how to configure an archive for use with EMC SourceOne. Topics include:

- Overview of configuring an archive ................................................................. 52
- Configuring EmailXtender 4.8 SP1 messages for viewing .............................. 52
- Configuring the Native Archive ....................................................................... 53
- Configuring Native Archive Server roles ....................................................... 53
- Configuring Native Archive folders and storage ............................................. 61
- Configuring Native Archive folder DiskXtender options ............................... 93
- Managing Native Archive folders ................................................................. 97
- Managing Multiple Native Archive Connections .......................................... 104
- Searching an archive .................................................................................... 109
- Moving an archive ....................................................................................... 110
- Retaining and disposing of archived data .................................................... 111
- Partitioning a Native Archive database ....................................................... 116
- Adding Native Archive supplemental language support ............................. 123
Overview of configuring an archive

When you installed EMC SourceOne, you also installed one or more archives that SourceOne uses to store and access content. After connecting the archive you need to configure it before it can be used.

How you configure an archive depends on which type of archive you select:

- To configure a Native Archive, refer to “Configuring the Native Archive” on page 53.
- To configure an EmailXtender 4.8 SP1 server archive, refer to “Configuring EmailXtender 4.8 SP1 messages for viewing” on page 52.

Note that you can only access previously archived messages in an EmailXtender 4.8 SP1 archive, you cannot archive additional content into an EmailXtender 4.8 SP1 archive using EMC SourceOne.

After an archive is configured, you may need to perform other tasks relating to it, such as the following:

- To understand how an archive is searched using Search, refer to “Searching an archive” on page 109.
- To change the physical location of an archive, perform the tasks described in “Moving an archive” on page 110.
- To set up the retention and disposal of data in the archive, perform the tasks described in “Retaining and disposing of archived data” on page 111.
- To improve performance by partitioning large tables in the database used by the Native Archive, perform the tasks described in “Partitioning a Native Archive database” on page 116.
- To add additional language support, perform the tasks described in “Adding Native Archive supplemental language support” on page 123.

Configuring EmailXtender 4.8 SP1 messages for viewing

Perform the following steps to configure EMC SourceOne to view EmailXtender 4.8 SP1 server archives.

1. Connect the EmailXtender 4.8 SP1 server archive to the EMC SourceOne system using the EMC SourceOne console.
2. Associate mapped folders to the folders in the EmailXtender 4.8 SP1 server archive.
Configuring the Native Archive

Perform the following steps to configure the Native Archive to contain the content processed by EMC SourceOne.

1. Install and configure the Native Archive as described in the EMC SourceOne Email Management Installation Guide. To use the Native Archive, you must add it.

2. Configure the server roles within the Native Archive.

3. Create archive folders within the Native Archive.

4. To optionally configure DiskXtender options for the Native Archive, refer to “Configuring Native Archive folder DiskXtender options” on page 93.

5. To optionally configure archive retention and disposal for a Native Archive, refer to “Retaining and disposing of archived data” on page 111.

6. To optionally configure partitioning of the Native Archive database, refer to “Partitioning a Native Archive database” on page 116.

7. To optionally configure supplemental language support for the Native Archive, refer to “Adding Native Archive supplemental language support” on page 123.

8. Associate mapped folders to the folders in the Native Archive so that EMC SourceOne can use it.

9. Review the status of the volumes and indexes you create within the archive folders.

Configuring Native Archive Server roles

A Native Archive can be installed on one computer, or across multiple computers, depending on your processing needs. Each computer that is part of the Native Archive is called a Native Archive Server. Each Native Archive Server has one or more processing roles assigned to it.

Perform the following steps to configure the Native Archive Server roles.

1. Review the list of Native Archive Servers used by your Native Archive installation.

2. On each Native Archive Server, review the roles assigned to that server and verify that they are correct for your environment. If they are not correct, modify and correct the roles.

3. For each role assigned to a Native Archive Server, configure that server role.
**Viewing the one or more servers that make up the Native Archive**

View the Native Archive Servers installed as part of your Native Archive in either of the following ways.

**Viewing all Native Archive Servers by name**

Complete the following procedure to view a list of all Native Archive Servers by name.

1. On the Start menu, perform one of the following steps:
   - Click the **EMC SourceOne Console** icon.
   - Select All Programs > EMC SourceOne > EMC SourceOne Console.

2. Expand the **Native Archive** node.

3. Select the **Server Configuration** node. The Server Configuration area lists all Native Archive Servers and their roles.

**Figure 13** Server configuration list of all Native Archive Servers

The following table lists the information provided in the Server Configuration area for each Native Archive Server:

**Table 8** Information provided in the Server Configuration area (page 1 of 2)

<table>
<thead>
<tr>
<th>Column</th>
<th>Contains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity</td>
<td>The name of the Native Archive Server.</td>
</tr>
<tr>
<td>Role</td>
<td>The one or more roles assigned to the Native Archive Server. Possible values are Archive, Index, Search, or Retrieval.</td>
</tr>
<tr>
<td>Version</td>
<td>The EMC SourceOne software version running on that Native Archive Server.</td>
</tr>
</tbody>
</table>
Configuring Archives

Viewing Native Archive Servers by role

To view a list of Native Archive Servers by role, select one of the following server configuration nodes in the tree pane, depending on the type of servers you want to view.

- Archive
- Index
- Search
- Retrieval

The results pane lists only the Native Archive Servers assigned to perform that role.

The title of the results pane changes to reflect the server role.
Assigning roles to a server

Perform the following steps to assign roles to a Native Archive Server.

1. Display the list of Native Archive Servers
2. In the results pane, select the Native Archive Server to which you want to assign roles.
4. On each tab of the Properties dialog box, specify the roles to assign to the server. By default, all roles are assigned.
   - To enable a specific role, select the Enable option for that role.
   - To disable a specific role, clear the Enable option for that role.
5. Configure each of the roles that are enabled.
6. Click OK to save your changes and to close the Properties dialog box for the Native Archive Server.

Note: If you are changing the roles for an existing Native Archive Server, those changes may not be effective until after the EMC SourceOne services have been stopped and restarted.

7. Review the changes you have made. As a result of the role assignment, the following occurs:
   - The Server Configuration area is updated to display the newly-assigned roles for the selected Native Archive Server.
   - The Actions pane updates to display a Manage role-name Role action for each role assigned to the selected Native Archive Server. For example, if the Native Archive Server has the index role assigned to it, the Actions pane displays the Manage Index Role action.
   - The Native Archive Server appears in the role-specific lists.

Configuring the archive role on a Native Archive Server

Perform the following steps to configure the archive role on a Native Archive Server.

1. Display the list of servers.
2. In the results pane, select the server that you want to configure as an archive server.
4. On the Archive tab of the server Properties dialog box:
   a. Select the Enabled option.
   b. The Message Center Location field displays the default Uniform Naming Convention (UNC) path where this archive server will store content.

To change the location:
   a. Click Browse.
b. In the **Browse For Folder** dialog box, browse to and select the new message center location.

c. Click **OK** to close the dialog box. The **Message Center Location** field now displays the path you specified. This path must be no longer than 1024 characters.

When specifying the path in the **Message Center Location** field, you can specify that path as a UNC path or a local path.

---

**Note:** Do not use nested network share folders as the Message Center Location for multiple archive servers. Archive services stop working when you use this configuration.

---

c. In the **Volume Idle Time** field, specify how long, in hours, an open volume can be idle before the volume is automatically closed and the content is moved to the permanent archive location. The default value for the **Volume Idle Time** field is 48 (2 days).

You can change this field to a minimum value of 1 (1 hour) up to a maximum value of 744.

d. Click **OK**.

---

![Figure 14 Archive role properties of a Native Archive Server](image-url)
Configuring the index role on a Native Archive Server

Perform the following steps to configure the index role on a Native Archive Server.

1. Review the following considerations before configuring the index role on a Native Archive Server:
   - When enabling the index role on a Native Archive Server, you need to have a Index Work directory on that server with at least 20 GB of free space.
   - If your organization is shortcutting content as well as indexing and searching that content, review “Best practices for deploying shortcuts” on page 259 as part of configuring an index role on a Native Archive Server.
   - If your organization is using the User Delete capability, review the best practices for setting the values in the Component limit per index action area as described in “Configuring index throttling for User Delete” on page 536.
   - Consider the indexing performance best practices as described in “Optimizing Native Archive index performance” on page 245.

2. Display the list of servers.

3. In the results pane, select the server that you want to configure as an index server.


5. On the Index tab of the server Properties dialog box, select the Enabled option and specify the archive servers that this index server will process.
   - To specify that all archive servers are to be processed, select Select All.
   - To specify that only selected archive servers are to be processed, select the individual archive servers from those listed. If the Select All option was previously selected, it will automatically be cleared.

6. In the Index Run Threshold field on the Index tab, specify how long (in minutes) EMC SourceOne will wait before adding one or more messages to an index.

   The default value is 10 minutes. You can change this value to a minimum value of 2 up to a maximum value of 100 minutes.

   EMC SourceOne allows messages to collect before writing them to the index to maximize performance, because adding a single message to an index typically takes as much time as adding several hundred.

7. In the Component limit per index action area, specify the maximum number of processes to be used for each listed index action (Add, Delete, Repair, or Update) for this index server. The maximum number of processes to be used is entered as an integer from 0 to 4.

   A value of 0 specifies that the index action will not occur. A warning message appears if you enter a value of 0 for one of these fields.

   For example, a value of 0 in the Delete field indicates that this index server will not process any index delete requests. Similarly, a value of 4 in the Delete field and 0 in the Add, Repair, and Update fields, will indicate that this index server will only process index delete requests.

   Changes to these field values are applied after the index service restarts or refreshes.
The following table indicates the maximum number of processes allocated for each index action field.

### Table 9 Index action field

<table>
<thead>
<tr>
<th>Index action field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>The maximum number of processes allocated to performing index add operations. The default value is 4.</td>
</tr>
<tr>
<td>Delete</td>
<td>The maximum number of processes allocated for deleting indexes. The default value is 2.</td>
</tr>
<tr>
<td>Repair</td>
<td>The maximum number of processes allocated to performing index refresh and index rebuild operations. The default value is 2.</td>
</tr>
<tr>
<td>Update</td>
<td>The maximum number of processes allocated to performing index update operations. The default value is 4.</td>
</tr>
</tbody>
</table>

8. Click OK.

9. Verify that the server you just assigned the index role to is allowed to use the index storage location as follows:

   a. Select the Properties action on the archive folder into which the content will be archived. The Archive Folder dialog box appears.

   **Note:** Archive folders are accessed using the Archive Folders node in the console.

   b. Select the Indexing tab and verify that the server you have added the index role to is listed as having access to the index storage location. This information appears in the Index Storage Locations list on the Indexing tab.
Configuring Archives

Configuring the retrieval role of a Native Archive Server

Perform the following steps to configure the retrieval role on a Native Archive Server.

1. Display the list of servers
2. In the results pane, select the server that you want to configure as a retrieval server.
3. Select **Action > Properties**.
4. On the **Retrieval** tab of the server **Properties** dialog box, select the **Enabled** option.

![Figure 16 Retrieval role properties of a Native Archive Server](image)

Configuring the search role of a Native Archive Server

Perform the following steps to configure the search role on a Native Archive Server.

1. Display the list of Native Archive Servers
2. In the results pane, select the server that you want to configure as a search server.
3. Select **Action > Properties**.
4. On the **Search** tab of the server **Properties** dialog box, select the **Enabled** option.
5. In the **Memory Allocated to Search Results (MB)** field, specify the amount of shared memory (in MB) that the search server can allocate for queuing search results.
The default value is 50 MB. You can set this value to a minimum of 10 up to a maximum of 500 MB.

**Figure 17** Search role properties of a Native Archive Server

6. Click OK.

**Configuring Native Archive folders and storage**

Define archive folders within a Native Archive to contain your content. You can define up to a maximum of 200 archive folders, although typically you will not require that many.

The following sections describe how to configure various attributes of Native Archive folders including the storage locations associated with them.

If you are using EMC DiskXtender for Windows with Email Management, refer also to “Configuring Native Archive folder DiskXtender options” on page 93.

**Selecting the type of storage to use for the archive folder**

When you create an archive folder, you select the type of storage for that folder. It is important to carefully consider what type of storage you will use because after the archive folder is created you cannot change the type of storage associated with it.
Configuring Archives

Available storage device options

The following table lists the types of storage that can be selected to store the information in archive folders:

**Table 10 Storage devices that can be used**

<table>
<thead>
<tr>
<th>Storage Type option</th>
<th>Storage device used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmos Container</td>
<td>EMC Atmos storage devices directly accessed by EMC SourceOne using RESTful Interface.</td>
</tr>
<tr>
<td>NAS Container</td>
<td>Network-accessible storage, such as network shareable drives or network-attached storage devices (NAS devices).</td>
</tr>
<tr>
<td>DiskXtender Container</td>
<td>Storage accessed using EMC DiskXtender, such as EMC Centera devices, NAS devices, WORM devices and so on.</td>
</tr>
<tr>
<td>Centera Container</td>
<td>EMC Centera storage devices directly accessed by EMC SourceOne without the use of EMC DiskXtender.</td>
</tr>
<tr>
<td>Celerra Container</td>
<td>EMC Celerra storage devices directly accessed by EMC SourceOne.</td>
</tr>
<tr>
<td>Data Domain Storage System Container</td>
<td>EMC Data Domain storage devices directly accessed by EMC SourceOne using either NFS or CIFS file systems. Note that performance may vary depending on whether NFS or CIFS is used. Refer to your Data Domain documentation for which is preferred in your environment. Data Domain devices are to only be used with EMC SourceOne as storage for archive folders.</td>
</tr>
<tr>
<td>Isilon Container</td>
<td>EMC Isilon devices directly accessed by EMC SourceOne using the OneFS distribution operating system.</td>
</tr>
<tr>
<td>NetApp Storage System Container</td>
<td>NetApp storage devices directly accessed by EMC SourceOne.</td>
</tr>
<tr>
<td>Virtual Container</td>
<td>Storage devices that are used with in-place indexing of content stored outside of the EMC SourceOne Native Archive, such as the EMC Cloud Tiering Appliance (CTA). Only the File Index in Place - Historical activity installed with EMC SourceOne for File Systems supports this type of storage.</td>
</tr>
</tbody>
</table>
Comparing and selecting storage device options

Determining the best storage type for an archive folder depends on your particular goals and computing environment. When selecting the storage type to use, be aware of the features you need in the storage device, such as whether it supports data retention, whether it supports deduplication, or whether it matches your computing environment in other ways.

The following table lists the storage type options and advises when to select them. For detailed information about any of these storage devices, refer to the manufacturer's documentation for that device.

Table 11 Choosing the type of storage to use for the archive folder (page 1 of 2)

<table>
<thead>
<tr>
<th>Storage Type option</th>
<th>Select this storage type when...</th>
</tr>
</thead>
</table>
| Atmos Container:            | • You want to store your data on a supported EMC Atmos storage system device.  
                              | • You require file-level retention enforced on the device.                                |
| Celerra Container           | • You want to store your data on a supported EMC Celerra storage device.  
                              | • You require file-level retention enforced on the device.  
                              | • You require file-based deduplication.  
                              | • You do not use DiskXtender software.                                                     |
| Centera Container           | • You want to store your archived data on a supported EMC Centera device without the use of DiskXtender software.  
                              | • You do not need the added capabilities that DiskXtender provides for managing a Centera device.  
                              | • You require file-level retention enforced on the device.  
                              | • You require data-based deduplication.  
                              | • You do not use DiskXtender software.                                                     |
| Data Domain Storage System Container | • You want to store your data on a supported EMC Data Domain storage system device.  
                                         | • You require file-level retention enforced on the device.  
                                         | • You require data-based deduplication.  
                                         | • You do not use DiskXtender software.  
                                         * Data Domain devices are to only be used with EMC SourceOne as storage for archive folders. |
| DiskXtender Container       | • You want to use DiskXtender software to store your archived data on a storage device, such as a WORM, UDO, NAS or Centera device.  
                              | • You want to use the added capabilities for managing a device that DiskXtender provides and that the direct support by EMC SourceOne for EMC Centera, EMC Celerra, EMC Data Domain, Isilon, and NetApp devices does not. |
| Isilon Container            | • You want to store your data on a supported EMC Isilon storage device.  
                              | • You require file-level retention enforced on the device.  
                              | • You require data-based deduplication.  
                              | • You do not use DiskXtender software.                                                     |
Configuring Archives

Using multiple archive folders with different storage types

You can store data using multiple storage types simultaneously, including NAS devices, devices accessed using EMC DiskXtender, and storage devices directly supported by EMC SourceOne, such as EMC Centera, EMC Celerra, EMC Data Domain, EMC Isilon, and NetApp devices.

You can use both the direct access and DiskXtender methods to access the same storage device simultaneously. This situation may occur if you have an existing DiskXtender installation that is used with the storage device and you want to also use direct access to the storage device for new archive folders that you create.

When you use multiple storage types, each storage type must be associated with a different Native Archive folder. You cannot mix access methods with the same Native Archive folder.

---

**Table 11** Choosing the type of storage to use for the archive folder (page 2 of 2)

<table>
<thead>
<tr>
<th>Storage Type option</th>
<th>Select this storage type when...</th>
</tr>
</thead>
</table>
| NAS Container       | • You want to store your data on a NAS storage device or network share.  
                      • You want to use a NAS device that is not directly supported. EMC Centera, EMC Celerra, EMC Data Domain, Isilon, and NetApp devices are directly supported.  
                      • You do not require file-level retention enforced on the device.  
                      • You do not require data-based or file-based deduplication. Note that data-based deduplication is generally more effective at reducing the amount of space used than file-based deduplication.  
                      • You do not use DiskXtender software. |
| NetApp Storage System Container | • You want to store your data on a NetApp storage system device.  
                                 • You require file-level retention enforced on the device.  
                                 • You do not use DiskXtender software. |
| Virtual Container   | You are using the File Index in Place - Historical activity with in-place indexing. |
Adding archive folders

Perform the following steps to add an archive folder to a Native Archive.

1. Select the **Archive Folders** node for the Native Archive. The Archive Folders area lists any folders for the selected Native Archive.

![Archive folders in a Native Archive](image)

**Figure 18** Archive folders in a Native Archive

2. Select **Action > New Archive Folder**. The **New Archive Folder** wizard appears.

3. Supply values on the pages of this wizard.

Refer to “Modifying archive folder properties” on page 84 for how to modify the properties of an existing archive folder.
Using the General page of the New Archive Folder wizard

Use the General page of the New Archive Folder wizard to specify general options for the archive folder. To modify existing general properties, refer to “Modifying general properties of archive folders” on page 84.

Perform the following tasks to specify the general options.

1. In the Folder Name field, enter a name for the folder.

   The following are the rules for creating a valid archive folder name:
   
   • The maximum number of characters for the folder name is 128.
   
   • Only ASCII characters are to be used for the folder name, excluding periods, not multi-byte characters and not the period character. If a mapped folder and the archive folder to which it is associated both have multi-byte characters in their folder names, then an index folder cannot be created, and indexing will fail.
   
   • The folder name also needs to meet the rules for operating system file directory names on which the folder is created.

   For example, for the Windows file system, refer to the section “File and Directory Names” in the MSDN document “Naming Files, Paths, and Namespaces (Windows):


   Naming rules may change with various operating system releases, so ensure you follow current practices as defined by the operating system provider.

2. In the Description field, enter a description for the folder. The maximum number of characters for the description is 1024.

3. Click Next. The Storage Options page of the New Archive Folder wizard appears.
Using the Storage Options page of the New Archive Folder wizard

Use the Storage Options page to select the storage and retention options for a new archive folder.

On the Storage Options page, in the Storage Type field, select one of the following as the type of storage to be used for the new archive folder:

- Atmos Container
- Celerra Container
- Centera Container
- Data Domain Storage System Container
- DiskXtender Container
- Isilon Container
- NAS Container
- NetApp Storage System Container
- Virtual Container

The other fields displayed on this page will vary depending on which storage type option you select.

Using NAS device containers for storage

The following storage types are all NAS devices that have the same options on the Storage Options page.

- Celerra Container
- Data Domain Storage System Container
- Isilon Container
- NAS Container
- NetApp Storage System Container
Figure 20  NAS Container devices variant of the New Archive Folder Storage Options page

If the Celerra Container, Data Domain Storage System Container, Isilon Container, NAS Container, or NetApp Storage System Container storage type is selected, the following fields must be defined.

1. In the Archive Location field, specify the path to the volumes for this folder.

   To change the location, click Browse and select a new path to the volumes. The maximum number of characters for the Archive Location field is 1024.

   When specifying the path in the Archive Location field, you can specify that path as a UNC path or a local path.

   **Note:** Do not use nested network share folders as the Archive Location for multiple archive folders. Archive services stop working when you use this configuration.

2. In the Maximum Volume Size (MB) field, specify the maximum size (in MB) of individual volumes in this folder. The default value is 100 MB. You can change this value to be from 10 MB up to 10000 MB (10 GB). When a volume reaches the maximum volume, it is closed and a new volume is created.

   If you set the Maximum Volume Size (MB) field to a value greater than 2048 (2 GB), you will receive a warning indicating that this may make your archiving and retrieval operations take longer.

3. Specify how long data in the archive folder is to be retained by entering a value in the Months to retain field.

   Valid values for the Months to retain field are the following:
   - The default value is 1, indicating 1 month.
Configuring Archives

- The minimum value is 0, indicating that no retention is specified. If 0 is selected the **Enable automatic disposition** field cannot be used.

- The maximum value is 1200 (indicating 100 years).

Consider the following before specifying the retention value:

- After an archive folder has been marked for retention, the file cannot be modified until it has expired.

- When calculating the months to retain value:
  a. Determine the number of months from the current date to the date when the file was last saved.
  b. Determine the number of months from the current date to the future date that you want to retain files for.
  c. Add the number of months from step a and step b together to determine the value in the Months to retain field.

- If you are storing the data in the archive folder on a NAS storage device that supports data retention, be aware of the data retention settings on that device, if any. Also be aware of the maximum time of retention supported by the device, as this differs by device.

- Retention is to not be enabled on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, the **Months to retain** field is to be set to 0.

- If you specify a retention period, test the retention after it is enabled to verify that it is working as you expect.

4. Select the **Enable automatic disposition** checkbox to have EMC SourceOne automatically dispose of data in the archive folder when the data is older than the value specified in the **Months to retain** field. The **Enable automatic disposition** checkbox is not selected by default.

   If you are storing the data in the archive folder on a NAS storage device that supports data retention, be aware of the data retention settings on that device, if any. For example, Isilon does not support the automated disposal of objects after their retention has expired.

5. The **Compress content in containers** checkbox determines whether to compress the containers written to a device. Unless the target device supports block-level deduplication, select the checkbox to minimize the space taken up on the device and in the **Message Center**.

   Clear the **Compress content in containers** checkbox if all the following apply:

   - The target device supports block-level deduplication, for example, Isilon with OneFS 7.1 or later.
   - Block-level deduplication is enabled on the device for the selected Archive Location UNC path.
   - Deduplication is more effective than compression for the content being archived (consult the device documentation).
   - It is acceptable for containers to take up additional space in the **Message Center**.
Otherwise, select the **Compress content in containers** checkbox.

**Note:** If the Storage Type is Data Domain Storage System Container, the checkbox is always clear, to optimize deduplication.

When deciding to use compression, consider the following:

- The **Compress content in containers** checkbox is selected by default (except for Data Domain).
- After the creation of the archive folder, the checkbox cannot change.
- Turning off compression will cause the containers in the Message Center to consume more space.
- If archiving large audio and video content, and also other content, consider disabling compression for the main container and storing large compressed content outside of the container.

6. For the **Maximum Large File Size [MB]** field, specify the maximum file size of the source file. The default value is 4 GB and the maximum supported value is 20GB.

   The **Maximum Large File Size [MB]** field is used to define the maximum file size that will be accepted by the archive folder for File Archiving or File Index in Place activities. This applies to file content only, not email or SharePoint content. Note that the Maximum Volume Size does not restrict the size of the file.

7. Click **Next**. The **New Archive Folder Large Content** page appears.

8. Select how to store large content:

   - Select the **Store all content inside containers** option to have all content, including large content, stored within the container for this folder.
   - Select the **Store large content outside of containers when larger than** option to have large content:
     - Stored with the content when the large content is less than or equal to the value specified in the **KB** field.
     - Stored separately from the content when the large content is larger than the value specified in the **KB** field.
   - Specify the large content size in the **KB** field. By default, this value is 1000.
   - For large content that is stored separately, select whether that content is to be compressed by selecting or clearing the **Compress large content** option.

   **Note:** If the Storage Type is Data Domain Storage System Container, then you cannot edit settings on the New Archive Folder Large Content page because content is always stored inside containers to optimize deduplication.

9. Click **Next**. The **Indexing** page of the **New Archive Folder** wizard appears.
Using DiskXtender containers for storage

The DiskXtender Container option is selected as the storage type for the archive folder to be created.

![New Archive Folder](image)

**Figure 21** DiskXtender Container variant of the New Archive Folder Storage Options page

If the DiskXtender Container storage type is selected, the following fields must be defined.

1. In the **Archive Location** field, specify the path to the volumes for this folder.

   To change the location, click **Browse** and select a new path to the volumes. The maximum number of characters for the **Archive Location** field is 1024.

   When specifying the path in the **Archive Location** field, you can specify that path as a UNC path or a local path.

   **Note:** Do not use nested network share folders as the Archive Location for multiple archive folders. Archive services stop working when you use this configuration.

2. In the **Maximum Volume Size (MB)** field, specify the maximum size (in MB) of individual volumes in this folder. The default value is 100 MB. You can change this value to be from 10 MB up to 10000 MB (10 GB). When a volume reaches the maximum volume, it is closed and a new volume is created.

   - If you set the **Maximum Volume Size (MB)** field to a value greater than 2048 (2 GB), you will receive a warning indicating that this may make your archiving and retrieval operations take longer.
   - If you are planning to use DiskXtender to write EMC SourceOne files to an EMC Centera device, change the maximum volume size to 90 MB, instead of the default size of 100 MB. There are known performance issues when retrieving volumes of...
3. Specify how long data in the archive folder is to be retained by entering a value in the **Months to retain** field.

Valid values for the **Months to retain** field are the following:

- The default value is 1, indicating 1 month.
- The minimum value is 0, indicating that no retention is specified. If 0 is selected, the **Enable automatic disposition** field cannot be used.
- The maximum value is 1200 (indicating 100 years).

Consider the following before specifying this value:

- If you are storing the data in the archive folder on a NAS storage device that supports data retention, be aware of the data retention settings on that device, if any. Also be aware of the maximum time of retention supported by the device, as this differs by device.
- Retention is to not be enabled on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, the **Months to retain** field is to be set to 0.

4. Specify whether to allow EMC SourceOne to automatically dispose of data in the archive folder. Select the **Enable automatic disposition** field to specify that EMC SourceOne automatically disposes of data in the archive folder when the data is older than the value specified in the **Months to retain** field.

5. For the **Maximum Large File Size [MB]** field, specify the maximum file size of the source file. The default value is 4 GB.

6. Select the type of media to be used by DiskXtender in the **Media Type** field. This media type must match the type selected in your DiskXtender configuration.

7. Specify the path the DiskXtender local extended drive in the **DiskXtender local extended drive path** field. This path must contain the drive letter and the path, such as E:\EMC SourceOne\Five Year.

8. Select the **Purge after move** option if you want the files purged immediately after they are moved to media by DiskXtender.
   
   If you do not select the **Purge after move** option, configure purge rules using the DiskXtender File System Manager Administrator as described in the DiskXtender for Windows documentation. Purging files is usually needed to avoid running out of space on the storage drive.

9. Select the **Direct Read** option if you want files to be read directly from media rather than first being copied back to the extended drive and then read.

   If you are using DVD-R or DVD+R media, files are not marked for direct read or purged until you finalize the media.

   If you use DiskXtender to write volumes to removable media, such as DVD-R, tape, or magneto-optical media, you may want to disable direct read to avoid too many competing read and write requests to the library containing the media.

10. Click **Next**. The **Indexing** page of the **New Archive Folder** wizard appears and is described in “Using the Indexing page of the New Archive Folder wizard” on page 80.
Using Centera containers for storage

The Centera Container option is selected as the storage type for the archive folder to be created.

![New Archive Folder](image)

**Figure 22** Centera Container variant of the New Archive Folder Storage Options page

If Centera Container is selected as the storage type for an archive folder, the following fields must be defined.

1. In the Pool Address field, specify the one or more addresses to be used with the Centera device.

   The address may be specified using the host name, such as mycomputer.emc.com or can be specified using the dotted decimal format, such as 8.10.444.122.

   To specify multiple addresses in either form, separate the addresses with a comma, for example, node1.emc.com,node2.emc.com.

   **Note:** A best practice is to use the host name address form if possible so that if an IP address changes for a machine, the Pool Address field value will not need to be changed. Instead, the change can be made at the DNS server or in the local hosts file. Using host names also makes more sense in a disaster recovery scenario.

2. Click Test Pool to verify the addresses in the Pool Address field are correct and reachable. Any problematic addresses will be identified for you to correct.
3. Specify how long data in the archive folder is to be retained by entering a value in the **Months to retain** field.
   - The default value is 1, indicating 1 month.
   - The minimum value is 0, indicating that no retention is specified. If 0 is selected the **Enable automatic disposition** field cannot be used.
   - The maximum value is 1200 (indicating 100 years).

Consider the following before specifying this value:
- If you are storing the data in the archive folder on a Centera storage device configured to support data retention, be aware of the data retention settings on that device, if any. Also be aware of the maximum time of retention supported by the device, as this differs by device.
- Retention is to not be enabled on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, the **Months to retain** field is to be set to 0.

4. Specify whether to enable EMC SourceOne to automatically dispose of data in the archive folder.

5. Select the **Enable automatic disposition** field to specify that EMC SourceOne is to automatically dispose of data in the archive folder when the data is older than the value specified in the **Months to retain** field.

6. In the **Maximum Volume Size (MB)** field, specify the maximum size (in MB) of individual volumes in this folder. The default value is 100 MB. You can change this value to be from 10 MB up to 10000 MB (10 GB). When a volume reaches the maximum volume, it is closed and a new volume is created.

   If you set the **Maximum Volume Size (MB)** field to a value greater than 2048 (2 GB), you will receive a warning indicating that this may make your archiving and retrieval operations take longer.

7. Determine whether to enable **Enable File Audit Deletes**. When enabled, EMC SourceOne labels all file deletions it makes on the Centera device with a string.

   By default, the file audit delete string is set to EMC SourceOne. You can change this to another string by entering another string in the **File Audit Delete String** field.

8. For the **Maximum Large File Size [MB]** field, specify the maximum file size of the source file. The default value is 4 GB.

9. Click **Import** to import a Pool Entry Authorization (PEA) file for use with the Centera device. A file selection dialog box appears to enable you to select the PEA file. After you select a PEA file, this configuration is entered into the **PEA Configuration** area.

   The PEA file allows access to data on a Centera storage device.

10. Click **Next**. The page of the **New Archive Folder** wizard appears and is described in “**Using the Large Content page of the New Archive Folder wizard**” on page 76.
Using Atmos containers for storage

If the Storage Type is Atmos container, the following New Archive Folder window appears with the Atmos Container storage options.

![Atmos Container New Archive Folder Storage Options window](image)

**Figure 23** Atmos Container New Archive Folder Storage Options window

If the Atmos Container storage type is selected, the following fields must be defined.

1. In the **Host Name/IP** field, specify the Host Name or IP of the Atmos Server. It can be a load balancer's address.
2. In the **Subtenant ID** field, specify the ID of the subtenant created in Atmos for SourceOne.
3. In the **User ID** field, specify the ID of a user for the subtenant.
4. In the **Shared Secret** field, specify the shared secret for the user.
5. Specify whether to **Enable SSL**. If SSL is enabled, HTTPS is used for data transport, otherwise, HTTP is used.
6. In the **Port** field, specify the port number for the Atmos server, the default value for http is 80 and the default value for https is 443.
7. In the **Fragment chunk size (MB)** field, specify the maximum size of bytes can be uploaded to Atmos each time. A big .emx file will be uploaded with multiple fragment chunks. The default value is 5 MB. You can change this value to be from 1 MB up to 2048 MB (2 GB).
8. In the **Maximum Volume Size (MB)** field, specify the maximum size (in MB) of individual volumes in this folder. The default value is 100 MB.
You can change this value to be from 10 MB up to 10000 MB (10 GB). When a volume reaches the maximum volume, it is closed and a new volume is created. If you set the **Maximum Volume Size (MB)** field to a value greater than 2048 (2 GB), then you receive a warning indicating that this may make your archiving and retrieval operations take longer.

9. Specify how long data in the archive folder is to be retained by entering a value in the **Months to retain** field. Valid values for the **Months to retain** field are the following:
   - The default value is 1, indicating 1 month.
   - The minimum value is 0, indicating that no retention is specified. If 0 is selected the **Enable automatic disposition** field cannot be used.
   - The maximum value is 1200 (indicating 100 years).

   Consider the following before specifying this value:
   - Be aware of the data retention settings on the Atmos device.
   - Do not enable retention on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, set the **Months to retain** field to 0.

10. Specify whether to enable EMC SourceOne to automatically dispose of data in the archive folder.

11. Select the **Enable automatic disposition** field to specify that EMC SourceOne is to automatically dispose of data in the archive folder when the data is older than the value specified in the **Months to retain** field.

12. For the **Maximum Large File Size [MB]** field, specify the maximum file size of the source file. The default value is 4 GB.

**Using the Large Content page of the New Archive Folder wizard**

Use the Large Content page to configure whether large content is to be stored separate from other content in the storage container. Large files, large email attachments, or large SharePoint attachments are all examples of large content.

Storing large content separately allows you to save storage space by allowing content addressed storage devices, such as EMC Centera, to remove duplicate copies of attachments when they are stored. However, if you do not have a device that removes duplicates, storing attachments separately may slow EMC SourceOne performance without any benefit.
Configuring Archives

The Large Content page is the same for most storage option types except for the Atmos Container, the Data Domain Storage System Container and the Virtual Container storage types.

- When the Atmos Container storage type is selected, the Large Content window displays that the Large Content settings are not applicable for Atmos archive folders.
- When the Data Domain Storage System Container storage type is selected, the Large Content page contains only the wizard navigation buttons and the statement that large content handling cannot be configured by the user.

**Note:** Data Domain content is not compressed before moving it to the Message Center directory as other content can be, and so using a Data Domain storage device may require more space in the Message Center directory than using other storage devices that have compression enabled.

![New Archive Folder Large Content page for Data Domain]

- When the Virtual Container storage type is selected, the Large Content page contains only the wizard navigation buttons and the statement that large content settings are not applicable for virtual folders.
Configuring storage of large content for all storage types except the Atmos container and the Data Domain Storage type

Perform the following steps to configure storage of large content for all storage types except the Atmos container and the Data Domain storage type.

1. Select how to store large content:
   
   - Select the **Store all content inside containers** option to have all content, including large content, stored within the container for this folder.
   
   - Select the **Store large content outside of containers when larger than** option to have large content:
     
     - Stored with the content when the large content is less than or equal to the value specified in the KB field.
     
     - Stored separately from the content when the large content is larger than the value specified in the KB field.

2. Click **Next**. The **Indexing** page of the New Archive Folder wizard appears.

Using the Organization Options page of the New Archive Folder wizard

Specify the organizing method for the archive folder by using the Organization Options page and performing the following tasks.

1. Select the organizing method to be used for the archive folder.
Configuring Archives

- Select the **By Date** option to have the archive folder organized by date. An archive folder organized by date can be used with any type of mapped folder, and can be used to contain EMC SourceOne Discovery Manager legal matters.

- Select the **By Matter** option to have the archive folder organized by a legal matter. A By Matter archive folder can only be used with EMC SourceOne Discovery Manager to store legal matters, and can only be associated with Legal Hold mapped folders.

  **Note:** Disaster Recovery is not available or supported by matter based archives.

After you have selected the organization method for an archive folder it cannot be modified.

2. Click **Next**.

![New Archive Folder Organization Options page](image)

**Figure 28 New Archive Folder Organization Options page**

Using the Indexing page of the New Archive Folder wizard

Use the Indexing page to specify whether to have full-text indexing enabled for the archive folder, and the indexing options if indexing is enabled.
Enabling or disabling indexing

You enable or disable indexing using the Enable Indexing checkbox on the Indexing page:

- To enable full-text indexing for the archive folder, select the Enable Indexing checkbox. After enabling indexing, you can configure other indexing options.

  **Note:** If the Enable Indexing checkbox on the New Archive Folder page is clear, then it is impossible to search for file content archived to an archive folder, by file names or by pathnames.

  If you want to index and search metadata (including file names and pathnames), but do not want a full-text index of all file content, then:
  1. Select the Enable Indexing checkbox.
  2. Clear the Content Cache checkbox.
  3. Clear the Attachment and File Indexing checkbox.

- To disable indexing, clear the Enable Indexing checkbox and click Finish.

  **Note:** Do not enable indexing on archive folders used for SharePoint External BLOB Storage (EBS).
Selecting indexing options

After enabling indexing, configure other indexing options by performing the following steps.

1. In the **Maximum Index Size (MB)** field, specify the maximum size (in MB) of individual indexes in this folder. The value of the default size is 2048 MB. You can modify this value to be from 500 to 16384 MB.

   The indexing system uses the **Maximum Index Size (MB)** field value to determine when it is to place new volumes into a new index. In general, indexes will not exceed the specified size, but because the indexing system estimates sizes, some indexes will exceed this maximum value. This is an expected condition.

2. Specify whether a content cache is to be created.

   Creating a content cache for the index greatly improves performance when rebuilding an index because the content for the index does not need to be read again from the archive.

   - To enable the caching of content, select the **Content Cache** checkbox.
   - To disable the caching of content, clear the **Content Cache** checkbox.

3. Specify whether attachments and files are to be indexed.

   - To enable the indexing of attachments, select the **Attachment and File Indexing** checkbox.
   - To disable the indexing of attachments, clear the **Attachment and File Indexing** checkbox.
   - If you enable attachment indexing, you can use the **Index nested subcontainers in attachments** checkbox to select whether subcontainers in attachments are to be indexed.

   By default, all new and existing indexes will have this option disabled. Changing the selection of the **Index nested subcontainers in attachments** checkbox only applies to content archived and indexed after the selection was changed. Existing indexes remain as they are and need to be rebuilt to be affected.
4. Specify whether to index file-specific metadata:
   - To enable file-specific metadata indexing, select the **Metadata indexing** checkbox.
   - To disable file-specific metadata indexing, clear the **Metadata indexing** checkbox.

File-specific metadata is additional information about a file that does not appear in the file body itself. This extra metadata tends to be application-specific, and not all file types support it. If the file does support it, you can typically see it in the Details pane of the file properties view in Windows Explorer.

For example, Microsoft Office documents can include author, subject, tags, comments, and other descriptive fields. Photographs can include details of the image, and the camera that took the image. Audio files can include details of the song title, album name, artist, and year recorded. If you select the **Metadata indexing** checkbox, then this results in the inclusion of this file-specific metadata in the index.

Clear is the default setting for the **Metadata indexing** checkbox because this process can slow down indexing performance and increase the size of the index, particularly for lots of small files with a lot of metadata. You cannot change the **Metadata indexing** checkbox setting after folder creation.

5. Specify one or more storage locations for the index by clicking **Add**. The **Index Storage Location** dialog box appears.

![Figure 30  Index Storage Location dialog box launched from Indexing page](image)

6. Specify the following values in the **Index Storage Location** dialog box:
   - Specify the path to the storage location by either directly editing the path in the **Index Storage Location** field, or click **Browse** to browse to the path.

   When specifying the path in the **Index Storage Location** field, you can specify that path as a UNC path or a local path.

   **Note:** Do not use nested network share folders for multiple Index Storage Locations. Index services stop working when you use this configuration.

   - Specify which Native Archive index servers are to use the storage location.
     - Select the **Allow all servers to use this storage** option to allow all Native Archive index servers to use the location.
Configuring Archives

Selecting this option not only allows all current index servers to use the index storage location, but also allows any index servers that are subsequently added to automatically use this index storage location.

- Select the **Only allow the following servers to use this storage** option to allow only the selected Native Archive index servers to use the location.

Selecting this option allows you to control which index servers have access to the index storage location and allows you to segment your index processing into groups of index servers and index storage locations.

- Click **OK** to add the location. The **Index Storage Location** dialog box closes.
- To remove an index storage location, select the location and click **Remove**.
- To change an index storage location, select the location and click **Edit**.
- When specifying the path in the **Index Storage Location** field, you can specify that path as a UNC path or a local path.

7. Click **Finish**.

**Modifying archive folder properties**

Perform the following steps to modify the properties for an archive folder.

1. Select the **Archive Folders** node for the Native Archive. The Archive Folders area lists the folders, if any, for the selected Native Archive node.
2. In the **Archive Folders** area, select the folder to modify.
3. Select **Action > Properties**.
4. Modify the properties of an archive folder as described in the following sections.

**Modifying general properties of archive folders**

Use the General page of the New Archive Folder wizard to specify general options for the archive folder.

Perform the following steps to modify the general properties of an archive folder.

1. Select the **General** tab of the **Archive Folder** dialog box.
2. If needed, modify the description by editing the text in the **Description** field.
3. Click **OK** to save your changes.
Modifying storage option properties of an archive folder
Modify the storage option properties of an archive folder by performing the following steps.

1. Select the **Storage Options** tab of the Archive Folder dialog box.

2. What fields can be modified depend on which storage type the archive folder was created. Follow the directions in the following sections to complete selecting the storage and retention options.

**Modifying NAS device container storage properties**
Modify one or more of the following NAS Container Storage Options page properties for the Celerra Container, Data Domain Storage System Container, Isilon Container, NAS Container, or NetApp Storage System Container.

1. Modify how long data in the archive folder is to be retained by entering a value in the **Months to retain** field.
   - The default value is 1, indicating 1 month.
   - The minimum value is 0, indicating that no retention is specified. If 0 is selected the **Enable automatic disposition** field cannot be used.
   - The maximum value is 1200 (indicating 100 years).

Consider the following before modifying this value:
   - When you make the value in the **Months to retain** field smaller, you shorten the retention period on the archive folder, and an informational dialog box appears. Shortening the retention period of an archive folder may make deletions from that archive folder behave differently than expected.
   - If you are storing the data in the archive folder on a NAS storage device that supports data retention, be aware of the data retention settings on that device, if any. Also be aware of the maximum time of retention supported by the device, as this differs by device.
   - Retention is to not be enabled on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, set the **Months to retain** field to 0.

2. Modify whether to allow EMC SourceOne to automatically dispose of data in the archive folder. Select the **Enable automatic disposition** field to specify that EMC SourceOne is to automatically dispose of data in the archive folder when the data is older than the value specified in the **Months to retain** field.

3. Click **OK** to save your changes.

**Modifying DiskXtender container storage properties**
Modify one or more of the following DiskXtender container storage properties.

1. Modify how long data in the archive folder is to be retained by entering a value in the **Months to retain** field.
   - The default value is 1, indicating 1 month.
   - The minimum value is 0, indicating that no retention is specified. If 0 is selected the **Enable automatic disposition** field cannot be used.
• The maximum value is 1200 (indicating 100 years).

Consider the following before modifying this value:

• When you make the value in the Months to retain field smaller, you shorten the retention period on the archive folder, and an informational dialog box appears. Shortening the retention period of an archive folder may make deletions from that archive folder behave differently than expected.

• If you are storing the data in the archive folder on a NAS storage device that supports data retention, be aware of the data retention settings on that device, if any. Also be aware of the maximum time of retention supported by the device, as this differs by device.

• Do not enable retention on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, set the Months to retain field to 0.

2. Modify whether to allow EMC SourceOne to automatically dispose of data in the archive folder. Select the Enable automatic disposition field to specify that EMC SourceOne is to automatically dispose of data in the archive folder when the data is older than the value specified in the Months to retain field.

3. Modify whether to select the Purge after move option. This option is used if you want the files purged immediately after they are moved to media by DiskXtender.

• If you do not select the Purge after move option, configure purge rules using the DiskXtender File System Manager Administrator as described in the DiskXtender for Windows documentation. Purging files is usually needed to avoid running out of space on the storage drive.

• If you are using DVD-R media, files are not marked for direct read or purged until you finalize the media.

4. Modify whether to select the Direct Read option. This option is used if you want files to be read directly from media rather than first being copied back to the extended drive and then read.

If you are using DVD-R media, files are not marked for direct read or purged until you finalize the media.

5. Click OK to save your changes.

Modifying Centera container storage properties

Modify one or more of the following Centera container storage properties by completing the following steps.

1. Modify how long data in the archive folder is to be retained by entering a value in the Months to retain field.

• The default value is 1, indicating the data is to be retained for 1 month.

• The minimum value is 0, indicating that there is no retention specified on the archive folder. If 0 is selected the Enable automatic disposition field cannot be used.

• The maximum value is 1200, indicating 100 years.
Consider the following before modifying this value:

- When you make the value in the **Months to retain** field smaller, you shorten the retention period on the archive folder, and an informational dialog box appears. Shortening the retention period of an archive folder may make deletions from that archive folder behave differently than expected.

- If you are storing the data in the archive folder on a NAS storage device that supports data retention, be aware of the data retention settings on that device, if any. Also be aware of the maximum time of retention supported by the device, as this differs by device.

- Do not enable retention on archive folders used for SharePoint External BLOB Storage (EBS). For these folders, set the **Months to retain** field to 0.

2. Modify whether to allow EMC SourceOne to automatically dispose of data in the archive folder. Select the **Enable automatic disposition** field to specify that EMC SourceOne is to automatically dispose of data in the archive folder when the data is older than the value specified in the **Months to retain** field.

3. Modify whether **Enable File Audit Deletes** is enabled or disabled. If enabled, you can modify the audit string written to the Centera by EMC SourceOne using the **File Audit Delete String** field.

4. Modify the PEA configuration by importing a PEA file. Click **Import** to import a PEA file to use with the Centera device. A file selection dialog appears to allow you to select the PEA file to use. After selecting a PEA file, this configuration is entered into the **PEA Configuration** area.

   The PEA file allows access to data on a Centera storage device.

5. Click **OK** to save your changes.

### Modifying large content properties of archive folders

You can modify large content properties of an archive folder by performing the following steps.

1. Select the **Large Content** tab of the **Archive Folder** dialog box to review the large content settings associated with the archive folder.

2. If the archive folder was created with the **Store large content outside of containers when larger than** option, then you can modify whether that content is compressed using the **Compress large content** option.

3. Click **OK** to confirm a modification.

### Modifying organization options properties of archive folders

You cannot modify the organization options for an archive folder after it is created. Perform the following steps to modify organization options.

1. Select the **Organization Options** tab of the **Archive Folder** dialog box to review the organization options settings associated with the archive folder.

2. Click **OK** to close the **Archive Folder** dialog box.
Modifying indexing properties of archive folders

If your organization is shortcutting content as well as searching that content, review “Best practices for deploying shortcuts” on page 259 prior to modifying the indexing properties of an archive folder.

Perform the following steps to modify the indexing properties of an archive folder.

1. Select the **Indexing** tab of the **Archive Folder** dialog box.

![Figure 31 Archive Folder properties Indexing tab](image1)

2. Add, modify or delete one or more of the index storage locations by doing one or more of the following actions:
   - To remove an index storage location, select the location and click **Remove**.
   - To add an index storage location, click **Add** and browse to the location.
   - To modify an index storage location, select it from the list in the **Index Storage Locations** area and click **Edit**. The **Index Storage Location** dialog box appears.

![Figure 32 Index Storage Location dialog launched from Indexing tab](image2)
3. Modify any of the following values in the **Index Storage Location** dialog box:

- Modify the path to the storage location by either directly editing the path in the **Index Storage Location** field, or click **Browse** to browse to a new path.

  When specifying the path in the **Index Storage Location** field, you can specify that path as a UNC path or a local path.

  Consider the following:
  - Do not use nested network share folders for multiple Index Storage Locations. Index services stop working when you use this configuration.
  - Removing or changing the location of existing indexes can lead to the content in that index no longer being searchable, and may cause other problems when searching, indexing, or re-indexing data in those existing indexes.
  - Removing or changing index storage locations that contain indexes is to be avoided if possible for these reasons.

- Modify which Native Archive index servers are to use the index storage location.

  - Select the **Allow all servers to use this storage** option to allow all Native Archive index servers to use the location.

    Selecting this option not only allows all current index servers to use the index storage location, but also allows any index servers that are subsequently added to automatically use this index storage location.

  - Select the **Only allow the following servers to use this storage** option to allow only the selected Native Archive index servers to use the location.

    Selecting this option allows you to control which index servers have access to the index storage location and allows you to segment your index processing into groups of index servers and index storage locations.

4. Click **OK** to accept the modifications. The **Index Storage Location** dialog closes.

5. Click **OK** to save your changes and close the **Archive Folder** dialog box.

### Deleting archive folders

Delete archive folders from the Native Archive. Before deleting those folders, be aware of the effects of that deletion.

### Considerations in deleting archive folders

The following are items to consider before deleting an archive folder.

- Before deleting an archive folder, ensure that:
  - All the data in that folder is to be deleted.
  - No mapped folders are associated with that archive folder.
  - The data in that folder is not being indexed.
  - There is sufficient time to delete the archive folder prior to performing a backup of the system.
Do not delete a month or folder until volumes are closed and not being indexed. If you delete a month or folder of data while the associated volume or index is active (while indexing, while writing to the volume, and so on), this can result in one of several types of errors, such as volume write failures, index failures, and archive failures, and may also result in only a partial deletion of the month or folder.

An archive folder typically contains multiple months of data which each contains one or more volumes of data. Deleting this amount of data at one time can take a long time to complete and it may appear that the console is unresponsive while this deletion occurs.

A better approach may be to delete each month individually from the folder and then delete the archive folder after it is empty. When the months are deleted, all indexes associated with the months are also deleted.

To make the deletion process take less time, you can schedule the deletion of the portion of the data that is in the SQL Server database to occur later.

**Procedure for deleting archive folders**

Perform the following steps to delete a folder from a Native Archive.

1. **Review the impact of deleting an archive folder.**
2. **Select the** Archive Folders **node for the Native Archive. The Archive Folders area lists the folders for the selected** Native Archive **node.**
3. **In the** Archive Folders **area, select the folder to delete.**
4. **Select** Action > Delete Folder. **Action > Delete Folder.**
5. **The** Delete Folder **dialog box appears. This dialog appears so that you do not unintentionally delete a folder containing data.**
6. **Use the** Delete Folder **dialog box to verify that you want to delete the archive folder containing data by selecting the I acknowledge that this action will permanently delete archive content checkbox. This causes the Yes button to be enabled. The No button is enabled and selected by default.**

**Figure 33  Delete Folder dialog for confirming deletion**

- **Click Yes** to confirm the deletion of a folder of data. The Delete Folder dialog box exits and the Folder of data and all associated volumes, indexes and metadata are deleted.
- **Click No** to not have the data deleted and dismiss the Delete Folder dialog box.

If deletion is confirmed, the deletion process begins. This action may take some time to complete if there is a large amount of data in the folder.
To make the deletion take less time, you can schedule the deletion of the metadata in the SQL Server database to occur later.

**Disposing of obsolete content in archive folders**

Data within archive folders can be disposed of automatically by setting the Enable automatic disposition option on the folder and specifying a certain number of months. EMC SourceOne then automatically disposes of any content in that folder that is older than the specified number of months.

Perform the following steps to manually dispose of data in an archive folder.

1. Select the **Archive Folders** node for the Native Archive. The Archive Folders area lists the folders for the selected **Native Archive** node.
2. In the **Archive Folders** area, select the folder for which to manually dispose of data.
3. Select **Action > Perform Disposition**.

**Environment specific information and configuration**

This section describes environment specific information and configuration for Native Archive folders and storage.

**Archive folder requirements for SharePoint EBS content**

Archive folders used to store SharePoint External BLOB Storage (EBS) content have the following requirements.

- Do not enable retention on the archive folder.
- Do not enable indexing on the archive folder.
- Only place EBS content in the archive folder.

**ATMOS configuration for a non-SEC 17 compliant tenant**

Perform the following steps to configure SourceOne policies for ATMOS.

1. Configure the default policy as follows:
   a. Disable **Retention**.
   b. Disable **Deletion**.
2. Create a policy, and name it, **SourceOne_Default_Policy** or give it any other name of your choice, then:
   a. Enable **Retention** and set retention period to 1 second.
   b. Disable **Deletion**.
3. Create a policy selector, and name it, **SourceOne_Default_Selector** or give it any other name of your choice, then:
   a. Relate it to Policy **SourceOne_Default_Policy**.
   b. Set the Event trigger to **ON_UMD_UPDATE**.
   c. Set the rule as **S1ObjectType equals S1RetentionObject**.
4. Assign this selector to the Subtenant that you want to use for the SourceOne storage.
ATMOS configuration for a SEC 17 compliant tenant

For a SEC 17 compliant subtenant SourceOne.

- Enables retention and checksum when uploading an object.
- Does not support the deletion of a single message from a container file from ATMOS storage.

Perform the following procedure to configure SourceOne SEC 17 policies for ATMOS.

1. Configure the default SEC 17 compliant policy as follows:
   a. Set retention period to 0 seconds.
   b. Disable Deletion.

2. Create a SEC 17 compliant policy, and name it, SourceOne_Default_Policy or give it any other name of your choice, then:
   a. Enable **Retention** and set retention period to 1 second.
   b. Disable **Deletion**.

3. Create a policy selector, and name it, SourceOne_Default_Selector or give it any other name of your choice, then:
   a. Relate it to Policy SourceOne_Default_Policy.
   b. Set the Event trigger to ON_UMD_UPDATE.
   c. Set the rule as S1ObjectType equals S1RetentionObject.

4. Assign this selector to the Subtenant that you want to use for the SourceOne storage.

Configuring Isilon prior to use with SourceOne

Perform the following step on the Isilon server to use Isilon with SourceOne.

1. Configure the SmartLock license for the cluster. If using compliance mode, the compliance clock must be set and a SmartLock root directory must exist.

2. Configure a SmartLock folder.

3. Ensure that the following settings are not set on the SmartLock directory when using SourceOne:
   - Default retention
   - Minimum retention
   - Maximum retention
   - Autocommit

The SmartLock directory settings can override the amount of retention SourceOne applies to a container. This can result in SourceOne treating a container as if retention has expired when it has not, or SourceOne retaining a container when the retention period has expired. For example, if someone sets the autocommit setting on the SmartLock directory, SourceOne may try to delete the folder if SourceOne does not realize that the container is in retention.
Isilon folder disposition

After the retention period expires on a SourceOne container, the file becomes eligible for deletion, but the Isilon device itself does not automatically delete the container.

Perform one of the following steps to dispose of a container in SourceOne.

- The user can right-click the Archive Folder in the console and select **Perform Disposition**.
- Enable **Automatic Disposition** for the Archive Folder and write a script to perform the disposition at scheduled times.

Deletion occurs only for folders that are out of retention. If there is a requirement to delete containers under retention, Isilon supports a privileged delete using the Isilon shell when the following conditions exist:

- The user that is performing the delete uses the ISI tool on the Isilon container.
- The Isilon container is in enterprise mode rather than compliance mode.
- The user that is performing the delete is logged in as the root user.
- The privileged delete setting on the SmartLock folder is set to On.

Isilon message disposition

The deletion of individual messages from a container is possible. Note the following.

- A privileged delete is only available on the Isilon device itself.
- If someone deletes a message when the parent container of the message is under retention, deletion of the message occurs in the SourceOne database and index, but not from the Isilon container.

Configuring Native Archive folder DiskXtender options

Use EMC DiskXtender for Windows (DiskXtender) to extend the capacity of the Native Archive by causing the Native Archive contents to be automatically written to other storage media, such as EMC Centera devices, tape, DVD-R, DVD-RAM, magneto-optical, Ultra-Density Optical (UDO), WORM, WORM-tape, and Network Attached Storage (NAS).

DiskXtender extends the storage capabilities of NTFS volumes by moving files from NTFS volumes to other storage media. However, the files still appear to be resident on the volume, and can be accessed from storage media as needed.
Configuring DiskXtender for use with EMC SourceOne

To configure DiskXtender for use with EmailXtender, perform the following steps using the DiskXtender File System Manager Administrator.

1. Create a media service.

   A media service provides access to the media so that DiskXtender can work with it. For some media services, like EMC MediaStor™, this means placing requested media into a drive. For other media services, like EMC Centera or Network Attached Storage (NAS), this means providing access to a place where the data is written.

2. Create an extended drive.

   When you are using DiskXtender with EmailXtender, select the EmailXtender storage drive as the extended drive.

3. Prepare the media.

   The way you prepare the media depends on the media service you are using. The following table describes how to prepare the media for each service.

   **Table 12 Media service preparation**

<table>
<thead>
<tr>
<th>Media service</th>
<th>Media preparation</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC Centera</td>
<td>If you are using the EMC Centera media service, there are no additional steps you must take to prepare the media. (You do not need to create the virtual media or allocate it to the extended drive; EmailXtender does this automatically for you when it begins closing volumes.)</td>
</tr>
<tr>
<td>MediaStor or StorageTek ACSLS</td>
<td>If you are using the MediaStor or StorageTek ACSLS media services, allocate blank media from the media service to the extended drive. When you allocate media, DiskXtender claims the media for file migration from the specified extended drive.</td>
</tr>
<tr>
<td>NAS or Tivoli Storage Manager (TSM)</td>
<td>If you are using the NAS or TSM media services, create the virtual media and allocate it to the extended drive.</td>
</tr>
</tbody>
</table>

4. For the remaining DiskXtender settings, leave the defaults unless instructed to change them by an EMC technical representative, with the exception of the **Use special application filtering** option on the **Options** tab of the **Service Properties** dialog box. This option allows you to specify whether an application can recall or directly read a purged file that resides on storage media.

   - If you are using virus scanning software on the EmailXtender storage drive (the extended drive), add the executable file for the virus scanning software to the **Special Application Filtering List** and set the file to **No recall**.
   - If you are using the EMC Centera, MediaStor, or Sun StorageTek ACSLS media services, do not create media folders, media groups, or move rules. These items are created automatically by EmailXtender. In addition, do not label Sun StorageTek ACSLS or MediaStor media. EmailXtender also does this automatically.

5. If you are using the NAS or TSM media services, create the media folders, media groups, move rules, and purge rules to enable file migration and purging. Automatic file migration is **not** available when you use these media services.

   You may want to create media folders for each storage drive directory for EmailXtender folders or cabinets.
6. The final step in configuring DiskXtender for use with EMC SourceOne is to configure the EMC SourceOne storage options that are specific to DiskXtender using the EMC SourceOne console. These include:

- Specifying the EMC SourceOne storage drive as the DiskXtender extended drive.
- Specifying the media type you selected in DiskXtender.
- Specifying the maximum volume size.

You configure these options when you create archive folders.

**Note:** Be aware that if using EMC DiskXtender with EMC Centera, and DiskXtender experiences connection issues with Centera (such as not being able to access all of the configured nodes), errors are generated in both EMC SourceOne and DiskXtender. A typical DiskXtender error may indicate “File fetch failed” for .emx files it is attempting to retrieve based on a request generated from EMC SourceOne. You can correct this problem by restarting the DiskXtender services and ensuring that the connection to the Centera device is re-established. Note that it may take some time for the errors to dissipate.

### Automatic file migration activities

After configuring DiskXtender and EmailXtender, the system can begin automatically migrating volumes to media.

**Note:** If you are using the NAS or TSM media services, automatic file migration is not available. You must use the EMC Centera, MediaStor, or Sun StorageTek ACSLS media services if you want to benefit from automatic file migration.

### What EMC SourceOne creates

As EmailXtender closes volumes and copies them to the storage drive as .emx files, EmailXtender automatically creates the necessary media folders, media groups, and move rules in DiskXtender based on the Message Center folders, collection rules, and retention periods.

- Media folders are folders on the extended drive that contain the files that DiskXtender moves to media.
- Media groups are specific groupings of media assigned to a media folder.
- Move rules define which files in a media folder are moved to each media group.

### What EMC SourceOne does not create

EmailXtender does not create purge rules, which define which files to purge from the extended drive. Instead you select whether to purge files immediately after they are moved using the Purge after move option in the EMC SourceOne console.

If you do not select the Purge after move option, configure purge rules using the DiskXtender File System Manager Administrator as described in the DiskXtender for Windows documentation. Purging files is usually needed to avoid running out of space on the storage drive.
EMC SourceOne configures DiskXtender

EMC SourceOne automatically configures DiskXtender by completing the following tasks.

1. Creates one media folder for the archive folder.
   The first time a volume closes in EMC SourceOne for this archive folder, the system automatically creates a single media folder, with a name using the first 12 characters of the archive folder name.

2. Creates one DiskXtender media group per folder per month.
   EMC SourceOne creates one media group for each month for each EMC SourceOne folder and adds media to the media group. If you are using removable media through the MediaStor or Sun StorageTek ACSLS media services, then DiskXtender automatically labels blank media before adding it to the media group.

3. Creates one move rule per folder per month.
   • EMC SourceOne also creates one move rule for each month for each EMC SourceOne folder and sets the move rule to move only .emx files.
   • Optionally you can select to have EMC SourceOne mark all files for direct read, or to purge files immediately after they are moved to media using the options described in “Using the Storage Options page of the New Archive Folder wizard” on page 67.
   • If you do not select the Purge after move option, configure purge rules to avoid running out of space on the storage drive.
   • If you configured a retention period for an EMC SourceOne folder, the retention period is configured for the move rule.

Consider the following:

• If you are using DVD-R media, files are not marked for direct read or purged until you finalize the media.

• If you are using DiskXtender to write volumes to removable media, such as DVD-R or DVD+R, tape, or magneto-optical, you may want to disable direct read to avoid too many competing read and write requests to the library containing the media. Consult with an EMC technical representative to determine if this strategy is for you.

Configuring media group options

If you are using the EMC Centera media service, set the Maximum media simultaneously receiving files option on the Options tab of the Media Group Properties dialog box to 4.

Do not change the remaining default values for the media folder, media groups, and move rules.

Note: If volumes exist on the EmailXtender storage drive before you extend the storage drive using DiskXtender, EmailXtender does not automatically configure DiskXtender to move those volumes; only volumes that close after you extend the storage drive cause automatic configuration to occur. You must create the media folder, media group, and move rule, as well as perform the associated assignments, manually using the DiskXtender File System Manager Administrator interface.
Managing Native Archive folders

You can manage the Native Archive folders after they are configured by performing the one or more actions described in this section.

Viewing Native Archive folder data and available actions

Native Archive folders contain the data archived in the Native Archive. This data is organized by month folders that are automatically created and populated during the archiving process. For example, the month folder 200805 would be automatically created in May of 2008.

Each month folder contains one or more volumes containing the archived data, and if selected, the one or more associated full-text indexes. You can view information about volumes and indexes in the Native Archive by expanding the Archive Folders node and then expanding the archive folder in which the volumes and indexes are stored.

![Figure 34  Viewing archive folder data](image)

When a volume is saved to the extended drive, the volume is added to the move list. The volume is then moved to media when the file migration schedule is active. By default, the file migration schedule is active from 8 P.M. to 9 A.M. They can optionally also be automatically purged and marked for direct read if those options have been selected in EMC SourceOne. If those options are not selected in EMC SourceOne, then volumes are purged according to the purge settings configured in DiskXtender.
Configuring Archives

The actions you can perform on a selected month, volume, or index are shown in the following table.

**Table 13** Available archive folder actions

<table>
<thead>
<tr>
<th>Selected item</th>
<th>Available actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>ReIndex Month</td>
</tr>
<tr>
<td></td>
<td>Delete Month</td>
</tr>
<tr>
<td>Volume</td>
<td>Close Volume</td>
</tr>
<tr>
<td>Index</td>
<td>Rebuild Index</td>
</tr>
<tr>
<td></td>
<td>Refresh from Content Cache</td>
</tr>
</tbody>
</table>

The following sections describe how to view the status of and manage the volumes and indexes in a Native Archive.

Viewing months and volumes

Perform the following steps to view the volumes in an archive folder.

1. Select the **Archive Folders** node under the **Native Archive** node.

The **Archive Folders** area appears with two panes:

- The top pane lists the existing archive folders and can be expanded to show the months within each archive folder.
- The bottom pane lists detailed information about volumes or indexes that are part of the selected month subfolder, depending on which tab in the bottom pane is selected.

The following list describes the columns displayed in the top pane of the **Archive Folders** area.

- **Name** — Specifies the name of the archive folder.
- **Year/Month** — Specifies the name of the month subfolder.
- **Volumes** — Specifies the number of volumes in the folder or subfolder.
- **Volume Size (MB)** — Specifies the size of the volumes listed. If there are multiple volumes, it specifies the total size of all volumes.
- **Volume Message** — Specifies the number of content items in the volume. If there are multiple volumes, it specifies the total number of content items in all volumes.
- **Indexes** — Specifies the number of indexes in the folder or subfolder.
- **Index Size (MB)** — Specifies the size of the indexes listed. If there are multiple indexes, it specifies the total size of all indexes.
- **Index Message** — Specifies the number of content items in the index. If there are multiple indexes, it specifies the total number of content items in all indexes.
- **Errors** — Specifies the number of months or indexes that have errors. For an archive folder, this is the total number of errors in the contained months and in the indexes.
- **Description** — Specifies the description associated with the archive folder.
2. In the top pane of the **Archive Folders** area, expand the archive folder that contains the month subfolder about which you want more information and select that month subfolder.

3. Click the **Volumes** tab to view detailed information about the volumes in the selected month subfolder. The following list describes the columns displayed on the **Volumes** tab.

- **Year/Month** — The name of the month subfolder containing the volume.
- **Volume Name** — The name of the volume.
- **Messages** — The number of content items in the volume.
- **Size (MB)** — The size of the volume in megabytes (MB).
- **Status** — The status of the volume. A volume can have more than one status simultaneously. The following are the possible values:
  - **Available** — The volume is available for use. This is the default status.
  - **Busy Trying to Record** — The system is busy attempting to record the volume.
  - **Closed** — The volume is closed and cannot have content added to it.
  - **Deleted from storage** — The volume is in the process of being deleted from the archive and is not available. When this is the status, the folder icon for the volume appears with an X on it indicating that the volume is being deleted.
  - **Deleted from SQL** — Information about the volume is in the process of being deleted from the SQL database and is not available.
  - **Failed Recording** — The volume could not be recorded.
  - **Online** — The volume is accessible.
  - **Recording** — The volume is being recorded.
  - **Record Pending** — The recording of the volume is pending.
  - **Removal Pending** — The removal of the volume is pending.
- **Start** — The date and time when the volume was opened.
- **End** — The date and time when the volume was closed.

Modify which columns are displayed in this view by selecting **Add/Remove Columns** from the **Actions** menu.

### Viewing indexes

Perform the following steps to view the indexes in an archive folder.

1. Select the **Archive Folders** node under the **Native Archive** node.

The **Archive Folders** area appears with two panes:

- The top pane lists the existing archive folders and can be expanded to show the months within each archive folder.
- The bottom pane lists detailed information about volumes or indexes that are part of the selected month subfolder, depending on which tab in the bottom pane is selected.
2. In the top pane of the **Archive Folders** area, expand the archive folder that contains the month subfolder that contains the index about which you want more information and select that month subfolder.

3. Click the **Indexes** tab in the bottom pane to view index information associated with the selected month subfolder. This table describes the columns displayed in this tab.

The following list describes the columns displayed in the top pane of the **Archive Folders** area:

- **Type** — The kind of index. Possible values are:
  - **ES1** — Indicates an EMC SourceOne index.
  - **EX** — Indicates an EMC EmailXtender index.

- **Year/Month** — The name of the month subfolder containing the index.

- **Index** — The name of the index. This name is a sequential number assigned to the index when it is created.

- **Messages** — The number of content items in the index.

- **Size (MB)** — The size of the index in megabytes (MB).

- **Status** — The status of the index. Possible values are:
  - **Available** — The index is complete and is searchable. This is the default status.
  - **Deleted** — The index is in the process of being deleted and is not searchable. When this is the status, the folder icon for the associated volume appears with an X on it indicating that the index is being deleted.
  - **Inconsistent** — The index has inconsistencies and is not searchable.
  - **Indexing** — The index is being created and is not searchable.
  - **Missing Item** — There is a mismatch between the number of content items in the index and the number of content items in the one or more volumes from which the index was created.
  - **Refreshing** — The index is in the process of being reindexed using data in the content cache and is not searchable.
  - **Reindexing** — The index is in the process of being reindexed using data in the archive and is not searchable.
  - **Unperformed Transaction** — After several attempts an index transaction file for the index could not be processed, and so the index transaction file was removed from the processing directory.

- **Start** — The date and time when the index was opened.

- **End** — The date and time when the index was closed.

Modify which columns are displayed in this view by selecting **Add/Remove Columns** from the **Actions** menu.
Managing Native Archive folders 101

Configuring Archives

Understanding and correcting indexes with the Unperformed Transaction status

The Unperformed Transaction message appears on the Indexes tab on the bottom pane of the Archive Folders area. When the Unperformed Transaction status appears for an index, it indicates that after several attempts an index transaction file for that index could not be processed, and so the index transaction file was removed from the processing directory.

Understanding index transaction files

The index transaction file contains the operations to be performed on an index. Index transaction files may have either of the following file types.

- Index transaction files with a .xvlts file type contain operations to add documents to an index.
- Index transaction files with a file type of .upds contain operations to update documents in an index.

Index transaction files are processed in the following directory:

`\EMC SourceOne\Indexes\DropDir`

When an index transaction file repeatedly cannot be processed, the Unperformed Transaction status is signaled, and the index transaction file is moved from the \DropDir directory to the \Intermediary subdirectory of the \DropDir directory, as in the following example:

`\EMC SourceOne\Indexes\DropDir\Intermediary\ArchiveFolder_201011_004.xvlts`

Correcting an unperformed transaction

When the Unperformed Transaction status is signaled, the administrator is to check the Intermediary directory for any files and then contact EMC Support for help in analyzing those files and correcting the problems so that the one or more files can be processed.

If the solution to the problem is to correct the index transaction file and then reprocess it, perform the following tasks.

1. Place the corrected file in the following directory:

   `\EMC SourceOne\Indexes\DropDir`

2. Afterwards, EMC SourceOne will automatically pick up the file for processing as part of regular indexing of content.

Search implications of unperformed transactions

When an index transaction file cannot be processed, the content to be processed by that index transaction file has not yet been indexed.

However, you can still return search results for that unindexed content using a search client.
Configuring Archives

Recreating indexes for a month of data

Perform the following procedure to recreate the index for a month of archived data.

1. Select and view the month
2. Select the month to be reindexed.
3. Select Action > Reindex Month. The archived data is reprocessed and the resulting one or more indexes are recreated.
   - To recreate only a single index from the archive, use the Rebuild Index option.
   - To recreate only a single index from the content cache, use the Refresh from content cache option.

Deleting a month

Perform the following steps to delete a month of archived data.

1. Review the considerations for deleting data in “Considerations in deleting archive folders” on page 89.
2. Display the volumes by month
3. Select the month to be deleted.
4. Select Action > Delete Month. The Delete Month dialog box appears. This dialog box appears so that you do not unintentionally delete a month of data.
5. Use the Delete Month dialog to verify that you want to delete the month of data by selecting the I acknowledge that this action will permanently delete archive content checkbox. This causes the Yes button to be enabled. The No button is enabled and selected by default.

![Delete Month dialog for confirming deletion](image)

6. Click Yes to confirm the deletion of a month of data. The Delete Month dialog exits and the month and all associated volumes, indexes and metadata are deleted.
7. Click No to reject deleting the data and dismiss the Delete Month dialog.

To improve time taken to delete data, schedule the deletion of archived data metadata from the SQL Server database for a non-peak time.
Closing a volume

Perform the following steps to close a volume.

1. Display the volumes
2. Select the volume to close.
3. Select Action > Close Volume. The volume status is changed to Closed and, if required, a new volume is opened for any subsequent content that is archived.

Consider the following:
- If the volume to be closed is stored on a network storage device, such as an EMC Centera, you may not be able to close the volume when that device is not reachable on the network. If this occurs, resolve the network connection issue to the storage device and attempt to close the volume again.
- If there are volumes which have failed to close in the Native Archive and the network connection to the SQL Server database is lost and then re-established, EMC SourceOne will attempt to close these volumes, resulting in Failed to Record Volume error messages to the event log.

Rebuilding an index

Perform the following steps to rebuild a single index from the archive.

1. Display the indexes
2. Select the index to rebuild.
3. Select Action > Rebuild Index. The index is recreated.

- To recreate only a single index from the content cache, use the Refresh from content cache option.
- To recreate all indexes associated with a month, use the Reindex Month option.

Rebuilding an index from the content cache

Complete the following procedure to refresh an index using data in the content cache rather than data in the archive.

1. Verify that the archive folder was created with content caching enabled.
2. Display the indexes.
3. Select the index to rebuild from the content cache.
4. Select Action > Refresh From content cache. The index is recreated.

- To recreate only a single index from the content cache, use the Refresh from content cache option.
- To recreate all indexes associated with a month, use the Reindex Month option.
Managing Multiple Native Archive Connections

The EMC SourceOne Email Management console, allows for the creation of multiple native archive connections. Each native archive connection requires a dedicated archive database and one or more native archive servers.

Install and configure multiple Native Archive connections

Perform the following steps to add new Native Archive connections.

1. Install new Archive Databases and configure the corresponding SQL permissions.
   Install new Archive Databases by using either of the following methods:
   - With a separate host for each database.
   - On the same host with each Archive database on a dedicated drive.
   The Important SQL Server considerations and the SQL Server permissions sections in the SourceOne for Email Management Installation Guide provides details about database installation.

2. Add new Archive Servers that point to the new Archive Database.

3. In the EMC SourceOne Admin console:
   a. Right-click Archive Connections.
   b. Select New Archive Connection as shown in the following figure.

   ![Figure 36 New Archive Connection](image)

4. Type the Archive Connection name in the Name field, and select Native Archive from the Type list as shown in the following figure box.
Note: Description is an optional field.

Figure 37  New Archive connection information

5. Click Next.

6. Type the Database Server and Database Name for the new Archive Database in the respective fields as shown in the following figure.

Figure 38  New database server name information
7. Click **Finish**. The creation of the new Native Archive connection occurs and appears in the **Archive Connections** node as shown in the following figure.

![Figure 39 New Native Archive added](image)

8. Create an archive folder in the Native Archive connection and create a mapped folder that maps to the new archive folders.

   When browsing Archive Folders while creating a mapped folder, all the Native Archive connections appear with the archive folders.

![Figure 40 Select Folder window](image)
Data segregation with Worker Group and multiple Native Archive connections

The Worker Group and the multiple Native Archive connections collectively process and store messages locally in environments that require two or more distinct locations to archive messages from a local mail server to local storage.

The following figure illustrates the supported configuration for this deployment.

![Data segregation deployment diagram](image)

**Figure 41** Data segregation deployment

The *SourceOne Email Management Installation Guide* provides details on the installation, recommendations, and considerations for adding Native Archive connections.

Multiple Native Archive Configuration considerations

The message center, archive, index, or unpack locations can use a share folder. The share folder must not use multiple native archive connections because this action can result in data unavailability.

The SourceOne software ensures exclusive use of a network share folder by only one native archive connection by creating a unique hidden file with a name of ES1NetworkShare.claim.

The share folder includes message center, unpack, archive, and index locations.

When configuring a share folder to a native archive connection, the native archive connection claims the share folder preventing other native archive connection from claiming the share folder again.
The archive service stops working if it cannot claim any of the following:

- The message center for the archive server.
- The unpack location for the archive server.
- The archive locations for each archive folder.

The index service stops working if it cannot claim the index locations for each archive folder.

**Archive server configuration errors**

If a native archive connection cannot claim either the message center or the index unpack directories during archive server configuration, archive server configuration errors appear.

The following is the Message Center Directory error that appears:

The Archive Folder data is invalid for the following reasons:
- Message Center Directory can’t be claimed. It may be claimed by another native archive connection.

The following is the Archive Index Unpack Directory error that appears:

The Archive Folder data is invalid for the following reasons:
- Archive Index Unpack Directory can’t be claimed. It may be claimed by another native archive connection.

**Archive Folder Configuration errors**

If a native archive connection cannot claim either the archive or the index locations during archive folder configuration, then archive folder configuration errors appear.

The following is the Archive location error that appears:

The following problems were found with this Archive Folder configuration:
- Archive Location can’t be claimed. It may be claimed by another native archive connection.

The following is the Index location error that appears:

The following errors were identified:
- Index Location can’t be claimed. It may be claimed by another native archive connection.

**New Archive Connection Configuration**

During archive connection configuration, if a native archive connection cannot claim either of the following then an archive connection configuration error appears.

- The message center or the unpack locations of each archive server.
- The archive or the index locations of each archive folder.

The following is the error message that appears:

This configuration is invalid for the following reasons:
- Message Center Directory can’t be claimed. It may be claimed by another native archive connection.
- Index Location can’t be claimed. It may be claimed by another native archive connection.
Using the network share claim functionality for multiple Native Archive connections

The SourceOne console administrator must have full access permissions to the network share folders to use the network share claim functionality in the SourceOne console. If the SourceOne console administrator does not have permission, the following steps ensure the claiming of the responding share folders to avoid a potential data unavailability issue.

1. Before saving the configuration:
   a. Ensure that the following file does not exist in the share folder or its sub folders:
      
      SourceOne ES1NetworkShare.claim
   
   b. If the following file exists in the share folders, ensure the native archive site ID in the file is the same as the current native archive site ID:
      
      SourceOne ES1NetworkShare.claim

2. After saving the configuration:
   a. Restart the archive and the index services.
   b. Let the archive and the index services claim the new share folders. If the archive and the index services fail to claim these share folders, the archive and the index service fail to start.

   Note: Do not use nested network share folders as the Message Center Location, Archive Location, or Index Location.

Disclaiming a network share folder

When decommissioning occurs for an archive server or a native archive connection, SourceOne does not automatically disclaim the related claimed share folders. If the SourceOne administrator wants to reuse these share folders for other native archive connection, they need to manually delete the claim file in the corresponding share folders.

Searching an archive

After an EMC SourceOne archive is configured and populated, you can search the contents of that archive using EMC SourceOne Search.

When a user executes a search query, EMC SourceOne Search dynamically determines which Archive and Archive Folder to search based on the Mapped Folder selected by the user performing the search.

- Simple search queries are executed as SQL queries of the EMC SourceOne database. Simple search queries tend to execute more quickly than complex queries because they are simpler and because they do not access the archive indexes.

   An example of a simple search query would be a search for all messages received by a user over a specified period of time.
Complex search queries are executed by searching the full-text indexes of the archive. How these indexes are accessed differs depending on whether the archive is stored in an EMC SourceOne Native Archive or an EmailXtender 4.8 SP1 archive. Complex search queries tend to execute more slowly than simple search queries because they are both more complex and because they access the full-text indexes.

An example of a complex search query would be a search for all messages received by multiple users that contained a certain text string in the subject or body of the message.

To ensure the success of any search, always first verify that the full-text search capabilities of the archive are completely operational. For example, prior to searching a Native Archive archive, verify that the one or more Native Archive search servers and retrieval servers are available.

Although it is possible to execute a simple search of the EMC SourceOne database even when the archive full-text search capabilities are not available, doing so is not advisable because what is considered a simple query versus a complex query can only be determined by the software when that query is executed.

### Moving an archive

In some situations, such as when hardware needs to be reallocated or replaced, you may need to move the physical location of the archive in which EMC SourceOne stores content.

**Note:** If you have a complex hardware and software configuration, you may want to contact EMC Professional Services for assistance in moving the archive.

Perform the following steps to move an archive.

1. Verify that there are no activities creating jobs to process content. You perform this by setting all active activities to the suspend state using the EMC SourceOne console.
2. Verify there are no EMC SourceOne jobs running on any of the Worker Servers using the EMC SourceOne console.
3. Close any open volumes.
4. Prepare to shut down the archive servers.
   Prior to shutting down the archive servers, coordinate the shut down of the archive servers with any related software or hardware, such as the following:
   - EMC DiskXtender
   - EMC Centera
   - EMC Symmetrix hardware
   - Microsoft Windows clustering software.
5. Shut down all of the Native Archive Servers.
6. Copy the data from the current storage location to the new storage location.
   a. Copy the data from the following folders to the new locations:
      - **Archive folder** — EMC SourceOne volumes (container files)
Retaining and disposing of archived data

Some organizations require that data, such as messages, be retained for a period and then disposed of after that time.

EMC SourceOne supports the retention and disposal of data as described in the following sections.

Configuring data retention and disposal

Configure data retention and disposal by completing the following procedure.

1. Specify the data retention on the archive folder in the Native Archive.

   You specify how long data in the archive folder is to be retained by entering a value in the Months to retain field as described in “Adding archive folders” on page 65.

2. Determine whether you want to automatically or manually dispose of data that is past the retention period.

   • To manually dispose of such data, select the archive folder containing the data to process and then select Action > Perform Disposition.

   • To automatically dispose of such data, perform the following:

     a. Configure the scheduling of automated data disposal.

   b. Verify that the new storage folders you create are configured as described in the EMC SourceOne Email Management Installation Guide.

7. Prepare to start the one or more archive servers. Before starting the archive servers, coordinate the start of the archive servers with any related software or hardware, such as those previously listed.

8. Start all of the Native Archive Servers.

9. Using the EMC SourceOne console, modify the locations for the Native Archive Servers to match where the archive is now stored:

   • If required, modify the value of the Message Center Location field to the new location.

   • If required, modify the value of the Archive Location field.

   • If required, modify the value of the Index Storage Location field.

   When specifying the path in the Message Center Location, Archive Location, or Index Storage Location fields, you can specify that path as a UNC path or a local path.

   Note: Reset the EMC SourceOne activities you previously set to suspend back to their original states.

Retaining and disposing of archived data
b. Select the Enable automatic disposition field on the archive folder.

**Configuring the scheduling of automatic data disposal**

If you decided to use automatic data disposal, you must install and configure the data disposal script that is scheduled to perform the disposal.

Perform the following tasks to configure automatic data disposal.

1. Copy the data disposal script to the local system as described.

2. Schedule the execution of the data disposal script as described in “Scheduling the execution of the EMC SourceOne data disposal script” on page 112.

3. Review how often to schedule automatic data disposal as described in “Determining how often automatic data disposal is to run” on page 113.

**Installing the EMC SourceOne data disposal script**

To install the data disposal script, copy the script to the computer on which it will be scheduled to run. This script can be scheduled to run on any computer that has the EMC SourceOne console installed.

The EMC SourceOne data disposal script is located on the EMC SourceOne kit in the \Utility\disposition folder and is named ES1_AutoDisposition.vbs.

**Scheduling the execution of the EMC SourceOne data disposal script**

Run the data disposal script regularly to determine if there is any data that is marked for disposal that needs deleting.

Perform the following tasks to schedule the typical execution of the data disposal script using the Microsoft Windows Scheduled Tasks applet.

1. Launch the Scheduled Tasks applet. The Scheduled Task wizard appears.

2. Click Browse to locate the data disposal script on the local computer. The Select Program to Schedule dialog box appears.

3. Select the ES1_AutoDisposition.vbs file and click Open. The ES1_AutoDisposition task is now listed in the Scheduled Task wizard.

4. Select how often to perform the task by selecting one of the following time options:
   - Weekly
   - Monthly

5. Click Next.

6. Select the start date, time, and interval for the task and then click Next.

7. Specify the name and password of the user account under which this task is to be run and then click Next.

   **Note:** The script is to run under an account that is part of the EMC SourceOne security group.

8. Select the Open advanced properties for this task when I click Finish option and then click Finish. The Properties page for the scheduled task appears.
9. On the Task tab, edit the string in the Run field to insert the cscript command to run the ES1_AutoDisposition.vbs script as a task.

For example, if the file is located in the directory C:\scripts, the Run field string appears as follows:

cscript C:\scripts\ES1_AutoDisposition.vbs

The previous example displays how this string appears for a 32-bit version of a Microsoft Windows operating system. The following example displays how this string appears for a 64-bit version of a Microsoft Windows operating system:

C:\Windows\SysWOW64\cscript C:\scripts\ES1_AutoDisposition.vbs

10. Click OK. The Set Account Information dialog box appears.

11. Type and confirm the password of the account under which the task will run.

   **Note:** The script is to run under an account that is part of the EMC SourceOne security group.

12. Click OK. The Properties page for the scheduled task closes.

13. The new task now appears in the list of scheduled tasks that appears when you select Scheduled Tasks from the Control Panel.

**Determining how often automatic data disposal is to run**

How often automatic data disposal is to be scheduled to occur depends on your email archiving environment and your organization’s data retention and disposal goals.

Data disposal is to be scheduled often enough that a large amount of data does not need to be deleted at one time, but not so often that another data disposal is scheduled to occur while the current amount of data is being deleted.

Usually, you schedule the disposal script to run weekly to detect if there is any data that needs disposal. However, you may decide to lengthen this to a monthly interval if that makes sense in your environment.

Be aware that deleting a month of archived data may take a significant amount of time if you archive large quantities of data. If deleting a month of archived data does take a significant amount of time, you can schedule when that deletion is to occur.

**Scheduling deletion of data from the database**

When disposing of a large quantity of data, you may want to delay the deletion of the metadata from the database as that deletion may effect the performance of the overall SourceOne system, such as jobs running to accomplish other tasks. Deleting the metadata from the database later when the system is not as heavily used may be a better choice for your environment because there would be less performance impact.

Perform the following steps to schedule disposal of data from the database.

1. In the EMC SourceOne console, select the Native Archive node.

2. Right-click that node and select Properties. The Native Archive Global Properties dialog box appears.
3. Select the **Disposition** tab.

![Disposition tab of the Native Archive Properties page](image)

**Figure 42** Disposition tab of the Native Archive Properties page

4. Specify the amount of time the disposal from the database is allowed to run by typing that value as an integer from 1 to 24 in the **Number of hours to run** field. By default this value is set to the maximum of 24 hours.

If the disposal cannot be completed in the amount of time specified, the remaining deletions will occur the next time the disposal is scheduled to occur.

5. Specify what time of day the database disposal is allowed to begin by selecting the time in the **Start time** field. The default value is 12:00AM (midnight) GMT.

Typically, set the time of day to be the beginning of the time when the system is under the least load.

6. Specify the maximum number of threads and processes that can be used using the **Maximum thread count** field. This value may be an integer from 1 to 10. The default value is 1.

- To increase the number of processes working to delete data in the database so that the disposal completes sooner, increase the **Maximum thread count** field value.
- If you increase this value to the point that your SQL Server is performing poorly, you may want to decrease this value.
- When you change the value of the Maximum thread count field, on the **Disposition** tab of the **Native Archive Global Properties** page, the change does not take effect immediately.
The new value will be available when one of the following occurs after the change has been made:

- A database disposition occurs.
- The Native Archive Servers are suspended and then resumed.
- The EMC SourceOne Administrator service (ExAsAdmin.exe) is stopped and restarted. Be aware that stopping and restarting the EMC SourceOne Administrator service causes several other EMC SourceOne services to stop and restart.

7. Select the days of the week on which disposal from the database is to be performed in the **Days of the week to perform disposition** area. By default, all days are selected which indicates that it is to be performed every day.

**Extending the retention period for archive folders**

EMC SourceOne Email Management has the ability to extend the retention period for archive folders. In the Archive Folder page under the Storage Options tab, if you update the Months to Retain field then SourceOne does the following.

- Updates the archive folder's retention month and applies the new retention policy to any new volumes.
- Extends the retention period of every stored object.

**Note:** This release only supports Centera containers.

View the Extend Retention Status in the Archive Folders page as follows.

**Figure 43** Extend Retention Status

The following list describes the available status codes for archive folders:

- Blank — No extend retention request exists for this folder. Blank is the default status.
- Submitted — The extend retention request was submitted and is waiting to begin processing.
- Pending — The extend retention request is processing.
- Complete — The extend retention request completed successfully.
- Failed — An error occurred for the extend retention request.

The following list describes the available status codes for month folders:

- Blank — No extend retention request exists for this folder. Blank is the default status.
Complete — The extend retention request completed successfully.

Failed — An error occurred for the extend retention request.

Only one job to extend the retention period can run at a time. You must wait for the previous job to complete before extending the retention period again.

Partitioning a Native Archive database

EMC SourceOne provides the ability to add partitions to tables in the Native Archive database to improve the performance and manageability of the Native Archive.

Native Archive partitioning concepts

Before deciding whether to partition your Native Archive database, you need to be familiar with the topics in the following sections.

Prerequisites for partitioning

The Native Archive partitioning feature requires that the EMC SourceOne database be installed on the Enterprise edition of Microsoft SQL Server. The Standard edition of Microsoft SQL Server does not support this feature.

If the Native Archive database is installed on the Standard edition of Microsoft SQL Server, the Properties menu item is not available and the Partitioning tab which you use to enable database partitioning is not available.

Note: You cannot create the Native Archive database using the Standard edition of SQL Server and then add partitioning capabilities to that database by moving it to the Enterprise edition of SQL Server, because the underlying schema and capabilities of the databases are different. The partitioning options are not available for databases initially created on the Standard edition of SQL Server and later moved to the Enterprise edition of SQL Server.

Understanding database partitioning in the Native Archive

Database partitioning is not the partitioning of the database itself, but is the partitioning of tables within the database. Database partitioning is the separation of a table or index in the database into smaller tables or indexes that act as one table or index. Partitioning is typically done only to tables that tend to grow to be large to improve the performance when using those tables. The ability to partition tables is built into the Enterprise edition of Microsoft SQL Server.

Database partitioning for the EMC SourceOne Native Archive is the horizontal splitting of rows in a table (or an index defined on a table) into smaller separate logical units. Only the following tables are partitioned in the Native Archive database:

- Message
- FolderMessage
- Route
Partitions are created to contain the data for these tables. Partitions can be created using the EMC SourceOne console either manually by the administrator or automatically based on selected criteria.

When a new partition is created, any new data to be stored in these three tables goes to the new partition. However, updates to existing information in these tables will occur in the partitions in which that information already exists.

Benefits of partitioning

Partition database tables when you have a large amounts of data in the database. Breaking large tables into partitions can deliver the following data management and performance benefits.

- Partitioning may improve the performance of archiving through the improved performance of database updates and insertions.
- Partitioning tables in the database may reduce the amount of time needed to perform data backup, index maintenance, and defragmentation of the tables in the database.
- Older partitions which are accessed less frequently can be moved to cheaper storage devices and to a less frequent maintenance cycle which can reduce database maintenance costs.

Refer to Microsoft’s documentation regarding Partitioned Table and Index Concepts for general information about the benefits of SQL Server database partitioning.

Creating partitioned tables in the Native Archive database

Native Archive database partitioning is only available if the EMC SourceOne database is installed on the Enterprise edition of Microsoft SQL Server. If the Native Archive database is installed on the Standard edition of Microsoft SQL Server, the Properties menu item is not available.

Figure 44  Partitioning tab of the Native Archive Global Properties dialog box
Perform the following steps to create additional partitions in the Native Archive database.

1. In the EMC SourceOne console:
   a. Select the **Native Archive** node.
   b. Right-click that node.
   c. Select **Properties**. The **Native Archive Global Properties** dialog box appears.

2. Select the **Partitioning** tab.

   Native Archive database partitioning is only available if the EMC SourceOne database is installed on the Enterprise edition of Microsoft SQL Server. If the Native Archive database is installed on the Standard edition of Microsoft SQL Server, the **Properties** menu item is not available.

3. Select the **Enable partitioning** option to enable the use of the rest of the tab, except for the Based on area. The Based on area is only enabled when you have selected automatic partitioning.

4. Select whether to enable the automatic or manual creation of partitions:
   - Select the **Manual** option to enable the manual creation of partitions. This is the default.
   - Select the **Automatic** option to enable the automatic creation of partitions based on selected criteria.

5. If automatic partitioning was selected, select one of the automatic partitioning criteria in the **Based on** area. These criteria are described in the following table.

   When an administrator sets the system to automatically create partitions, the partitions are typically not created immediately because it takes time for the automatic criteria to be met. Also, the partition is not created at all unless the minimum size for a partition criteria are met.

   **Table 14 Automatic partitioning criteria**

<table>
<thead>
<tr>
<th>Partitioning Criteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition size (GB)</td>
<td>Specifies how large the current partition can be before creating a new partition is attempted. This value is entered as a whole number which represents the size of the partition in GB. The default value is 100, indicating 100 GB.</td>
</tr>
<tr>
<td>Item count (millions)</td>
<td>Specifies how many rows must be in the current partition before creating a new partition is attempted. This value is entered as a whole number where the number represents that many million rows in the partition. The range in values is from 50 - 200. The default value is 50, indicating 50 million rows.</td>
</tr>
</tbody>
</table>
   | Processing date           | Specifies whether creating a new partition is to be attempted each month or each year:  
                                - Select the Yearly option to attempt to create a partition whenever a new year begins, assuming the current partition. An attempt to create a partition will occur when the first content is inserted into the Native Archive after the new year begins according to the time on the SQL Server computer.  
                                - Select the Monthly option to attempt to create a partition whenever a new month begins. An attempt to create the new partition will occur when the first content is inserted into the Native Archive after the new month begins according to the time on the SQL Server computer. |
6. For either type of partitioning, select the attributes for the partition datafiles using the fields in the New partition datafiles attributes area. These datafiles are the underlying physical database for the partition.

The partition datafile attribute fields are described in the following table.

Table 15 New partition datafile attribute fields

<table>
<thead>
<tr>
<th>Attribute Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Specifies the location of the datafiles on the SQL Server computer for the new partition. By default, EMC SourceOne assumes that the location for the partition is to be the same directory as the directory used by the primary datafile which has a file name extension of .mdf. When you specify a location for a partition, manually verify that it is correct because EMC SourceOne cannot validate that location. If the location is not valid, the partition will not be created. After a new location is specified and you click either the Create Partition or OK button on the Partitioning tab, a warning dialog box appears indicating that you must be specifying a valid data location path.</td>
</tr>
<tr>
<td>Count</td>
<td>Specifies the number of datafiles to be created for the new partition. Valid values are the whole numbers 1 to 8. The default number of datafiles is 1. Typically, this value is correct for most installations.</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>Specifies the size of the underlying physical datafiles in GB created for the new partition. This value is specified as a whole number from 1 to 50.</td>
</tr>
<tr>
<td>Growth (GB)</td>
<td>Specifies the amount each of the partition datafiles can increase in size from their initial size in GB. This value is specified as a whole number from 1 to 10. For example, if the Size field value is set to 25 and the Growth field value is set to 5, that means that when each datafile needs to grow it can grow in increments of 5 GB; the first time each datafile will grow to 30 GB, the second time each datafile will grow to 35 GB and so on.</td>
</tr>
</tbody>
</table>

7. If you are creating partitions manually, click Create Partition. The values on the Partitioning tab are saved and EMC SourceOne immediately attempts to create the partition.

The partition will not be created if it does not meet the minimum criteria described in “Partition creation criteria and status messages” on page 121.

8. Click OK to save your changes to the Partitioning tab.

Note: This does not cause a partition to be created, it only saves the changes you have made to fields on this tab.

The Native Archive Global Properties dialog box closes.

9. After attempting to create a partition, either manually or automatically, validate that it was created by doing either or both of the following:

- Review the status line at the bottom of the Native Archive Global Properties dialog box to see if the partition was recently successfully created. This status line would appear as follows:

  Last attempt to create a partition succeeded on date-and-time
Configuring Archives

- Verify that a new partition was created by seeing if it exists in the directory specified in the Location field on the Partitioning tab. Within this directory, the new partition will have a name formed as follows:

  \[\text{DatabaseName}\$\text{PartitionNumber}\_\text{FileNumber}.ndf\]

  For example, a file named ES1Archive$1_2.ndf has this form.

  If the partition was not created, verify that the existing partition meets the minimum criteria for a new partition to be created and review the event logs.

**Advanced partitioning concepts**

The following sections will help you understand what options to select when partitioning the Native Archive database.

**Understanding manual and automatic partitioning**

Use EMC SourceOne to create partitions in selected tables in the database. This partitioning can be performed manually or automatically.

Refer to “Creating partitioned tables in the Native Archive database” on page 117 for detailed instructions about how to perform manual or automatic partitioning.

**Manual partitioning process**

When an administrator creates a partition manually by clicking the Create Partition button on the Partitioning tab of the EMC SourceOne console, the following occurs.

1. EMC SourceOne immediately submits a SQL command to be executed by a stored procedure on the SQL Server.

2. The stored procedure verifies that the current partition meets the criteria needed to justify making a new partition. Refer to “Partition creation criteria and status messages” on page 121 for these criteria.

3. If the criteria are met, the stored procedure immediately attempts to create the new partition using the datafile attributes defined by the administrator.

   The results of this attempt are displayed at the bottom of the Partitioning tab and any failures are recorded in the event log.

**Automatic partitioning process**

When an administrator configures partitions to be automatically created using the EMC SourceOne console, the following occurs.

1. EMC SourceOne checks periodically to see whether the criteria for automatically creating a new partition have been met.

   There can be some latency in when the new partition will be created because EMC SourceOne does not check to see if a new partition is to be created each time content is archived as this could potentially degrade the performance of the EMC SourceOne database. Instead, this check is made each time a set number of content items are ingested.

2. When the automatic partitioning criteria are met, the partition is scheduled to be created.
3. When EMC SourceOne attempts to create the partition, a stored procedure verifies that the current partition meets the criteria needed to justify making a new partition. Refer to “Partition creation criteria and status messages” on page 121 for these criteria.

4. If the criteria for creating a new partition are met, the stored procedure attempts to create the new partition using the datafile attributes defined by the administrator.

The results of this attempt are displayed at the bottom of the Partitioning tab and any failures are recorded in the event log.

**Partition creation criteria and status messages**

EMC SourceOne will only try to create a partition when the current partition is full enough to justify creating a new partition. This is done to protect administrators from creating unnecessary numbers of partitions.

EMC SourceOne will not attempt to create a partition unless one or both of the following is true:

- The current partition contains at least 20 GB of data.
- The current partition contains at least 10 million rows of data.

When a partition is successfully created, the following message appears at the bottom of the Partitioning tab of the Native Archive Global Properties page:

*Last attempt to create a partition succeeded on* **date-and-time**

If the partition cannot be created, the following message appears at the bottom of the Partitioning tab of the Native Archive Global Properties page:

*Last attempt to create a partition failed on* **date-and-time**

Also, a *Failed to Create Partition* message is written to the event log. This message provides additional information about why the partition could not be created. Which event log the message is written to depends on how the partition was created:

- If the attempt to create the partition was manual, the *Failed to Create Partition* message is written to the event log on the computer on which the EMC SourceOne console is installed.
- If the attempt to create the partition was automatic, the *Failed to Create Partition* message is written to the event log on the Worker computer that initiated the partition creation process. This Worker computer could be any of the Worker computers in the EMC SourceOne system which has been assigned the Native Archive archive role and which is ingesting content into the Native Archive.

**Selecting whether to use manual or automatic partitioning**

Partitions can be created manually or automatically.

Creating partitions manually has the following benefits:

- You have more control over when a partition is created because you are creating them yourself, rather than having the system decide when to create the partition.
- Manually creating partitions allows you to gain experience with what size of partition works best for your environment, and how often you need to create such a partition.
Creating partitions manually does have some drawbacks that you need to remember when manually creating partitions. Failing to create partitions when needed means that the partition may grow more than you want, causing it to possibly become fragmented and to perform less than optimally.

Creating partitions automatically has the following benefit:

- You do not need to remember to create partitions because the system is performing that task.
- Generally, using size-based automated partitioning is best because your partitions are created in a more deterministic and predictable manner.
- Size-based automated partitioning is performed by selecting the Partition size (GB) option on the Partitioning tab.
  However, still monitor the creation of partitions to ensure the automatic partitioning is occurring as you expect.

Selecting which automatic partitioning method to use

When automatic partitioning is enabled, you must select the method EMC SourceOne uses to determine when to try to create partitions in the Native Archive database.

**Note:** Regardless of what automatic partitioning method is selected, the current partition must meet the criteria described in “Partition creation criteria and status messages” on page 121 before a partition can be created.

The following list contains the methods available and considerations on when they are to be used:

- Create partitions based on the size of the current partition by selecting the Partition size (GB) option.
  Creating partitions based on size is the recommended method for most installations because it allows you to predict the sizes of the partitions that are created more accurately than the other methods.

- Create partitions based on the number of items in the current partition by selecting the Item count (millions) option.
  Partitions created based on the number of content items archived may be quite variable in size because the amount of space used in the database is determined by the size of the content, the number of recipients of that content, and other information.

  For example, a partition containing information about 50 million messages sent to one or two users and stored in a single folder will be smaller than a partition containing information about 50 million messages sent to many recipients and stored in 20 folders.

- Create partitions based on the current month or year by selecting the Processing date option.
  Creating partitions each month or year makes sense when you expect to typically create partitions every month or year. Using this option makes the time at which a new partition is created more predictable.
Note: Selecting this option does not mean that a partition will be created for every month or year, only that creating a partition at that time will be attempted. If the current partition is not full enough, a new partition will not be created at that time. Refer to “Partition creation criteria and status messages” on page 121 for the minimum criteria for creating partitions.

Understanding partition datafile attributes

When you specify partition datafile attributes on the Partitioning tab of the Native Archive Global Properties page dialog box, you are specifying the physical characteristics of the new partition to be created.

- The Location field specifies the directory in the SQL Server disk subsystem in which the partition datafiles are to be created.
- The Count field specifies how many datafiles are to be created as part of the partition. The default value for this field is 1.
- The Size (GB) field specifies how large each datafile is to be initially.
- The Growth (GB) field specifies the amount each of the datafiles can grow in size each time they need to grow.

The collective size of a new partition files in the database is the total size of the one or more datafiles that make up that partition. So, to compute the initial new partition size in GB, multiply the Size (GB) field value by the Count field value. The initial size of the one or more partition datafiles will increase as the datafiles grow.

Adding Native Archive supplemental language support

If you are planning on using the Native Archive to archive and index certain non-English languages, you must enable supplemental language support in the Native Archive Server operating system. Refer to the Microsoft Windows help system for information about which languages are controlled by this support.

Perform the following steps to enable supplemental language support.

1. Select Regional and Language Options from the Windows Control Panel. The Regional and Language Options dialog box appears.
2. Select the Languages tab and verify that both of the following options are selected in the Supplemental language support area:
   - Install files for complex script and right-to-left languages (including Thai)
   - Install files for East Asian languages
3. Click Apply to save your changes.
4. Click OK to save the changes and dismiss the dialog box.
CHAPTER 6
Configuring Mapped Folders

This section describes how to configure mapped folders in EMC SourceOne. Topics include:

- Introduction to mapped folders ................................................................. 126
- Mapped folder concepts ........................................................................... 126
- Viewing the list of mapped folders ............................................................ 141
- Creating and associating mapped folders ................................................. 142
- Modifying mapped folder properties ....................................................... 145
- Copying mapped folders .......................................................................... 148
- Deleting mapped folders .......................................................................... 148
- Best practices for using mapped folders with EmailXtender archives .... 149
- Best practices for configuring Legal Hold mapped folders ..................... 149
- Examples of using mapped folders ........................................................... 151
Introduction to mapped folders

In EMC SourceOne, a mapped folder is the destination for all content.

When you create a mapped folder in EMC SourceOne, you associated it with an archive folder that resides in an archive. You can map a maximum of 10 mapped folders to a single archive folder.

An archive can be an Native Archive, including an In Place Migrated Native Archive, or a legacy EmailXtender 4.8 SP1 archive.

The EMC SourceOne components installed at your site determine the types of content that can be placed in the archive as shown in the following table:

<table>
<thead>
<tr>
<th>Table 16 Types of content that can be archived</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed product</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>EMC SourceOne Email Management</td>
</tr>
<tr>
<td>EMC SourceOne for Microsoft SharePoint</td>
</tr>
<tr>
<td>EMC SourceOne for File Systems</td>
</tr>
</tbody>
</table>

When you create an EMC SourceOne mapped folder, you:

- Specify a name and type for the new mapped folder.
- Associate the new mapped folder to an existing archive folder in an archive.
- Specify the accounts, users, and groups who can search the new mapped folder, and set their permissions.
  - Administrators use EMC SourceOne Search to search for archived email content, files, and SharePoint content.
  - Users use EMC SourceOne Search to search for archived email content and files.
  - Users use Archive Search in SharePoint to search for archived SharePoint content.

**Note:** EMC SourceOne for Microsoft SharePoint includes the optional External Blob Storage (EBS) feature. EBS is storage management, not archiving. EBS uses archive folders (without indexing or retention) to store SharePoint content in the Native Archive. For EBS, dedicate one archive folder to each SharePoint farm. EBS does not use mapped folders. EBS content is not searchable using EMC SourceOne Search or Archive Search. SharePoint users access EBS content in SharePoint, as usual.

Mapped folder concepts

The following sections outline key concepts for defining and using mapped folders.
Summary of mapped folder types and their uses

The following table describes the types of EMC SourceOne mapped folders that can be created.

<table>
<thead>
<tr>
<th>Mapped folder</th>
<th>Description</th>
</tr>
</thead>
</table>
| Organization  | Use for:  
  • SharePoint archiving, file archiving, and migrating PST files.  
  • Email archiving (journaling, historical archiving, archiving PST and NSF files, and shortcutting) when you do not want users to delete mail items from the archive (compliance archiving). Users cannot delete mail items archived to Organization folders.  
  Not available for user-directed archiving (UDA) or for use as EMC SourceOne Discovery Manager hold folders. |
| Community     | Use for:  
  • User-directed archiving (UDA) of email to a public UDA folder. Allows multiple users to contribute mail to a public/shared UDA folder.  
  • Email archiving (journaling, historical archiving, archiving PST and NSF files, and shortcutting) when you want users to be able to delete archived mail items.  
  If they have the proper folder permissions, users can delete their references to messages. The message is still retained in the archive even after a user deletes the last reference to the message.  
  Do not use for EMC SourceOne Discovery Manager hold folders. |
| Personal      | Use for:  
  • User-directed archiving (UDA) of email to a personal UDA folder. Allows users to archive their own mail.  
  • Email archiving (journaling, historical archiving, archiving PST and NSF files, and shortcutting) when you want users to be able to delete archived mail items.  
  If they have the proper folder permissions, users can delete mail items archived to a Personal folder. Users can delete their references to messages. When a user deletes the last reference to a message, then the message is deleted from the archive.  
  Do not use for compliance archiving.  
  Do not use for EMC SourceOne Discovery Manager hold folders. |
| Legal Hold    | Use only for EMC SourceOne Discovery Manager hold folders.  
  Do not use for general-purpose archiving or for user-directed archiving (UDA). |

About user permissions on mapped folders

The following section contains information about user permissions on mapped folders.

**Note:** The EMC SourceOne primary service account must have Administrator permission on every EMC SourceOne mapped folder. The EMC SourceOne primary service account is also used to run services related to Discovery Manager task processing.

Permissions on mapped folders required by Offline Access users

To retrieve messages from the archive, Offline Access users must have permissions on mapped folders.
Configuring Mapped Folders

For Outlook Delegate Access, a delegated user does not need permissions on the mapped folders. If the delegator has permissions on the mapped folders and can access shortcuts from the archive, then the delegated user can access the same shortcuts.

In a mixed environment that includes EMC SourceOne and EmailXtender, to retrieve EmailXtender shortcuts in Public Folders, Offline Access users must have Read All permission on the mapped folders associated with the EmailXtender archive.

Permissions on mapped folders used by IBM Lotus Domino mail-in databases

The record name of the IBM Lotus Domino mail-in database must have Owner permission on all mapped folders that may be used to archive or shortcut messages for that mail-in database.

You can create a group, add all mail-in databases as members, and then give this group Owner permission to all mapped folders. You must maintain this group to add all new mail-in databases that may have mails shortcut.

Delay in updating permissions on mapped folders

A Domino or Notes user continues to have mapped folder permissions for some time after being removed from a Domino group.

This delay occurs by design and is due to:

- Delay in the update information available to the EMC SourceOne Address Cache Sync
  After removing a Domino user from a group, it takes time before the views update. The next Address Cache Sync picks up the changes after the views update.

- User caching in the EMC SourceOne Search Web Service
  When a user logs into the Search Web Service and runs a search, the list of mapped folders that the user can access is cached for 20 minutes. The mapped folder list for a user is not refreshed until this 20 minute cache timeout is reached, or until the cache is flushed by other means, such as restarting IIS.

Permissions on mapped folders used for SharePoint archiving

The following accounts and users must have Administrator and Read All permissions on the Organization mapped folders used for SharePoint Archive activities.

- EMC SourceOne primary service account
- EMC SourceOne Security group
- EMC SourceOne Admin group
- Access Account used by Archive Search in SharePoint

Note: SharePoint users do not need permissions on mapped folders to use Archive Search in SharePoint.

- SourceOne administrators who use SourceOne Search to search for archived SharePoint content

Note: SharePoint External BLOB Storage (EBS) does not use mapped folders.
Permissions and mapped folder types used for file archiving

The following sections describe the permissions and mapped folder types needed for file archiving activities.

System account and administrator permissions

The following accounts and users must have Administrator and Read All permissions on the Organization mapped folders used for File Archive activities.

- EMC SourceOne primary service account
- EMC SourceOne Security group
- EMC SourceOne Admin group
- SourceOne administrators who use SourceOne Search to search for archived file content

User permissions

To search for archived files, SourceOne Search users must have My Files permission on the Organization mapped folders used for File Archive activities.

Note: File archiving uses the Access Control List (ACL) model to assign group access, not the traditional Owner model used for email. This means that you are to assign the My Files permission, not the Owner permission, on the Organization mapped folders used for file archiving.

Summary of permissions required to search for archived files

The following table summarizes whether a user will be able to search for a particular file, depending on their permission on the mapped folder and the option selected in the Archived File Access page of the File Archive activity wizard.

<table>
<thead>
<tr>
<th>Permission on mapped folder</th>
<th>File Archive activity - option on Archive File Access page</th>
<th>Permit access only to users with Administrator permissions on the mapped folder</th>
<th>Permit access to the original file owner</th>
<th>Permit access to specified users, groups, or both</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Any file (Administrator search)</td>
<td>Any file (Administrator search)</td>
<td>Any file (Administrator search)</td>
<td></td>
</tr>
<tr>
<td>Read All</td>
<td>Any file (All Items search)</td>
<td>Any file (All Items search)</td>
<td>Any file (All Items search)</td>
<td></td>
</tr>
<tr>
<td>Contributor</td>
<td>No files</td>
<td>No files</td>
<td>No files</td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>No files</td>
<td>No files</td>
<td>No files</td>
<td></td>
</tr>
<tr>
<td>My Files</td>
<td>No files</td>
<td>Files originally owned by the user on the file system (My Files search)</td>
<td>All files archived by the activity, if user is in list of specified users/groups (My Files search)</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>
Permissions on mapped folders required for User Delete

To support User Delete, the use of Personal and Community mapped folders has been extended beyond User-Directed Archiving (UDA) activities to Journal, Archive - Historical, Archive - Personal Mail Files, and Shortcut - Historical activities. For those four activities, User Delete works only on mail items that are archived to Personal or Community mapped folders.

The following sections describe how to delete archived mail items.

To delete archived mail items through SourceOne Search

Users must have Contributor permission and Delete permission on Personal or Community mapped folders to delete mail items that were archived through the following.

- Journaling, Archive - Historical, and Archive - Personal Mail Files activities
- User-Directed Archiving (UDA)

Note: The database update scripts add the new Delete permission to existing Personal or Community mapped folders for which the user already has Contributor permission. However, for Personal or Community folders created after the update, you must add the Delete permission for each user manually.

To delete archived mail items through the mail client

Users need the Delete permission on Personal or Community mapped folders. Users do not need Contributor permission on mapped folders unless they will also be deleting archived items through Search.

Delete permission not needed for Administrator deletes

The Delete permission is not needed for Administrator deletes performed in Search. The Administrator permission implicitly allows Administrator deletes.

Permissions on mapped folders required for User Directed Archiving (UDA)

To search for and read the mail items that they directed to be archived into a user-directed archive (UDA) folder, the user must have Contributor permission on the folder.

To delete their user-directed archived mail items through Search, the user must also have Delete permission on the folder.

Permissions on mapped folders required for Public Folder archiving

The owner of an item in an Exchange Public Folder is the user who created that item. The following sections describe other details of permissions needed with Public Folder archiving.

Non-owner searches

To allow non-owner users to perform an All Items search for items that were archived from a Public Folder, the best practice is to perform both of the following.

- Archive Public Folder content to a EMC SourceOne Community mapped folder.
- Grant Read All permission on that Community folder to everyone.
Owner searches

To allow owners to perform a My Items search for items that were archived from a Public Folder to a Community folder, grant users Owner permission on the Community folder.

Permissions required by the EMC SourceOne primary service account

The EMC SourceOne primary service account must have the following access for Public Folder archiving.

◆ Administrator permission on all Community folders.
◆ Read All permission on all Community folders that will be searchable in Discovery Manager.

Summary of permissions that can be assigned to mapped folders

The permissions that a user has on a mapped folder determine the actions a user can perform on the contents of the mapped folder. The following table describes the permissions available on EMC SourceOne mapped folders for users and groups.

Table 19 Permissions for EMC SourceOne mapped folders (page 1 of 2)

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>A user with Owner permission on a folder:</td>
</tr>
<tr>
<td></td>
<td>• Can see only email items that they own.</td>
</tr>
<tr>
<td></td>
<td>• Cannot delete items from the folder.</td>
</tr>
<tr>
<td>Contributor</td>
<td>A user with Contributor permission on a folder:</td>
</tr>
<tr>
<td></td>
<td>• Can read only the email items that they directed to be archived into a</td>
</tr>
<tr>
<td></td>
<td>user-directed archive (UDA) folder, or those that they own and were</td>
</tr>
<tr>
<td></td>
<td>journaled or archived into a Personal or Community mapped folder.</td>
</tr>
<tr>
<td>My Files</td>
<td>A user with My Files permission on a folder:</td>
</tr>
<tr>
<td></td>
<td>• Can see only files for which they have access permission.</td>
</tr>
<tr>
<td></td>
<td>• Cannot delete items from the folder.</td>
</tr>
</tbody>
</table>
### Table 19 Permissions for EMC SourceOne mapped folders (page 2 of 2)

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
</table>
| Read All   | The Read All permission is meant for supervisors and management.
A user with Read All permission on a folder:
- Can see all items in the folder, even if they are not the owner of the email items or do not have access permission to the files or SharePoint items.
- Has read-only privileges on all items in the folder.
- Cannot delete items from the folder.

**Note:** Administrator permission always overrides Read All permission if a user has both permissions.
The EMC SourceOne primary service account must have Read All permission on all folders that will be searchable in Discovery Manager and in SharePoint Archive Search, and on all Legal Hold folders.
The Access Account used by Archive Search must have Read All permission on all Organization folders used for SharePoint Archive activities.

| Administrator | A user with Administrator permission on a folder:
- Has full control over all items in the folder.
- Can search, retrieve, and delete items in the folder.
- Can search for all archived content types (email, files, SharePoint).

**Note:** The EMC SourceOne primary service account must have Administrator permission on all mapped folders including all Legal Hold folders.

| Delete | A user with Delete permission on a folder:
- Can delete the email items that they directed to be archived into a user-directed archive (UDA) folder, or that were journaled or archived into a Personal or Community mapped folder. The user deletes their own references to the email items so that they no longer see those items. For a Community folder, the message is still retained in the archive even after a user deletes the last reference to the message. For a Personal folder, when the last user deletes their reference to the item, then the item is deleted from the archive.

**Note:** You must assign the Delete permission to users so that they can delete items that were archived through UDA.
User permissions and mapped folder types

The following table indicates the user permissions for each type of mapped folder.

Table 20  Appropriate user permissions for folder types

<table>
<thead>
<tr>
<th>Mapped folder type</th>
<th>User permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Contributor</td>
</tr>
<tr>
<td>Organization</td>
<td>Yes, for email content</td>
</tr>
<tr>
<td>Community</td>
<td>Yes, for email content</td>
</tr>
<tr>
<td>Personal</td>
<td>Yes, for email content</td>
</tr>
<tr>
<td>Legal Hold</td>
<td>No, not applicable</td>
</tr>
</tbody>
</table>

**Note:** The New Folder wizard does not validate permissions against the folder type.

Grant all EMC SourceOne Search users Owner permission for mapped folders

An administrator can grant all Search users Owner permission for a mapped folder by using the All ES1 Users group.

Matter Manager permissions

The Matter Manager Access permission allows SourceOne administrators to control Discovery Manager search permissions for individual matter managers. A SourceOne administrator must select the Matter Manager Access checkbox for a folder in order for a Discovery Manager matter manager to perform a search of that folder.

The All Matter Managers group and the Matter Manager Access permission enable an administrator to grant all matter managers access to search a specific mapped folder.
About mapped folder types, user permissions, and search types

The permissions that you assign to a mapped folder for a user determine which folders the user is allowed to search and which messages the user is allowed to read, retrieve, or delete.

The following table describes combinations of folder types, user permissions, and search types.

Table 21  Folder types, user permissions, and search types  (page 1 of 4)

<table>
<thead>
<tr>
<th>Mapped folder type</th>
<th>Permission</th>
<th>Search type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Owner</td>
<td>My Items</td>
<td>Assign Owner permission to users who need to search their own archived mail and retrieve shortcuts in an Organization folder. Owner permission is required to perform a My Items search on an Organization folder.</td>
</tr>
<tr>
<td>Organization</td>
<td>Contributor</td>
<td>My Contributed Items</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>
| Organization       | My Files   | My Files    | Assign My Files permission to users who need to search their own archived file content. My Files permission is required to perform a My Files search on an Organization folder that contains archived files.  
  **Note:** SharePoint users use Archive Search to search for archived SharePoint content, and do not need permissions on Organization folders used for SharePoint Archive activities. |
| Organization       | Administrator | Administrator | Assign Administrator permission to users who need to search other users’ mail and delete mail from the archive. Administrator permission is required to perform an Administrator search on an Organization folder.  
  **Note:** The EMC SourceOne primary service account must have Administrator permission on all Organization folders. |
| Organization       | Read All   | All Items   | Assign Read All permission to users who need to read all mail in an Organization folder, even if they are not the owners. Read All permission is required to perform an All Items search on an Organization folder.  
  **Note:** The EMC SourceOne primary service account must have Read All permission on all Organization folders that will be searchable in Discovery Manager and in Archive Search. The Access Account used by Archive Search must have Read All permission on all Organization folders used for SharePoint Archive activities. |
| Organization       | Delete     | Not applicable. | Not applicable. |
### Table 21 Folder types, user permissions, and search types (page 2 of 4)

<table>
<thead>
<tr>
<th>Mapped folder type</th>
<th>Permission</th>
<th>Search type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community</td>
<td>Owner</td>
<td>My Items</td>
<td>Assign Owner permission to users who need to search their own mail and retrieve shortcuts in a Community folder. Owner permission is required to perform a My Items search on a Community folder.</td>
</tr>
<tr>
<td>Community</td>
<td>Contributor</td>
<td>My Contributed Items</td>
<td>Assign Contributor permission to users who need to search their own mail, and in a Community folder. Contributor permission is required to perform a My Contributed Items search on a Community folder.</td>
</tr>
<tr>
<td>Community</td>
<td>My Files</td>
<td>My Files</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Community</td>
<td>Administrator</td>
<td>Administrator</td>
<td>Assign Administrator permission to users who need to search other users' mail and delete mail from a Community folder. Administrator permission is required to perform an Administrator search on a Community folder.</td>
</tr>
</tbody>
</table>

**Note:** The EMC SourceOne primary service account must have Administrator permission on all Community folders.

| Community          | Read All   | All Items        | Assign Read All permission to users who need to read all mail in a Community folder, even if they are not the owners. Read All permission is required to perform an All Items search on a Community folder. |

**Note:** The EMC SourceOne primary service account must have Read All permission on all Community folders that will be searchable in Discovery Manager.

<table>
<thead>
<tr>
<th>Community</th>
<th>Delete</th>
<th>All search types</th>
<th>Assign Delete permission to users who need to delete their own references to messages in a Community folder. When the last reference is deleted from a message, the message is still retained in the archive. For deletes performed through the mail client, users need only Delete permission. For deletes performed through SourceOne Search, users need Delete permission and Contributor permission.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal</td>
<td>Owner</td>
<td>My Items</td>
<td>Assign Owner permission to users who need to search their own mail and retrieve shortcuts in a Personal folder. Owner permission is required to perform a My Items search on a Personal folder.</td>
</tr>
<tr>
<td>Personal</td>
<td>Contributor</td>
<td>My Contributed Items</td>
<td>Assign Contributor permission to users who need to search their own mail, in a Personal folder. Contributor permission is required to perform a My Contributed Items search on a Personal folder.</td>
</tr>
<tr>
<td>Personal</td>
<td>My Files</td>
<td>My Files</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>
Configuring Mapped Folders

<table>
<thead>
<tr>
<th>Mapped folder type</th>
<th>Permission</th>
<th>Search type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Personal           | Administrator| Administrator| Assign Administrator permission to users who need to search other users’ mail and delete mail from a Personal folder. Administrator permission is required to perform an Administrator search on a Personal folder.  

**Note:** The EMC SourceOne primary service account must have Administrator permission on all Community folders. |
| Personal           | Read All    | All Items   | Assign Read All permission to users who need to read all mail in a Personal folder, even if they are not the owners. Read All permission is required to perform an All Items search on a Personal folder.  

**Note:** The EMC SourceOne primary service account must have Read All permission on all Personal folders that will be searchable in Discovery Manager. |
| Personal           | Delete      |             | Assign Delete permission to users who need to delete their own references to messages in a Personal folder. When the last reference is deleted from a message, the message is deleted from the archive.  

For deletes performed through the mail client, users need only Delete permission.  

For deletes performed through Search, users need Delete permission and Contributor permission. |
| Legal Hold         | Owner       | My Items    | Not applicable. |
| Legal Hold         | Contributor | My Contributed Items | Not applicable. |
| Legal Hold         | My Files    | My Files    | Not applicable. |
About search types for archived files

By design, the Owner field does not return results when Administrators search for owners of archived files. File archiving uses the Access Control List (ACL) model to assign group access, not the traditional Owner model used for email. This means that you are to use the My Files search type when you search for archived files, not the My Items search type. When you perform a My Files search, your group membership is determined, allowing a group member to see files to which that group has access.

<table>
<thead>
<tr>
<th>Mapped folder type</th>
<th>Permission</th>
<th>Search type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Hold</td>
<td>Administrator</td>
<td>Searchable in EMC SourceOne Discovery Manager. Not searchable in EMC SourceOne Search.</td>
<td>Assign Administrator permission to the EMC SourceOne primary service account, which needs to search for, read, and delete all messages in Legal Hold folders. Note: The EMC SourceOne primary service account must have Administrator permission on all Legal Hold folders.</td>
</tr>
<tr>
<td>Legal Hold</td>
<td>Read All</td>
<td>Searchable in EMC SourceOne Discovery Manager. Not searchable in EMC SourceOne Search.</td>
<td>Assign Read All permission to the EMC SourceOne primary service account, which needs to search for, read, and delete all messages in Legal Hold folders. Note: The EMC SourceOne primary service account must have Read All permission on all Legal Hold folders.</td>
</tr>
<tr>
<td>Legal Hold</td>
<td>Delete</td>
<td>Not applicable.</td>
<td></td>
</tr>
</tbody>
</table>

**About access control for archived content**

A user's ability to search for an archived item depends on the following.

- The user's ownership or permission on the item, which varies by content type.
  - For email content permissions, refer to “Understanding mapped folders, message owners, and message contributors” on page 138.
  - For SharePoint content permissions, refer to the *EMC SourceOne for Microsoft SharePoint Administration Guide*.
  - For file content permissions, archived file content uses an Access Control List (ACL) model to assign group access, not the owner model used for email content. You assign access to files when you create a File Archive activity. Refer to the *EMC SourceOne for File Systems Administration Guide*.
- The user's permission on the mapped folder in which the item is archived.
Understanding mapped folders, message owners, and message contributors

Email messages processed by Email Management can have both owners and contributors. How owners and contributors are assigned to a message are described in the following sections.

Understanding message owners

Email Management determines when an email message belongs to a user. Being an addressee does not determine message ownership:

- For journaled messages, ownership depends on the type of SourceOne mapped folder in which the message is archived:
  - If you journal to an Organization mapped folder, all senders and recipients (internal and external) are message owners. Users are not able to delete messages that are journaled to an Organization mapped folder.
  - If you journal to a Personal or Community mapped folder, only internal recipients are marked as owners of mail items. If the recipient’s email address is found in the cache of internal addresses, journaling adds the user as an owner on the mail item. Recipients not found in the address cache are considered external recipients and are not added as owners on the mail item. Users are able to delete messages that are journaled to a Personal or Community mapped folder, if they have the folder permissions of Contributor and Delete. This ownership ensures that a mail item is deleted from the archive only when all the internal owners have deleted the mail item.
  - For messages archived through historical archiving, PST archiving, NSF archiving, or user-directed archiving (UDA), only mailbox or mail file owners are set as message owners.
  - Newly discovered owners can be added as owners of a message.

For example, if the same unedited message is found in another user’s mailbox, then EMC SourceOne adds that user as an owner of the message.

Determining ownership in this way prevents problems in the following situations:

- Archive from Drafts folder — Intended recipients are to not be able to search the archive and see a draft message, because it has not been received by them. Only the mailbox owner is to be considered an owner of the message.

- Edited messages — Assume a message is sent to Recipient1 and Recipient2. Recipient1 edits the message and Recipient2 does not edit the message. With the new message ID algorithms based on content, both instances of the message will be archived in an Historical Archive activity. When Recipient1 searches the archive, only the edited version of the message is to be discovered. When Recipient2 searches the archive, only the non-edited version of the message is to be discovered.
Understanding message contributors

In addition to owners, email messages can also have contributors.

In User Directed Archiving (UDA), when the owner of a message directs the message to be archived, a reference is recorded with the message for that owner. The owner is now also a contributor of the message. When a user deletes the message from the folder, the reference to the message is deleted.

Contributor designation is a property of the mapped folder to which the message is archived, and is not set by the archiving activity. This allows several archiving activities to contribute messages to the same mapped folder on behalf of the same user.

For example, a UDA activity can archive messages to a mapped folder that applies the contributor attribute. A PST or NSF archive activity can also archive messages to the same folder and have the contributor attribute applied.

About mapped folder types and activities

The following table describes the folder types for EMC SourceOne activities and applications. For most email management activities, the types of mapped folders you use depend on whether you want to allow users to delete mail items from the archive.

Table 22 Activities and folder types

<table>
<thead>
<tr>
<th>Activity/application</th>
<th>Folder types</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Organization</td>
</tr>
<tr>
<td>Journal, user delete not allowed</td>
<td>Yes</td>
</tr>
<tr>
<td>Journal, user delete allowed</td>
<td>No</td>
</tr>
<tr>
<td>Archive - Historical, user delete not allowed</td>
<td>Yes</td>
</tr>
<tr>
<td>Archive - Historical, user delete allowed</td>
<td>No</td>
</tr>
<tr>
<td>Archive from Personal Mail Files (PST/NSF), user delete not allowed</td>
<td>Yes</td>
</tr>
<tr>
<td>Archive from Personal Mail Files (PST/NSF), user delete allowed</td>
<td>No</td>
</tr>
<tr>
<td>User-Directed Archive</td>
<td>No</td>
</tr>
<tr>
<td>Migrate PST to Mailbox</td>
<td>Yes</td>
</tr>
<tr>
<td>Shortcut - Historical, user delete not allowed</td>
<td>Yes</td>
</tr>
<tr>
<td>Shortcut - Historical, user delete allowed</td>
<td>No</td>
</tr>
<tr>
<td>Shortcut - User-Directed Archive</td>
<td>No</td>
</tr>
<tr>
<td>SharePoint Archive</td>
<td>Yes</td>
</tr>
<tr>
<td>File Archive</td>
<td>Yes</td>
</tr>
<tr>
<td>EMC SourceOne Discovery Manager</td>
<td>No</td>
</tr>
</tbody>
</table>
About mapped folders and user-directed archiving (UDA)

Email Management includes the optional user-directed archiving (UDA) feature.

Folder recommendations for user-directed archiving

The following sections describe how you can use Community or Personal folders for user-directed archiving.

Using Community folders for user-directed archiving

Use Community folders for shared or public mail.

- Add both Contributor and Read All permissions for all users. This allows users to see only their contributed mail in a My Contributed Items search, and all mail in an All Items search.
- Add Owner permission for users if you want them to see mail items that are still owned by them, but for which all references have been deleted.
- Add Delete permission if you want users to be able to delete their archived mail items through SourceOne Search. Users delete their own references to mail items in a Community folder. When the last reference is deleted from a mail item, the item is still retained in the archive.

Using Personal folders for user-directed archiving

Use Personal folders for personal mail.

- Add only Contributor permission for all users. This allows users to see only their contributed mail in a My Contributed Items search.
- Add Read All permission for users in a supervisory position, such as Human Resources or management.
- Add Owner permission for users if you want them to see mail items that are still owned by them, for which the last reference has not yet been deleted.
- Add Delete permission if you want users to be able to delete their archived mail items through SourceOne Search. Users delete their own references to mail items in a Personal folder. When the last reference is deleted from a mail item, the item is deleted from the archive.

Archiving PST/NSF files into a user-directed archiving (UDA) folder

User-directed (UDA) activities archive mail into Community folders or Personal folders, which are mapped to EMC SourceOne archive folders.

The Archive From Personal Mail Files (PST/NSF) activity can put messages into the same folder in EMC SourceOne as the UDA Archiving activity did.

A user with Contributor permission on the folder can see only those mail items they added, and if they also have Delete permission, they can delete their reference to each mail item.

A user with Owner permission can see the mail items they own. Initially, the user sees the same mail items as with Contributor permission. When all references have been deleted from the mail items, a user with Owner permission will see the mail items.
About mapped folders and SharePoint archiving

For SharePoint Archive activities, create one or more mapped folders of the Organization type, and map them to the archive folders.

Note: SharePoint External BLOB Storage (EBS) does not use EMC SourceOne mapped folders. EBS does use EMC SourceOne archive folders. For EBS, dedicate one archive folder to each SharePoint farm.

About mapped folders and file archiving

For File Archive activities, create one or more mapped folders of the Organization type, and map them to the archive folders.

About mapped folders and User Delete

For users to be able to delete archived mail items, the items must be archived to a Personal or Community mapped folder.

Viewing the list of mapped folders

Perform the following steps to view existing mapped folders.

1. In the EMC SourceOne console, select the Mapped Folders node. The Mapped Folders area lists defined mapped folders, if any.

Figure 45  Mapped folders list
2. To view folders of a certain type:
   a. In the Actions pane, click **Current View**.
   b. Select one of the following options:
      - All (default)
      - Community
      - Legal Hold
      - Organization
      - Personal

### Creating and associating mapped folders

Perform the following steps to create a mapped folder, associate it with an existing archive folder in an archive, and specify user permissions on the mapped folder.

1. In the EMC SourceOne console, select the **Mapped Folders** node.
2. Select **Action > New Folder**.

#### New Folder - General page

On the General page of the New Folder wizard, specify the name, description, and folder type of the mapped folder.

![New Folder wizard — General page](image)

**Figure 46** New Folder wizard — General page

1. In the **Folder Name** field, type a name for the new mapped folder. Use alphanumeric characters. Invalid characters include:

   | ; | = | / | : | * | ? | " | < | > | |

   **Note:** Use ASCII characters for the folder name, not multi-byte characters. If a mapped folder and the archive folder to which it is associated both have multi-byte characters in the folder names, then an index folder is not created, and indexing will fail.
2. In the **Description** field, type a description for the new mapped folder.

3. Click **Browse**.

4. In the **Select Folder** dialog box, select an archive folder in an archive.

   For EmailXtender 4.x archives, either all archive folders will be listed, or only the virtual archive folder that you created when you configured the EmailXtender 4.x archive.

![Select Folder dialog box](image)

5. Click **OK** to close the **Select Folder** dialog box and return to the **New Folder - General** page.

6. In the **Folder Type** field, select a type for this mapped folder.

7. Click **Next**.

**New Folder - Permissions page**

On the Permissions page of the New Folder wizard, specify the following.

- The users and groups who can access the folder.
- The permissions each user and group has on the folder.
Configuring Mapped Folders

**Figure 48** New Folder wizard — Permissions page

**Note:** The EMC SourceOne primary service account must have Administrator permission on each mapped folder.

1. In the **Select user from** field, select either a directory or a group (Active Directory, All ES1 Users, All Matter Managers, Domino Directory, Exchange Address Book, or LDAP Directory Lookup).

   **Note:** If the user or group exists in more than one domain, use the Active Directory Select Users, Contacts or Groups dialog box to determine the domain. Otherwise, the users and groups listed on the Permissions page are difficult to differentiate.

2. Click **Add**.

   If you do not select All ES1 Users or All Matter Managers a dialog box appears. The dialog box that appears depends on what you select in the Select user from field. Perform one of the following:
   - If you select Active Directory, Domino Directory, or Exchange Address Book, select the user or group from the directory.
   - If you select LDAP Directory Lookup, the Data Sources dialog box appears.
Figure 49  New Folder wizard — Data Sources — LDAP

3. In the Group or user names list in the New Folder - Permissions page, select the user or group for whom you want to specify permissions. Query-based distribution lists are supported.

4. In the Permissions list, select the permissions that the user or group will have on the new mapped folder.

   **Note:** The Owner permission is the only configurable permission for the All ES1 Users group. The Matter Manager Access permission is the only configurable permission for the All Matter Managers group.

5. To remove a user or group from the list, select the user or group, then click Remove.
6. Click Finish. The entry for the new mapped folder appears in the Mapped Folders list.

**Modifying mapped folder properties**

Follow this procedure to modify the properties of a mapped folder.

1. In the EMC SourceOne console, select the Mapped Folders node.

2. In the Mapped Folders list, select the folder you want to modify.


   **Note:** If you assign a group to a mapped folder, and then you move that group to another organizational unit (OA) in Active Directory, you must reassign the group to the mapped folder.
Modifying general properties of a mapped folder

Follow this procedure to modify general properties of a mapped folder.

1. Select the General tab of the Folder Properties dialog box.

![General tab — Folder properties](image)

2. Edit the Folder Name field and the Description field.

You cannot edit the following fields:

- Archive Folder
- Folder Type

3. Click OK.

Modifying permissions on a mapped folder

The following section contains information about modifying permissions on a mapped folder.

**Note:** The EMC SourceOne primary service account must have Administrator permission on each mapped folder.

Perform the following steps to modify permissions on a mapped folder.

1. Select the Permissions tab of the Folder Properties dialog box.

2. In the Select user from field, select either a directory or a group (Active Directory, All ES1 Users, All Matter Managers, Domino Directory, Exchange Address Book, or LDAP Directory Lookup).

3. Click Add. The directory or group displayed depends on what you selected in the Select user from field.

4. Select the user or group from the directory. The name of the selected user or group appears in the Group or user names list.

5. In the Group or user names list, select the user or group for whom you want to specify permissions.
6. In the **Permissions** list, select the permissions that the user or group will have on this folder.

   **Note:** The Owner permission is the only configurable permission for the All ES1 Users group.
The Matter Manager Access permission is the only configurable permission for the All Matter Managers group.

7. To remove a user or group from the list:
   a. Select the user or group.
   b. Click **Remove**.

8. To save your changes and close the dialog box, click **OK**.

**Maintaining permissions on a mapped folder for a moved group**

If you grant a group access to a mapped folder and you move that group from one organizational unit (OU) to another in Active Directory, then users in the moved group will lose access to the mapped folder after the next address synchronization.

Remove the group from the mapped folder permissions, and then reassign the group to the mapped folder.

Perform the following steps to maintain permissions on a mapped folder for a moved group.

1. In the EMC SourceOne console, select the **Mapped Folders** node.

2. In the **Mapped Folders** list, select the folder you want to modify.

3. Select **Action > Properties**.

4. Select the **Permissions** tab of the **Folder Properties** dialog box.

5. To remove the group from the mapped folder, on the **Permissions** tab:
   a. In the **Group or user names** list, select the group.
   b. Click **Remove**.

6. To reassign the group to the mapped folder, on the **Permissions** tab:
   a. In the **Select user from** field, select **Active Directory**.
   b. Click **Add**.
   c. Select the group from the directory. The name of the selected user or group appears in the **Group or user names** list.
   d. In the **Group or user names** list, select the group.
   e. In the **Permissions** list, select the permissions that the group will have on this folder.
Configuring Mapped Folders

Copying mapped folders

Perform the following steps to copy a mapped folder.

1. In the EMC SourceOne console, select the Mapped Folders node.
2. In the Mapped Folders list, select the mapped folder you want to copy.
3. Select Action > Copy Folder.

   The General page of the New Folder wizard appears. The default name of the copy is Copy of folder. The values for Archive Name and Folder Type are the same as that of the original folder.
4. Edit the fields on the General page.
5. Click Next.

   The Permissions page of the New Folder wizard appears. Users and permissions are not copied from the original folder.
6. Edit the fields on the Permissions page, as described in “Modifying permissions on a mapped folder” on page 146.
7. Click Finish.

Deleting mapped folders

The following sections describe how to delete mapped folders.

Effects of deleting mapped folders

Map a maximum of 10 mapped folders to a single archive folder.

Assume you map several mapped folders to a single archive folder, and then later you delete all but one of those mapped folders. The last remaining folder that is mapped to an archive folder will allow access to all content in the archive folder. This behavior is by design, to allow access to items in the archive that were orphaned when you deleted the other mapped folders.

Deleting mapped folders procedure

Perform the following steps to delete a mapped folder from the Mapped Folders list.

1. In the EMC SourceOne console, select the Mapped Folders node.
2. In the Mapped Folders list, select the mapped folder that you want to delete.
3. Select Action > Delete Folder. The Mapped Folder list no longer displays the name of the deleted mapped folder.
Best practices for configuring Legal Hold mapped folders

The following are best practices for configuring Legal Hold folders for Discovery Manager.

◆ Create one or more archive folders for exclusive use by Legal Hold folders. Do not configure retention on Native Archive folders that will be mapped to Legal Hold folders.

◆ You can map multiple Legal Hold folders to the same archive folder.

◆ You are prevented from:

  • Mapping a Legal Hold folder to an archive folder that is already mapped to a folder of another type (Organization, Personal, or Community), due to the potential for a retention policy to trigger the disposition of items that are on hold.

  • Mapping a non-Legal Hold folder to an archive folder that is already mapped to a Legal Hold folder.

If you attempt to perform such mappings, the following error message appears:

The data is invalid for the following reasons: Legal Hold folders cannot coexist with other mapped folder types on the same archive folder.

The error appears for new mappings. It does not appear when you view properties of mapped folders where the invalid mapping already exists.

Best practices for using mapped folders with EmailXtender archives

Create mapped folders to EmailXtender archives so that messages in those archives can be searched and accessed using EMC SourceOne. When using EmailXtender archives with EMC SourceOne, keep the following best practices in mind.

Best practices for creating EMC SourceOne mapped folders for EmailXtender archives

If your environment includes multiple EmailXtender servers that you want to connect to Email Management, you need to create mapped folders for those EmailXtender servers. How you structure those mapped folders is determined by your computing environment.

◆ Usually, the best practice is to have each mapped folder associated with no more than a single EmailXtender server in a 1:1 relationship. This configuration avoids potential resource and duplication problems.

You can have multiple mapped folders associated with a single EmailXtender server, but avoid multiple EmailXtender servers being associated with a single mapped folder.

◆ However, sometimes, you may want to associate multiple EmailXtender server archives with a single mapped folder. For example, you may want to organize data from multiple EmailXtender servers logically, such as by the retention period set on the data (three year retention, five year retention, and so on), rather than by server.
Associating multiple EmailXtender server archives with a single mapped folder can cause the following problems:

- Search retrieval performance may degrade when data from multiple EmailXtender servers are placed into a single mapped folder. This is because when results from multiple EmailXtender servers are combined, those results are processed to remove duplicate entries before returning those results to the requesting client (EMC SourceOne Web Search or EMC SourceOne Discovery Manager). This deduplication processing does not occur for results from a single EmailXtender server.

- Instances of a message on different EmailXtender servers may have the same content, but have different metadata (stored in SQL). Because messages with the same content (not including the metadata) are automatically removed in this configuration, the retrieved content will have the metadata associated with only one of the messages, and the metadata of the other messages is not returned. If you are in a compliance or legal discovery environment, or if you want to view each copy of a message in the search results, do not use this mapped folder configuration.

Determine if the value of combining data from multiple EmailXtender servers into a single mapped folder outweighs the problems previously described.

**Understanding EmailXtender archive restrictions when used with EMC SourceOne**

When you connect EmailXtender archives with EMC SourceOne you need to be aware of the restrictions on using the EmailXtender archives. These restrictions are described in the following sections.

**EmailXtender archives are read-only**

Content in EmailXtender archives can only be read using EMC SourceOne. EMC SourceOne cannot archive to EmailXtender archive folders.

**Items in EmailXtender archives cannot be deleted using EMC SourceOne Search**

Items in EmailXtender archive folders connected to EMC SourceOne must be deleted using the EmailXtender Search Plug-in. They cannot be deleted using Search.

**EmailXtender archive folders cannot be used with Legal Hold folders**

Do not use an archive folder in EmailXtender 4.8 SP1 as a Legal Hold folder for use with Discovery Manager.
Examples of using mapped folders

The following sections describe examples of how you can use mapped folders to achieve various business goals.

Example of configuring a simple email compliance archive

Business requirement
You have 10,000 employees, and must archive and retain all email for 2,000 users for three years.

Solution
Create an Organization folder, for example, named Archive, and map it to an archive folder with a retention of three years. Create Journal activities and rules to archive the mail for the 2,000 users to the Archive Organization folder.

The following list describes the user permissions for the Archive Organization folder:
- Owner — Users can perform a My Items search to access email in the Archive folder, where the user is an owner of the message.
- Contributor — Not applicable because there are no contributed messages in an Organization folder.
- My Files — Not applicable for email.
- Read All — Users can perform an All Items search to read all messages in the Archive folder.
- Administrator — Administrators can perform an Administrator search to read, retrieve, and delete any messages in the Archive folder.
- Delete — Not applicable for Organization folders (compliance archives).

Example of mapped folders for the convenience retention of messages

Business requirement
You have 10,000 employees, and want them all to be able to locate and restore messages they have deleted from their mailboxes, for up to two years.

Solution
Create an Organization folder, for example, named Archive, and map it to an archive folder with a retention of two years. Create Journal activities and rules to archive the mail for all users to the Archive Organization folder.

The user permissions for the Archive Organization folder are the same as for a simple compliance archive.

Example of mapped folders for a combined compliance and community archive

Business requirement
You have 10,000 employees, and must archive and retain all email for 2,000 users for three years. You also want the remaining 8,000 users to archive selected messages that are relevant to the business. These messages will also be retained for three years.
Solution
Create an Organization folder, for example, named Archive, and a Community folder, for example, named Company Records. Map both folders to archive folders with retentions of three years. Create Journal activities and rules to archive the mail for the 2,000 users to the Archive Organization folder. Create a user-directed archiving (UDA) activity to archive the user-selected messages for the 8,000 users to the CompanyRecords Community folder.

The user permissions for the Archive Organization folder are the same as shown.

The following list describes the user permissions for the Company Records Community folder:

- **Owner** — Users can perform a My Items search to access email in the Company Records Community folder, where the user is an owner of the message. Initially, this includes all messages originally contributed by the user through the user-directed archiving (UDA) activity. If the user also has Delete permission and deletes their reference to a message, this type of search also returns that message along with the other contributed messages.

- **Contributor** — Users can perform a My Contributed items search to access only those messages that the user contributed to the Company Records Community folder and that were archived by a user-directed archiving (UDA) activity.

- **My Files** — Not applicable for email.

- **Read All** — Users can perform an All Items search to read all messages in the Company Records folder.

- **Administrator** — Administrators can perform an Administrator search to read, retrieve, and delete any messages in the Company records folder.

- **Delete** — The user can delete their references to the messages that they contribute to the Company Records Community folder. After a user deletes their reference to a message, that message will no longer be found by the user in My Contributed Items searches.

Example of creating mapped folders for use with a personal archive

**Business requirement**
You have 10,000 employees, and want them all to store personal messages in the archive for up to two years. In addition, to minimize the size of the archive, you want these users to be able to delete the messages when they are no longer needed.

You also want the user’s folder structure retained during archiving.

**Solution**
Create a Personal folder, for example named MyArchive, and map it to an archive folder with a retention of two years. Create user-directed archiving (UDA) activities to archive personal messages for all users to the MyArchive Personal folder. Because the UDA activity is configured to run against a Personal folder, the folder hierarchy for the message is preserved when the message is archived.
The following list describes the permissions on the MyArchive Personal folder:

- **Owner** — Users can perform a My Items search to access email in the MyArchive Personal folder, where the user is an owner of the message. Initially, this includes all messages originally contributed by the user through the user-directed archiving (UDA) activity. If the user also has Delete permission and deletes their reference to a message, this type of search also returns that message along with the other contributed messages if the message has not been removed from the archive.

- **Contributor** — Users can perform a My Contributed items search to access only those messages that the user contributed to the MyArchive Personal folder and that were archived by a user-directed archiving (UDA) activity.

- **My Files** — Not applicable for email.

- **Read All** — Users can perform an All Items search to read all messages in the MyArchive Personal folder.

- **Administrator** — Administrators can perform an Administrator search to read, retrieve, and delete any messages in the MyArchive Personal folder.

- **Delete** — The user can delete their references to the messages that they contributed to the MyArchive Personal folder. After a user deletes their reference to a message, that message can no longer be found in the My Contributed Items list. If the user’s reference is the last reference on the message, then the message is removed from the MyArchive Personal folder.

---

### Example of a personal archive including existing PSTs

**Business requirement**

You have 10,000 employees, and want to eliminate the existing PST files for all users. In addition, you want each user to store personal messages, including those in their existing PST files, in the archive for up to two years. You want to minimize the size of the archive, so users will delete messages from their Personal archive when they are no longer needed.

**Solution**

Create a Personal folder, for example, named MyArchive, and map it to an archive folder with a retention of two years. Create user-directed archiving (UDA) activities to archive personal messages for the users to the MyArchive Personal folder. Create a PST archive activity against the MyArchive Personal folder to collect messages from existing PST files.

The user permissions for the MyArchive Personal folder are the same as shown.

### Example of using mapped folders for SharePoint archiving

**Business requirement**

You have 10,000 employees, and want them to be able to find their own SharePoint content that has been archived from the SharePoint farm, for up to two years.

**Solution**

Create an Organization folder, for example, named SharePoint Archive, and map it to an archive folder with a retention of two years. Create a SharePoint Archive activity to archive the SharePoint content for all users to the SharePoint Archive Organization folder.
The following list describes the user permissions for the SharePoint Archive Organization folder:

- **Owner** — Not applicable.
- **Contributor** — Not applicable.
- **My Files** — Not applicable.
- **Read All** — The Access Account used for Archive Search in SharePoint needs Read All permission. SharePoint users do not need folder permissions to use Archive Search in SharePoint.
- **Administrator** — Administrators can perform an Administrator search to read, retrieve, and delete any files in the SharePoint Archive folder.
- **Delete** — Not applicable.

**Example of using mapped folders for file archiving**

**Business requirement**
You have 10,000 employees, and want them to be able to find their own files that have been archived from the file systems, for up to two years.

**Solution**
Create an Organization folder, for example, named File Archive, and map it to an archive folder with a retention of two years. Create a File Archive activity to archive the files for all users to the File Archive Organization folder.

The following list describes the user permissions for the File Archive Organization folder:

- **Owner** — Not applicable.
- **Contributor** — Not applicable.
- **My Files** — Users can perform a My Files search to read their files in the File Archive folder.
- **Read All** — Users can perform a All Items search to read their files in the File Archive folder.
- **Administrator** — Administrators can perform an Administrator search to read, retrieve, and delete any files in the File Archive folder.
- **Delete** — Not applicable.

**Example of using Legal Hold mapped folder for EMC SourceOne Discovery Manager**

**Business requirement**
You have 10,000 employees, and a legal staff that conducts investigations and needs to search email archived in the company. Your email archive is set up as follows.

- **Folder1 Community folder** - All email deemed relevant to the business for all 10,000 users. Retention is three years.
- **Folder2 Personal folder** - All personal email for 10,000 users. Retention is two years.

You want the legal staff to run Discovery Manager, create legal matters, search all archived mail, and place relevant mail on hold in the matter.
Solution

Create a Legal Hold folder, for example, named Matters. In Discovery Manager, the Matter Manager creates new matters, and specifies the Matters folder as the hold folder for a new matter.

The following list describes the user permissions for the Folder1 Community folder and the Folder2 Personal folder for Discovery Manager:

- Owner — Not applicable.
- Contributor — Not applicable.
- My Files — Not applicable.
- Read All — Assign Read All permission to the EMC SourceOne primary service account which must be able to search Folder 1 Community folder and the Folder 2 Personal folder.
- Administrator — Not applicable.
- Delete — Not applicable.

The following list describes the user permissions for the Matters Legal Hold folder for Discovery Manager:

- Owner — Not applicable.
- Contributor — Not applicable.
- My Files — Not applicable.
- Read All — Not applicable.
- Administrator — Assign Administrator permission to the EMC SourceOne primary service account which must be able to read, write, and delete items in the Matters hold folder.
- Delete — Not applicable.
CHAPTER 7
Configuring Worker Servers and Worker Groups

This section describes how to configure Worker Servers and Worker groups for EMC SourceOne. Topics include:

◆ Introduction to Servers and Groups Node .............................................................. 158
◆ Viewing Workers and their roles ............................................................................ 158
◆ Viewing or editing Worker properties .................................................................. 159
◆ Controlling Workers .............................................................................................. 162
◆ Tuning Worker Server job access to servers ....................................................... 163
◆ Configuring Worker groups ................................................................................... 166
Introduction to Servers and Groups Node

Use the Servers and Groups node in the EMC SourceOne console to configure and control Worker Servers, create and manage Worker groups.

- Use the Configuration tab of Servers to view Worker roles, specify the types of jobs that Workers can run, and control Workers.
- Use the Tuning tab to control how many Worker jobs can connect to a server at one time.
- Use the Worker Groups node to create and manage Worker groups. You must create Worker groups in order to assign individual Workers. Activities can then be assigned to specific Worker groups.

Viewing Workers and their roles

Perform the following tasks to view the list of Workers, and their roles if already assigned.

1. In the EMC SourceOne console, expand the EMC SourceOne node in the left pane.
2. Click the Servers node.
3. Click the Configuration tab.

![Figure 51 Viewing Workers and roles](image)
The Servers results pane lists information about each Worker Server registered in the EMC SourceOne system as described in this table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the Worker Server.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the Worker Server. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Available — Indicates that the server is available to accept jobs.</td>
</tr>
<tr>
<td></td>
<td>• Working — Indicates that the server is processing one or more jobs.</td>
</tr>
<tr>
<td></td>
<td>• Paused — Indicates that the server has been suspended by the user.</td>
</tr>
<tr>
<td></td>
<td>• Off Duty — Indicates that the server is not accepting jobs.</td>
</tr>
<tr>
<td></td>
<td>• Unresponsive — Indicates that the server has stopped responding.</td>
</tr>
<tr>
<td></td>
<td>• Restart — Indicates that the server has just started and will not accept jobs until the dispatcher updates the server state.</td>
</tr>
<tr>
<td></td>
<td>• Suspended for backup — Indicate that server has been temporarily paused for backup operations.</td>
</tr>
<tr>
<td>Roles</td>
<td>The types of jobs (activities) that have been assigned to each Worker Server.</td>
</tr>
<tr>
<td></td>
<td>To assign types of jobs (activities) to a Worker, refer to “Viewing or editing Worker properties” on page 159.</td>
</tr>
</tbody>
</table>

### Viewing or editing Worker properties

Perform the following tasks to view or edit the properties of a Worker Server.

1. In the EMC SourceOne console, expand the EMC SourceOne node in the left pane.
2. Click the Servers node.
3. Click the Configuration tab.
4. Select the Worker in the list.
5. Select Action > Properties.

The Server Properties dialog box appears.

![Server Properties dialog box](image)

**Figure 52** Server Properties (Worker roles)

6. To edit Worker properties, refer to the following sections.
Specifying types and numbers of jobs for a Worker

This section discusses the types and numbers of jobs for a Worker.

Job types

In the first column of the Server Properties dialog box, the selected check boxes indicate the types of jobs (activities) that the Worker is allowed to run. The job types that are available depend on the EMC SourceOne components that you have installed, as described in the following table.

Table 24  SourceOne components and job types

<table>
<thead>
<tr>
<th>SourceOne component</th>
<th>Job types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email Management</strong></td>
<td>• Archive - Historical</td>
</tr>
<tr>
<td></td>
<td>• Archive - Personal Mail Files</td>
</tr>
<tr>
<td></td>
<td>• Archive - User Directed Archive</td>
</tr>
<tr>
<td></td>
<td>• Delete - Historical</td>
</tr>
<tr>
<td></td>
<td>• Delete - User Directed Archive</td>
</tr>
<tr>
<td></td>
<td>• Delete - User Initiated Delete</td>
</tr>
<tr>
<td></td>
<td>• Find - Microsoft Office Outlook .PST</td>
</tr>
<tr>
<td></td>
<td>• Journal</td>
</tr>
<tr>
<td></td>
<td>• Migrate - Microsoft Office Outlook .PST</td>
</tr>
<tr>
<td></td>
<td>• Restore Shortcuts - Historical &amp; User Directed Archive</td>
</tr>
<tr>
<td></td>
<td>• Shortcut - Historical</td>
</tr>
<tr>
<td></td>
<td>• Shortcut - User Directed Archive</td>
</tr>
<tr>
<td></td>
<td>• Update Shortcuts - Historical &amp; User Directed Archive</td>
</tr>
<tr>
<td><strong>For descriptions of Email Management activity types, refer to “Configuring Email Management Activities” on page 341.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>EMC SourceOne for Microsoft SharePoint, SharePoint Archive</strong></td>
<td></td>
</tr>
<tr>
<td><strong>EMC SourceOne for File Systems</strong></td>
<td>• File Archive - Historical</td>
</tr>
<tr>
<td></td>
<td>• File Delete - Historical</td>
</tr>
<tr>
<td></td>
<td>• File Restore - Historical</td>
</tr>
<tr>
<td><strong>EMC SourceOne Search or Discovery Manager</strong></td>
<td>The following job types do not have corresponding activities in the Activity wizard, because they are performed directly by users in Search or Discovery Manager:</td>
</tr>
<tr>
<td></td>
<td>• Delete — A user deletes messages using Search.</td>
</tr>
<tr>
<td></td>
<td>• Export — A user copies or restores messages to a folder using Search or copies messages to a hold folder in Discovery Manager.</td>
</tr>
<tr>
<td></td>
<td>• Export Discovery Manager — A user exports messages from Discovery Manager.</td>
</tr>
<tr>
<td></td>
<td>• Query — A user performs a search in Search.</td>
</tr>
<tr>
<td></td>
<td>• Query Discovery Manager — A Discovery Manager user performs a search in Discovery Manager.</td>
</tr>
</tbody>
</table>

Job limit

The Job Limit column indicates the maximum number of jobs of each type that the Worker may run simultaneously. The default is 4 jobs.
**Procedure**

Perform the following steps to specify the types of jobs (activities), and maximum number of jobs a Worker may run simultaneously.

1. Access the **General** tab in the **Server Properties** dialog box.

2. For each job type, perform one of the following steps:
   - To allow the Worker to run jobs of this type, select the checkbox next to the job type.
   - To prevent the Worker from running jobs of this type, clear the checkbox next to the job type.

3. To specify the maximum number of jobs that a Worker may run simultaneously for a job type:
   a. Perform one of the following steps:
      - Double-click the number in the **Job Limit** column.
      - Click the task name to highlight the line, then click **Set Limit**.
      
      The **Server Job Limits** dialog box appears.
   b. In the **Instance limit** field, either edit the value directly or click the increment/decrement buttons.
      
      Valid values are integers in the range 1 - 25.
      
      (Deselecting the checkbox for a job type is equivalent to an **Instance limit** of 0.)

   ![Server Job Limits](image)

   **Figure 53**  Figure 3-31 Server Job Limits
   
   c. Click **OK** to close the **Server Job Limits** dialog box.

4. To change the poll time limit, refer to **“Specifying the polling time interval for a Worker”** on page 162.

5. Click **OK** to save your changes and to close the **Server Properties** dialog box.
Configuring Worker Servers and Worker Groups

Specifying the polling time interval for a Worker

The Polling time interval field indicates how often the Job Dispatcher polls the Worker for jobs, in seconds.

- For Workers with the Search role, the default is 2 seconds. This short polling interval provides better responsiveness to client applications (Search, Discovery Manager) that issue real-time interactive queries to the system through jobs.
- For other Workers, the default is 10 seconds.

Edit the Polling time interval if required to improve performance or responsiveness.

The minimum value for the Polling time interval field is 2 seconds. The maximum value is 10 seconds.

Considerations and recommendations

This section contains considerations and recommendations for specifying the polling time interval for a Worker.

- Consider the effects of the polling time on traffic and responsiveness:
  - A low polling time value increases traffic, but improves responsiveness.
  - A high polling time value decreases traffic, but also decreases responsiveness.
- If multiple roles, including Search, are configured on a Worker, specify the shortest polling interval.

For example, assume WorkerA has the Delete, Export, and Query (Search) roles assigned to it. If these roles were on separate Workers, the default polling time values for each Worker would be 10 seconds, 10 seconds, and 2 seconds respectively. Set the polling time for WorkerA to be that of the Query (Search) role, which is 2 seconds.

Procedure

Perform the following steps to change the polling time for a Worker.

1. Access the General tab in the Server Properties dialog box.
2. Edit the Polling time interval field by clicking the increment/decrement buttons or by typing the value directly.
3. Click OK to save your changes and to close the Server Properties dialog box.

Controlling Workers

Control a Worker Server by using actions to change its state.

Perform the following procedure to control a Worker.

1. In the EMC SourceOne console, expand the EMC SourceOne node in the left pane.
2. Click the Servers node.
3. Click the Configuration tab.
4. Select the Worker that you want to control.
5. Select **Action > action**, where **action** is one of the options described in the following table.

**Table 25 Controlling Worker Servers**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action available when Worker is in this state</th>
<th>Changes Worker state to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>Makes the Worker temporarily unavailable for starting new jobs. Pauses all running jobs on the Worker. Use the Backup action to suspend a Worker for backup, not the Pause action.</td>
<td>Available, Working</td>
<td>Paused</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops all jobs on the Worker. Running jobs stop and do not complete. Makes the Worker temporarily unavailable for starting new jobs.</td>
<td>Available, Paused, Working</td>
<td>Off Duty</td>
</tr>
<tr>
<td>Start/Resume</td>
<td>Resumes the Worker so that it can accept jobs. Resumes all paused jobs on the Worker.</td>
<td>Paused</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the Worker from the list.</td>
<td>Unresponsive</td>
<td>Removed</td>
</tr>
<tr>
<td>Backup</td>
<td>Makes the Worker temporarily unavailable for starting new jobs, except for search jobs, and prepares the Worker for backup. Pauses all running jobs on the Worker, except for search jobs.</td>
<td>Start/Resume</td>
<td>Suspended for Backup</td>
</tr>
</tbody>
</table>

The available actions vary, depending on the current state of the Worker.

To view the latest changes, press **F5**. The list may take a few moments to update.

**Tuning Worker Server job access to servers**

Use the Tuning tab to control how many Worker Server jobs can simultaneously connect to a Domino mail server, Exchange mail server or SharePoint server as described in the following sections.

**Understanding the Tuning tab**

Use the Tuning tab to control how many EMC SourceOne jobs can simultaneously connect to your Domino, Exchange, or SharePoint server.

The Tuning tab automatically updates with the servers EMC SourceOne is accessing, when jobs created by activities connect to those servers.

The Tuning tab lists the following information about each server displayed:
Configuring Worker Servers and Worker Groups

- Server — The unique name of the server.
- Type — The type of server. This value will be Domino, Exchange, or SharePoint.
- Limit — The total number of EMC SourceOne jobs that can simultaneously connect to the server. The default value is 4. The range for this value is 1 to 100.

You can change the default limit value automatically assigned to any server when it is first added to the Tuning tab display.

You can also change the limit value assigned to a specific server as described after it has been added to the Tuning tab display.

- Current — The current number of EMC SourceOne jobs that are connecting to the server. The range for this value is 0 to 100, with 0 indicating that no jobs are connected to the server.

Displaying the Tuning tab

Display the Tuning tab by doing performing the following tasks.

1. In the EMC SourceOne console, expand the EMC SourceOne node in the left pane.
2. Click the Servers node.
3. Click the Tuning tab. The Tuning tab appears.

![Figure 54 Using the Servers node Tuning tab](image)

Changing the tuning server limit default value

By default, all servers that are added to the Tuning tab are initially assigned a default limit value of 4, indicating that a maximum of 4 jobs can connect to the server at one time.

You can change the default value by performing the following tasks:

1. With the Tuning tab displayed, select Action > Set Default Limit. The Server Limit Default dialog box appears.
2. Replace the value that appears in the **Limit value** field with a new value from 1 to 100.
3. Click **OK**.

Any servers that are added to the **Tuning** tab after this change will have a limit value set to the value you have entered.

### Changing the tuning server limit value

By default, all servers that are added to the Tuning tab are assigned a default limit value of 4, indicating that a maximum of 4 jobs can access the server at one time.

You can change this default limit value by doing the following tasks:

1. With the **Tuning** tab displayed, select **Action > Set Limit**. The **Server Limit** dialog box appears.

2. Replace the value displayed in the **Limit value** field with a new value from 1 to 100.
3. Click **OK**.

Any servers that are added to the Tuning tab after this change will have a limit value set to the value you have just entered.

### Best practices for changing Tuning tab server limit values

Whether to change the default value for the server limit or default server limit from 4 to some other number, depends on the computing environment.

- If the performance of the servers is significantly impacted by the activity jobs connecting to them, you may want to reduce the number of jobs connecting to each of these servers by reducing the server limit value.

Note that reducing the number of jobs that can access each server may increase the amount of time it takes for an activity to complete, because it may cause some of the activity jobs to wait to access the server.
You may also want to reduce the default server limit value so that any newly discovered servers get the reduced value automatically.

- If the servers are not impacted by the current number of activity jobs connecting to them, and activities complete in a workable amount of time, there is no need to modify the server limit value.

- If the performance of the servers are not impacted by the activity jobs connecting to them, and you want to shorten the time it takes for an activity to complete, you may want to increase the number of jobs connecting to each these servers by increasing the server limit value.

You may also want to increase the default server limit value so that any newly discovered servers get the increased value automatically.

**Configuring Worker groups**

Create Worker groups for which to assign individual Workers. Activities can then be assigned to specific Worker groups.

Create, edit and delete Worker groups in the SourceOne Management Console.

**Create a new Worker group**

In the SourceOne Management Console, create a new Worker group and add Workers to the new group by performing the following tasks.

1. Start the Worker Group Creation wizard by selecting Servers and Groups > Worker Groups, and clicking New Worker Group.
2. Type the **Worker Group Name** and **Description** in the respective fields.

![New Worker Group](image)

**Figure 58** New Worker Group Select Workers for the Worker group — General

*Note:* The Worker group name is required, but the description is optional.

3. Click **Next** and select the Workers for this Worker group.

   - A Worker can only be assigned to one group. Select some Workers to join this Worker group.
   - One Worker can be assigned to only one group.
   - If a Worker is already assigned to other Worker group, it is disabled (grayed out) and can not be selected.
Figure 59  Select Workers for the Worker group

4. Click Finish. If a Worker is selected for the Worker group, a dialog box that displays the following appears:

   No worker is selected for this worker group. Would you like to proceed?

5. Click Yes to create the Worker group without Workers, or click No to return to the select Workers window.

Edit an existing Worker group

In the SourceOne Management Console, edit an existing Worker group by performing the following tasks.

1. Start the Worker Group Creation wizard by selecting Severs and Groups > Worker Groups, and clicking Edit Worker Group....

2. Change the Worker Group Name, and Description.
3. Click **Next** and select the Workers for this Worker group.

4. Click **Finish**.
5. If a Worker is selected for the Worker group, a dialog box that displays the following appears:

No worker is selected for this worker group. Would you like to proceed?

6. Click Yes to create the Worker group without Workers, or click No to return to the select Workers window.

Delete a Worker group

A Worker group cannot be deleted if the following conditions are true.

- There are jobs or activities associated with the Worker group, and if the activity is in any of the following states:
  - Defined
  - Active
  - Read-only
  - Suspend
- There are unassigned jobs associated with the Worker group.

Perform the following steps to delete a Worker group in the SourceOne Management Console.

1. Start the Worker Group Creation wizard by selecting Severs and Groups > Worker Groups.

2. Select the Worker group and click Delete.

   A dialog box that displays the following appears:

   Are you sure you want to delete the selected worker group(s)?

3. Click Yes to confirm the deletion.

   If there are activities or jobs associated with the Worker group being deleted, an error message appears. For example,

   Cannot remove the selected worker group(s). The following activities or their jobs are specified to the selected worker group(s):
   Historical Archive 1, Historical Shortcut 1

   The names of the related activities or jobs are listed in the message.

Assign a Worker group to an activity

When creating an activity, you can assign the execution of the activity to Worker Servers in a specified Worker group.

- If an activity is specified with a Worker group, all the jobs of this activity can only be processed by Worker Servers in that Worker group.
- If an activity is not specified with a Worker group, all the jobs of this activity can be processed by any Worker Servers.
CHAPTER 8
Configuring Applications and Web Services

This section describes how to configure applications and Web services used by EMC SourceOne. Topics include:

- Introduction ................................................................. 172
- Editing global settings for applications and Web services ........................................ 173
- Editing settings for Retrieval Web service .............................................................. 178
- Auditing search operations .................................................................................... 178
- Editing settings for Shortcut Web service and mobile restore .............................. 187
- Editing settings for EMC SourceOne Web Search application ............................... 190
- Editing settings for EMC SourceOne Web Search server ......................................... 197
- Index Validation ................................................................................................. 205
Introduction

In the EMC SourceOne console, use the Application Configuration node to specify settings for EMC SourceOne applications and Web services.

The Application Configuration node has four subnodes:

- Global Settings
- Retrieval
- Universal URL
- Web Search

Figure 62 Application Configuration subnodes
Perform the following steps to configure global settings for EMC SourceOne applications and Web services.

1. In the EMC SourceOne console, expand the Application Configuration node.
2. Double-click the Global Settings node. The Global Settings dialog box appears.

![Global Settings dialog](image)

Figure 63  Global Settings dialog
3. Edit the settings on this page, as described in the following table.

**Table 26 Global Settings properties**

<table>
<thead>
<tr>
<th>Field/option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported environments</td>
<td>Specifies the mail environments supported at your site. By default, all options are selected. Clear the checkbox for any mail environment that is not applicable.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Email Management supports the use of an SMTP environment if it is part of an Exchange or Domino mail environment. An SMTP environment without Exchange or Domino is not supported.</td>
</tr>
<tr>
<td></td>
<td>The following are valid values:</td>
</tr>
<tr>
<td></td>
<td>• IBM Lotus Domino</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Office 365</td>
</tr>
<tr>
<td></td>
<td>Also determines whether to use Exchange or Domino to resolve LDAP queries for user permissions on mapped folders. If both Exchange and Domino mail environments are selected and you run an LDAP query for mapped folder permissions, an error occurs for the invalid mail platform.</td>
</tr>
<tr>
<td>Archive deletion eligibility period</td>
<td>Specifies the age of mail items that users can delete by selecting one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Allow all dates — (Default) Select this option if the age of the mail item does not matter.</td>
</tr>
<tr>
<td></td>
<td>• Newer than — Select this option to restrict the activity to a sliding date window. Only those mail items that were deleted by users within the specified time after the Received Date will be deleted from the archive. The maximum age value in the first field is 18263 days (50 years plus 13 days to account for leap years), regardless of the units you select in the second field. Negative numbers and non-numeric characters are invalid.</td>
</tr>
<tr>
<td></td>
<td>This option is used by the User Delete feature and applies to user deletions from the archive done through Search and the mail client. The Delete - User Initiated Delete activity uses this option. The best practice for using this option is to specify a narrow date window to limit the number of volumes, indexes, and database partitions that are affected. The Archive deletion eligibility period option is enforced for user deletes performed through:</td>
</tr>
<tr>
<td></td>
<td>• The mail client (processed by Delete - User Initiated Delete activities).</td>
</tr>
<tr>
<td></td>
<td>• My Contributed Items searches in Search.</td>
</tr>
<tr>
<td></td>
<td>The Archive deletion eligibility period option is not enforced for Administrator deletes performed in Search. When you change the value of this option, existing activities continue to use the previous value. New activities use the new value.</td>
</tr>
<tr>
<td>Mail User Synchronization</td>
<td>Specifies when to start synchronization with the User Delete feature.</td>
</tr>
<tr>
<td>Cloud Tiering Appliance (CTA)</td>
<td>Specifies whether to enable the launching of the CTA console within the EMC SourceOne console. This is disabled by default.</td>
</tr>
</tbody>
</table>

4. Apply the changes you made on this page, as described in the following section.
Applying changes after editing environments settings

When EMC SourceOne is installed, all supported mail environments displayed in the Global Settings dialog box are enabled by default. Although you can change the supported environments settings to reflect your mail environment, for example, selecting only Microsoft Exchange, the first user that logs in to the EMC SourceOne Search application sees both Microsoft Windows and IBM Lotus Domino as choices in the Log on to: list.

After you change the Supported environments setting in the Global Settings dialog box, or the Default authentication environment setting in the Client Settings tab of the Web Search dialog box, You must perform the following procedure on each web server on which you installed EMC SourceOne Search.

For example, if you deployed four instances of EMC SourceOne Search in a web farm, you must perform the following procedure on each of those four web servers, so that the settings can be saved to the local settings file of each server.

Perform the following steps to apply changes.

1. Access the EMC SourceOne Search application.
2. Log in using the login method (Microsoft Windows or IBM Lotus Domino) for your environment.
3. Log out of the EMC SourceOne Search application.

Subsequent EMC SourceOne Search users will see only the supported environments configured in the Global Settings dialog box.

**Note:** If you change the supported environments settings in the future, wait at least 10 minutes for the settings to propagate through the system and repeat this procedure.

Initializing the address cache for User Delete

The Start Sync button in the Global Settings dialog is used only for the User Delete feature.

The following components use an address cache to distinguish internal recipients from external recipients:

- Journal activities that archive to Personal or Community mapped folders
- Folder Conversion utility

Before you create a Journal activity to a Personal or Community folder, you must initialize the address cache. This step synchronizes all mail users with SourceOne, based on the mail systems you select at the top of the Global Settings dialog box.

**Note:** If you do not initialize the address cache, then you cannot create Journal activities that archive to Personal or Community folders. In addition, permissions on mapped folders do not take effect until the address synchronization completes. Users cannot search or retrieve items from those mapped folders until the synchronization completes.
After the initial synchronization completes, subsequent incremental synchronizations are much faster. For example, in a large environment with more than a million addresses, the initial synchronization can take several hours, but subsequent synchronizations take less than 30 minutes.

You only have to initialize the address cache one time.

**Note:** If you already ran the Folder Conversion utility, then the address cache is initialized and you do not have to perform the following procedure.

**Best practice**

Add new users to the mail system at least one day before they arrive, so that their addresses are synchronized before their mail starts to be archived.

**Procedure**

Perform the following procedure to initialize the address cache.

1. In the EMC SourceOne console, expand the **Application Configuration node**.
2. Double-click the **Global Settings node**. The **Global Settings** dialog box appears.

   ![Figure 64  Global Settings properties](image)

3. To specify the mail systems that you want to synchronize with SourceOne:
   a. In the **Supported environments** area, select the mail systems.
   b. Click **OK** to save your changes.
Note: If you do not save your changes, then you will be prompted to perform so when you click the Start Sync button.
If you have a mixed mail environment (both Exchange and Domino are selected), then Outlook must be the default mail client.

4. Perform one of the following steps:

- If the Start Sync button is disabled, then the initial synchronization is either already in progress or is complete. Skip the rest of this procedure.

Note: If you already performed the initialization for one mail system and you added a second mail system, refer to “Synchronizing the address cache after adding another mail system” on page 177.

- If the Start Sync button is available, then the initial synchronization has not occurred. Click the Start Sync button.

5. Before creating a Journal activity to a Personal or Community folder, verify that the Sync Status is Synchronization complete.
To view updated status, close the Global Settings dialog box and then reopen it.

Synchronizing the address cache after adding another mail system

If you initialize the address cache for one mail system, and then later you select a second mail system in the Global Settings dialog box, you cannot use the Mail User Sync button to re-initialize the address cache. The button becomes unavailable after the initial synchronization.

Instead, you must wait for the daily address synchronization to occur before you create Journal activities to Personal or Community folders for the new mail system.

To verify that the daily synchronization is complete, look at the Event log for the following ExAddressCacheService status:

Successfully completed sync for data source All Mail Users.

![Figure 65 Event log — Address cache synchronized successfully](image)

If you create Journal activities to Personal or Community folders for the new mail system before the daily synchronization is complete, you can save the activity because an address cache already exists. However, because the existing address cache does not have the addresses of the new mail system users, mail items that do not have an internal owner...
and that are journaled to Personal or Community folders are marked as having an unknown owner. This protects the mail item from being deleted. Users cannot delete the message as intended due to ownership assignments.

**Editing settings for Retrieval Web service**

Perform the following steps to configure settings for the Retrieval Web service.

1. In the EMC SourceOne console, expand the Application Configuration node.
2. Double-click the Retrieval node. The Retrieval dialog box appears.

![Figure 66 Retrieval properties](image)

3. Edit the **Security group name**.

   The **Security group name** specifies the Active Directory security group whose members can retrieve messages and documents from the archive.

   Click **Browse** to select the EMC SourceOne security group, because that group contains all of the EMC SourceOne service accounts as members.

   **Note**: You do not need to specify the Security group name if you use a single EMC SourceOne service account for all EMC SourceOne services.

4. Click **OK**.

5. Restart the Document Management Service. If you do not restart the Document Management Service, then OWA users cannot access messages that have been shortcut.

**Auditing search operations**

The following section describes how to audit Search operations.
About search roles

Auditing recognizes two search roles, based on the type of search that is performed in Search, as described in this table:

<table>
<thead>
<tr>
<th>Search role recognized by auditing and reporting</th>
<th>Search type in SourceOne Search</th>
<th>What is audited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>All searches performed using the Administrator search type are audited.</td>
</tr>
<tr>
<td>Audited User</td>
<td>My Items, My Contributed Items, All Items</td>
<td>Searches performed using the My Items, My Contributed Items, or All Items search types are audited for a user only if the user is explicitly identified as an audited user. Typically, audited users are certain managers and executives who are required to have their searches audited.</td>
</tr>
</tbody>
</table>

Note: An Administrator search role and an EMC SourceOne system administrator are distinct concepts and are not necessarily the same person. An EMC SourceOne system administrator cannot perform Administrator searches until he is granted Administrator permission on the mapped folders that he wants to search.

The audit options are organized by the search roles of Administrator and Audited Users.

Auditing search operations performed by using the Administrator search type

Perform the following steps to audit search operations that were performed using the Administrator search type.

1. In the EMC SourceOne console, expand the Application Configuration node.
2. Double-click the Search Audit Settings node. The Search Audit Settings dialog box appears.
3. Click the Administrator Audit Settings tab.
4. Edit the settings, as described in the following table.

**Note:** By default, all search operations are audited for the Administrator search type. You cannot turn off this auditing. You can choose to audit details of the items that are processed by each type of search operation.

**Table 28 Administrator Audit Settings (page 1 of 2)**

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit search activities</td>
<td>Cannot be turned off. Audits searches of archived content that were performed using the Administrator search type. Audited information appears in the Search Activity report.</td>
<td>Selected</td>
</tr>
<tr>
<td>Audit search result view activities</td>
<td>Cannot be turned off. Search views are always audited for the Administrator search type. Audits the viewing and previewing of archived content that were performed using the Administrator search type. It records information about the document, job, and mapped folder for every document viewed. Audited information appears in the Documents Viewed report.</td>
<td>Selected</td>
</tr>
<tr>
<td>Audit restore activities</td>
<td>Cannot be turned off. Audits the Restore operations that were performed using the Administrator search type. Audited information appears in the Search Restore report.</td>
<td>Selected</td>
</tr>
</tbody>
</table>
Table 28  Administrator Audit Settings  (page 2 of 2)

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture document details</td>
<td>Audits the details of the copied items. This option has higher system impact because EMC SourceOne stores a summary of every document that is restored. This option can generate a large amount of data quickly if large numbers of items are restored. Enable this option only if you must track specific documents that are restored. Audited information appears in the Documents Restored report.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Audit delete activities</td>
<td>Cannot be turned off. Audits the Delete operations that were performed using the Administrator search type. Audited information appears in the Search Delete report.</td>
<td>Selected</td>
</tr>
<tr>
<td>Capture document details</td>
<td>Audits details of the restored items. This option has some system impact because SourceOne stores a summary of every document that is deleted. The impact can be lower for Delete operations than for Restore or Copy To operations, because typically fewer items are deleted per operation. Enable this option, due to the destructive nature of delete operations (documents are deleted from the archive). Audited information appears in the Documents Deleted report.</td>
<td>Not selected</td>
</tr>
<tr>
<td>Audit copy to folder activities</td>
<td>Cannot be turned off. Audits the Copy To operations that were performed using the Administrator search type. Audited information appears in the Search Copy report.</td>
<td>Selected</td>
</tr>
<tr>
<td>Capture document details</td>
<td>Audits details of the deleted items. This option has higher system impact because EMC SourceOne stores a summary of every document that is copied. This option can generate a large amount of data quickly if large numbers of items are copied. Enable this option only if you must track specific documents that are copied. Audited information appears in the Documents Copied report.</td>
<td>Not selected</td>
</tr>
</tbody>
</table>

Auditing search operations performed by specific users

The following section describes how to track search operations for audited users.

Perform the following procedure to audit search operations performed by specific users.

1. In the EMC SourceOne console, expand the Application Configuration node.
2. Double-click the Search Audit Settings node. The Search Audit Settings dialog box appears.
3. Continue to the following sections.
Specifying search operations to audit for audited users

Perform the following steps to specify the search operations to audit for audited users.

1. In the **Search Audit Settings** dialog box, click the **Audited User Audit Settings** tab.

![Figure 68 Audited User Audit Settings tab](image)

2. Edit the settings, as described in the following table.

   By default, search operations are not audited for users who perform searches by using the My Items, My Contributed Items, or All Items search types:

   - You can configure auditing of selected search operations for specified users.
• You can also audit details of the items that are processed by each type of search operation.

**Table 29 Audited User Audit Settings (page 1 of 2)**

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
</table>
| Enable Audited User Auditing    | When you select this checkbox:  
  • Other checkboxes on this tab become available for editing.  
  • The Audited Users tab becomes available.                                                                                                          | Not selected  |
| Audit search activities         | Audits searches of archived content performed by specified users using the My Items, My Contributed Items, or All Items search type. This option has low system impact.  
  Enable this option if you need to know what searches were performed by audited users.  
  Audited information appears in the Search Activity report.                                                                                       | Not selected  |
| Audit search result view activities | Audits the viewing and previewing of archived content performed by specified users using the My Items, My Contributed Items, or All Items search type. It records information about the document, job, and mapped folder for every document viewed by an audited user.  
  This option has low system impact.  
  Enable this option if you need to know what documents were viewed by specific users, especially if archived documents contain sensitive information and it is important to know who accessed the documents.  
  Audited information appears in the Documents Viewed report.                                                                                       | Not selected  |
| Audit restore activities        | Audits the Restore operations performed by specified users using the My Items, My Contributed Items, or All Items search type. This option has low system impact.  
  Enable this option if you need to know about restore operations performed by audited users.  
  Audited information appears in the Search Restore report.                                                                                         | Not selected  |
To audit search operations performed using My Items, My Contributed Items, or All Items search types, you must explicitly identify the users. Typically, audited users are certain managers and executives who are required to have their searches audited.
Perform the following to specify the users to audit, in the **Search Audit Settings** dialog box.

1. Click the **Audited Users** tab.

   **Note:** If the **Audited Users** tab is not available, select the **Enable Audited User Auditing** checkbox on the **Audited User Audit Settings** tab.

   ![Audited Users tab](figure70.png)

   **Figure 70** Audited Users tab

2. In the **Maximum audited users** field, specify the maximum number of users to audit.

   The default is 20. This value must be an integer in the range 1 - 50.

   **Note:** The maximum is 50 users to prevent performance or storage issues.

3. Create an LDAP query to specify the users that you want to audit.

4. Test the LDAP query.

5. Immediately after you save the configuration settings, the specified LDAP query is executed to synchronize the users with the address cache. Audits will occur after the initial synchronization completes. The synchronization also occurs periodically according to the address cache synchronization schedule.
The Sync Status field shows the status of the synchronization:

- **Not synchronized** — The initial state, before the first synchronization occurs.
- **Complete** — The synchronization was successful. The date and time of the last successful synchronization appears.
- **Failed** — A synchronization error occurred. The date and time of the last successful synchronization appears.

6. Verify that the **Sync Status** field displays a status of **Complete**.

To display the latest status, click **Refresh Status**.

**Note:** The **Refresh Status** button does not perform a synchronization. It updates the display of the status information.

### Testing the LDAP query for Audited Users

Testing the LDAP query in the Audited Users tab is optional, but it is helpful to avoid errors later when the query is synchronized with the address cache.

1. To test the LDAP query, click **Execute**. The results are displayed in the **Test Results** area.

2. If the number of results resolves to more than the number of users specified in the Maximum audited users field, then an error appears:

   The LDAP Query is invalid for the following reasons: The LDAP Query resulted in more users than are allowed. Please refine your query or increase the maximum allowed users. Failure to do so results in errors when this query is synchronized later.

   To fix the problem, perform one of the following steps:
   - Refine the LDAP query to retrieve fewer users.
   - Increase the value in the **Maximum audited users** field.

   **Note:** You are allowed to save changes even if the query returns more than the number of users specified in the Maximum audited users field. However, the set of audited users recognized by auditing will remain unchanged until the LDAP query resolves to a count less than the value you specified in the Maximum audited users field. Synchronization errors are recorded in the event log on the Master Server, and the synchronization fails.
Editing settings for Shortcut Web service and mobile restore

The EMC SourceOne Universal URL feature provides a platform-independent mechanism to restore shortcut emails and files.

- Email clients such as Microsoft Entourage and OWA Light, and mobile Exchange email clients (such as the Research in Motion Blackberry), use the Universal URL. When a user clicks on a URL link embedded in the body of a shortcut message, the email client starts a Web browser.

  **Note:** In an Exchange environment, delegate users cannot use the universal URL to resolve shortcuts in the delegate mailbox. Delegate users can use Offline Access to resolve the shortcut.

- For EMC Source One for File Systems, the Universal URL is required if you want to use the Shortcut files option when you create a File Archive activity.

In the External URL field, specify the DNS CNAME alias of the server that is running the SourceOne Mobile Services. Do not specify a fixed IP address or a hostname as these can change.

If you do not configure the Universal URL/External URL, then you cannot create activities to shortcut email or files.

Persistence of configuration information

Configuration information is cached. The cache is refreshed before any mobile pages load, not just the Login page. If the configuration cache has expired, the edited list of restricted extensions takes effect on the next page load.

The following settings are reset when the user logs out and logs in again:

- Login information cookie timeout
- Session cookie timeout

Configuring settings for the EMC SourceOne Universal URL

Perform these steps to configure settings for the Universal URL, including mobile restore.

1. In the EMC SourceOne console, expand the Application Configuration node.
2. Double-click the Universal URL node. The Universal URL dialog box appears.
Figure 71 Universal URL properties
3. Edit the settings, as described in the following table.

**Table 30  Universal URL properties (page 1 of 2)**

<table>
<thead>
<tr>
<th>Field/option</th>
<th>Description</th>
<th>Valid range of values</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable universal URL</td>
<td>Enable or disable the URL of the server on which EMC SourceOne Mobile Services is installed for use by external clients.</td>
<td>Perform one of the following steps:</td>
<td>Selected — URL of the Shortcut Web server is enabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The other options in the Universal URL dialog box are available only if the Enable universal URL checkbox is selected.</td>
<td>• To enable the URL, select the Enable universal URL checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To disable the URL, clear the Enable universal URL checkbox.</td>
<td></td>
</tr>
<tr>
<td>External URL</td>
<td>In Exchange environments, specify the URL of the server on which EMC SourceOne Mobile Web services is installed for use by external clients.</td>
<td>Not applicable.</td>
<td>Blank</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use SSL (https).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format: <a href="https://MobileServicesServer.domain.com">https://MobileServicesServer.domain.com</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default restore folder</td>
<td>Specify the default mail client folder in which to restore messages.</td>
<td>Perform one of the following steps:</td>
<td>Default Inbox</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not specify nested folders for a custom folder.</td>
<td>• Select Default Inbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select Custom folder, then type the name of the custom folder.</td>
<td></td>
</tr>
<tr>
<td>Restricted extensions</td>
<td>Lists the file extensions to exclude from retrieval.</td>
<td>When adding extensions, use commas to separate extensions in the list.</td>
<td>See dialog box for list of extensions restricted by default.</td>
</tr>
<tr>
<td>(comma delimited)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save logon information</td>
<td>Specify whether users will be able to save logon information as a cookie on their computers.</td>
<td>Perform one of the following steps:</td>
<td>Selected — Users can save logon information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To allow users to save logon information, select the Save logon information checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To prevent users from saving logon information, clear the Save logon information checkbox.</td>
<td></td>
</tr>
</tbody>
</table>
Using shortcuts with email clients supported by the Universal URL feature

Email clients supported by the Universal URL, such as Microsoft Entourage and OWA Light, and mobile Exchange email clients, such as Blackberry, typically rely on a pull mechanism to retrieve messages. Synchronization between mailbox shortcuts and the display of the retrieved shortcut messages in the email client might lag. This lag is caused by having large numbers of cached messages stored locally.

Users may avoid this retrieval and display lag by periodically synchronizing their email client mailbox to reduce their local cache size, if the email client has that capability.

Editing settings for EMC SourceOne Web Search application

The configuration settings are cached by the Search application, and refreshed for a user at the next login after the cache expires. By default, the cache expiration timeout is 10 minutes.

Note: Your changes to these settings take effect after the web service retrieves an update from the database, which can take up to 20 minutes. Alternately, you can restart IIS using iisreset to force an immediate update.

Perform these steps to configure settings for the Web Search application.

<table>
<thead>
<tr>
<th>Field/option</th>
<th>Description</th>
<th>Valid range of values</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon information cookie timeout (hours)</td>
<td>Specify how long to retain the logon information cookie on users' computers.</td>
<td>8 - 720 (hours) (720 hours equals 30 days.)</td>
<td>8 (hours)</td>
</tr>
<tr>
<td>Session cookie timeout (minutes)</td>
<td>Specify the number of minutes before a user session times out.</td>
<td>30 - 60 (minutes)</td>
<td>30 (minutes)</td>
</tr>
<tr>
<td>Always restore</td>
<td>Adds the file directly to the Restore List Directory when a file shortcut is opened.</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td>Always download</td>
<td>Pushes the file directly to the client when a file shortcut is opened.</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td>Allow user to choose</td>
<td>Select to restore the files to its original location, open the file directly, or save the file:</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td></td>
<td>• Add to Restore List — Adds the file to the Restore List where you can choose to restore the file to its original location.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Save/Open — Save or open the file.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
1. In the EMC SourceOne console, expand the **Application Configuration** node.
2. Double-click the **Web Search node**. The **Web Search** dialog box appears.
3. Click the **Client Settings** tab.

![Web Search Client Settings](image)

**Figure 72** Web Search properties — Client Settings
4. Edit the settings, as described in the following table.

Table 31 Web Search properties - Client Settings (page 1 of 3)

<table>
<thead>
<tr>
<th>Field/option</th>
<th>Description</th>
<th>Valid range of values</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum results</td>
<td>Specify the maximum number of items that can be returned in search results.</td>
<td>10 - 100000 (items)</td>
<td>5000 (items)</td>
</tr>
<tr>
<td>User default maximum results</td>
<td>Specify the default maximum number of items that can be returned in search results.</td>
<td>10 - 100000 (items)</td>
<td>1000 (items)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This value must be less than or equal to the Maximum results value.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Restricted extensions (comma delimited) | If an attachment's extension matches one in this list, in the Search preview pane:  
• The attachment appears as a plain text attachment name instead of a clickable link for download.
• A warning informs the user that the attachment was blocked for security reasons, and that the attachment can be viewed by opening the native message. | List the file extensions of email attachment types that you do not want users to download through links in the Search preview pane. Use commas to separate extensions in the list. | See dialog box for list of extensions restricted by default. |
| Default page size                   | Specify the number of items to display per page in search results.         | 10 - 50 (items)       | 10 (items)    |
| Default search type                 | Specify the default type of search. The selected type will display in the Search Type field on the Search toolbar, as described in the Search User Guide. | • Administrator  
• All Items  
• My Items  
• My Contributed Items | My Items |
|                                     | **Note:** The My Files search type is not available as a default.           |                       |               |
| Default authentication environment  | Select the default authentication environment. The selected environment will be the default selection in the Log on to field in the Search logon screen. | • IBM Lotus Domino  
• Microsoft Windows | Microsoft Windows |
|                                     | **Note:** Refer to “Applying changes after editing environments settings” on page 175. |                       |               |
### Table 31  Web Search properties - Client Settings (page 2 of 3)

<table>
<thead>
<tr>
<th>Field/option</th>
<th>Description</th>
<th>Valid range of values</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application session timeout</td>
<td>Specify the number of minutes before a search session times out.</td>
<td>20 - 60 (minutes)</td>
<td>20 (minutes)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Refer to “Changing the IIS Application Pool Idle Timeout” on page 195.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum number of saved searches per user</td>
<td>Specify the maximum number of searches that a user can save. This setting affects the Save Search dialog box.</td>
<td>10 - 50 (saved searches)</td>
<td>10 (saved searches)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A saved search includes search criteria, not results.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable delegate search</td>
<td>Enables/disables delegate searches in Search. This setting controls the display of the Search As button in the Search toolbar for the following search types: My Items, My Contributed Items, All Items. Delegate search (the Search As button) is never available for the following search types: Administrator, My Files.</td>
<td>Perform one of the following steps: To enable delegate search, select the Enable delegate search checkbox. To disable delegate search, clear the Enable delegate search checkbox.</td>
<td>Selected — Users can perform delegate searches for the My Items, My Contributed Items, and All Items search types.</td>
</tr>
<tr>
<td>Enable web download of ONM Viewer</td>
<td>The EMC ONM Viewer is required to open Lotus Notes messages in search results. You can install it or allow users to download and install it. This setting controls the ability of users to download the ONM Viewer.</td>
<td>Perform one of the following steps: To allow users to download the ONM Viewer, select the Enable web download of ONM Viewer checkbox. Users are presented with the option to install the ONM Viewer the first time they try to view a Lotus Notes message. Users must have local administrator rights to install the viewer. To prevent users from downloading the ONM Viewer, clear the Enable web download of ONM Viewer checkbox. Install the viewer according to the instructions in the <em>EMC SourceOne Email Management Installation Guide</em>.</td>
<td>Selected — Users can download the ONM Viewer.</td>
</tr>
</tbody>
</table>
Table 31 Web Search properties - Client Settings (page 3 of 3)

<table>
<thead>
<tr>
<th>Field/option</th>
<th>Description</th>
<th>Valid range of values</th>
<th>Default value</th>
</tr>
</thead>
</table>
| Enable restore                                   | Controls whether archived email messages and file content can be restored using Search.  
  • Select the Enable restore option to allow restoring messages to mailboxes and restoring files in Search.  
  This is the default. For restoring messages, this is the behavior seen in previous versions of Search.  
  • Clear the Enable restore option to not allow restoring messages to mailboxes and restoring files.  
  When this option is cleared, the restore capability is removed and disabled for all search types in Search:  
  - The Restore toolbar button is removed.  
  - The Restore context menu item on the search results grid is disabled.  
  This is the recommended setting when using the Journal activity with Office 365 content. | • Selected — Enables the Restore function in Search for messages and files.  
  • Clear — Disables the Restore function in Search for messages and files. | Selected       |
| Enable file restore to alternate locations       | Controls whether the Restore selected files to a new location option is available in the Restore Files dialog box in EMC SourceOne Search. | • Selected — Enables Restore selected files to a new location option in Search.  
  • Clear — Disables Restore selected files to a new location option in Search. | Selected       |
| Enable default date range for Search             | An unbounded date search can adversely affect search performance. To improve search performance, you can specify a default date range. Users can override this default in search. | Perform one of the following steps:  
  • To enable a default date range, select the Enable default date range for Search checkbox, then specify the date range in the associated fields.  
  • To disable a default date range, clear the Enable default date range for Search checkbox. | Clear — A default date range is not specified. |

5. If you changed the Default authentication environment setting, apply the changes.
Changing the IIS Application Pool Idle Timeout

If you increase the value of the Application session timeout field in the EMC SourceOne console (on the Application Configuration > Web Search > Client Settings tab), you must perform the following procedure for the installed version of Internet Information Services (IIS) Manager.

Perform the following in IIS Manager:
1. In the Connections pane, expand the Servers node and then select Application Pools.
2. In the Application Pools pane, select the Search application pool.
3. In the Actions pane, select Advanced Settings.
4. In the Advanced Settings dialog box, increase the value of Idle timeout to a value that is greater than the value that you set for Application session timeout in EMC SourceOne.
5. You may need to restart the application pool.

Enabling file restore to alternate locations

If the Enable file restore to alternate locations (requires Java applet) option in the EMC SourceOne console (on the Application Configuration > Web Search > Client Settings tab) is selected.

- A Java applet is downloaded and installed on the client machine when a user tries to restore files for the first time.

**Note:** For the Java applet to work, the Java Runtime Environment (JRE) must be installed on the client machine.

- In Search, the Browse buttons and the Restore selected files to a new location option are available in the Restore Files dialog box.

The Java applet:
- Allows the user to browse for a target restore location.
- Verifies that the user has write permission to the target restore location for the Restore selected files to a new location option.

If you do not want the Java applet to be downloaded, then clear the Enable file restore to alternate locations (requires Java applet) option in the EMC SourceOne console. Without the Java applet, you can restore:

- Individual files by downloading files from the preview pane in EMC SourceOne Search
- Multiple files by using the File Restore - Historical activity in the EMC SourceOne Admin Console

Specifying a default date range for Search

In EMC SourceOne Search, an unbounded date range can cause the search to run for a long time. To improve performance, you can use the Enable default date range for Search option to specify a default sliding date range.
The sliding date range is based on today’s date and adjusted according to the amount of time that you specify. You can select from three date ranges:

- On or before (today’s date)
- On or after (today’s date)
- Between (two dates based on today’s date)

Excluding the last two weeks

To exclude the last two weeks, specify On or before 2 weeks ago.

![Example 1 — On or before](image)

In Search, the amount of time you specified (two weeks) is subtracted from today’s date. If today’s date is 4/27/2010, users see the Date field pre-filled to on or before 04/13/10.

![Example 1 — Search — On or before](image)

Limiting the search to the previous year (365 days)

To limit search to the previous year (365 days), specify On or after 1 year(s) ago.

![Example 2 — On or after](image)

In Search, the amount of time you specified (1 year) is subtracted from today’s date. If today’s date is 4/27/2010, users see the Date field pre-filled to on or after 04/27/09.

![Example 1 — Search — On or after](image)

Limiting the search to the previous year

To limit search to the previous year, excluding the last two weeks, specify Between 2 weeks ago and 1 year(s) ago.
Specifying a default date range

Perform the following steps to specify a default date range, in the Client Settings tab of the Web Search dialog box.

1. Select the **Enable default date range for Search** checkbox.
2. In the first field, select one of the following options:
   - On or before
   - On or after
   - Between
3. Use the second and third fields to specify the date boundary.
   
   If you selected the **Between** option in the previous step, the second and third fields define one of the date boundaries:
   a. In the second field, specify the amount of time.
   b. In the third field, select the unit of time:
      - Days
      - Weeks
      - Months
      - Years
4. If you selected the **Between** option in step 2, use the fourth and fifth fields to specify the other date boundary.
5. In the **Web Search** dialog box, click **OK** to save your changes.

**Editing settings for EMC SourceOne Web Search server**

Perform the following steps to configure settings for the Web Search server.
1. In the EMC SourceOne console, expand the **Application Configuration** node.
2. Double-click the **Web Search** node. The **Web Search** dialog box appears.
3. Click the **Server Settings** tab.

![Web Search properties — Server Settings](image)

**Figure 79** Web Search properties — Server Settings
4. Edit the settings, as described in the following table.

Table 32 Web Search properties - Server Settings (page 1 of 3)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Valid range of values</th>
<th>Default value</th>
</tr>
</thead>
</table>
| Limit maximum server results:             | Perform one of the following:  
• To allow unlimited server results, clear the Limit maximum server results checkbox.  
• To specify the maximum number of server results, select the Limit maximum server results checkbox, then specify the maximum number of items in the Maximum server results field.                                                                                                                                         | 100 - 100000 (items) | Clear — Limit maximum server results is clear. Selected — The Maximum server results default is 5000 (items).                                                                                                                   |
| Maximum server results                     |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                           |                       |                                                                                                                                                                                                                                |
| Limit search time:                         | Perform one of the following:  
• To allow unlimited time for a search, clear the Limit search time checkbox.  
• To specify a search timeout, select the Limit search time checkbox, then specify the timeout in the Search timeout field.                                                                                                                                                                                                                       | 10 - 3600 (minutes)  | Clear — Limit search time is clear. Selected — The Search timeout default is 10 (minutes).                                                                                                                                       |
| Search timeout (minutes)                   |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                           |                       |                                                                                                                                                                                                                                |
| Maximum number of days to save results     | Specify the maximum number of days to save search results. Search results are automatically saved, along with search criteria, whenever a user logs off. These are restored when the user logs on again.                                                                                                                                                                                                                                         | 1 - 30 (days)         | 7 (days)                                                                                                                                                                                                                        |
| Maximum address book entries               | Specify the maximum number of address book entries to display in the result list. This option only has an effect when Exchange is selected as a supported environment or when Domino is selected as a supported environment and the Use LDAP for Domino address lookup option is selected. You specify the supported environment on the Global Settings tab of the Application Configuration node. This option has no effect when Domino is selected as a supported environment and the Use LDAP for Domino address lookup option is not selected. Note: Setting this value to a larger value than the default may impact the time it takes for Search to return the results. | 50 - 10,000 (entries) | 1000 (entries)                                                                                                                                                      |
| Enable detailed logging for deletions      | To enable or disable detailed logging for delete operations performed through Search, perform one of the following:  
• To enable detailed logging, select the Enable detailed logging for deletions checkbox  
• To disable detailed logging, clear the Enable detailed logging for deletions checkbox.  
The change affects new Delete jobs for SourceOne Search, not Delete jobs that are already running.                                                                                                                                                                                                                           |                       | • Selected — Enabled.  
• Clear — Disabled.                                                                                                                                                                                                             |
Enable open SMTP/MIME messages in native format

Controls how SMTP email content is opened by Search users.

- To not have SMTP messages opened in their native format, do not select the Enable open SMTP/MIME messages in native format option. This is the default. In this case, when a Search user logs in using their Windows or Domino credentials and double clicks on an .eml message, the .eml message is converted to the user's logged-in environment message type, (.msg or .onm), before it is delivered to the user for download.

- To allow SMTP MIME messages to be opened in their native mail format by Search, select the Enable open SMTP/MIME messages in native format option. Setting this option may provide a better user experience than having the messages converted, if all user clients can be configured.

When this setting is enabled, SMTP messages are not converted before they are returned to the user. The native .eml message is downloaded when a user double-clicks on the .eml message. Enabling this option only affects SMTP message types. Domino messages are still converted to a Exchange .msg message if the user logs in with Windows credentials and double-clicks a Domino message. Likewise, if the user logs in using Domino credentials and double-clicks an Exchange message, that message would be converted to a Domino .onm message.

Because Search cannot determine if the user's machine will be able to properly open the .eml file delivered to the user's Web browser, the user must have configured an application to open files with the .eml file type. Both Outlook Express and Outlook can be configured to open .eml files.

SMTP Address Reuse

Refer to "Configuring SMTP address reuse" on page 201.
Configuring SMTP address reuse

If you reassign previously used SMTP addresses to new users, then configure EMC SourceOne for SMTP address reuse.

Overview of configuring SMTP address reuse.

If you reassign previously used SMTP addresses to new users, then configure EMC SourceOne for SMTP address reuse.

- If you do not configure SMTP address reuse in EMC SourceOne and if you reassign a previously used SMTP address to a new user, then the user will see all mail sent to the SMTP address before the address was assigned to him.
If you configure SMTP address reuse in EMC SourceOne, the date ranges of My Items and My Contributed Items searches will be restricted to the user's hire date and will only return search results on or after that date. This prevents the user from seeing items that were archived before his designated hire date. Administrator, All Items, and My Files searches are not affected. In addition, performance is improved because fewer indexes will be searched.

Use one of the following properties in the user directory (Active Directory or Domino directory) as the hire date of the user:

- Creation date of user record:
  - For Active Directory/Microsoft Exchange, this is the whenCreated attribute of the user object in Active Directory.
  - For IBM Lotus Domino, this is the @Create attribute in the person record.
- A custom property.

Considerations and limitations of SMTP address reuse

It can take up to 20 minutes for Active Directory changes to take effect in the Search Web Service. To force the change to take effect immediately, you can manually restart IIS to flush the Search Web Service’s cache.

It can take up to ten minutes for changes to the SMTP address reuse settings in the EMC SourceOne console to take effect in the Search Web Service. To force the change to take effect immediately, you can manually restart IIS to flush the Search Web Service’s cache.

Prerequisites for SMTP address reuse

If you plan on using a custom property as the hire date of the user, create it in the user directory before you configure SMTP address reuse in EMC SourceOne.

- For Microsoft Exchange, you can repurpose an existing, unused Active Directory extension attribute or you can add a custom attribute. Refer to Microsoft documentation.
- For IBM Lotus Domino, edit the Domino person template to add a custom field. Refer to Domino documentation.

Note the following considerations and limitations for the custom property:

- The custom property can be a String or Date data type.
- For a String custom property, valid date formats are:
  - yyyy/mm/dd
  - dd/mm/yyyy
  - mm/dd/yyyy (Also supports values in the format m/d/yyyy)
  You must include all four digits of the year.

Examples of valid date formats:

07/02/2011
7/2/2011

Invalid date formats include:

m/d/yy
Examples of invalid date formats:

07/02/11
7/2/11

- The hire date attribute for each user will be interpreted as GMT/UTC time.

With the native String type, you can specify only the start day. With native Date types, you can specify the exact start time:

- A custom property of String type provides a hire date with granularity up to the day, but it cannot provide a start time within that day. The day specified will be interpreted as being in GMT time zone, starting at 12:00AM that day. For example, if the hire date is specified as 12/20/10, then all items on or after 12/20/10 at 12:00AM GMT will be returned.

- To specify an exact start time, use a native UTC/GMT Date type. It also reduces the possibility of error when you set the date values for all users.

Procedure for configuring SMTP address reuse

Perform the following procedure to enable SMTP address reuse.

1. In the EMC SourceOne console, browse to the Application Configuration > Web Search > Server Settings tab.

2. The list box lists the mail environments that you specified in the Supported Environments option on the Global Settings dialog box.

   If you have a mixed mail environment, select one mail system in the list box to configure first:
   - Microsoft Exchange
   - IBM Lotus Domino

   If you have only one mail system, then it is already selected in the list box.

3. Select the Limit date range for user searches in checkbox.

4. Perform one of the following steps:
   - To use the date on which the user record was created:
     a. Select the Use creation date of user option.
     b. Click OK.
   - To use a custom property that you defined previously in the user directory:
     a. Select the Use custom property of user option.
     b. In the Custom property name field, type the name of the property that you created previously in the user directory.

       Note: The name you enter in this field must be the same as the name of the custom property in the user directory.

     c. Perform one of the following steps:
– If the custom property that you defined is a String data type, then select the format of the date in the **Date format** field:

```
yyyy/mm/dd
dd/mm/yyyy
mm/dd/yyyy
```

**Note:** The format you select must match the format of the value that you specified for the custom property.

– If the custom property that you defined is a native Date data type, then ignore the **Date format** field.

d. To failover to the creation date of the user record in case the custom property does not exist or it has no value or the date format is not valid, select the Failover to creation date if custom property is empty checkbox.

**Note:** If you do not select the Failover option, and if the custom property does not exist or it has no value or the date format is not valid, then the custom property and creation date of the user are ignored and all items for the user could be returned in Search.

5. If you have a mixed mail environment, perform the following steps for the other mail system.

**Note:** You must specify settings for each mail platform. Settings are not shared among mail platforms.

a. Select the **Limit date range for user searches** in checkbox.

b. To use the date on which the user record was created:

   a. Select the **Use creation date of user** option.

   b. Click **OK**.

c. To use a custom property that you defined previously in the user directory:

   a. Select the **Use custom property of user** option.

   b. In the **Custom property name** field, type the name of the property that you created previously in the user directory.

   **Note:** The name you type in this field must be the same as the name of the custom property in the user directory.

c. Perform one of the following steps:

   – If the custom property that you defined is a String data type, then select the format of the date in the **Date format** field:

```
yyyy/mm/dd
dd/mm/yyyy
mm/dd/yyyy
```

   **Note:** The format you select must match the format of the value that you specified for the custom property.

   – If the custom property that you defined is a native Date data type, then ignore the **Date format** field.
d. To failover to the creation date of the user record in case the custom property does not exist or it has no value or the date format is not valid, select the **Failover to creation date if custom property is empty** checkbox.

**Note:** If you do not select the **Failover** option, and if the custom property does not exist or it has no value or the date format is not valid, then the custom property and creation date of the user are ignored and all items for the user could be returned in Search.

6. Click **OK**.

## Index Validation

Use the index validation feature to monitor the state of index sets and to identify and resolve issues that might lead to inaccurate search results.

With this feature, schedule an index scan or perform manual index scans. The sections that follow provide detailed instructions.

Consider the following limitations when validating indexes within an IPM Archive:

- You can scan rebuilt SourceOne indexes that reside in IPM folders.
- If an IPM Archive contains a mix of EmailXtender and SourceOne formatted indexes, only the SourceOne indexes are validated.
- EmailXtender indexes are only checked to confirm that they exist on the file system.

## Configuring index validation

Perform the following steps to configure index validation.

1. Ensure that at least one Native Archive server in each Native or IPM Archive Folder is configured with the index role.

   Enable the index role by selecting the **Enabled** checkbox in the **Index** tab of the **Native Archive Server Properties** page.
2. In the EMC SourceOne console, expand the Application Configuration node.

3. Double-click the Index Validation Settings node. The Index Validation dialog box appears.

4. Ensure that the Enable Index Validation checkbox is selected.

   When the Enable Index Validation checkbox is selected, every Native Archive server with a configured index role can validate indexes. Several index scanners run on those Native Archive servers.

5. Select a value for the Scan Mode field. The scan mode defines the level at which indexes are validated. Scan mode 1 performs the least amount of checks and scan mode 4 performs the most in-depth validation. The default value for the Scan Mode is two.

   **Note:** The scan intensity is cumulative, meaning that scan mode 2 includes checks specific to that mode plus checks from scan mode 1. Scan mode 4 contains checks from all previous modes.

   The scan includes several modes:

   **Scan Mode 1**
   - For ISYS indexes:
     - Checks if the following files are present: CORRUPT.IDX, MISSINGMSG.IDX, CONTENTCACHEINCOMPLETE.IDX. If these files are present, then the index is not valid.
     - Checks for the availability of ISYS index sets.
     - Checks for the availability of ISYS files.
• For Elasticsearch indexes:
  – Checks if the following files are present: CORRUPT.IDX, MISSINGMSG.IDX, CONTENTCACHEINCOMPLETE.IDX. If these files are present, then the index is not valid.
  – Checks the status of the Elasticsearch index. For example, if the index does not exist, if the index is closed, if the status of the index is red, or if the index is not available.
  – Checks if there are any unindexable documents. If some messages and documents are missing from the index, the index is not valid.

Scan Mode 2
• For ISYS indexes:
  – Checks for all ids in the content cache.
  – Checks for all ids in the ancillary database.
  – Checks that all messages in SQL are indexed.

• For Elasticsearch indexes:
  – Checks that all messages in SQL are indexed.

Scan Mode 3
• Checks for any missing business folders, BCCs, or missing owners.

Scan Mode 4
• Checks all the recipients (to/cc/bcc/unknown) for every message.

6. Optional, select the Fix Mode checkbox.

Note: If the Content Cache attribute is enabled and the Fix Mode checkbox is selected, the SourceOne software schedules an index rebuild scan of any indexes that are marked as problematic.

7. For the Enable automatic fix when the number of problematic indexes less than or equal to field, select a value that represents the maximum number of indexes that are scheduled to be rebuilt.

Note: An automatic fix is performed only when the number of problematic indexes are less than the specified threshold value.

8. Optional, mark the Enable schedule scan checkbox to schedule index scans.

Note: If scans are not scheduled, the scan will need to be performed manually.

9. Click OK.
The following figure illustrates the Index Validation property page.

![Index Validation property page](image)

**Figure 81** Index Validation property page

### Scheduling an index scan

Schedule an automatic index scan for all of your SourceOne indexes.

Indexes that meet the following criteria, can be scanned:

- Completed indexes that are not awaiting the addition of any new data.
- Indexes that have been idle for more than 24-hours.
- Indexes which have been updated since the last index scan.
- EmailXtender indexes that have been rebuilt as SourceOne indexes in IPM archives.

**Note:** Indexes in an IPM Archive that were migrated from EmailXtender and remain in the EmailXtender format are only checked for availability. Consistency checks cannot be run on indexes that were created by EmailXtender.

### Configuring index validation

Perform the following steps to configure index validation.

1. Ensure that at least one Native Archive server in each Native or IPM Archive Folder is configured with the index role.

   You can enable the index role by selecting the **Enabled** checkbox in the **Index** tab of the **Native Archive Server Properties** page.
2. In the EMC SourceOne console, expand the **Application Configuration** node.
3. Double-click the **Index Validation Setting** node. The **Index Validation** dialog box appears.
4. Mark the **Enable schedule scan** checkbox.
5. In the **Days of the week to perform index validation** section, mark the required days.
6. In the **Start time** section, select a start time to trigger the scheduled scan.
7. Click **OK**.

### Manually performing an index scan

Indexes that meet the following criteria, can be scanned.

- Completed indexes that are not awaiting the addition of any new data can be scanned.
- Indexes which have been updated since the last index scan.

Consider the following:

- Only EmailXtender indexes that have been rebuilt as SourceOne indexes in IPM archives can be manually scanned.
- Indexes in an IPM Archive that were migrated from EmailXtender and remain in the EmailXtender format will only be checked for availability. Consistency checks cannot be run on indexes that were created by EmailXtender.

### Manually scanning an index for a month folder or a special index set

Perform the following procedure to manually scan an index for a month folder or a special index set.

1. Ensure that at least one Native Archive server in each Native or IPM Archive Folder is configured with the index role.

   You can enable the index role by selecting the **Enabled** checkbox in the Index tab of the **Native Archive Server Properties** page.

2. Ensure that Index validation has been configured.

   For example:
   - In the EMC SourceOne console, expand the **Application Configuration** node.
   - Double-click the **Index Validation Settings** node. The **Index Validation** dialog box appears.
   - Ensure that the **Enable Index Validation** checkbox is selected.

3. In the EMC SourceOne console:
   - Expand the **Native Archive Folder** node in the left pane.
   - Double-click **Archive Folders**.

4. To scan all indexes in a specific month folder:
   - Select the item that you want to manually submit an index scan for. In the right pane, the name of the selected item appears.
b. Rescan the index:
   - In the right pane, select Rescan.
   - Right-mouse click and then select Rescan.

The following figure illustrates an index scan performed on a month folder.

![Index scan performed for a month folder](image)

Figure 82 Index scan performed for a month folder

5. To scan a specific index:
   a. Select the item that you want to manually submit an index scan for. In the right pane, the name of the selected item appears.
   b. In the lower pane, select the Indexes tab. The list of indexes appears.
   c. Select the index that you want to scan.
   d. Scan the index:
      - In the right pane, select Rescan.
      - Right-mouse click and then select Rescan.

The following figure illustrates an index scan performed for a specific index.
Reviewing the status of an index scan

Complete the following procedure using the console to review the status of every scanned index.

1. In the EMC SourceOne console, expand the Native Archive Folder node in the left pane.

2. Double-click Archive Folders.

3. Select the item that contains the indexes that you would like to review. In the right pane, the name of the selected item appears.

4. In the lower pane, select the Indexes tab. The list of indexes appears.

5. In the bottom pane, the indexes for the selected folder display.

6. Review the Status column:

   - Available — Indicates the default status.
   - Inconsistent — Indicates that the index is incomplete. The scan mode is 1.
   - Missing items — Indicates that an index has missing messages. The scan mode is 1 and 2.
   - Inconsistent content cache — Indicates that an index has a corrupt content cache. The scan mode is 1 and 2.
   - Inconsistent ancillary DB — Indicates that an index has an inconsistent ancillary database. The scan mode is 2.
   - Index unavailable — Indicates that the index set is missing or cannot be accessed. The scan mode is 1.
   - Missing business folder — Indicates that the index is missing business folders. The scan mode is 3.
• Missing file ACE — Indicates that the index is missing the ACE file. The scan mode is 4.

• Missing BCC recipients — Indicates that the index is missing BCC recipients. The scan mode is 3.

• Missing owners — Indicates that the index is missing owners. The scan mode is 3.

• Missing recipients — Indicates that the index is missing recipients. The scan mode is 4.

7. Review the Last Scan Mode column. This column records the mode of the last scan.

Scan Mode 1

• For ISYS indexes:
  – Checks if the following files are present: CORRUPT.IDX, MISSINGMSG.IDX, CONTENTCACHEINCOMPLETE.IDX. If these files are present, then the index is not valid.
  – Checks for the availability of ISYS index sets.
  – Checks for the availability of ISYS files.

• For Elasticsearch indexes:
  – Checks if the following files are present: CORRUPT.IDX, MISSINGMSG.IDX, CONTENTCACHEINCOMPLETE.IDX. If these files are present, then the index is not valid.
  – Checks the status of the Elasticsearch index. For example, if the index does not exist, if the index is closed, if the status of the index is red, or if the index is not available.
  – Checks if there are any unindexable documents. If some messages and documents are missing from the index, the index is not valid.

Scan Mode 2

• For ISYS indexes:
  – Checks for all ids in the content cache.
  – Checks for all ids in the ancillary database.
  – Checks that all messages in SQL are indexed.

• For Elasticsearch indexes:
  – Checks that all messages in SQL are indexed.

Scan Mode 3

• Checks for any missing business folders, BCCs, or missing owners.

Scan Mode 4

• Checks all the recipients (to/cc/bcc/unknown) for every message.

8. Review the Last Scan Date column. This column lists the date of the last scan:

9. Rebuild indexes to correct any of the issues listed in the Status column.
The following figure illustrates the status of an index.

**Figure 84** Reviewing the status of an index
CHAPTER 9
Managing Organizational Policies

This section describes how to manage organizational policies within EMC SourceOne.
Topics include:

◆ Introduction .......................................................................................................... 216
◆ Creating Organizational Policies ............................................................................ 216
◆ Editing organizational policies .............................................................................. 217
◆ Pausing organizational policies ............................................................................. 218
◆ Stopping organizational policies ........................................................................... 218
◆ Deleting organizational policies ............................................................................ 219
Managing Organizational Policies

Introduction

To understand how to manage organizational policies within EMC SourceOne, you must first know what a policy is, what an activity is, and how they relate.

- A policy is a logical grouping of archiving configurations that you define, based on your business practices.

  For example:
  - For Email Management, define a policy for journaling (real-time archiving), and another policy for storage management.
  - For SharePoint archiving, define a separate policy.

A policy contains one or more activities.

- In a policy, an activity defines the configuration for a specific combination of task type, activity extensions, and schedule.

  For example:
  - For Email Management you could create a policy called Archiving for Asia Pacific, which might include two activities: Journaling for Asia Pacific and Historical Archive (Japan).
  - For SharePoint archiving, you could create a policy called “SharePoint Archiving”, which might include several activities, each of which archives content from a different SharePoint site.

Creating Organizational Policies

Perform the following steps to create an organizational policy.

1. In the EMC SourceOne console, select the Organizational Policies node.

   The Organizational Policies area lists existing policies, if any. Expand the policy to see the activities it contains.
2. Select **Action > New Policy**.

3. In the **New Policy** wizard:
   a. In the **Name** field, type a name for the new policy. You can reuse names of previously deleted policies.
   b. In the **Description** field, type a description.
   c. Click **Finish**.

![New Policy wizard](image)

**Figure 86** New Policy wizard

4. Add activities to the policy. Which activities are available depends on what products are installed.

### Editing organizational policies

Perform the following steps to change the description of an organizational policy.

1. In the EMC SourceOne console, select the **Organizational Policies** node.

2. In the **Organizational Policies** list, select the policy you want to edit.

3. Select **Action > Edit Policy**.

4. In the **Edit Policy** wizard, edit the description.

**Note:** Do not rename a policy. Although the **Name** field is editable, problems can occur if you edit the name.
Pausing organizational policies

Perform the following to pause an organizational policy and all its activities.

1. In the EMC SourceOne console, select the Organizational Policies node.
2. In the Organizational Policies list, select the policy you want to suspend.

In the Organizational Policies area, the status of the policy, and all associated activities, changes from Active to Paused.

Resuming a paused policy

Perform the following steps to resume a paused policy.

1. Select the policy.
2. Select Action > Resume.

Stopping organizational policies

Perform the following steps to stop an organizational policy and all its activities.

1. In the EMC SourceOne console, select the Organizational Policies node.
2. In the Organizational Policies list, select the policy you want to stop.
3. Select Action > Stop.

In the Organizational Policies area, the status of the policy, and all associated activities, changes from Active to User Terminated.

Resuming a stopped policy

Perform the following steps to resume a stopped policy.

1. Select the policy.
2. Select **Action > Resume**.

**Deleting organizational policies**

Perform the following steps to delete an organizational policy, and all of its activities and rules.

1. In the EMC SourceOne console, select the **Organizational Policies** node.
2. In the **Organizational Policies** area, select the policy you want to delete.
3. Select **Action > Delete Policy**.
4. At the following prompt, click **Yes**:

   Are you sure you want to delete the selected policy?
CHAPTER 10
Managing Jobs

This section describes how to configure and manage jobs created using EMC SourceOne. Topics include:

- About creating jobs .......................................................... 222
- Viewing the list of jobs ......................................................... 222
- Refreshing a view ............................................................... 224
- Delay in start of Journaling jobs ........................................... 224
- Adjusting a job list when the display limit is reached .............. 224
- Specifying maximum number of jobs to display ................... 224
- Viewing job details ............................................................ 225
- Using a different job view ................................................. 228
- Customizing a job view ...................................................... 228
- Controlling jobs ............................................................. 237
Managing Jobs

About creating jobs

Do not create jobs directly. Jobs are generated automatically from tasks, according to the criteria you specify in policies and activities.

Viewing the list of jobs

To view a list of jobs, in the EMC SourceOne console, expand the EMC SourceOne > Operations > Job Management node.

The results pane lists information about jobs. The default view is the Active jobs view. The following example displays the All jobs view.

![List of jobs](image)

**Figure 88** List of jobs

If SharePoint Archiving is installed, then the SharePoint Archive activity/job type appears in job information.

If EMC SourceOne Discovery Manager is installed, then additional activities/job types are displayed in job information, with the following prefixes:

- DM_Search — Discovery Manager search activity
- DM_Hold — Message hold activity
- DM_Export — Export items from a matter activity
- DM_Delete — Delete items activity

Job columns

The following list describes the columns that can be displayed for jobs.

**Note:** The current view determines the columns that appear.
Managing Jobs

- Icon — Indicates the status of the job.
- Activity ID — Number that uniquely identifies the activity in the database.
- Activity Name — Name of the activity that generated the job.
- Activity State — Status of the activity that generated the job (Active, Paused, or Suspended.).
- End Time — Date and time at which the job finished.
- Job ID — Number that uniquely identifies the job in the database.
- Job State — Status of the job, that corresponds to the icon displayed in the first column.
- Last Active — The date and time that the job was last active.
- Parent ID — The ID of the parent job. To make it easier to distinguish each day’s run, group by Activity Name, then Parent ID. This groups all child jobs associated with a Parent ID, including the parent job.
- Policy ID — Number that uniquely identifies the policy in the database.
- Policy Name — Name of the policy that contains the activity that generated the job.
- Policy State — Status of the policy (Active, Paused, or Suspended).
- Start Time — Date and time at which the job started.
- Task ID — Number that uniquely identifies the task in the database.
- Task State — Status of the task associated with the job.
- Task Type — Name of the task type, such as Journaling, Mailbox Management, or SharePoint Archive. EMC SourceOne Search also generates jobs, identified by the task types Query and Restore.
- Worker Name — Name of the Worker machine that claimed the job.

Job status icons

The icon in the first column in the jobs list indicates the state of the job. Some icons may indicate more than one state. For example, the failed/stopped icon indicates any of the terminated states. To display more specific states, add the Status column. For details about job states, refer to the following table:

<table>
<thead>
<tr>
<th>Status icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="active.png" alt="Active" /></td>
<td>Active — Normal, running job.</td>
</tr>
<tr>
<td><img src="finished.png" alt="Finished" /></td>
<td>Finished — Normal, completed job.</td>
</tr>
<tr>
<td><img src="failed.png" alt="Failed" /></td>
<td>Failed, stopped, or incomplete.</td>
</tr>
</tbody>
</table>
Managing Jobs

### Refreshing a view

To update the list of jobs and view the latest changes, select **Action > Refresh**, or press F5. The list may take a few moments to refresh.

### Delay in start of Journaling jobs

Journaling jobs may take several minutes to start.

Data sources and journaling mailboxes are resolved and synchronized daily. Five minutes are added to the start time:

- To prevent the scheduled start time from occurring before an activity is saved to the database.
- To allow time for the parent job to be created.

It takes a few minutes to resolve the journaling mailboxes. Finally, the child jobs are created.

### Adjusting a job list when the display limit is reached

By default, up to 1,000 jobs are displayed. If the number of jobs exceeds the maximum display limit for the view, the following message and links appears at the top of the job list.

<table>
<thead>
<tr>
<th>Status icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Needs attention icon" /></td>
<td>Job has not been picked up by a Worker, and processing is falling behind.</td>
</tr>
<tr>
<td><img src="image" alt="Suspended icon" /></td>
<td>Normal, but paused. The job can be resumed.</td>
</tr>
<tr>
<td><img src="image" alt="Status unknown icon" /></td>
<td>Status unknown.</td>
</tr>
</tbody>
</table>

#### Table 33  Status icon

![Needs attention icon](image)

**Figure 89  Job List — Links to properties and filter**

- To change the number of jobs displayed, click the maximum number of rows link, and refer to “Specifying maximum number of jobs to display” on page 224.
- To filter the job list, click the filter link, and refer to “Filtering jobs in a view” on page 231.

### Specifying maximum number of jobs to display

By default, up to 1,000 jobs are displayed.
Perform the following procedure to change the maximum number of jobs displayed in the job list.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Maximum Rows Displayed**.
   - The **Maximum Rows Displayed** dialog box appears.

![Maximum Rows Displayed dialog box](image)

**Figure 90** Maximum Rows Displayed dialog box

3. Enter the maximum number of jobs to display, in the range 1 to 99,999.
4. Click **OK**.

**Viewing job details**

Complete the following procedure to view details about a job.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. If the preview pane is not visible below the jobs list, select **Action > Show Preview Pane**.
3. Select the job in the job list.

Details about the job appear in the preview pane below the list of jobs.
Managing Jobs

Job 12

Job ID: 12
Policy name: Policy Job Testing
Activity name: Act 1
Activity type: Archive - Historical
Status: Completed

Start time: 3/31/2009 4:58:54 PM
End time: 3/31/2009 4:59:47 PM
Last Active: 3/31/2009 4:59:39 PM
Machine: XYZ0005
Total number of items processed: 0
Number of failed items processed: 0
Number of discarded items processed: 0
Policy ID: 5
Policy state: Active
Activity ID: 8
Activity state: Success
Task ID: 16
Task state: Exited
Task type: Archive
Parent Job ID: 5


Parent activity: Policy Job Testing/Act 1

Figure 91  Example — Job details in the preview pane

Using the information in the preview pane, you can:

◆ Go to the policy and activity that generated the job by clicking the link next to the Parent activity label in the preview pane.

◆ Review other information about the job including the data sources associated with the job.

Note: By design, messages that fail during journaling because they are corrupt will not be processed. The detailed log will contain entries for the corrupt messages. Corrupt messages are not added to the Number of failed items processed shown in the job details for the activity.

Determining number of data sources associated with a job

Review the Total number of Data sources value on the job detail page to determine the number of data sources (typically mailboxes) associated with a particular job. The information displayed by the Total number of Data sources field differs depending on whether the job is a parent job or a child job. Child jobs are jobs created to perform the work of a parent job.

◆ For parent jobs — The value in the Total number of Data sources field is the total number of data sources associated with all of the child jobs of the selected parent job.

The value in the Data source(s) field is empty; to see all data sources associated with the parent job, review the Data source(s) field for all of the child jobs of the selected parent job.

◆ For child jobs — The value in the Total number of Data sources field is the number of data sources associated with the selected child job.
The Data source(s) field lists all the data sources associated with the selected child job.

**Understanding Processed Count, Failed Count, and Duplicate Count column values**

In the Job Management node, you can view details regarding the number of items processed by a job.

- **Processed Count** — Indicates the count of items processed by the job.
- **Failed Count** — Indicates the count of items that the job failed to process.
- **Duplicate Count** — During job processing, when a duplicate item exists in the database, then the duplicate count increases by one.

If a job’s Task Type is Query or Query Discovery Manager, then the Processed Count, Failed Count, and Duplicate Count columns do not update until the job completes. While the job is running, the values that appear in these columns are always zero.

**Understanding items processed totals**

In the Job Management node, you can view details regarding the number of items processed by a job.

- **Total number of items processed** — Indicates the total number of items processed by the job.
- **Number of failed items processed** — Indicates the total number of items that the job failed to process.
- **Number of duplicate items processed** — During job processing, when a duplicate item exists in the database, then the duplicate count increases by one. For example, consider a situation where there are three items that are named A, B, and C. If a job archives items A and B, then the details that appear in the Job Management node for the job are as follows:
  - Total number of items processed: 2
  - Number of failed items processed: 0
  - Number of duplicate items processed: 0

If a subsequent job archives items A, B and C into the same archive folder, then the details that appear in the Job Management node for the job are as follows:

  - Total number of items processed: 3
  - Number of failed items processed: 0
  - Number of duplicate items processed: 2

If a job’s Task Type is Query or Query Discovery Manager, then the Total number of items processed, Number of failed items processed, and Number of duplicate items processed totals are not updated until the job completes. While the job is running, the values that appear in these fields are always zero.
Managing Jobs

Using a different job view

The default view is the active jobs view.

Perform the following steps to use a different view.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > Job Management node.
2. Select Action > Current View.
3. Select a view.
   
   Refer to the following table for a description of each view.

<table>
<thead>
<tr>
<th>View</th>
<th>Columns</th>
<th>Sort order</th>
<th>Default filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Jobs</td>
<td>• Icon • Job ID • Start Time • Activity Name • Policy Name</td>
<td>Start time</td>
<td>Filters out all non-active job states.</td>
</tr>
<tr>
<td>All Jobs</td>
<td>• Icon • Job ID • Start Time • End Time</td>
<td>Start time</td>
<td>No filter</td>
</tr>
<tr>
<td>All Jobs by Worker</td>
<td>Group by Worker Name, then: • Icon • Job ID • Start Time • Activity State • Policy State</td>
<td>Worker, then Start time</td>
<td>No filter</td>
</tr>
<tr>
<td>Failed Jobs</td>
<td>• Icon • Job ID • Worker Name • Job State</td>
<td>Start time (not in view)</td>
<td>&quot;Status&quot; &quot;Does not contain&quot; &quot;Success&quot;</td>
</tr>
</tbody>
</table>

Customizing a job view

To customize the current view, refer to the following sections.

About view persistence

The changes that you make to a view will persist across sessions.

The following properties of each customized view are saved automatically to the Registry:

- Columns and column order
- Group-by column
- Filter settings
Persistence is maintained per user, per view. Multiple users can customize the same view. Users see only their own customized views. Users cannot see each other’s customized views. View persistence is machine-specific and does not roam.

**Adding or removing columns in a view**

Perform the following steps to add or remove columns in a view.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Current View**.
3. Select the view in which you want to add or remove columns.
4. Select **Action > View > Add/Remove Columns**.
   
The **Choose Columns** dialog box appears.

![Choose Columns dialog box](image)

5. To add a column, select the checkbox next to that column.
6. To remove a column, clear the checkbox next to that column.

   **Note:** Non-indexed columns are not included in the default views. You can add non-indexed columns to views. However, sorting or grouping on a non-indexed column causes the view to render more slowly.

**Changing the order of columns in a view**

Perform the following steps to change the order of columns in a view.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Current View**.
3. Select the view you want to customize.
4. Drag the column header left or right to a new location. Red arrows indicate where to drop the column header.
Managing Jobs

Changing sort order in a column

The direction of the triangle in a column header indicates the direction of sort for that column.

- Up — Ascending (alphabetical)
- Down — Descending

Perform the following procedure to toggle between ascending and descending sort order in a column.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Current View**.
3. Select the view you want to customize.
4. Click the header of the column you want to toggle.

Grouping jobs by column

Organize the display of jobs based on a specific column.

Perform the following steps to group jobs by column.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Current View**.
3. Select the view you want to customize.
4. Select **Action > Enable Grouping**.
5. Drag-and-drop the column to the indicated area above the jobs list.

![Drag a column header here to group by that column](image)

**Figure 93** Group by column prompt

The jobs are now grouped under expandable rows, similar to a tree pane.

![Group by column prompt](image)

**Figure 94** Group by column (task type)
To undo the group by column, select **Action > Disable Grouping**.

**Filtering jobs in a view**

To refine the information displayed in a view, you can create a filter. You can create one filter for each view.

In the Actions pane, the label (Applied) next to the Filter option indicates that a filter is already applied to a view.

Perform the following steps to filter the list of jobs in the current view.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Current View**.
3. Select the view you want to filter.
4. Select **Action > Filter**.
   The **Filter** dialog box appears.

![Figure 95 Filter dialog box](image)

5. In the **Column** field, select the name of the column that you want to filter.
6. In the **Condition** field, select the condition to apply to the column's values. The conditions depend on the data type of the column you selected previously.
7. In the **Value** field, enter or select a value for the column and the condition. Depending on the condition you selected previously, the **Value** field may not be available.
8. Click **Add**.
   The new criterion appears in the list.
Managing Jobs

9. To add another criterion to the list, repeat step 5 through step 8.
   The criteria displays an AND query.
   Use the same column more than one time in a filter. For example, you would use the
   Start Time column twice to specify a date-time range.

10. To remove entries from the criteria list, perform one of the following:
   - Click Clear All.
   - Select the line in the list that you want to remove, then click Remove.

11. To edit a selected entry in the filter:
   a. Select the entry in the criteria list.
   b. Click Edit. The Edit Filter Criteria dialog box appears. Modify the filter entry and
      click OK.

12. Click OK to close the Filter dialog box.

Specifying conditions for string data
The following list describes the conditions available for columns that display string data.
- Is exactly — Includes all of the string you specify in the Value field
- Is Empty — Does not contain any data. The Value field is unavailable for this condition.
- Is Not Empty — Contains any data. The Value field is unavailable for this condition.

Specifying conditions for numeric data
The following list describes the conditions available for columns that display numeric data.
- Is Equal To — Includes only numeric data that exactly matches the number you specify
  in the Value field.
- Is Not Equal To — Includes only numeric data that does not match the number you
  specify in the Value field.
- Is Less Than or Equal To — Includes only numeric data that is less than or equal to
  the number you specify in the Value field.
- Is Greater Than or Equal To — Includes only numeric data that is greater than or equal
  to the number you specify.

Specifying conditions for states
For state data, specify the following.
- Two conditions are available: Is Equal To and Is Not Equal To.
- Select a state in the Value field.

Specifying conditions for time data
Filter jobs by specifying a date or date range, and the time, using the conditions described
in the following list.
Customizing a job view 233

Managing Jobs

◆ On or Before — Select this condition to specify a greater than or equals (≥) date time. For example, selecting this condition for the Start Time column will filter jobs that were started on or before a certain date. Select a date from the calendar and a time from the time picker. The Value field fills in automatically with the date and time you selected.

◆ On or After — Select this condition to specify a greater than or equals (≥) date time. For example, selecting this condition for the Start Time column will filter jobs that were started on or after a certain date. Select a date from the calendar and a time from the time picker. The Value field fills in automatically with the date and time you selected.

◆ Is Empty — Select this condition to test that the column is blank. The Value field is unavailable for this condition.

◆ Is Not Empty — Select this condition to test that the column is not blank. The Value field is unavailable for this condition.

Note: The default date and time is that of the local computer.

You can use combinations of datetime conditions in a filter.

To filter jobs that were created between two dates, use the same datetime column twice: one time with the On or after condition and one time with the On or before condition.

The following example filters jobs that started between May 5, 2007 and August 22, 2007:

Start Time On or after 05/05/2007
Start Time On or before 08/22/2007

Filtering on activity type example

To filter on activity type, use the Task Type column.

This is useful when you want to view only one type of activity, or you want to exclude specific activity types. For example, you can exclude user searches and exports.

In the Filter dialog box, perform the following tasks.

1. In the Column field, select Task Type.
2. In the Condition field, select a condition:
   - To display only a one task type, select the Is Equal To condition.
   - To exclude a task type, select the Is Not Equal To condition.

Figure 96  Filter on Task Type — Conditions

3. In the Value field, select the task type.
Managing Jobs

4. Click Add.

5. To add another criterion to the list, repeat this procedure.

For example, to filter out all user Search jobs:

- Column = Task Type
- Condition = Is Not Equal
- Value = Query

Job states

The following list describes the job states available for the Status column.

- Active — A Worker is processing the job.
- Available — Job was generated and is available for a Worker to pick it up and begin processing it.
- Completed — The job has finished. This state does not imply success or failure.
- Dispatcher Terminated — The job was instructed to terminate itself by Job Dispatcher but was unable to, so Job Dispatcher forcibly terminated the job.
- Expired — The job was never dispatched because the Job Dispatcher became aware of the job after the job’s end time had passed.
- Failed — The job never ran or failed to run.
- Incomplete — The job did not complete within the time allotted for it to run.
- Self Terminated — The job was instructed to terminate itself by Job Dispatcher and did so successfully.
- Suspended — The job was paused by an administrator. It can be resumed.
Managing Jobs

- **Taken** — The job was picked up by a Worker, and the Worker is preparing to start it. The activity component has not started working yet.
- **Unknown** — The job is in an undefined state.
- **User Terminated** — The job was stopped by an administrator using the EMC SourceOne console.
- **Waiting for Resource** — The job is waiting for a Worker to become available.

### Managing custom views

The following section describes how to manage a custom view.

#### Saving a custom view

Perform the following steps to save the changes you made to the current view.

1. Select **Action > Current View > Save As**.
2. In the **Custom Views - Save As** dialog box, type a name for the custom view, then click **OK**.

![Custom Views - Save As](image)

**Figure 99** Custom Views — Save As

The name of the custom view is added to the **Action > Current View** menu. The Current View menu lists the names of the five most recently used custom views.

#### Opening a custom view

Perform the following steps to open a saved custom view.

1. Select **Action > Current View > Custom Views**.
2. In the **Custom Views** dialog box, select a custom view, then click **Open**.
Managing Jobs

Alternatively, select **Action > Current View > name of custom view**. The Current View menu lists the names of the five most recently used custom views.

**Renaming a custom view**

Perform the following steps to rename a custom view.

1. Select **Action > Current View > Custom Views**.
2. In the **Custom Views** dialog box, select a custom view, then right-click and select **Rename**.
3. Edit the name of the custom view.

**Deleting a custom view**

Perform the following steps to delete one or more custom views.

1. Select **Action > Current View > Custom Views**.
2. In the **Custom Views** dialog box, select the views, then right-click and select **Delete**.
Resetting a view

Resetting a view cancels all changes you made to the current view, and changes it to the default view.

**Note:** Reset View only works while you are still in the view. If you make changes to a view, select another view, and come back to the view you changed, you will still see your changes after using Reset View.

Perform the following procedure to reset a view.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > Job Management** node.
2. Select **Action > Current View**.
3. Select the view you want to reset.
4. Select **Action > Reset View**.

Controlling jobs

The following section contains information about controlling jobs.

Active and inactive jobs

You can change the state of an active job. You cannot change the state of an inactive job.

About changing job states

Perform the following actions to control a selected active job:

- Stop
- Pause
- Resume
Managing Jobs

The following figure illustrates the state changes. Unlabeled arrows represent changes made by the EMC SourceOne system:

![State Changes Diagram]

Figure 103  Controlling job states

Controlling jobs procedure

Perform the following tasks to control a job.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > Job Management node.

2. In the job list, select the job(s) you want to control.

   To select more than one job, refer to this table:

<table>
<thead>
<tr>
<th>To select</th>
<th>Use this key/mouse combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single job</td>
<td>Click</td>
</tr>
<tr>
<td>Multiple non-contiguous jobs</td>
<td>Ctrl-Click</td>
</tr>
<tr>
<td>Multiple contiguous jobs (range)</td>
<td>Shift-Click</td>
</tr>
<tr>
<td>From current selection to end of list</td>
<td>Ctrl-Shift-End</td>
</tr>
<tr>
<td>From current selection to top of list</td>
<td>Ctrl-Shift-Home</td>
</tr>
</tbody>
</table>
When you select multiple jobs, the **Stop**, **Pause**, or **Resume** action is enabled if at least one job in the selection is eligible for the action. The action is applied only to the eligible jobs in the selection.

3. Select **Action**, then select the action you want to apply to the selected job(s), as described in the following table:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Action is available when job is in this state</th>
<th>Changes job state to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>Terminates the executing job. The job does not complete.</td>
<td>Active, Available, Paused</td>
<td>User Terminated</td>
</tr>
<tr>
<td>Pause</td>
<td>Temporarily suspends the executing job. The job may be resumed later.</td>
<td>Active, Available</td>
<td>Paused</td>
</tr>
<tr>
<td>Resume</td>
<td>Reactivates a paused job. The job continues executing from the point at which it was paused.</td>
<td>Paused</td>
<td>Active</td>
</tr>
</tbody>
</table>

The available actions vary, depending on the current state of the job.

4. To update the list of jobs and view the latest changes, press **F5** or select **Action > Refresh**. The list may take a few moments to refresh.
Managing Jobs
CHAPTER 11
Common and email-specific best practices

This section describes best practices for using EMC SourceOne.

The following topics are best practices for use with all content types including email, SharePoint, or files:

- Best practices for data retention and disposal
- Common guidelines for specifying archive location paths
- Optimizing Native Archive index performance
- Best practices for setting the volume size
- Best practices for selecting indexing of nested attachments
- Best practices for selecting archive folder organization options
- Best practices for tuning job access to servers
- Being aware of interaction between EMC SourceOne tasks and other scheduled tasks

The following topics are best practices for use only with email content:

- Best practices in email identity management
- Best practices for using rules in email activities
- Best practices for setting date formats on Workers processing Domino content
- When best to use LDAP queries to select data sources
- Best practices for deploying shortcuts
- Understanding historical archiving from Sent or Sent Items
- Improving Office 365 journaling performance by increasing target folders used
- Optimizing EMC SourceOne Search behavior for use with Office 365 content
- Recommendations for improving User Delete performance
- Best Practices for using mapped folders with EmailXtender archives
- Best practices for using Shortcut - Historical or Archive - Historical activities to process EmailXtender data
Best practices for data retention and disposal

EMC SourceOne supports the retention and disposal of data it archives. Review the best practices in the following sections for data retention and disposal with EMC SourceOne.

Apply your organization’s policies for retention and disposal to EMC SourceOne data

Some organizations require that data, such as the content archived by EMC SourceOne, be retained for a period of time and then disposed of after that time. Review your organization’s policies for the retention and disposal of data before setting these options in EMC SourceOne because these policies will have a direct effect on how you configure EMC SourceOne.

Understanding how deletions occur and affect performance

Data can be deleted from the archive by deleting a month of data, or by disposing of the data manually or automatically. When you dispose of data from the archive, you delete data from the following locations.

- Archived data is deleted from the archive storage location, if possible. Some storage devices may be configured to restrict data deletions.
- Metadata associated with the archived data is deleted from the SQL database.
- Indexes associated with the data are deleted from the index storage location (if you created indexes).

While this data is being deleted, an X appears on the folder icon on the folder that contains the data on the Archive Folders page (displayed when the Archive Folders node is selected in the EMC SourceOne console). If the data cannot be deleted, an X and an exclamation point (!) are displayed on the folder icon, and a message about the error is written to the event log on the Native Archive computer with the archive role installed.

When disposing of a large quantity of data, you may want to delay the deletion of the metadata from the database as that deletion may affect the performance of the overall SourceOne system, such as jobs running to accomplish other tasks. Deleting the metadata from the database later when the system is not as heavily used may be a better choice for your environment because there would be less performance impact.
Be aware of interactions of multiple retention settings on data

If you set a retention period on data using EMC SourceOne and also set it using a storage device such as EMC Centera, be aware of the possible interactions of those retention settings.

- Because retention is time-based, it is important that both the storage device and the EMC SourceOne computers have their system times synchronized.

- If the EMC SourceOne retention on the archive folder is longer than the storage device retention on the folder, there are no potential deletion problems. When the EMC SourceOne retention period on the data has elapsed, the data in the folder can be deleted manually or automatically using the automatic disposition feature.

- If the EMC SourceOne retention on the archive folder is shorter than the storage device retention on the folder (either initially or as a result of modifying the retention on the archive folder), and the storage device is configured to enforce that retention (such as when an EMC Centera device is set to Compliance Plus mode), there is a potential deletion problem.

When the EMC SourceOne retention period on the data has elapsed, the EMC SourceOne administrator may attempt to delete the data in the folder, either manually or automatically using the automatic disposition feature.

When EMC SourceOne attempts to perform the deletion, the storage device does not permit the deletion to occur because the data is marked to be retained.

When the deletion cannot occur, EMC SourceOne writes an error indicating that the folder was not deleted to the event log on the computer which has the Native Archive archive role installed.

Common guidelines for specifying archive location paths

How you specify the path to an archive location using the EMC SourceOne console can impact the network usage of the Native Archive when all EMC SourceOne components are installed on a single computer. The following file locations are affected.

- Archive Location field on the Archive Folder Storage Options page
- Index Storage Location field on the Archive Folder Indexing page
- Message Center Location field on the Archive folder on the Archive tab of the Server Properties dialog box
Common and email-specific best practices

Specify all these locations as either Uniform Naming Convention (UNC) paths or as local paths, using the following guidelines:

- Specify these paths as UNC paths when EMC SourceOne components are installed on several computers. This is a typical configuration for medium to large installations.

  When specifying UNC paths for shared locations, such as the Archive Location, the Index Storage Location, or the Message Center Location, you may want to specify them using a DNS server alias rather than the actual server name.

  Using a DNS server alias for shared locations, including NAS device locations, allows for a more flexible installation that makes it easier to change the back-end storage in the future. Consult with your network administrator for what form of UNC path to use in your environment.

  The following are examples of UNC paths:

  ```
  \Server\ShareName
  \DNSServerAliasOfServerorNAS\ShareName
  ```

  **Note:** When adding a UNC path, to avoid indexing issues, remove any trailing backslash ("\") characters.

- Specify these paths as local paths when all EMC SourceOne components are installed on a single computer. Specifying UNC paths for these locations when using a single computer installation may incur additional and unnecessary network bandwidth. The following is an example of a local path:

  ```
  D:\myfolder\n
  ```

  **Note:** When specifying local paths, do not use mapped drives unless they will always be defined for the EMC SourceOne system, and are not defined only for a particular user or group of users.
Optimizing Native Archive index performance

Index processing for the Native Archive is performed by one or more Native Archive Servers that have the index role enabled. The ability to use multiple servers to perform the same logical function is called vertical scalability. The Native Archive allows vertical scalability for all Native Archive Server roles, so you can have one or more Native Archive Servers performing the indexing, archiving, searching, or retrieval roles.

If your current indexing performance is not adequate, you can improve that indexing performance by increasing the number of Native Archive Servers that have the indexing role enabled. However, when this is done, it is important to also consider adding additional index storage locations as these can also help improve index processing. In addition, you can control which indexing operations are available on each indexing server, and balance the resources available to those operations on a per server basis.

Reviewing the index server and index storage location configuration

A Native Archive Server with the index role selected performs the index processing for the Native Archive. This index server writes files to, and reads files from, one or more network file shares that are defined as index storage locations.

The Native Archive supports multiple index servers and multiple index storage locations to make index processing scalable. This support allows the administrator to configure the Native Archive to spread index processing across multiple servers and multiple disks.

When looking to improve index processing performance, the administrator is to consider the topics in the following sections.

Are system problems being caused by index processing?

Review the state of indexes, Worker event logs, and overall system performance to see if they indicate the problems described in “Conditions that indicate you may want to add index storage locations” on page 246.

If these problems exist, adding additional index storage locations may solve these problems.

Are there enough computing resources for index processing?

Review the computing power of the servers being used to process the indexes to see if they are sufficient.

If there is not enough computing power available, add additional index servers. When you add index servers you may also need to add index storage locations to work with those servers.

Assign additional computing resources by adding the index role to one or more existing Native Archive Servers or by adding one or more new servers to the Native Archive and assigning the index role to them. Which choice makes sense will be determined by your hardware and software environment.
Common and email-specific best practices

Are there enough disk resources for index processing?
Review the index storage locations available to the index servers to see if they are sufficient. Indications of insufficient disk resources would include the following.

- Little free space available on any of the index storage locations
- Encountering any of the conditions described in “Conditions that indicate you may want to add index storage locations” on page 246.

If there are not sufficient disk resources, add additional index storage locations or reduce the number of index servers accessing the problematic index storage location.

You assign additional disk resources by adding additional index storage locations and making those resources available to the indexing servers. You assign index storage locations when you create an archive folder or modify an archive folder.

- Assign index storage locations when you create an archive folder.
- Modify an existing archive folder to assign additional index storage locations.

Are disk resources structured effectively for index processing?
Review which index storage locations are available to which index servers to see if they are structured effectively. If certain index storage locations are under or over utilized, modify which index storage locations are available to each index server to correct the problem. Overused index storage locations can cause the problems described in “Conditions that indicate you may want to add index storage locations” on page 246.

Make an index storage location available either to all index servers or only to selected index servers. For example, if you have six index servers and two index storage locations, you could select three index servers to use one storage location and have the other three index servers use the other storage location. Alternatively, you could have all index servers access all index storage locations. Which configuration makes sense will be determined by your hardware and software configuration.

Select which index storage locations are available to which index servers when you create an archive folder or modify an archive folder.

Conditions that indicate you may want to add index storage locations
Consider adding index storage locations and associating them with index servers if any of the following occur.

- Indexing performance remains slow even after adding an additional index server. The additional index server may have solved a lack of processing ability, but you may still be having problems with indexing storage.
- One or more index storage locations are filled or nearly filled with data.
- Inconsistent indexes appear in the EMC SourceOne console. Inconsistent indexes can be created when EMC SourceOne cannot write to the index storage location. Inconsistent indexes cannot be searched.
- Delayed Write Failed error messages are displayed in the event log on an index server. This indicates that EMC SourceOne cannot write to the index and may result in indexes becoming inconsistent.
This is a warning level message and may have one of several event sources depending on your environment. The following is an example of such a message:

**Event Type:**       Warning  
**Event Source:**     MRxSmb  
**Description:**      (Delayed Write Failed) Windows was unable to save all the data for the file \Device\LanmanRedirector. The data has been lost. This error may be caused by a failure of your computer hardware or network connection. Please try to save this file elsewhere.

### Tuning index operation performance

Tune the performance of index operation processing by using the Component limit per index action area on the Index tab of the Properties page for a selected Native Archive index server.

This area allows you to specify the maximum number of processes to be used on the specified index server for each of the possible index actions:

- Add
- Delete
- Repair
- Update

The default values for the index processing operations are adequate for typical installations, however you may want to change these values if you are experiencing indexing performance problems, or for other reasons.

#### Configuring index operation performance for User Delete scenario

In some scenarios when deploying the User Delete capability to a large number of users, or a small number who will use it extensively, an administrator may want to modify the index performance settings as follows, depending on the number of index servers available.

- If a single Native Archive index server handles several types of index operations, reduce the value of the Delete index action field to be 1 on that server to limit the number of resources used to process delete requests. This will decrease the chance that users of the User Delete capability will overburden that index server.

- If there are multiple Native Archive index servers, dedicate one or more servers to process only index deletions, by setting a value of 4 in the Delete field and 0 in the Add, Repair, and Update fields on the index server. Other servers could retain their default index settings if the dedicated index deletion server absorbs the additional processing used by the User Delete capability.

#### Configuring index operation performance to reduce rebuild backlog scenario

In this scenario, an administrator has a backlog of indexes that need to be rebuilt, and wants to reduce this backlog during the weekends when users are not heavily using the system.

To reduce the number of indexes that need to be rebuilt in the system, the administrator temporarily increases the value of the Repair field to the maximum of 4 on all his index servers during the weekend so that as many indexes as possible are rebuilt.
At the end of the weekend, the administrator resets the value of the Repair field to the previous value (lower than 4) on those index servers so that other indexing operations are not slowed during the work week.

Best practices for setting the volume size

The Maximum Volume Size (MB) field on the Archive Folder Storage Options page allows you to specify the maximum size (in MB) of individual volumes in the archive folder. When a volume reaches the maximum volume size, it is closed and a new volume is created.

The default value for this field is 100 MB. You can change this default value to be from 10 MB up to 10000 MB (10 GB).

Be aware of the following effects of setting the value of the Maximum Volume Size (MB) field:

◆ After the value of the Maximum Volume Size (MB) field is set, it cannot be changed using the EMC SourceOne console.

◆ If you are planning to use DiskXtender to write EMC SourceOne files to an EMC Centera device, change the value of the Maximum Volume Size (MB) field to 90 MB, instead of the default size of 100 MB. There are known performance issues when retrieving volumes of 100 MB and greater from an EMC Centera device. Setting the volume file size to 90 MB allows for slight overflow of the volumes before they are closed, while keeping the total volume file size to under 100 MB.

◆ If you set the Maximum Volume Size (MB) field to a value greater than 2048 (2 GB), you will receive a warning indicating that this may make your archiving and retrieval operations take longer.

◆ Setting a higher value on the Maximum Volume Size (MB) field has the following effects:
  • Fewer volumes will be created, but each volume will be larger.
  • While those volumes are open, the Native Archive message center directory will have more temporary files in it than if the volumes were smaller. This means the message center directory will use more space than if the volumes were smaller.
  • Deletions of individual objects (such as messages or documents) from a volume, will take longer when the volume from which they are deleted is larger.

◆ Setting a lower value on the Maximum Volume Size (MB) field has the reverse effects of setting a higher value:
  • More volumes will be created, but those volumes will be smaller.
  • While those volumes are open, the Native Archive message center directory will have fewer temporary files in it than if the volumes were larger. This means the message center directory will require less space than if the volumes were larger.
  • Deletions of individual objects (such as messages or documents) from a volume will take less time when the volume from which they are deleted is smaller.
Best practices for selecting indexing of nested attachments

If attachment indexing is enabled, you can use the Index nested subcontainers in attachments option to select whether subcontainers in attachments are to be indexed.

Selecting the Enable indexing option on the archive folder indexing page causes any content archived in that archive folder to be indexed. Additionally, selecting the Attachment Indexing option causes attachments to that content to be indexed.

If a content attachment contains a file container, such as those created by PKZIP for Windows, files in that container will be indexed if the Index nested subcontainers in attachments option is selected. This includes file containers nested in other file containers if those file containers are not password protected.

By default, all new and existing indexes will have this option disabled.

The following information is to be considered when using this option:

◆ When the Index nested subcontainers in attachments option is selected, it will only apply to content archived and indexed after the selection was changed in the EMC SourceOne console. Existing indexes will remain as they are and will need to be rebuilt to be affected by the change to the option.

◆ If the Index nested subcontainers in attachments option is changed while an archive folder is having content archived into it, it is recommended that you rebuild the one or more indexes for that archive folder so that all content in the one or more associated indexes has the attachment subcontainers processed in the same way.

◆ If the content you are indexing contains a large number of nested subcontainers, you may find that enabling this option causes your indexing to take more time to complete. Because you are enabling the potential indexing of more content, more indexes may be created and more disk space may be consumed by the resulting indexes.

◆ Password protected containers or subcontainers cannot be accessed for indexing and so will not be indexed.

Best practices for selecting archive folder organization options

The EMC SourceOne Native Archive contains data in archive folders which can be organized either by month (using the By Date option) or by legal matter (using the By Matter option) using the Organization Options page of the New Archive Folder wizard.

◆ If you are creating an archive folder to contain any other kind of data aside from a legal matter, you must select the By Date option.

◆ If you are creating an archive folder to contain a legal matter that was created by Discovery Manager, you can select either the By Date or By Matter option.

Advantages of using archive folders organized by matter

When creating and selecting archive folders to contain legal matters created using Discovery Manager, there are advantages to using archive folders organized by matter rather than using archive folders organized by date.
Common and email-specific best practices

Matters are deleted more quickly
Legal matters stored in an archive folder organized by matter are deleted more quickly than those stored in an archive folder organized by date, because the matter content can be accessed and deleted more efficiently by the EMC SourceOne system.

Matter indexes can be managed more easily
Managing the indexes of a matter can be done more easily if the related archive folders are organized by matter rather than by date, because there is only a single folder of indexes to manage, rather than several folders of indexes if the archive folders are organized by date.

Indexes may require management, such as needing to be deleted or rebuilt. Performing these tasks on a single folder of indexes, created from a single archive folder organized by matter, is easier than performing the tasks on typically multiple folders of indexes, created from multiple archive folders organized by date.

This is especially likely if the contents of the matter spans several months or years of time, which would cause the matter to be spread across several month folders if the archive folder is organized by date.

For example, if the content that is part of a matter was created during a 6 month period, the matter would be contained in 1 matter folder if the archive folder is organized by matter, but in 6 month folders if the archive folder is organized by date. The minimum number of indexes to be managed would be 1 index if the archive folder is organized by matter, and 6 indexes if the archive folder is organized by date.

Matter Indexes are quicker to search
Indexes generated from archive folders organized by matter are quicker to search than those organized by date. The indexes generated from an archive folder organized by matter are quicker to search for the following two reasons.

◆ Only one folder of indexes needs to be searched rather than several folders of indexes as would typically be the case for archive folders organized by date. Searching fewer indexes allows the search to complete more quickly.

◆ Because the indexes are created from an archive folder organized by matter, the indexes contain only data about the matter, so no extraneous information needs to be searched, and the search can then complete more quickly.

Restrictions on using archive folders organized by matter
There are some restrictions to using archive folders organized by matter that may make using archive folders organized by date a better choice. These restrictions are described in the following sections.

Only Legal Hold mapped folders can be used with archive folders organized by matter
Only Legal Hold mapped folders can be associated with archive folders organized by matter.

If you create a mapped folder that is not a Legal Hold mapped folder, and associate it with an archive folder that is organized by matter, the following message is issued:

Archive folders created with the By Matter option cannot be used with this type of mapped folder. Select an archive folder created with the By Date option for this type of mapped folder.
Virtual Container storage types not supported for archive folders organized by matter

Only create archive folders that are organized by matter if the storage type of the archive folder has not been set to be Virtual Container.

If the storage type is set to Virtual Container on the Storage Options page, the following message is issued when you try to select the By Matter option on the Organization Options page:

Virtual archive folders cannot be organized by matter. Select another organizing method.

Retention cannot be set on archive folders organized by matter

Only create archive folders that are organized by matter if retention has not been specified for that archive folder. If the Months to retain field on the Storage Options page has been set to a value other than 0, the following message is issued when you try to select the By Matter option on the Organization Options page:

Archive folders that have retention enabled cannot be organized by matter. Select another organizing method.

Archive folders organized by matter use different deletion processes than those organized by date

Archive folders organized by matter follow a different deletion process than those that are organized by date.

- Archive folders organized by date can be deleted from the EMC SourceOne console using the Delete Folder action, even if it contains subfolders of data (months or matters) and is associated with a mapped folder.

  Refer to the section “Deleting archive folders” in “Configuring Archives” on page 51 for more information about deleting archive folders, including best practices.

- Archive folders organized by matter can be deleted from the EMC SourceOne console only when the following is true:

  No matters are stored in the archive folder. You can delete matters within Discovery Manager.

  After this condition is met, you can use the Delete Folder action to delete the archive folder organized by matter. If this condition is not met, the Delete Folder action will not be available for use when the archive folder organized by matter is selected.

Best practices for tuning job access to servers

Use the Servers node in the EMC SourceOne console to control Worker Servers. You can use the Tuning tab displayed by the Servers node to control how many EMC SourceOne jobs can simultaneously connect to your Domino, Exchange, or SharePoint servers.

The following are the conditions that may cause you to increase or decrease the number of jobs that you allow to simultaneously access your mail server:

- If the performance of your SharePoint or mail servers is significantly impacted by the jobs connecting to them, you may want to reduce the number of jobs connecting to each these servers by reducing the server limit value.
Common and email-specific best practices

**Note:** Reducing the number of jobs that can access each server may increase the amount of time it takes for an activity to complete, because it may cause some of the activity jobs to wait to access the server.

You may also want to reduce the default server limit value so that any newly discovered servers get the reduced value automatically.

- If your servers are not impacted by the current number of activity jobs connecting to them, and activities complete in a workable amount of time, there is no need to modify the server limit value.
- If the performance of your servers is not impacted by the activity jobs connecting to them, and you want to shorten the time it takes for an activity to complete, you may want to increase the number of jobs connecting to each these servers by increasing the server limit value.

You may also want to increase the default server limit value so that any newly discovered mail servers get the increased value automatically.

Being aware of interaction between EMC SourceOne tasks and other scheduled tasks

EMC SourceOne uses the Microsoft Windows scheduler to schedule jobs. These jobs all are named with the prefix ExTask followed by a number, such as ExTask1132 or ExTask1133.

Verify that no other scheduled tasks are created with the same name prefix as the EMC SourceOne task names. Creating scheduled tasks with names in this form can cause them to be mistakenly deleted by the EMC SourceOne job scheduler when it performs certain maintenance tasks.

Best practices in email identity management

To conduct effective and complete compliance or legal discovery searches on a specific person, all known variations of the system identifiers associated with the person must be available for use as search criteria.

When executing searches, EMC SourceOne uses the address information stored in the current global address book for the mail environment. Because EMC SourceOne does not programmatically maintain historical address information, it is up to companies to manage this information themselves. This document provides recommendations on how to maintain this information and conduct effective compliance or legal discovery search results.

What is identity management?

In a typical environment, users are added and deleted from global address books on a daily basis. In addition, email address information for a user can change over time due to name changes, company mergers and acquisitions, the use of aliases, and other factors. Identity management consists of managing the correlation between a real person and the system identifiers associated with this person over time.
These recommendations assume that you are starting from a particular point in time and want to set up a methodology to capture and manage historical address information going forward. For environments that require assistance with discovering historical address information over a specific period of time in the past, contact EMC Professional Services.

**Managing historical address information**

Employ a methodology to track when former employees are removed from the Global Address List (GAL) in Microsoft Exchange, or the Name and Address Book (NAB) in Lotus Domino. Also track changes to user address information which occur over time, for example, domain name changes due to company mergers, name changes, email address formatting changes. At a minimum, the methodology it to involve recording the following information.

- Name
- Employee ID
- All address forms used and effective dates for each

For example, address information for a Lotus Domino user named John Doe could include the SMTP, domain and canonical forms of the address shown below:

- SMTP — John_Doe@legato.com, john.doe@emc.com
- Domain — John Doe/Boston/Legato/EMC
- Canonical — CN=John Doe/OU=Boston/OU=Legato/O=EMC

Similarly, address information for a Microsoft Exchange user named John Doe could include the SMTP, canonical/Distinguished Name, and X.500/Distinguished Name forms of the address as shown below:

- SMTP — John_Doe@legato.com, john.doe@emc.com
- Canonical/Distinguished Name — /O=EMC/O=Legato/OU=Boston/CN=recipients/CN=JohnDoe
- X500/Distinguished Name — /O=EMC/O=Legato/OU=Seattle/CN=recipients/CN=JohnDoe

**Configuring legacy addresses for existing users**

For users who still exist in the Microsoft Exchange GAL or Lotus Domino NAB, you can include other known addresses as a legacy address in the properties of the corresponding user on the mail server. When EMC SourceOne executes a search, it automatically includes the legacy address information in the search.

For example, if employee Jane Doe marries and changes her name to Jane Smith, you can make the name change to Jane.Smith@emc.com in the GAL or NAB and add the legacy address Jane.Doe@emc.com to the properties for Jane Smith on the mail server. Subsequent searches on Jane.Smith@emc.com return email addressed to both Jane.Smith@emc.com and Jane.Doe@emc.com.
Configuring legacy addresses in Microsoft Exchange

Perform the following steps to add legacy email address information for a user in Microsoft Exchange.

1. Log in to the domain with an account that has Exchange administrator rights, and view the properties of the user to whose profile you want to add a legacy address.

   Access user properties by selecting Active Directory Users and Computers from the Administrative Tools menu, expanding the Users node (beneath the domain server node), and double-clicking on a user name.

2. Activate the E-mail Addresses tab and click the New button. The New E-mail Address dialog box appears.

3. Open the Other Address Properties dialog box, select Custom Address and click OK.

4. In the E-mail address text box, enter the user’s legacy address.

5. In the E-mail type text box, enter LEGACY.

6. Click OK.

7. Repeat the previous steps for additional legacy addresses you want to include.

Configuring legacy addresses in Lotus Domino

Perform the following steps to add legacy email address information for a user in Microsoft Exchange.

1. From the Start menu, select Programs > Lotus Applications > Lotus Domino Administrator.

2. Enter the password when prompted. The Domino Administrator appears.

3. Click the People and Groups tab.

4. Expand Domino Directories, and then expand the address book.

5. Click People. Contacts appear in the main pane.

6. Double-click the user to whose profile you want to add a legacy address. The person record appears, starting with the Basics tab.

7. Double-click within the Short name/User ID area so that it becomes editable.

8. Move to a new line, and enter the legacy address.

9. Click Save and Close to save changes and return to the Administration - People & Groups page.

Best practices for using rules in email activities

Activities that allow you to archive email messages also allow you to use rules to determine which of those messages are archived and into what folder the messages are archived.
Best practices for setting date formats on Workers processing Domino content

Do not set the Microsoft Windows short date format (set using the Regional and Language Options applet in the Control Panel) on computers used to perform Domino message processing activities to the following value.

dd-mmm-yy (for example 21/Jun/12)

This short date format causes those activities to not process correctly.

When best to use LDAP queries to select data sources

There are situations when a Lightweight Directory Access Protocol (LDAP) query is the best, or only, method to use to select a data source for an activity.

Review the following information to select when and how to use LDAP queries with EMC SourceOne:

◆ For summary information about how to create an LDAP query for use by EMC SourceOne, refer to “Selecting data sources using LDAP overview” on page 352.
◆ For detailed information about creating LDAP queries refer to the RFC 1650 and RFC 2252 specifications at:
  http://ldapman.org/ldap_rfcs.html
  Additionally, you may want to review one of the many books on using LDAP.

Use LDAP query to focus data source and improve processing speed

When you select the data source for an activity, you can select it from a server hierarchy, from the address book, or as a result of an LDAP query.

Using an LDAP query to select the data source for an activity can shorten the amount of time it takes for the activity to complete because it can eliminate unnecessary processing.

◆ When creating an archive activity, rather than selecting the mail server from which to archive and then using rules to fine tune exactly which messages in which mailboxes you want to archive, use an LDAP query to precisely select the mailboxes you are interested in and so limit or avoid the overhead of server or address book lookup and rule processing.

  Define your data source as precisely as possible so that any rule you define has to look at as small a group of messages as possible to find matches for the rule. In some cases, you may not need to create any rules at all.

◆ When creating a shortcut activity, rather than selecting a data source by server hierarchy or by address book, use an LDAP query to precisely select the mailboxes you are interested in and so limit or avoid the overhead of server or address book lookup.
Common and email-specific best practices

Use LDAP query for related activities

If several activities are related and you want to use an LDAP query to select the data source for one of them, consider using the same LDAP query to select the data source for all the activities.

Reusing the same LDAP query for a data source in related activities makes maintaining those activities easier. If you need to modify the LDAP query for one of the activities, you can more easily modify it for the related activities. For example, if you want to both archive and shortcut messages from the same data source, use the same LDAP query to select the data source in both cases.

Use LDAP query to process mailboxes excluded from a distribution list or group

In some cases, you may want to archive or shortcut messages based not on what mailboxes are included in a distribution list or group, but on what mailboxes are excluded by a distribution list or group. For example, you may want to have all messages to members of the temporary-employee distribution list or group archived into one folder and messages to all other employees archived in another folder.

An LDAP query is the easiest and most maintainable way to archive or shortcut messages based on what mailboxes are not listed in a distribution list or group. Note that you can define rules only to archive what is in a distribution list, not on what is not in a distribution list.

LDAP query data source example

The following is an example of using an LDAP query to select a data source.

In this example, the EMC SourceOne administrator wants to process messages on an Exchange mail server as follows.

- Separate email addresses into two groups using a distribution list:
  - Email addresses in the distribution list constitute one group. This group of messages will be retained for seven years.
  - Any email that was sent to an address that was not part of the seven year retention distribution list would be part of the other group, and would be retained for three rather than seven years.
- Archive email into two different folders with different retention periods. One set of email will be retained for seven years and all other email will be retained for three years.
- Shortcut the email in both the seven year retention folder and the three year retention folder.
To perform the tasks described above, the administrator does the following.

- Creates and runs two **Archive - Historical** activities for each Exchange server:
  - An **Archive - Historical** activity to archive messages sent to members of the seven year retention distribution list. The data source for this activity is selected using the following LDAP query:
    \[
    (&(msExchHomeServerName=/o=suxen/ou=First Administrative Group/cn=Configuration/cn=Servers/cn=ABCENEX2003) (memberof=CN=7 Years DL, OU=USOperations, DC=abcen, DC=emc, DC=com))
    \]
  - An **Archive - Historical** activity to archive messages sent to all email addresses that are not part of the seven year retention distribution list.
    \[
    (&(msExchHomeServerName=/o=suxen/ou=First Administrative Group/cn=Configuration/cn=Servers/cn=ABCENEX2003)(!memberof=CN=7 Years DL, OU=USOperations, DC=abcen, DC=emc, DC=com))
    \]

- Creates and runs two **Shortcut - Historical** activities for each Exchange server:
  - A **Shortcut - Historical** activity to shortcut messages sent to members of the seven year retention distribution list. The data source for this activity is selected using the same LDAP query as that used for the seven year retention Archive - Historical activity.
  - A **Shortcut - Historical** activity to shortcut messages sent to all email addresses that are not part of the seven year retention distribution list. The data source for this activity is selected using the same LDAP query as that used for the non-seven year retention Archive - Historical activity.

**Note:** The previously listed LDAP queries do not work across multiple domains and so will not function in an environment with multiple domains in a single forest. To modify the previous LDAP queries to work across multiple domains, select the Active Directory global catalog as the LDAP server for the queries because the global catalog contains objects from multiple domains in the same forest. When you select the global catalog as the LDAP server, the port number must be changed from 389 to 3268 and the search base distinguished name must be left blank.

Avoid using Exchange distribution lists or Domino groups when defining folder permissions or activities using LDAP

Using Exchange distribution lists or Domino groups within LDAP queries can cause problems when defining folder permissions or archiving activities.

When an LDAP query contains an Exchange distribution list or a Domino group (such as CN=GroupName), LDAP returns only the name of that list or group.

- When such a query is used within EMC SourceOne, in all cases other than within address rules, only the list or group name is returned.
- When such a query is used in within a rule, EMC SourceOne automatically expands that list or group name to list the members of that list or group prior to processing the rule.
Do not use distribution lists or groups within an LDAP query when defining folder permissions or archiving activities, because this will cause only the list or group name to be processed instead of the list of users who are members of that list or group.

Instead, select the distribution list or group from the Exchange Global Address List (GAL) or the Domino Directory, which will cause all members of the list or group to be used.

**Review existing LDAP server settings after upgrade**

After upgrading Email Management, review the values of the following LDAP server options to ensure they are correct for your environment.

- Review the Use Microsoft ADSI option value on the Select Data Sources dialog box.
- Review the Server supports Microsoft ADSI search option value on the LDAP Server Configuration dialog box.

After upgrading Email Management, the LDAP server options have the following values for each LDAP server:

- By default, the new Server supports Microsoft ADSI search option on the LDAP Server Configuration dialog box is not enabled.
- The existing value (enabled or not enabled) for the Use Microsoft ADSI option on the Select Data Sources dialog box is retained after the upgrade.
  - If this option had not been enabled before the upgrade, it is still marked as not enabled.
  - If this option had been enabled before the upgrade, it remains enabled, but is grayed out to indicate that the administrator is to review the setting and perhaps modify it.

To enable the use of the Use Microsoft ADSI option, modify the value of the Server supports Microsoft ADSI option on the LDAP Server Configuration dialog box for that LDAP server; this causes the Use Microsoft ADSI option to be editable for that server.

After modifying the value of the Server supports Microsoft ADSI option to enable the Use Microsoft ADSI option, verify that the Server supports Microsoft ADSI option is set correctly (enabled or disabled) for the LDAP server.
Best practices for deploying shortcuts

Use EMC SourceOne’s ability to shortcut Domino or Exchange messages and attachments to significantly reduce the amount of storage needed for email within an organization. When a shortcut is created, a message or message attachment is removed from an Exchange or Domino server and replaced by a much smaller (about 4 kilobytes) message shortcut which points to the full message or attachment in the EMC SourceOne archive.

Deploy shortcuts in an organization using a strategy that accounts for both all technical issues and also accounts for the impact on email users. Not having a shortcutting strategy can cause problems for email server administrators, EMC SourceOne administrators and email users. These problems may include:

- Performance problems for an EMC SourceOne server or email server when trying to create or restore shortcuts.
- Users being unable to restore shortcuts using their email client.
- Users having long email synchronization times when using Notes local replicas or Outlook cache mode.

Shortcutting best practices for both Exchange and Domino environments

The following best practices apply to environments that contain Exchange servers, Domino servers, or both.

Create and publish a plan for deploying shortcuts

Before you deploy shortcuts in your organization, create and publish a plan for that deployment. Creating and deploying according to a plan will make the use of shortcuts as seamless as possible for the email users while providing maximum savings in message storage. The deployment plan is to at a minimum cover the topics in the following sections.

Preparing for shortcutting messages

List any preparations you need to make before beginning to shortcut messages. This may include the following.

- Setting up a pilot environment in which to test your shortcutting procedures.
- Verifying the EMC SourceOne is archiving all messages as you would expect before beginning the shortcutting process.
- Installing any needed support for mobile users who routinely work disconnected from the email server. This may include creating local mail file replicas for Domino mobile users.

Processes used to create shortcuts

List the processes you will use to create shortcuts.

- The process used to initially create the shortcuts, including:
  - When you will run EMC SourceOne to initially create the shortcuts, such as at midnight every night.
Common and email-specific best practices

- What criteria you will use to initially create the shortcuts. For example, you may determine that you will create shortcuts for all messages more than three years old first. When that is complete, create shortcuts for all message that are more than two years old, and so on.

- The process you will use to continue to create shortcuts.
  
  After all shortcuts are initially created, you will need to continue to create new shortcuts as needed. Schedule when that processing will occur and what criteria you will use for selecting the messages to be shortcut. For example, you may want to shortcut all messages with large attachments that are older than 90 days.

**Communicating with email users about shortcut usage and impact**

List what information you want to communicate to users and how and when those communications will occur. This information may include the following.

- What a shortcut is and how it helps keep email accounts smaller in size and more manageable.

- Any changes in the user environment made to accommodate shortcuts, such as creating local mail file replicas.

- What criteria you are using to determine what messages are shortcut. For example, these criteria may include what message size and message age qualifies a message for being shortcut.

- When shortcuts will be enabled for your email users.

**Shortcut large and rarely accessed messages**

When you create message shortcuts, you want to reduce your email storage without inconveniencing your email users. You can accomplish this by shortcutting messages that are both large and rarely accessed.

- Large messages are messages that have attachments that are larger than 100 kilobytes.

  Shortcutting large messages allows you to maximize the amount of storage you reclaim while shortcutting relatively few messages. This is because even though large messages are not numerous, their size causes them to occupy a large amount of email storage.

  Shortcutting only large messages (instead of all messages) reduces the number of shortcuts that need to be created and that will need to be synchronized between email clients and email servers, if using Outlook cache mode or Domino local mail file replicas.

  **Note:** Shortcut only message attachments and do not shortcut the body of a message. There is very little storage savings in shortcutting message bodies and creating such shortcuts inconveniences users.
- Rarely accessed messages are typically messages that are older than 90 days.

  Shortcutting rarely accessed messages allows you to shortcut messages that users will not often restore from the EMC SourceOne archive. This means that user email performance will not be heavily impacted by these shortcuts and the EmailXtender server will not have to frequently restore these shortcuts.

  Avoid creating shortcuts to email that is actively used (newer than 90 days) for the following reasons:

  • Any storage savings gained from shortcutting newer active messages is only temporary and is lost as soon as the message is opened and restored.

  • EMC SourceOne will continually process active messages, either to create shortcuts to the message after it is restored, or to restore the message after the corresponding shortcut is opened. This may impact the performance of EMC SourceOne and possibly impact the performance of the mail server.

Use a phased approach: shortcut the oldest messages first

  When rolling out the initial use of shortcuts in an organization, create the shortcuts incrementally. Typically you perform incremental shortcutting by processing the oldest email messages first, and more recent messages later. The more email you have stored on your servers, the more valuable it is to use an incremental approach.

  For example, you could initially shortcut attachments to messages that were older than 730 days. After those shortcuts were created, you could shortcut all messages that were older than 670 days, and so on in 90 day increments until you have reached your shortcut policy goal (such as having all messages older than 90 days shortcut).

  Using an incremental approach based on message age has the following advantages:

  • Shortcutting older email first allows you to process the majority of your email (which is older email) and reclaim valuable email storage while impacting relatively few email users. In addition, because these messages are less likely to be opened as a result of them being older, very few of the shortcuts that you create are restored and so need to be recreated.

  • Shortcutting email in smaller more manageable groups based on message age allows you to spread out the processing EMC SourceOne performs to create the shortcuts.

  • An incremental approach to shortcutting allows email shortcuts to be synchronized between the email client and the email server in small amounts after each batch of shortcuts is created which minimizes the delay the email client experiences when opening and synchronizing with the email server.

  Avoid taking a large archive of messages and shortcut all messages for all users that are older than 90 days at one time. Doing so will cause shortcut creation to take a very long time and will cause users to have a long wait while their mailboxes initially open and synchronize after the shortcuts are created.

Delete messages and shortcuts from mail server if possible

  Another strategy for reducing email storage is to use EMC SourceOne to delete older messages and shortcuts from the mail server (typically messages older than a year or more). Typically, these messages are archived by EMC SourceOne so the messages are not lost.
Verify that messages have been archived by EMC SourceOne before deleting them from the mail server. Also, consider your organization’s email retention plans when considering deleting messages from the mail server.

You delete messages and shortcuts using the Delete activity.

Users wanting access to these messages can search for them by performing an end-user search using Search. If the organization does not want to allow user access, then an administrator can perform an administrative search using Search to search for user email upon request.

**Shortcutting best practices for Domino environments**

This section contains shortcutting best practices that apply only to environments that contain Domino servers.

**Use local mail file replicas**

Use local mail file replicas to minimize the amount of shortcut retrieval performed. Replication is a native capability of Domino. When you create a local replica of the mail file, the Shortcut Extension Manager add-in replaces the shortcut stub within the Notes message with the original message before Domino replicates the message to the local replica.

Ideally, do not begin shortcutting messages until existing users who require local replicas create them. The creation of local replicas containing shortcuts has a high performance impact because every shortcut must be retrieved when creating the replica.

**Configure an EMC SourceOne server locator record for each Domino server**

By default, EMC SourceOne shortcuts use a single EMC SourceOne server locator record in the public name and address book (NAB). This locator record is a Domino person record with the name EMC SourceOne Shortcut. The Comments field in the Miscellaneous tab for this user contains a list of EMC SourceOne shortcut retrieval servers for all Domino servers.

In an environment using one EMC SourceOne server, a single locator record is sufficient. However, in environments with multiple EMC SourceOne servers, specify a separate EMC SourceOne server locator record for each Domino server so that shortcuts will be requested first from the EMC SourceOne server associated with each Domino server, limiting the amount of failover.

Specify additional locator records using the notes.ini variable ExShortcutServerLocatorPerson. This variable overrides the default locator record and allows each Domino server to have its own person record and, therefore, its own list of EMC SourceOne servers to retrieve shortcuts.

Perform the following steps to create a shortcut locator record.

1. Create a new person record in the public NAB (such as DominoServer1 Shortcut).
2. Modify the person record to add a list of EMC SourceOne servers in the desired search order to the Comments field on the Miscellaneous tab.
3. Define the ExShortcutServerLocatorPerson variable to indicate the new person record by adding that variable to the notes.ini file on the Domino server as follows:
   
   ```ini
   ExShortcutServerLocatorPerson=DominoServer1 Shortcut
   ```
Disable transaction logging on ExShortcut.nsf in high volume environments

The EMC SourceOne shortcut cache database, ExShortcut.nsf, is created the first time the Domino server is run after installing the EMC SourceOne shortcut extension manager. In high volume email environments, disable database transaction logging of the EMC SourceOne shortcut cache database.

Disable transaction logging of the EMC SourceOne shortcut cache database, ExShortcut.nsf, by completing the following task.

1. After installing the EMC SourceOne shortcut extension manager, delete the existing EMC SourceOne shortcut cache database, ExShortcut.nsf. This file was created when you installed the EMC SourceOne shortcut extension manager.

2. Add the following line to the Domino server notes.ini file:

   ExDisableShortcutTXNLogging=1

3. Restart the Domino server.

Exclude selected Domino tasks from retrieving shortcuts

Domino server tasks, such as Adminp or the agent manager, can create server performance problems when they access documents that have been shortcut. When these tasks access documents that have been shortcut, they can cause those shortcuts to immediately be restored from the EMC SourceOne server, potentially causing a performance problem on the Domino server, the EMC SourceOne server, or both.

To prevent this problem, exclude selected Domino tasks from restoring shortcuts. Note that the Domino agent manager is excluded automatically by EMC SourceOne and does not need to be specified.

You exclude tasks from restoring shortcuts by specifying the EmailXtenderShortcutExclude variable in the Domino server notes.ini file by completing the following task.

1. Identify the tasks that you want to exclude from shortcut processing. Typically at least the Adminp task is excluded.

2. Modify the notes.ini file on the Domino server to add the EmailXtenderShortcutExclude variable. The value for this variable is the name of one or more executables that are to be excluded. If multiple executables are listed, they are separated with commas.

3. Restart the Domino server.

For example, adding the following line to the notes.ini file excludes the Adminp and Example tasks from restoring shortcuts (note that the Example task is not an actual task and is shown only to illustrate the comma list syntax):

   EmailXtenderShortcutExclude=Adminp,Example

When a task is excluded from restoring shortcuts, a message indicating that action is written to the Domino server console log. Review the log to see what tasks are excluded from restoring shortcuts.
Common and email-specific best practices

Best practices for using Legal Hold folders

There are several best practices that you can follow when using Legal Hold folders. Refer to “Configuring Mapped Folders” on page 125 for a list of these best practices.

Understanding historical archiving from Sent or Sent Items

Use the Archive - Historical activity to archive messages from the Notes Sent view or the Outlook Sent Items folder. When you use the Archive - Historical activity to archive items from this view or folder, it is important to understand the following:

◆ Items in the Sent view or Sent Items folder have not necessarily been successfully received by the recipients listed on the message. Typically these messages are received, but if the mail server encounters a problem, they may not be received by the intended recipients.

◆ When you use the Archive - Historical activity to archive messages from the Sent view or Sent Items folder and that message contains one or more distribution lists, the users in those distribution lists will not be listed as recipients of that message in the EMC SourceOne archive and will not be listed as owners of the message.

◆ A Notes message that is archived from the Notes Sent view can appear in an archive as two messages with different Message IDs. This situation occurs when:

1. The Notes message is sent to an external and an internal address.
2. The Notes message is journaled.
3. The Notes message is archived by using an Archive - Historical or a Shortcut - Historical activity.

Messages that are sent to external and internal addresses include different content which results in the creation of different Message IDs. Messages that are sent to external addresses contain MIME. Messages that are sent to internal addresses do not contain MIME.

Improving Office 365 journaling performance by increasing target folders used

If needed, increase the performance of a Journal activity processing Office 365 content by increasing the number of target folders used by the Journal activity.

One processing job is created for each defined target folder for that activity, so to have more messages processed simultaneously, increase the number of target folders in use.

Refer to “Modifying SMTP Journaling Groups” on page 463 for how to increase the number of target folders used.
Optimizing EMC SourceOne Search behavior for use with Office 365 content

How EMC SourceOne Search handles Office 365 email content can be modified by using the Web Search dialog box from the Application Configuration node of the EMC SourceOne console.

Recommendations for improving User Delete performance

The following sections discuss how to improve the performance of User Delete activities.

Folder Conversion utility

The Folder Conversion utility affects the performance of the following:
- SQL Server, due to metadata updates to the EMC SourceOne Archive database.
- EMC SourceOne Native Archive Server with the Index role, due to ownership updates.

To improve performance for folder conversion:
- Add EMC SourceOne Native Archive Servers that have the Index role.
- Use the Folder Conversion utility to schedule folder conversion for off-peak hours.
- If you plan to run folder conversion during peak hours, use the Folder Conversion utility to reduce the number of threads.
- After folder conversion completes, run database maintenance on the SQL Server.

Journaling to Personal or Community mapped folders

Journaling to a Personal or Community folder rather than an Organization folder affects the performance of the following:
- EMC SourceOne jobs, due to longer run times.
- SQL Server, due to metadata being added to the EMC SourceOne Archive database.

To improve performance of journaling to a Personal or Community mapped folder:
- Increase the number of Journaling jobs on EMC SourceOne Workers.
- Add EMC SourceOne Workers.

Message deletion through the mail client (Delete - User Initiated Delete activity)

The Delete - User Initiated Delete activity processes user requests to delete messages through the mail client.

Perform the following to improve the performance of the Delete - User Initiated Delete activity.

1. Schedule the Delete - User Initiated Delete activity to run at a time when other activities are not running.
2. Increase the number of connections to the mail server. Refer to “Tuning Worker Server job access to servers” on page 163.

3. Increase the number of Delete - User Initiated Delete jobs on EMC SourceOne Workers.

4. Add EMC SourceOne Workers.

5. Add EMC SourceOne Native Archive Servers that have the Archive role.

**Message deletion through EMC SourceOne Search**

Perform the following to improve the performance of message deletions through EMC SourceOne Search.

1. Increase the number of Delete jobs on EMC SourceOne Workers.

2. Add EMC SourceOne Workers.

3. Add EMC SourceOne Native Archive Servers that have the Archive role.

**Best Practices for using mapped folders with EmailXtender archives**

If you are connecting EmailXtender archives to Email Management and associating mapped folders with those archives, be aware of the best practices for creating those mapped folders and using EmailXtender archives.

**Best practices for using Shortcut - Historical or Archive - Historical activities to process EmailXtender data**

If you have both Email Management and EmailXtender in your environment, and you have journaled EmailXtender data and want to create shortcuts of that data to save space, you have the following options for performing so.

- The easiest method is to use the EmailXtender Archive and Shortcut tasks to journal and shortcut content until EmailXtender is replaced by Email Management as the active email archiving system, and then journal and shortcut new content using Email Management by performing the following tasks.

  1. Use EmailXtender to journal and shortcut journaled content initially using the Archive and Shortcut tasks.

  2. Discontinue EmailXtender journaling and shortcutting.

  3. Use the EMC SourceOne Email Management Journal and Shortcut - Historical activities to journal and shortcut content.

- Use EmailXtender to archive the content, and use Email Management to shortcut by performing the following tasks:

  1. Use the EmailXtender Archive task to archive content from the user mailboxes.
2. Use the EMC SourceOne Shortcut - Historical activity to create shortcuts from the messages archived by EmailXtender by selecting the folder containing the archived content, and specifying the Process only previously archived items option on the Item Types page for that activity.

- Use the Archive - Historical activity to archive EmailXtender content that has not been shortcut. Note that this may cause that content to be stored in both the EmailXtender and the Email Management archives.

1. Use the Archive - Historical activity to archive the EmailXtender content into Email Management.

2. Use the Shortcut - Historical activity to create shortcuts from the archived messages by selecting the mapped folder containing the archived content, and specifying the Process only previously archived items option on the Item Types page for that activity.

Note: Creating shortcuts from content in Exchange public folders is handled differently.
Common and email-specific best practices
This section describes how to enable and use job logs using EMC SourceOne. The following topics are included in this section:

- Introduction to job logs ................................................................. 270
- Enabling and disabling job logging .................................................. 270
- Viewing job logs .............................................................................. 271
- Where to find job logs ................................................................. 271
- Understanding information in the job log ...................................... 271
- Computing mailbox reduction from email activities ...................... 275
Introduction to job logs

Certain activities allow you to create log files that contain more information about the content processing performed by jobs. This information is more detailed than the summary information displayed by the Job Details area for that job.

This more detailed information is useful in understanding how content is processed by the job. And if you encounter problems in processing, may be useful in detecting and correcting such problems.

It is important to note that a single activity may create multiple jobs, and each job will have their own job log.

Enabling and disabling job logging

To enable the creation of job logs, select the Enable Detailed Logging option on the Activity Name page for the activities which support this option. The following activities support the Enable Detailed Logging option:

- Archive - Historical
- Archive - Personal Mail Files
- Archive - User Directed Archive
- Delete - Historical
- Delete - User Directed Archive
- File Archive - Historical
- File Delete - Historical
- File Restore - Historical
- Migrate - Microsoft Office Outlook .PST
- SharePoint Archive
- Shortcut - Historical
- Shortcut - User Directed Archive
- Update Shortcut - Historical

Normally, you do not have the creation of job logs enabled because collecting this data consumes some system resources. Enable it only when you need detailed information about the message processing for that job.

To disable the creation of job logs, click the Enable Detailed Logging option so that it is no longer selected on the Activity Name page.
Viewing job logs

View job log information by performing the following tasks.

1. Select the job about which you want to view log information by using the EMC SourceOne console and navigating to the Job Management node.

2. Select the job from the job list displayed in the Preview pane. If the preview pane is not visible below the job list, select Action > Show Preview Pane.

3. In the Jobs Detail area, select the For more detailed job information, click here link. The log file will display.

If the link is not displayed, job logging was not enabled for this job. Refer to “Managing Jobs” on page 221 for more information about how to manage jobs and use the Job Details area.

Where to find job logs

Job log messages are written to files in the job logging directory specified during installation of the Worker.

By default, this directory is:

\mapped-network-drive:\EMC SourceOne\JobLogs\

The EMC SourceOne Email Management Installation Guide describes setting the job log file directory during the installation process.

The log file name is formed by taking the job identifier, expressed in hexadecimal, and prefixing it to the name DETMSG and then adding the .log file name extension. For example, the log file for the job with the identifier 123456 would be 1E240DETMSG.log. Note that the job identifier is expressed as a decimal number in the EMC SourceOne console.

Understanding information in the job log

Each job log file has three separate sections.

Understanding job initialization information

The initialization information for a job is very similar for all jobs and contains the following.

◆ The job number and when it started.
◆ Whether the input provider could be successfully accessed.
◆ The container processed.
◆ The size of the container before beginning the job processing.

This example displays the initialization information for an Archive - Historical activity job used to archive mail from a Domino mail server.
Using Job Logs

Example - Job initialization information in an Archive - Historical job log

Folders to Process:
Input provider 'ExNotesProvider.CoExNotesProvider' is successfully initialized.

Processing Mail Container: Alana N Raysor/QAE5 (CN=Alana N
Raysor/O=QAE5)
Mailbox size before archiving messages: 18.63MB

Processing Folder: (Mail Threads), Type: 32768
Archive ->MsgId:
47A0B97E9D3876AE6CD93B1D2A551D669F8AE38CEA1677B000,
Subject: Message 16 Date: 2007-05-21T17:53:04

Understanding job processing information

The processing information for a job is very similar for all jobs and contains the following.

◆ The name of the container being processed.
◆ The content in the container that was processed and how it was processed.
◆ Summary information about the processing of each container.

“Example - Job processing information in an Archive - Historical job log” on page 273
displays an example of an Archive - Historical activity job used to archive mail from a
Domino mail server. Examples for an Exchange mail server or a SharePoint server would
be similar.

In “Example - Job processing information in an Archive - Historical job log” on page 273
the following messages appear:

◆ The name of the mail folder being processed. The log displays that the Mail Threads
folder was being processed:
Processing Folder: (Mail Threads), Type: 32768

◆ The messages in the folder that are being processed and how they are processed. The
log in “Example - Job processing information in an Archive - Historical job log” on
page 273 indicates that a message was archived from the mailbox:
Archive ->MsgId:
47A0B97E9D3876AE6CD93B1D2A551D669F8AE38CEA1677B000, Subject: Message 16 Date: 2007-05-21T17:53:04

In another log file, the following message indicates that a message was shortcut:
Shortcut ->MsgId:
48AC54EB539F61A89DA85A342B13F12321372B6ED3BC165300, Subject: Multi
WMF Images Date: 2007-12-07T17:31:23

In another log file, the following message indicates that a message was deleted:
Delete -> MsgId: N/A, Subject: What is the form of a draft message
Date: 2008-07-31T22:14:51
Message deleted. Subject: What is the form of a draft message, Date:
2008-07-31T22:14:51
After the processing for each mailbox is completed, summary information for that mailbox appears before processing begins on the next mailbox. The summary information for the Mail Threads mailbox is shown in the following log:

Mailbox size after archiving messages: 19.13MB
Job(101) -> Total messages processed: 38 Size: 5.63 MB

Although not shown in "Example - Job processing information in an Archive - Historical job log" on page 273, any errors encountered during processing would also be listed with the job processing messages.

In the following log, a message about the successful creation of a message shortcut is followed by an unsuccessful attempt to create a message shortcut:

Shortcut ->MsgId:
47A0B8B08D3F5CD31DC7ED391DC56EEABFF5DFF88566500, Subject: Fw:
Message 10 Date: 2007-05-21T17:49:38

Shortcutting message failed. MsgId:
47A0B9929C0FC5E425DA669AF27E14DA102EE84F7D069400, Subject:
Message 15 Date: 2007-05-21T17:51:44

Example - Job processing information in an Archive - Historical job log

The following is an example.

...  
Processing Folder: (Mail Threads), Type: 32768
  Archive ->MsgId:
47A0B97E9D376AE6CD93B1DA551D669F8AE38CEA16777B000, Subject: :
Message 16 Date: 2007-05-21T17:53:04
  Archive ->MsgId:
47A0BF521BC2421267D06ED59F8516ACC0C087E115538F00, Subject: :
Message 17 Date: 2007-05-21T18:17:55
  Archive ->MsgId:
47A0BF8F083E3FO5D78B1AC768A89947B25EB8FBDAEB1AA500, Subject: :
message 9 Date: 2007-05-21T17:33:44
  Archive ->MsgId:
47A0B561CFCD33D52DF4C1ABEDF58BCF19A4482AC8360B00, Subject: :
Message 10 Date: 2007-05-21T17:35:31
  Archive ->MsgId:
47A0BF9E0DC2E11FB3AC130ADC08217375A0442D0C3D8BA5100,
  88B9308DC055BA724200, Subject: New Todo 5 Date:
  2008-07-26T15:22:09
  Archive ->MsgId:
49E358A1704EDA92098A2DD87B052816F9EE21A11CE253B000, Subject: New
Todo 3 Date: 2008-07-26T15:22:09
  Processing Folder: ($All), Type: 262144
  Processing Folder: ($Calendar), Type: 1
  Processing Folder: ($Contacts), Type: 2
  Processing Folder: ($Drafts), Type: 8
Mailbox size after archiving messages: 19.13MB
Job(101) -> Total messages processed: 38 Size: 5.63 MB
...
Using Job Logs

Understanding job summary information

The summary information for a job contains similar information for all jobs. “Example - Job summary information in an Archive - Historical job log” on page 274 displays summary information for an Archive - Historical activity job used to archive mail from a Domino mail server. The job summary information lists the following.

- The size of the container after processing the content.

  In “Example - Job summary information in an Archive - Historical job log” on page 274, the log displays that the mailbox size was 3.26 MB after being processed:

  Mailbox size after archiving messages: 3.26MB

- The total number of pieces of content processed by the job and their total size.

  In “Example - Job summary information in an Archive - Historical job log” on page 274, the log file indicates that job 175 processed a total of 6 messages with a total size of 3.25 MB.

  Job(175) -> Total messages processed: 6 Size: 3.25 MB

- The number of containers processed and the number of pieces of content in those containers that were processed.

  In “Example - Job summary information in an Archive - Historical job log” on page 274, the log file indicates that 2 mail containers (mailboxes) were processed.

  Total mail containers: 2

Example - Job summary information in an Archive - Historical job log

The following is an example.

- Mailbox size after archiving messages: 3.26MB
  Job(175) -> Total messages processed: 6 Size: 3.25 MB
  Total mail containers: 2 Total messages processed: 6 Size: 3.25 MB
Computing mailbox reduction from email activities

The following activities can create jobs which reduce the amount of storage used by a mailbox.

- Delete - Historical
- Delete - User Directed Archive
- Migrate - Microsoft Office Outlook .PST
- Shortcut - Historical
- Shortcut - User Directed Archive

You can determine how much storage was reduced for a mailbox by analyzing the job log for the job that processed that mailbox and comparing the size of the mailbox before and after processing. Using “Example - Job log from a Delete - Historical activity” on page 275 as an example, perform the following.

1. Locate the log message listing the size of the mailbox before processing.
   
   Mailbox size before archiving messages: 17.34MB

2. Locate the log message listing the size of the mailbox after processing.

   Mailbox size after archiving messages: 17.05MB

3. Subtract one from the other. In this example, 17.34 - 17.05 indicates that 0.29 MB were saved by the message deletions.

Example - Job log from a Delete - Historical activity

The following is an example.

Folders to Process:
Input provider 'ExNotesProvider.CoExNotesProvider' is successfully initialized.

Processing Mail Container: Alana N Raysor/QAE5 (CN=Alana N Raysor/O=QAE5)

Mailbox size before archiving messages: 17.34MB

Processing Folder: ($Calendar), Type: 1
Processing Folder: ($Drafts), Type: 8
  Delete -> MsgId: N/A, Subject: What is the form of a draft message
  Date: 2008-07-31T22:14:51
  Message deleted. Subject: What is the form of a draft message,
  Date: 2008-07-31T22:14:51
Processing Folder: ($Inbox), Type: 16
Processing Folder: ($JunkMail), Type: 1024
Processing Folder: ($Sent), Type: 256
  Delete -> MsgId: N/A, Subject: A message for Ted to Reply to
  Date: 2008-07-31T22:14:51
  Message deleted. Subject: Delivery Failure Report message
  Date: 2008-07-31T22:14:51
  Delete -> MsgId: N/A, Subject: A 2nd message for Ted to Reply to
  Date: 2008-07-31T22:14:51
  Delete -> MsgId: N/A, Subject: A message for Ted to Reply to
  that has attachment
  Date: 2008-07-31T22:14:52
  Message deleted. Subject: A 2nd message for Ted to Reply to
  that has attachment
  Date: 2008-07-31T22:14:52
  Message deleted. Subject: A message for Ted to Reply to
  that has attachment
  Date: 2008-07-31T22:14:52
Processing Folder: ($SoftDeletions), Type: 270340
Processing Folder: ($ToDo), Type: 512
Processing Folder: ($Trash), Type: 4Certain

Mailbox size after archiving messages: 17.05MB
Job(212) -> Total messages processed: 4 Size: 0.00 MB
Total mail containers: 0 Total messages processed: 4 Size: 0.00 MB
CHAPTER 13
Maintaining EMC SourceOne

The following sections describe the EMC SourceOne maintenance tasks that are common to all content types as well as those that are email management-specific. The following topics are included in this section:

◆ Daily Maintenance Tasks (common and email-specific) ......................................... 278
◆ Performing a backup of an EMC SourceOne system ............................................... 282
◆ Restoring an EMC SourceOne system after backup ................................................ 291
◆ Maintaining the EMC SourceOne databases (common).......................................... 292
◆ Infrequent Maintenance Tasks (common and email-specific)................................. 306

Refer to the *EMC SourceOne for Microsoft SharePoint Administration Guide* for information about maintaining SharePoint archiving components.

Refer to the *EMC SourceOne for File Systems Administration Guide* for information about maintaining file archiving components.
Daily Maintenance Tasks (common and email-specific)

To ensure that EMC SourceOne is functioning correctly and that content is being processed and archived as you intend, verify the health and correct operation of the EmailXtender system daily by performing the maintenance tasks in the following sections.

In addition to the daily tasks there are other less frequent tasks that need to be performed regularly:

- Perform backups of the EMC SourceOne system
- Perform database maintenance
- Perform other less frequent maintenance tasks

The following are daily maintenance tasks for an EMC SourceOne system:

- Review the status of all EMC SourceOne system computers.
- Review the status of all EMC SourceOne jobs.
- Review the event logs for potential problems relating to EMC SourceOne.
- Review the storage occupied by the EMC SourceOne archive.
- Review the status of storage volumes and searchable indexes.
- Email-specific: Review journaling mailboxes to see if there are any unprocessed messages.
- Email-specific: Review Journal activity directories for SMTP messages that need to be manually reprocessed.
  - For messages encountered when using the Journal activity with the SMTP data source type.
  - For messages encountered when using the Journal activity with the Microsoft Office 365 data source type, refer to the section on reprocessing Office 365 Exchange journal reports.

Review status of all EMC SourceOne system computers

Review the network status of all EMC SourceOne system computers to make sure there are no connectivity problems.

Perform the following steps to review the status of all EMC SourceOne computers.

1. Use a network management tool (such as the ping command) to verify network connectivity to all computers used by EMC SourceOne:
   - EMC SourceOne Master Server and Worker Server computers
   - EMC SourceOne database server computers
   - EMC SourceOne Native Archive Servers
   - Any other servers with which the EMC SourceOne system interacts (such as mail servers or SharePoint servers)
   - The primary domain controller for the domain in which the EMC SourceOne system is used
Review activity job status

Review the status of all jobs created by EMC SourceOne activities to make sure they are functioning properly.

Use the Job Management node of the EMC SourceOne console to review the status of the activity jobs. Using the Job Management node is described in “Managing Jobs” on page 221.

At a minimum, review the following status fields:

- Review the Activity State field to make sure the activity is correct.
- Review the Job State field to make sure the jobs completed as expected.

If the status fields indicate a problem, gather additional information by performing the following:

- Review the event log for the Worker on which the job ran
- Review the job log file for the job if it was enabled. “Using Job Logs” on page 269 describes how to enable and use job logging.

Review event logs

Events that can effect the EMC SourceOne system are reported in the EMC, Application, and System event logs. Periodically review those logs to examine if any unexplained or problematic events have occurred in EMC SourceOne, or any of the software EMC SourceOne uses, or the operating system.

It can be useful to create your own MMC application that loads the event logs from all the machines you monitor. “Creating a custom event log monitor for all EMC SourceOne computers” on page 77 describes how to create such an event log monitor.

Perform the following procedure to view these event logs using the Microsoft Windows Event Viewer.

1. On the computer on which you want to view the event log, select Programs > Administrative Tools > Event Viewer from the Start menu.
   
   The Event Viewer appears. The left pane lists the following event logs: Application, Security, System, and EMC.
   
   The EMC log is installed by EMC SourceOne. The other logs are installed as part of the operating system.
   
2. To see a list of events in a log, click the log in the left pane.
3. To see the details of an event:
   a. In the right pane, right-click the event.
   b. Select Properties from the shortcut menu.

In some cases, you may be directed by EMC Support personnel to also review other information or log files associated with the product.

**Review available storage space**

As content is archived, the amount of space used by EMC SourceOne to contain those messages grows. Review the amount of storage used and available on the servers you use to store EMC SourceOne content (including database servers or Native Archive computers).

If the computers containing the messages or their associated databases run out of space, EMC SourceOne will no longer be able to archive messages.

**Review storage volumes and searchable index status**

Review the creation of archival storage volumes and searchable indexes to make sure they are performing as expected.

Review the status of volumes and indexes using the EMC SourceOne console.

In the Native Archive, a large number of open volumes may indicate that EMC SourceOne is having problems closing volumes, which may indicate that something is wrong with the storage drive (which is the extended drive, if you are using DiskXtender), or that the drive to which the volume is being written may be full.

**Email-specific: Review journaling mailboxes or databases for unprocessed messages**

In some cases, EMC SourceOne may encounter a problem transferring a message from an Exchange journaling mailbox or a Domino journaling database to EMC SourceOne. These messages are then not processed by EMC SourceOne.

The handling of these messages is different for each type of mail server:

- Messages that could not be transferred from an Exchange mail server are moved to the Sent Items folder of the Exchange journaling mailbox for processing later.

  The SourceOne administrator must review the Sent Items folder for these messages periodically and copy them to the Inbox folder of the journaling mailbox to attempt to reprocess them.

  If a message remains in the Inbox folder for a long time (such as a day or more) this indicates that there is a problem either with the message or the system. Have the administrator check the event log for a possible problem.

- Messages that could not be transferred from a Domino mail server are moved to the Bad Documents Folder of the Domino journaling database. Periodically, the ExProcBadDocs.exe agent takes messages from the Bad Documents Folder, places them in an NSF file and then places the NSF file into a message as an attachment. It then puts that message back in the All Documents view of the journaling database for processing.
If a message from a Domino mail server still cannot be processed, it is placed in the Bad Data Folder. An administrator must check the Bad Data Folder for these messages periodically and copy them back to the All Documents view of the journaling database to attempt to process them.

If a message remains in the Exchange Inbox folder or the Domino All Documents view for a long time (such as a day or more) this indicates that there is a problem either with the message or the system. Have the administrator check the event log for a possible problem.

**Email-specific: Reprocessing Journal activity SMTP messages**

In some cases, the Journal activity cannot process certain SMTP messages and so places them into a different folder for manual reprocessing.

The following section describes how to reprocess those SMTP messages.

Refer to “Using the Journal Activity for Office 365 Content” on page 453 for information about reprocessing Exchange journal reports received from an Office 365 environment.

**Overview of reprocessing SMTP messages**

When SMTP is selected as the data source type for a Journal activity, that content is received by the Journal activity as an SMTP message.

When the Journal activity cannot process an SMTP message, that message is placed in the Baddir folder created within the Drop directory where the SMTP message was originally accessed by the Journal activity.

The message is moved to the Baddir folder so that the following occurs.

- The message is not continually being processed by EMC SourceOne Email Management.
- The message is more easily found by the administrator for manual reprocessing.

The Baddir directory is created as a subdirectory of the IIS SMTP Drop directory (`\IIS\Drop\Baddir`) the first time an SMTP message cannot be processed by the Journal activity.

In many cases, reprocessing a message corrects the processing problem, because many problems are temporary.

The following sections describe why SMTP messages may need to be reprocessed and how to perform that processing.

**Causes for SMTP messages to not be processed**

The following are reasons an SMTP message may not be processed by the Journal activity.

- There is a problem with the format of the message.
- The message cannot be separated into its components by the Email Management unpacker.
- The SMTP message cannot be placed in the Native Archive for some reason, such as there being a network issue.
Maintaining EMC SourceOne

- One or more data source directories had a network connection problem and could not be accessed by Email Management.
- One or more Email Management servers failed during processing, possibly because of operating system problems.

SMTP message reprocessing procedure

Perform the following steps to reprocess SMTP messages that could not initially be processed by the Journal activity.

1. Navigate to the one or more Baddir directories for the Journal activity for the SMTP data source.

   Email Management creates a Baddir directory when needed as a subdirectory of each specified data source directory (typically the IIS Drop directory). Each of these Baddir directories will need to be reviewed for messages that may need reprocessing.

   **Note:** There are possibly several Baddir directories for the Journal activity when SMTP is selected (one for each Drop directory), but only one Journaling issues folder when Microsoft Office 365 is selected as the data source for the Journal activity.

2. Select an SMTP message from the one or more Baddir directories and move it to the data source directory specified for this activity so that it will be processed again.

3. If the SMTP message is not processed after several attempts, record any event log messages about the processing of the SMTP message, and contact EMC Software Support for assistance.

Performing a backup of an EMC SourceOne system

Because the EMC SourceOne system is a distributed system composed of many components, performing a backup of those components must be done in a particular order to be successful.

To perform a backup of the EMC SourceOne system, suspend the operations of the various components in the correct order. After the backup has completed, you can then resume the operation of those components again in the correct order.

“Restoring an EMC SourceOne system after backup” on page 291 describes how to restore an EMC SourceOne system from backup.

The following is the ordered procedure for performing a backup of an EMC SourceOne system.

1. Before beginning the backup process, review how EMC SourceOne behavior is changed during the backup procedure.

2. If not previously installed, install the EMC SourceOne scripts for performing a backup of the EMC SourceOne system.

3. Suspend any other applications that make use of EMC SourceOne, such as Discovery Manager, prior to suspending EMC SourceOne itself.

4. Suspend the operation of the EMC SourceOne activities and Workers.

5. Suspend the operation of the archives you are using with the EMC SourceOne system.
6. Perform a backup of the EMC SourceOne system and archive computers.

7. When the backup has completed on all computers, resume the operation of the archives.

8. Resume the operation of the EMC SourceOne system.

9. Verify the operation of the EMC SourceOne system after it has resumed operation.

10. Resume any other applications that make use of EMC SourceOne, such as Discovery Manager, after resuming EMC SourceOne itself.

**EMC SourceOne behavior during the backup process**

While the EMC SourceOne system is suspended and being backed up, the following changes in behavior will occur.

- The current state of the EMC SourceOne system, activities or jobs can be viewed, but are to not be changed. Worker Servers cannot be added or removed from the system.

- Scheduled jobs may expire during the backup if their schedule causes them to expire while the backup is taking place.

- Jobs will be suspended and will maintain their state without any failure or loss of data when they resume after the backup is complete.

- Which jobs are suspended depends on which suspend script is used:
  - If the ES1_ActivitySuspend.vbs script is used to suspend activities for backup, all user initiated jobs will be suspended.
  - If the ES1_ActivityBackupSuspend.vbs script is used to suspend activities for backup, all user initiated jobs except EMC SourceOne Search search jobs will be suspended.

  During this suspension, user interactions with the EMC SourceOne Search application can occur and the jobs created as a result of that interaction will function correctly during the backup process. All other job types will be suspended.

- Administrators are to review the EMC SourceOne system to verify that no Native Archive archive folders are in the process of being deleted before beginning the backup process.

  If a Native Archive archive folder is being deleted when the backup process occurs, the deletion will be paused and then continue to occur after the EMC SourceOne system is restored. However, pausing and continuing the deletion may cause problems and are to be avoided.
Installing and using the EMC SourceOne suspend for backup scripts

The EMC SourceOne backup scripts used to suspend and resume the EMC SourceOne system and Native Archive are located on the EMC SourceOne kit in the \Utility\Backup folder and named as described in this table.

**Table 37** EMC SourceOne backup scripts

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ES1_ActivitySuspend.vbs</td>
<td>Suspends all Workers prior to backup, does not allow searches</td>
</tr>
<tr>
<td>ES1_ActivityBackupSuspend.vbs</td>
<td>Suspends all Workers prior to backup, but allows searches</td>
</tr>
<tr>
<td>ES1_NativeArchiveSuspend.vbs</td>
<td>Suspends the Native Archive archives prior to backup</td>
</tr>
<tr>
<td>ES1_NativeArchiveResume.vbs</td>
<td>Resumes the Native Archive archives from a suspended state</td>
</tr>
<tr>
<td>ES1_ActivityResume.vbs</td>
<td>Resumes Workers from a suspended state</td>
</tr>
</tbody>
</table>

These scripts are provided as Microsoft Visual Basic Scripting Edition (VBScript) source files. Use the cscript command to run these scripts from the command line as follows:

C:\> cscript ES1_ActivitySuspend.vbs

The previous example displays how to run this command on a 32-bit version of a Microsoft Windows operating system. The following example displays how to run this command on a 64-bit version of a Microsoft Windows operating system:

C:\> C:\Windows\SysWOW64\cscript ES1_ActivitySuspend.vbs

These scripts can be run from any computer that has the EMC SourceOne console installed using an account that is part of the EMC SourceOne security group. Refer to the *EMC SourceOne Email Management Installation Guide* for more information about the EMC SourceOne security group.

These scripts can be used as is, or customized and integrated into existing backup procedures. The scripts do not use command line parameters, so any changes to the scripts must be made by editing the scripts. The script variables most likely to be changed by administrators are defined in the scripts as global variables and are described in this table.

**Table 38** Frequently modified backup script variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>timeout</td>
<td>Is the amount of time in seconds that the script will wait before exiting if it does not complete. If the value is set to a value of 0 or less, the script will not exit until it completes. The default value is 3600 (1 hour). If you do not want the script to wait for an hour, you can shorten this time by reducing the value to a shorter period.</td>
</tr>
<tr>
<td>pollInterval</td>
<td>Is the amount of time in seconds that the script will wait before polling the Worker Server state. The default value is 10.</td>
</tr>
</tbody>
</table>
Performing a backup of an EMC SourceOne system

Maintaining EMC SourceOne

Suspending applications that use EMC SourceOne

Prior to suspending the EMC SourceOne system, suspend any other applications that make use of EMC SourceOne, such as EMC SourceOne Discovery Manager. This prevents the application from logging any errors because it cannot reach EMC SourceOne while it is in a suspended state.

While these applications are suspended, you may want to take the opportunity to backup any data associated with these applications.

Refer to the *EMC SourceOne Discovery Manager Installation and Administration Guide* for information about how to suspend Discovery Manager.

Suspending the EMC SourceOne activities

The first step in performing a backup of EMC SourceOne is to suspend the operation of the EMC SourceOne activities as follows.

1. Verify that no Native Archive archive folders are in the process of being deleted before beginning the suspension and backup process. If an archive folder is in the process of being deleted, wait for the deletion to complete before suspending the system.

2. Use an account that is part of the EMC SourceOne security group to log on to the computer on which the EMC SourceOne console is installed and where the ES1_ActivitySuspend.vbs script will be run. Refer to the *EMC SourceOne Email Management Installation Guide* for more information about the EMC SourceOne security group.

3. Open a command prompt window by selecting Programs > Accessories > Command Prompt from the Start menu. The cmd.exe window appears.

4. In the cmd.exe window, use the cscript command to run one of the scripts to suspend EMC SourceOne activities and Worker operations:
   - Run the ES1_ActivitySuspend.vbs script to suspend all activities, including EMC SourceOne Search searches.
   - Use the ES1_ActivityBackupSuspend.vbs script to suspend all activities for backup, but allow EMC SourceOne Search searches to occur.

The following is an example of running the ES1_ActivitySuspend.vbs script:

C:\> cscript ES1_ActivitySuspend.vbs

5. Review the output of the script to determine if the script was successful:
   - The following message indicates that the Workers and activities have been successfully suspended, and then lists the suspended Workers:

     All workers suspended successfully.

     Worker status report:
     Worker ‘ALPHA’: Suspended
     Worker ‘BETA’: Suspended
     Worker ‘GAMMA’: Suspended

     Continue with the backup procedure by suspending the installed EMC SourceOne archives
   - The following message indicates that one or more Workers could not be successfully suspended before the script exited:
Timeout occurred while waiting for workers to suspend
Worker status report:
Worker ‘ALPHA’: Suspended
Worker ‘BETA’: Available
Worker ‘GAMMA’: Suspended

The previous message indicates that there was a problem suspending the activities and Workers. The status message in this case indicates that the Worker Server BETA was not suspended. Do the following to correct this problem:

a. Review the state of your EMC SourceOne system and correct any problems you encounter that may have caused one or more Workers to be unable to suspend, then rerun the script.

b. If no problem could be found, edit the ES1_ActivitySuspend.vbs or the ES1_ActivityBackupSuspend.vbs script and increase the value of the timeout variable to allow the activities and Workers more time to suspend and then rerun the script.

Suspending EMC SourceOne archives

After suspending the EMC SourceOne Workers and activities, the next step is to suspend the archives used with EMC SourceOne. The process for suspending an archive is different for each type of archive and is described in the following list.

◆ EMC EmailXtender 4.8 SP1 archive - Suspend the EMC EmailXtender 4.8 SP1 archive as part of performing a backup of EMC SourceOne. This archive is to be backed up using the procedure described in the EMC EmailXtender Administrator’s Guide. Continue the backup procedure.

◆ EMC SourceOne Native Archive - Suspend the EMC SourceOne Native Archive. Perform the following steps to suspend EMC SourceOne Native Archives.

1. Use an account that is part of the EMC SourceOne security group to log on to the computer on which the EMC SourceOne console is installed and where the ES1_NativeArchiveSuspend.vbs script will be run. Refer to the EMC SourceOne Email Management Installation Guide for more information about the EMC SourceOne security group.

2. Open a command prompt window by selecting Programs > Accessories > Command Prompt from the Start menu. The cmd.exe window appears.

3. In the cmd.exe window, use the cscript command to run the ES1_NativeArchiveSuspend.vbs script to suspend all Native Archive Servers and operations:

   C:\> cscript ES1_NativeArchiveSuspend.vbs

4. Review the output of the script to determine if the script was successful:

   • The following message indicates that an archive has been successfully suspended:

     All archives suspended successfully.
     Archive status report:
     Archive ‘NativeArchive1’: Suspended

     Continue with the backup procedure by performing the backup as described in the following section.
The following message indicates that an archive could not be successfully suspended before the script exited:

Timeout occurred while waiting for archives to suspend.
Archive status report:
Archive ‘NativeArchive1’: Available

The previous message indicates that there was a problem suspending the archive. The status message in this case indicates that the archive NativeArchive1 was not suspended. Perform the following to correct this problem:

a. Review the state of the Native Archive and servers, and correct any problems you encounter that may have caused them to be unable to suspend, then rerun the script as described in step 1.

b. If no problem could be found, edit the ES1_NativeArchiveSuspend.vbs script and increase the value of the timeout variable to allow the archive more time to suspend and then rerun the script as described in step 1.

Performing the EMC SourceOne backup

Use your preferred backup solution, such as the EMC NetWorker backup and recovery software, to perform the backup of the EMC SourceOne system and archives. Make sure you include the following in your backup of the EMC SourceOne system and one or more archives:

- The Microsoft SQL Server databases used by the EMC SourceOne system, and if used, the Discovery Manager:
  - Activity database (EMC SourceOne system database)
  - Search database (EMC SourceOne Search database)
  - Native Archive database
  - EmailXtender database (this database is only available if you are using EmailXtender with EMC SourceOne).
  - Discovery Manager database (this database is only available if you have installed Discovery Manager)
- The one or more archives used by EMC SourceOne:
  - The Native Archive. A backup of the Native Archive includes backing up the following:
    - The Native Archive database
    - The one or more Native Archive message center directories.
    - The one or more Native Archive container file (volume) locations. This includes container files stored on EMC Centera or other devices.
    - The one or more Native Archive index locations (if indexes have been created).
  - The EmailXtender 4.x archive. Perform a backup of the EmailXtender system and archive (including the database) as directed in the *EMC EmailXtender Administrator’s Guide*.

  To reduce downtime, have the EmailXtender backup occur simultaneously as the EMC SourceOne system backup.

After the backup has completed on all EMC SourceOne system and archive computers, resume the operation of the EMC SourceOne system as follows.

1. Resume the archive processing.
2. Resume the activity processing.
Resuming operation of the EMC SourceOne archives

To resume the operation of EMC SourceOne after performing a backup, first resume the operation of the EMC SourceOne archive.

In order to resume the EmailXtender 4.0 SP1 archive, review the *EMC EmailXtender Administrator's Guide*. Continue the backup procedure by resuming operations of the EMC SourceOne activities.

Perform the following steps to resume operation of the Native Archives.

1. Use an account that is part of the EMC SourceOne security group to log on to the computer on which the EMC SourceOne console is installed and where the ES1_NativeArchiveResume.vbs script will be run. Refer to the *EMC SourceOne Email Management Installation Guide* for more information about the EMC SourceOne security group.

2. Open a command prompt window by selecting **Programs > Accessories > Command Prompt** from the Start menu. The cmd.exe window appears.

3. In the cmd.exe window, use the cscript command to run the ES1_NativeArchiveResume.vbs script to resume all Native Archive Servers and operations:

   C:\> cscript ES1_NativeArchiveResume.vbs

4. Review the output of the script to determine if the script was successful:

   - The following message indicates that the archives have successfully resumed operation:

   All archives resumed successfully.
   Archive status report:
   Archive ‘NativeArchive1’: Available

   Continue to resume operation of EMC SourceOne.

   - The following message indicates that a Native Archive archive could not successfully resume operation before the script exited:

   Timeout occurred while waiting for archives to resume.
   Archive status report:
   Archive ‘NativeArchive1’: Suspended

The previous message indicates that there was a problem resuming operation of the archives. The status message in this case indicates that the archive NativeArchive1 is suspended and not available. Do the following to correct this problem:

   a. Review the state of your EMC SourceOne Native Archive and servers, and correct any problems you encounter that may have caused them to be unable to resume operation, then rerun the script as described in step 1.

   b. If no problem could be found, edit the ES1_NativeArchiveResume.vbs script and increase the value of the timeout variable to allow the archive more time to resume operation and then rerun the script as described in step 1.
Resuming operation of the EMC SourceOne system

The final step in resuming operation of the EMC SourceOne system after performing a backup is to resume the operation of the EMC SourceOne activities and Worker Servers.

Perform the following steps to resume the operation of the activities and Worker Servers.

1. Use an account that is part of the EMC SourceOne security group to log on to the computer on which the EMC SourceOne console is installed and where the ES1_ActivityResume.vbs script will be run. Refer to the *EMC SourceOne Email Management Installation Guide* for more information about the EMC SourceOne security group.

2. Open a command prompt window by selecting Programs > Accessories > Command Prompt from the Start menu. The cmd.exe window appears.

3. In the cmd.exe window, use the cscript command to run the ES1_ActivityResume.vbs script to resume operation of all EMC SourceOne activities and Workers:

   ```
   C:\> cscript ES1_ActivityResume.vbs
   ```

4. Review the output of the script to determine if the script was successful:

   - The following message indicates that the Workers and activities have successfully resumed operation:

     ```
     All workers resumed successfully.
     Worker status report:
     Worker ‘ALPHA’: Available
     Worker ‘BETA’: Available
     Worker ‘GAMMA’: Available
     
     The EMC SourceOne system has resumed operation.
     
     Verify that EMC SourceOne has completely resumed operation.
     ```

   - The following message indicates that one or more Workers could not successfully resume operation before the script exited:

     ```
     Timeout occurred while waiting for workers to resume
     Worker status report:
     Worker ‘ALPHA’: Suspended
     Worker ‘BETA’: Available
     Worker ‘GAMMA’: Available
     
     The previous message indicates that there was a problem resuming operation of one or more Workers. The status message in this case indicates that the Worker Server ALPHA is still suspended and is not available. Do the following to correct this problem:
     
     a. Review the state of your EMC SourceOne system, and correct any problems you encounter that may have caused the system to be unable to resume operation, then rerun the script as described in step 1.
     
     b. If no problem could be found, edit the ES1_ActivityResume.vbs script and increase the value of the timeout variable to allow the activities more time to resume operation and then rerun the script as described in step 1.
Verifying successful operation of EMC SourceOne after the backup

After the EMC SourceOne system has resumed operation, review the system status to make sure everything has resumed properly by performing the tasks in the system maintenance checklist.

In particular, review job status to make sure that no jobs that were scheduled to run expired while the backup was occurring. If one or more jobs did expire, determine whether they need to be rescheduled to run.

Resuming applications that use EMC SourceOne

After resuming the EMC SourceOne system, resume any other applications that make use of EMC SourceOne, such as Discovery Manager. Resuming dependent applications after you have resumed the EMC SourceOne system, prevents those applications from logging errors because they cannot reach EMC SourceOne while it is in a suspended state.

Refer to the EMC SourceOne Discovery Manager Installation and Administration Guide for information about how to resume Discovery Manager.

Restoring an EMC SourceOne system after backup

When restoring an EMC SourceOne system from backup you must restore the entire system, even if only one component needs restoration. Restoring the entire system from backup keeps all the components synchronized.

Restore an EMC SourceOne system from backup by completing the following tasks.

1. If the EMC SourceOne system is running, suspend the system.
2. Perform the restoration using the same solution to restore the EMC SourceOne system and archives as you did to back them up.
3. Remove any existing files from the following locations before you restore files to those locations:
   - The one or more Native Archive message center directories
   - The one or more Native Archive container file (volume) locations. This includes container files stored to EMC Centera or other devices using EMC DiskXtender
   - The one or more Native Archive index locations (if indexes have been created)
4. Restore the Microsoft SQL Server databases used by the EMC SourceOne system, and if used, the Discovery Manager:
   - Activity database (EMC SourceOne system database)
   - Search database (EMC SourceOne Search database)
   - Native Archive database
   - EmailXtender database (this database is only available if you are using EmailXtender with EMC SourceOne).
   - Discovery Manager database (this database is only available if you have installed Discovery Manager)
5. Restore the one or more archives used by EMC SourceOne:

- The Native Archive, including the following:
  - The Native Archive database
  - The one or more Native Archive message center directories.
  - The one or more Native Archive container file (volume) locations. This includes container files stored to EMC Centera or other devices using DiskXtender.
  - The one or more Native Archive index locations (if indexes have been created).

Refer to “Considerations for restoring Native Archive with multiple index storage locations” on page 292 for additional considerations when restoring certain Native Archive configurations.

- The EmailXtender 4.x archive. Restore the EmailXtender system and archive (including the database) as directed in the *EMC EmailXtender Administrator’s Guide*.

To reduce downtime, you can have the EmailXtender restoration occur simultaneously as the EMC SourceOne system restoration.

6. Resume the suspended EMC SourceOne system as described in the following sections, in the following order:

   c. Resume the operation of the EMC SourceOne archives
   d. Resume the operation of the EMC SourceOne system
   e. Resume the applications that use EMC SourceOne

### Considerations for restoring Native Archive with multiple index storage locations

If you are using the Native Archive and you have multiple index storage locations defined, you need to take additional precautions when restoring the Native Archive from backup.

Native Archive indexes are numbered sequentially as they are generated and information about the indexes is stored in the Native Archive database.

When restoring the Native Archive from backup in an environment in which you have two or more index storage locations, ensure that the sequentially numbered indexes in the index storage locations match the data about the indexes in the Native Archive database for the recovery point objective (RPO).

### Maintaining the EMC SourceOne databases (common)

Part of maintaining the EMC SourceOne system includes maintaining the Email Management databases, and the Discovery Manager database if that product is installed.

When you first install the EMC SourceOne products, there is not a great need to perform database maintenance because there is not a large amount of data stored in the databases. However, after the products are in regular use, perform regular database maintenance.

Refer to the following sections for important database maintenance concepts and processes.
Refer to “Configuring Archives” on page 51 for how to configure the Native Archive and the Native Archive database.

Database maintenance concepts

Understand some core concepts about databases and their need for maintenance before performing that maintenance. Refer to the following sections for those concepts.

Also review the guidelines in “Database maintenance guidelines and best practices” on page 296.

Why is database maintenance required?

Microsoft SQL Server databases that have a high volume of activity require regular maintenance. In particular, index fragmentation and out-of-date statistics can degrade performance if the databases are not regularly maintained to avoid these problems.

The Native Archive, Activity, and Discovery Manager databases are high-volume databases and require the maintenance previously described to avoid performance degradation.

More about index defragmentation

Index fragmentation occurs when the logical and physical structure of the database gets out of order. Indexes in high-volume databases become fragmented due to the high volume of data being inserted, deleted, and updated. When a database becomes fragmented, the performance of that database degrades.

The performance impact of fragmented indexes is more significant with operations that cause SQL Server to process large amounts of data, such as archiving, searching, exporting or disposing of large amounts of data. However, even if you are not processing large amounts of data, defragmenting indexes is still necessary and will allow you to optimize your system performance.

Refer to “Installing and Using the EMC SourceOne database maintenance tools” on page 299 for how to defragment indexes using the maintenance tools. Refer to “Microsoft guidelines for SQL Server database maintenance” on page 296 for how to defragment indexes without using the maintenance tools.

More about updating statistics

SQL Server collects and uses statistics about the distribution of data in table indexes to build efficient query plans that improve the performance of database queries. Indexes in high-volume databases require regular updates to these statistics because such tables often change which causes the statistics to become out-of-date. If the statistics are not updated regularly, query, retrieval, and archive performance will degrade, especially when performing operations on large amounts of data such as large queries and large retrievals.

Even though the EMC SourceOne databases are created with the auto update statistics option enabled so that statistics get automatically updated, it is still necessary to perform additional updates to those statistics. This is because the EMC SourceOne database statistics can get outdated more often than the auto update option causes them to be updated.
Refer to “Installing and Using the EMC SourceOne database maintenance tools” on page 299 for how to update statistics using the maintenance tools. Refer to “Microsoft guidelines for SQL Server database maintenance” on page 296 for how to update statistics without using the maintenance tools.

Which EMC SourceOne databases need maintenance?

Email Management installs the following SQL Server databases.

- Native Archive database
- Activity database
- Search database

Discovery Manager installs a single SQL Server database.

- DiscoveryManager

The Native Archive, Activity, and Discovery Manager databases are high-volume databases that require regular maintenance as described in this section.

The data in the Search database is temporary, so maintenance tasks such as index defragmentation and updating statistics may not be necessary for that database.

When and how often is maintenance to occur?

Typically, the best time to perform your database maintenance tasks is immediately after you have backed up your database and the EMC SourceOne system is in a suspended state.

Typically, for high-volume databases such as those used by Email Management and Discovery Manager, maintenance tasks are to be performed at the specified intervals described in the following sections.

**Weekly database maintenance tasks**

As general guidance, maintenance may need to be performed as often as three times a week if the system is very active, such as a system processing over 100,000 documents a day.

The interval at which you need to perform maintenance may vary depending on several factors, such as: the amount of content you are archiving, how much and how often you are regularly conducting searches, and how much time you have available in your maintenance window to perform your maintenance tasks.

Review “Database maintenance guidelines and best practices” on page 296 before performing this maintenance.

Perform the following tasks on a weekly basis in order to ensure the functionality of the system.

1. Defragment the indexes for the following Email Management databases using the provided database maintenance tools:
   - Native Archive database
   - Activity database

2. Defragment the indexes for the following Discovery Manager database, if it is installed:
• DiscoveryManager database

3. Update statistics for the following EMC SourceOne Email Management databases using the provided database maintenance tools:
   • Native Archive database
   • Activity database

4. Update statistics for the following EMC SourceOne Discovery Manager database, if it is installed:
   • DiscoveryManager database

Monthly database maintenance tasks

Whether one time a month is the correct interval for your installation depends on several factors, such as: the amount of content you are archiving, how much and how often you are regularly conducting searches, and how much time you have available in your maintenance window for these tasks.

Review “Database maintenance guidelines and best practices” on page 296 before performing this maintenance.

Perform the following tasks on a monthly basis in order to ensure the functionality of your system.

1. Review the disk space available for each of the following databases to make sure that you have enough physical space to allow for database growth:
   • Native Archive database
   • Activity database
   • Search database
   • DiscoveryManager database (if installed)

2. Review database integrity for each of the following databases:
   • Native Archive database
   • Activity database
   • DiscoveryManager database (if installed)

Refer to your SQL Server documentation or the following article for more information about checking database integrity:


3. Review whether to increase the sizes of the following databases or the growth value for these databases using SQL Server Management Studio:
   • Native Archive database
   • Activity database
   • DiscoveryManager database (if installed)

Refer to your Microsoft SQL Server documentation for more information about how to increase the size or growth value of a database.

By default, EMC SourceOne creates the databases with an initial size of 1 GB and a growth value of 100 MB.
It is recommended that you increase the growth value from 100 MB to 1 GB after installation. You may need to increase the growth value to greater than 1 GB depending on the monthly growth pattern of the database. Increasing these values may help limit physical fragmentation of the database.

Even though the EMC SourceOne database files are configured with the auto grow option, EMC SourceOne recommends that you review whether to increase the database file size to limit the physical fragmentation of the database that can occur when the database files auto grow often.

Database maintenance guidelines and best practices

The following sections list guidelines and best practices for performing maintenance of your EMC SourceOne databases.

Microsoft guidelines for SQL Server database maintenance

Microsoft provides guidance on how to perform SQL Server database maintenance. This guidance is specific to the version and edition of SQL Server used.

◆ Refer to the following article for overall database maintenance information:

◆ Refer to the Microsoft SQL Server documentation or the following online article for the procedure to defragment an index:
  Refer especially to section D of this online article for a sample script for use in defragmenting an index.

◆ Refer to the Microsoft SQL Server documentation or the following online article for the procedure to update statistics:

You can also use the EMC SourceOne tools for maintenance of the EMC SourceOne Email Management or EMC SourceOne Discovery Manager databases. Refer to “Installing and Using the EMC SourceOne database maintenance tools” on page 299 for more information about these tools.

EMC SourceOne guidelines for maintaining EMC SourceOne databases

Consider the following guidelines before performing maintenance on your EMC SourceOne databases. These guidelines are described in the following sections.

Guidelines for preparing to maintain the databases

The following are guidelines for how to prepare to perform database maintenance.

◆ How you prepare the databases before performing database maintenance differs depending on the edition of SQL Server you are using:
  • The Standard edition of SQL Server requires that the database be suspended and offline for index maintenance. Failure to suspend the system may cause problems as tables in the database will be locked. This means that EMC SourceOne (and Discovery Manager if installed) must be in a suspended state as well and that no activity, including searches or shortcut retrievals, can be performed.
• Even with the Enterprise edition of SQL Server, EMC SourceOne recommends that the database be suspended and offline for index maintenance.

However, Enterprise edition does support index maintenance while the database is online, with the caveat that database performance will be degraded while the maintenance is taking place. This degraded performance may cause slow retrieval of shortcuts, and may even cause such retrievals to not complete in the allotted time and timeout.

If you allow the database to be online then shortcut retrievals can be performed, although no other activity can be performed.

• If there are multiple EMC SourceOne products installed, such as Email Management and Discovery Manager, the database maintenance of both products are to be coordinated so that the impact of the maintenance is minimized for all users.

• When running the database maintenance scripts on Email Management databases, you need sufficient space in the tempdb database for the processing to occur. When the script rebuilds an index, the tempdb database is used for sorting operations. If the rebuild is being done while in online mode, a copy of the index is maintained by SQL Server in the target database for availability while the rebuild occurs.

In a typical partitioned database using the default partition size, the tempdb database size is to be large enough to contain as much as 20% of the size of the database being processed.

Note: This is in addition to whatever other use is being made of the tempdb database.

Refer to the following article for more information about the tempdb database: http://msdn.microsoft.com/en-us/library/ms190768.aspx

• If there are any groups or software monitoring your database resource usage, such as usage of tempdb, of log space, and so on, they are to be made aware of when you are performing database maintenance to prevent unnecessary alerts from being generated. The groups or software may need to adjust the alerts to take into account database maintenance, or to create exceptions for the database maintenance operations.

Performing database maintenance can cause high disk I/O on the database server and may cause an alert of some kind to be issued by the monitoring group or software. Refer to the EMC SourceOne Email Management Installation Guide for recommendations for installing the databases.

• Be aware that when performing index maintenance, SQL Server may increase the amount of log space used. This can cause the log file in the database to grow.

• Performing database maintenance with the database in offline mode is preferred because it allows more complete maintenance to be performed. If you cannot perform the database maintenance in offline mode at all times, still try to perform it regularly. For example, you could perform maintenance in online mode twice, and then the third time perform it in offline mode.

Guidelines for when or how often to maintain the databases

The following are guidelines on when or how often to perform database maintenance and how often to perform it.
Typically, the best time to perform database maintenance is immediately after you have backed up your database and the EMC SourceOne system (and Discovery Manager if installed) are already in a suspended state.

Refer to “Performing a backup of an EMC SourceOne system” on page 282 for how to perform a backup of your EMC SourceOne system.

Refer to the *EMC SourceOne Discovery Manager Installation and Administration Guide* for how to perform a backup of Discovery Manager.

Database maintenance tasks are to be performed when no other heavy processing is occurring on the database server, such as when EMC SourceOne is performing archiving activities. This is because performing tasks such as defragmenting indexes and updating database statistics make heavy use of the database server disks and CPU.

Maintenance tasks such as updating statistics or defragmenting indexes can be interrupted with no damage to the system. Such interruptions may be necessary when a higher priority operation needs to complete and so the maintenance task needs to be interrupted and delayed until a more suitable time.

On high volume systems that are ingesting 100,000 or more documents a day, performing index maintenance more often than one time a week may be warranted.

**Guidelines for defragmenting the indexes in the databases**

The following are guidelines for defragmenting the indexes in the databases.

- If you are using the Enterprise edition of SQL Server, you can use partitioning to shorten the time it takes to defragment your indexes because the most recently created partition will contain most of the fragmentation.
- Typically, you will gain the largest benefit to your system if you defragment your indexes before you update the statistics.
- The Archive database indexes are more likely to be fragmented than the Activity or Discovery Manager database indexes. This is because the volume of data inserted or updated into the Archive database will cause the indexes in that database to be more frequently fragmented and more heavily fragmented than those in the Activity or Discovery Manager database indexes.

Typically, the indexes for the following tables in the Archive database tend to be candidates for being highly fragmented and so will often need to be defragmented or rebuilt:

- Message
- FolderMessage
- Route
- FTIndexUpdate
- MessageExtension
- EmailAddress

**Other guidelines for maintaining the databases**

The following are other database maintenance guidelines.
In some cases, you may need to move the EMC SourceOne databases from one SQL Server to another after they are installed. Refer to “Moving EMC SourceOne databases” on page 309 for guidance in performing that task.

Contact your EMC representative if you need assistance to move your EMC SourceOne databases.

Updating statistics can be a time-consuming operation. Schedule this maintenance task with that in mind.

Note that the Email Management database maintenance scripts will timeout after approximately 12 hours to prevent them from running too long and consuming too many resources. If a timeout occurs, you can run the script again and it will start where it left off.

If database performance has become seriously degraded, and you are seeing higher than normal disk usage and CPU usage, you may be able to improve performance more quickly by only defragmenting the indexes and not updating statistics.

After database performance has improved, defragment the indexes and update the statistics as soon as possible.

**Installing and Using the EMC SourceOne database maintenance tools**

In addition to the general database maintenance guidance provided by Microsoft and described in “Microsoft guidelines for SQL Server database maintenance” on page 296, EMC SourceOne includes scripts which allow you to maintain the indexes of the Archive, Activity, and Discovery Manager databases. No scripts are provided for maintaining the Search database.

Before using these scripts, review “Database maintenance guidelines and best practices” on page 296.

Refer to the following sections for how to install and use these maintenance scripts.

**Installing the database maintenance scripts**

The database maintenance scripts for the Archive, Activity, and Discovery Manager databases are very similar, and so the options, and output from the selected options are very similar. The primary difference between the output of the scripts is seen when the Archive database is partitioned, because the Activity and Discovery Manager databases cannot be partitioned.

To install these scripts, copy the following directories (and the files they contain) from the installation kit to a directory on the SQL Server computer:

- \Setup\Database\Utilities\Maintenance\Activity
- \Setup\Database\Utilities\Maintenance\Archive
- \Setup\Database\Utilities\Maintenance\DiscoveryManager

These directories contain the Activity, Archive, and Discovery Manager database maintenance scripts and the associated Visual Basic scripts needed by those scripts as follows:

- \Activity\ES1_ActivityDB_Helper.vbs
- \Activity\ES1_ActivityDB_Maintenance_mssql.bat
- \Archive\ES1_ArchiveDB_Helper.vbs
Maintaining EMC SourceOne

- \Archive\ES1_ArchiveDB_Maintenance_mssql.bat
- \DiscoveryManager\ES1_DMDB_HELPER.vbs
- \DiscoveryManager\ES1_DMDB_Maintenance_mssql.bat

The Visual Basic files in these directories are used only to redirect output to log files as well as to the terminal screen and do not perform any other function.

Using the database maintenance scripts

Perform the following tasks for the Activity, Archive, and Discovery Manager databases to run the database maintenance scripts.

1. Review the script guidelines before you run the scripts.
2. Verify that the EMC SourceOne system is in a suspended state as it would be for backing up the system.

   The ability to perform searches while the system is suspended depends on which script you used to suspend the system:
   
   • If you suspend the system using the ES1_ActivitySuspend.vbs script prior to performing database maintenance, only shortcut retrieval is possible.
   
   • If you suspend the system using the ES1_ActivityBackupSuspend.vbs script prior to performing database maintenance, both shortcut retrieval and Search searches are possible. elsewhere.

   Refer to “Performing a backup of an EMC SourceOne system” on page 282 for more information about suspending the EMC SourceOne system.
3. Log into an account on the SQL Server computer that has the Alter and View Database State permissions for the specific database you are processing (Archive, Activity, or Discovery Manager).
4. Execute the batch file either by running it from the DOS command prompt or by double clicking the file name:

   • Execute ES1_ActivityDB_Maintenance_mssql.bat to maintain the Activity database.

   • Execute ES1_ArchiveDB_Maintenance_mssql.bat to maintain the Archive database.

   • Execute ES1_DMDB_Maintenance_mssql.bat to maintain the Discovery Manager database.

   Note that if the batch file is run from a CD-ROM, or any other read-only location, it will fail with an access denied message.

   Refer to “Sample database maintenance interactive session” on page 304 for an example of an interactive session with the maintenance script.

   Refer to “Sample database maintenance log file” on page 305 for a sample log file.
5. Review the guidelines for performing database maintenance that are printed when the script executes:
   - Database maintenance, being a very resource intensive process causing high disk and CPU usage on SQL Server, is to be performed in off-peak hours.
   - Both index maintenance and update statistics steps can be time consuming, depending on the maintenance state and size of the database.
   - EMC SourceOne administrative activities are to not be operational during maintenance.
   - To reduce maintenance time and increase the quality of the maintenance, the maintenance process is to be performed in offline mode. However, offline maintenance will have an effect on performing the EMC SourceOne operations such as user searches and shortcut retrieval.
   - Online database maintenance mode is supported only in SQL Server Enterprise edition; only offline mode is supported using SQL Server Standard edition.

6. In response to the prompt, specify the instance name for the SQL Server on which the database is installed.

7. In response to the prompt, specify the name of the database to process. The default database name is either ES1Archive, ES1Activity, or Discovery Manager depending on the script used.

8. In response to the prompt, specify whether to display a report on index fragmentation and to display the maintenance steps before performing the steps. The default is to display the report and simulated maintenance steps prior to actually performing those steps.
9. In response to the prompt, specify whether to rebuild indexes in online or offline mode, if the indexes need to be rebuilt. The default is online mode.

The maintenance script defragments or rebuilds indexes based on the amount of fragmentation detected in the index:

- 0 - 9% fragmentation, no processing is done or needed.
- 10 - 30% fragmentation, the index is defragmented.
- Greater than 30% fragmentation, the index is rebuilt.

While rebuilding the index (whether in online or offline mode), no historical archiving, journaling, shortcut creation or administrative search activities can be performed. Also, administrative searches, such as long-running Discovery Manager searches or Administrative searches must not be run during index maintenance. This is because these activities and the index maintenance operations will contend for the same resources, and may cause the activities to timeout or fail.

Refer to the following table to decide whether to allow the script to maintain the database in online or offline mode.

Table 39 Selecting whether to use online or offline mode for database maintenance

<table>
<thead>
<tr>
<th>Using online mode...</th>
<th>Using offline mode...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requires the use of SQL Server Enterprise edition.</td>
<td>Requires the use of either the Enterprise edition or Standard edition of SQL Server.</td>
</tr>
<tr>
<td>The index maintenance process completes more slowly than in offline mode.</td>
<td>The index maintenance process completes more quickly than in online mode.</td>
</tr>
<tr>
<td>User searches and shortcut retrievals are more likely to complete without delays, timeouts or signaling errors.</td>
<td>User searches and shortcut retrievals are less likely to complete without delays, timeouts or signaling errors. When using offline mode, tables are locked and so operations using those tables will not be able to complete.</td>
</tr>
<tr>
<td>A less complete maintenance of the database is possible.</td>
<td>A more complete and higher quality maintenance of the database is possible while the database is offline.</td>
</tr>
</tbody>
</table>

10. In response to the prompt, specify whether to update the SQL statistics after the indexes are defragmented or rebuilt. The default is to update the statistics.

If you have sufficient time, it is always best to perform your statistics update immediately after defragmenting or rebuilding the indexes, as it makes your statistics update as effective as possible.

11. In response to the prompt, specify whether to perform the maintenance steps that were listed in the simulation, or to not do them. The default is to perform them.
12. Review the resulting log file from the maintenance run. This file records the data about the maintenance processing that is written to the screen as the processing occurs.

This file is created in the current working directory and has the same name as the batch script you ran, but with a .log file name extension, as one of the following:

- ES1_ActivityDB_Maintenance_mssql.log
- ES1_ArchiveDB_Maintenance_mssql.log
- ES1_DMDB_Maintenance_mssql.log

**Note:** The log file contains data about multiple runs of the maintenance utility. This information is also stored in the database that was processed.

Refer to “Sample database maintenance log file” on page 305 for an example of such a log file.

**Scheduling database maintenance script execution**

Schedule the execution of the database maintenance scripts by creating a scheduled task to execute the script using the Windows Scheduled Task applet.

Schedule the stored procedures used by the database maintenance scripts to run on a schedule by creating SQL Server Agent jobs. Refer to the following article for information about SQL Server Agent jobs:


**Note:** The maintenance scripts will timeout after approximately 12 hours to prevent them from running too long and consuming too many resources. If a timeout occurs, you can run the script again and it will start where it left off.
Sample database maintenance interactive session

The following figure is sample output from an interactive session with the database maintenance script `ES1_ArchiveDB_Maintenance_mssql.bat`.  

![Database Maintenance Interactive Session](image-url)
Sample database maintenance log file

The following figure is sample output from a
ESI_ArchiveDB_Maintenance_mssql.bat file.

EMC SourceOne 6.61 Archive Database Maintenance Utility

USER INPUTS:
Script Location = D:\MAR6_6E_2\EXAS\src\SQL\ 
SQL Server = localhost
Database = ES1Archive
View Log File = n
Log File = *ES1_ArchiveDB_Maintenance_mssql.bat.log*
Display Report = y
Defrag Online = 1
Update Statistics = y

sqlcmd -S localhost -d ES1Archive -Q "exec ExDBDefragIndexes @ExecuteCommands=0, @ShowFragmentationReport=2, @ShowSQL=1, @ForceRescan=1, @RebuildOnline=1 "

2010-10-27 14:59:54|Database:ES1Archive: Index maintenance procedure invoked..
2010-10-27 14:59:54|Starting index fragmentation analysis in database:ES1Archive..
2010-10-27 14:59:54|Displaying fragmentation report before defragmentation process..

<table>
<thead>
<tr>
<th>Table</th>
<th>PartitionId</th>
<th>Index</th>
<th>Fragmentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmailAddress</td>
<td>1</td>
<td>PK_EmailAddress</td>
<td>98%</td>
</tr>
<tr>
<td>FolderMessage</td>
<td>2</td>
<td>PK_FolderMessage</td>
<td>99%</td>
</tr>
<tr>
<td>FolderMessage</td>
<td>2</td>
<td>IX_FolderMessage_VolumeId</td>
<td>98%</td>
</tr>
<tr>
<td>FolderMessage</td>
<td>2</td>
<td>IX_FolderMessage_MetadataMD5</td>
<td>65%</td>
</tr>
<tr>
<td>Message</td>
<td>2</td>
<td>PK_Message</td>
<td>99%</td>
</tr>
<tr>
<td>Message</td>
<td>2</td>
<td>IX_Message_TrackingId</td>
<td>99%</td>
</tr>
<tr>
<td>Message</td>
<td>2</td>
<td>IX_Message_TrackingId2</td>
<td>98%</td>
</tr>
<tr>
<td>Message</td>
<td>2</td>
<td>IX_Message_MsgDate</td>
<td>70%</td>
</tr>
<tr>
<td>Message</td>
<td>2</td>
<td>IX_Message_MsgSize</td>
<td>99%</td>
</tr>
<tr>
<td>Route</td>
<td>2</td>
<td>PK_Route</td>
<td>97%</td>
</tr>
<tr>
<td>Route</td>
<td>2</td>
<td>IX_Route_EmailIdRouteType</td>
<td>99%</td>
</tr>
<tr>
<td>Volume</td>
<td>1</td>
<td>PK_Volume</td>
<td>41%</td>
</tr>
</tbody>
</table>

2010-10-27 14:59:54|Simulating maintenance commands:
ALTER INDEX [IX_Message_TrackingId] ON [ES1Archive].dbo.Message REORGANIZE Partition = 2
ALTER INDEX [IX_Message_MsgSize] ON [ES1Archive].dbo.Message REORGANIZE Partition = 2
ALTER INDEX [IX_Route_EmailIdRouteType] ON [ES1Archive].dbo.Route REORGANIZE Partition = 2
ALTER INDEX [PK_FolderMessage] ON [ES1Archive].dbo.FolderMessage REORGANIZE Partition = 2
ALTER INDEX [IX_Message_MsgSize] ON [ES1Archive].dbo.Message REORGANIZE Partition = 2
ALTER INDEX [PK_Message] ON [ES1Archive].dbo.Message REORGANIZE Partition = 2
ALTER INDEX [IX_FolderMessage_MetadataMD5] ON [ES1Archive].dbo.FolderMessage REORGANIZE Partition = 2
ALTER INDEX [PK_FolderMessage] ON [ES1Archive].dbo.FolderMessage REORGANIZE Partition = 2
ALTER INDEX [IX_FolderMessage_MetaDataMD5] ON [ES1Archive].dbo.FolderMessage REORGANIZE Partition = 2

2010-10-27 14:59:55|Database:ES1Archive: Index maintenance procedure invocation complete

sqlcmd -S localhost -d ES1Archive -Q "exec ExDBUpdateStats @ExecuteCommands=0, @ShowSQL=1, @ForceRescan=1, @ExcludeAutoCreatedStats=1 "

2010-10-27 14:59:55|Database:ES1Archive: SQL statistics update procedure invoked..
2010-10-27 14:59:55|Starting SQL statistics analysis in database:ES1Archive..
2010-10-27 14:59:55|Simulating maintenance commands:
Statistics: [ES1Archive].dbo.[FolderMessage] [IX_FolderMessage_MsgSize] WITH SAMPLE 14 PERCENT;
Statistics: [ES1Archive].dbo.[Message] [IX_Message_MsgSize] WITH SAMPLE 14 PERCENT;
Statistics: [ES1Archive].dbo.[Message] [PK_Message] WITH SAMPLE 14 PERCENT;
Statistics: [ES1Archive].dbo.[Message] [IX_Message_MsgSize] WITH SAMPLE 14 PERCENT;
Statistics: [ES1Archive].dbo.[Route] Last Updated On: Nov 12 2009 5:01AM
Statistics: [ES1Archive].dbo.[Route] [IX_Route_EmailIdRouteType] WITH SAMPLE 12 PERCENT;
Statistics: [ES1Archive].dbo.[Message] Last Updated On: Nov 9 2009 1:06PM
Infrequent Maintenance Tasks (common and email-specific)

There are some maintenance tasks that occur infrequently that you may need to perform. Some of the more common of these tasks are described in the following sections.

Resetting EMC SourceOne service account passwords

EMC SourceOne creates and assigns the service account credentials to EMC SourceOne Windows services which perform various types of processing. If a service account password is allowed to expire, this will cause authentication errors to be written to the event logs.

Be aware of when this password will expire and change it before it expires to avoid interrupting EMC SourceOne processing.
After changing the password in Active Directory, use the Log On tab in the Services console to update the new password for each of the EMC SourceOne services on the Master Server, Worker Server and Native Archive computers.

For more details on the service accounts used by EMC SourceOne, refer to the *EMC SourceOne Email Management Installation Guide*.

**Moving an EMC SourceOne archive**

In some system maintenance situations, such as when hardware needs to be reallocated or replaced, you may need to move the physical location of the archive in which EMC SourceOne stores content.

**Note:** If you have a complex hardware and software configuration, you may want to contact EMC Professional Services for assistance in moving the archive.

To move an EMC SourceOne Native Archive, use the procedure described in “Configuring Archives” on page 51.

**Moving a Native Archive Index Work directory**

The following section describes the procedure for moving the Native Archive Index Work directory to a drive with adequate space to support the indexing role.

**Overview**

Beginning with version 6.6 SP1, EMC SourceOne performs all indexing locally on the Native Archive computer. To support this requirement, you must allocate a local directory (referred to as the Index Work directory) with at least 20 GB of space on all Native Archive indexing computers to serve as a temporary space for indexing.

This directory:

- Must be regarded as a local drive by the operating system.
- Cannot be the operating system drive (e.g., c:).
- Can be on local disk or SAN storage, if it is regarded as a local drive by the Native Archive Server. For best performance, use a dedicated physical disk.
- Requires a minimum of 20 GB of free disk space be available.

Ideally, allocate the required space prior to installing Native Archive software on the indexing servers, as described in the *EMC SourceOne Email Management Installation Guide*. Then, when installing the Native Archive software, select a destination folder on this drive.

Although you are required to specify this location when installing the Native Archive software, you can bypass the 20 GB requirement during the installation (the installer will provide a warning). This is necessary when installing Native Archive software on a server which is not designated for indexing. If you later decide to enable indexing, you will need to either:

- Free up space on the current Index Work directory drive.
- Move the Index Work directory to another drive which has enough space.
Example

Install Native Archive software on a computer not originally intended to perform indexing, but you later decide to enable the indexing role. The current Index Work directory that you established when you installed the Native Archive software is on a 30 GB drive, but has only 5 GB of free disk space.

In this case, you can either:

- Move or delete files to free up 20 GB space, and then enable the indexing role on this server.
- Use a utility (provided in the EMC SourceOne Email Management 6.6 SP1 software kit) to move the Index Work directory to another drive with at least 20 GB of free space. You can then enable the indexing role.

Procedure

Use the utility to move the current Index Work directory to a new drive using the information provided in this section.

**Stop Native Archive services**

Before running the utility, use the Services console to stop the following Native Archive services.

- EMC SourceOne Administrator
- EMC SourceOne Archive
- EMC SourceOne Indexer
- EMC SourceOne Query

*Note:* Stopping the EMC SourceOne Administrator service stops the other three services.

**Permissions**

You must be logged in with an account which has adequate permissions to write to the Index Work directory. Normally, this is the EMC SourceOne service account. Refer to the *EMC SourceOne Email Management Installation Guide* for more information about this service account.

**Run the utility**

Perform the following procedure to update the Index Work directory location.

1. Locate the `ES1_IndexPrereqVerifier.exe` utility in the EMC SourceOne version 6.6 SP1 software kit (in the *Utility\Index* folder) and copy it to the Native Archive indexing server.
2. Open a command prompt and navigate to the utility location.
3. To change the Index Work directory location from its current location to a new location, type:

   ```
   ES1_IndexPrereqVerifier -ChangeIdxTempDir drive:\path
   ```

   For example:

   ```
   ES1_IndexPrereqVerifier -ChangeIdxTempDir F:\IndexWork
   ```
Results
When this command is issued, the following occurs.

◆ The utility updates the Archive database with the new drive and folder location that you specify.
◆ The previous Index Work directory location is no longer used by the product.
◆ The new folder is not created in the file system until the first index run is performed after the upgrade is completed.

Moving EMC SourceOne databases

This section describes how to move EMC SourceOne Email Management and Discovery Manager databases from one SQL Server host computer to another. This procedure applies to all releases of EMC SourceOne Email Management and Discovery Manager.

This procedure is typically used to perform a planned move from one SQL Server to another SQL Server (for example, you are replacing your existing SQL Server with a newer computer).

Review considerations

Review the following considerations before attempting to move the EMC SourceOne Email Management and Discovery Manager databases from one SQL Server host computer to another.

Different SQL Server host name
If you are moving SourceOne databases from one physical SQL Server to another SQL Server with a different host name, use the database move procedure in its entirety.

Alias configuration
The database move procedure is simplified if you used a DNS CNAME alias configuration for your SQL Server when you installed EMC SourceOne software.

Differences for a CNAME alias configurations are noted in the procedures.

Disaster recovery configuration consideration
If you have implemented the disaster recovery configuration described in the EMC SourceOne Disaster Recovery Solution Guide, the “Moving EMC SourceOne databases” on page 309 procedure is not applicable. This is because the disaster recovery solution includes:

◆ a required DNS CNAME alias configuration for SQL Server.
◆ regular replication of EMC SourceOne databases and the SQL Server Master database between the primary and secondary sites.

Applicable databases
This procedure applies to the following SourceOne databases.

◆ Activity database
◆ Archive database
- Search database
- Discovery Manager database

**Moving between SQL Server editions**

Databases can be moved from SQL Server Standard Edition to SQL Server Enterprise edition.

The following movements are supported:

- From SQL Server 2008 R2 Standard edition to SQL Server 2008 R2 Enterprise edition
- From SQL Server 2012 SP2 Standard edition to SQL Server 2012 SP2 Enterprise edition

Movement between editions with different versions are not supported, for example, from SQL Server 2008 R2 Standard edition to SQL Server 2012 SP2 Enterprise edition.

After completing a movement, the partition functions within the EMC SourceOne Console or within Discovery Manager Administration are not available.

**Moving between SQL Server versions**

SourceOne databases can be moved between the following versions of Microsoft SQL Server.

- SQL Server 2012 to SQL Server 2014
- SQL Server 2008 R2 to SQL Server 2014
- SQL Server 2008 R2 to SQL Server 2012
- SQL Server 2008 to SQL Server 2014
- SQL Server 2008 to SQL Server 2012
- SQL Server 2008 to SQL Server 2008 R2
- SQL Server 2005 to SQL Server 2008 R2
- SQL Server 2005 to SQL Server 2008

**Important SQL Server considerations**

When moving databases to a new SQL Server review the detailed SQL Server considerations provided in the *EMC SourceOne Email Management Installation Guide*.

Review this information to ensure that you are moving the databases to a SQL Server environment that is optimized for use with SourceOne. This information includes the following topics:

- Disk configuration
- Partitioning
- Memory allocation
- Permissions
- Alias configuration
Infrequent Maintenance Tasks (common and email-specific)

- Recovery model
- Collation
- Storage best practices.

**Newer product version databases require additional steps**

With the release of Email Management version 6.8 (and 6.8 SP1), the Activity database supports the creation of partitions to support auditing and reporting features. The Discovery Manager 6.8 SP1 database also supports the creation of partitions to support auditing and reporting features.

With both databases, the file location of a new partition is derived from the existing database file location. If you move the database and change the database storage location, the database’s internal configuration table will still point to the location that may no longer be valid for new partitions.

If you change the database storage location when moving the Activity database, a database administrator must manually update values in both the Activity database and Discovery Manager database (if used).

Please contact EMC Customer Support for specific details and assistance in manually updating the database values to reflect the new storage locations, and refer to Solution Note esg129639. This information is also available on the EMC Support site.

After this update is performed, new partitions will be created in the desired storage locations.

**Establish destination SQL Server permissions**

Prepare the destination SQL Server with the same login configuration used on the current SQL Server.

**Installation account**

Ensure that the installation account is a local administrator and has the SQL `sysadmin` role.

---

**Note:** For important details about database installation permissions, see the *EMC SourceOne Email Management Installation Guide*.

**Security logins**

Configure the following groups and accounts as Security Logins in SQL Server.

- EMC SourceOne security group
- EMC SourceOne Admins group
- EMC SourceOne installation account(s)

You will later assign individual database privileges to these logins after EMC SourceOne databases are moved.
Create required entries in the destination SQL Server Master database

EMC SourceOne databases require that some minor entries exist in the `sys.messages` table of the Master database. To create these necessary entries in the SQL Server Master database, install and uninstall a dummy Activity database.

Perform the following procedure on the destination SQL Server instance.

1. Install a new Activity database using the Activity database installation script (`ES1_ActivityDB_Create_mssql.bat`) provided in the EMC SourceOne software kit.
   - Use the same version of the Activity database installation script as the databases that you are moving.
   - Ensure that if you use a named database instance, you specify it when running the script.
   - For details, refer to the *EMC SourceOne Email Management Installation Guide*.
2. Delete the Activity database created in the previous step. This removes the empty Activity database while retaining the necessary entries in the SQL Server Master database.

Prepare the system

Perform the following steps to prepare the system.

1. Perform a backup of the EMC SourceOne system.
2. Stop all active jobs using the EMC SourceOne console as follows.
   a. Expand the *EMC SourceOne > Organizational Policies* node.
   b. Right-click each policy and select *Stop*.
   c. Expand the *EMC SourceOne > Operations > Job Management* node.
   d. Observe that all jobs in the Jobs (Active) view are stopped.

   **Note:** Client requests (such as jobs generated by users performing searches) will also be listed in this view. These requests can remain in an active state. End users will experience a service interruption until the systems are running again.
3. Close the EMC SourceOne console.
4. Close any other open MMC consoles.
5. Stop all EMC SourceOne services on all computers on which EMC SourceOne components are installed. However, if you are running the Master computer in an active/passive cluster, perform the following:
   - Do not manually stop the Master services (*EMC SourceOne Job Scheduler* and *EMC SourceOne Address Cache*).
   - From the cluster administration console, take the group containing these services “offline”. This ensures that the Master services are no longer running on either node.
6. Close the Services console if it is open.
Move the databases

Perform the procedures provided by Microsoft to move the databases from the current SQL Server computer to the destination computer.

Consult Microsoft’s documentation for instructions on how to detach and attach databases on SQL Server 2008 R2.

If you are using another supported version of SQL Server, use the Other Versions link to select it.

Configure SQL permissions

After the databases are moved to the destination SQL Server, you must re-configure specific permissions for the security logins for each of the databases. Refer to the following resources.

- Activity, Archive and Search databases – Refer to the *EMC SourceOne Email Management Installation Guide*.
- Discovery Manager database – Refer to the *EMC Discovery Manager Installation and Administration Guide*.

Ensure database connectivity

Options for ensuring database connectivity depend on whether you are using a DNS CNAME alias configuration or a different SQL Server host.

**Option 1: DNS CNAME alias configuration**

If you used a DNS CNAME alias configuration, perform the necessary steps in Active Directory to re-direct the DNS CNAME resource record to the new SQL Server host (and named instance, if used). For more information, consult Microsoft’s documentation.

**Option 2: Different SQL Server host**

When initially installed, some EMC SourceOne components installers created DNS and Registry entries that include information about how to connect to SourceOne databases. If you moved the EMC SourceOne databases to a SQL Server host with a different name, you must repair the components to specify the new database server host (and named instance, if used).

**Note:** To avoid this step in the future, you can establish a DNS CNAME record at this time that points to your new SQL Server host computer. You can then use Option 1 if you need to perform a subsequent database move.

Repair the following components:

- Console
- Master Services
- Worker Services
- Archive Services

Using Add/Remove Programs, repair all EMC SourceOne components, pointing to the new SQL Server (and named instance, if used) when prompted for database information. For each component, perform the following.
Maintaining EMC SourceOne

1. Click Change.
2. Click Next.
3. Select Repair.
4. Complete the wizard to repair the installation.

Resume operations

After updates are completed on all applicable systems, perform the following tasks.

1. Ensure that all systems and EMC SourceOne services are running.
2. Start the EMC SourceOne console. Because you have not yet established a connection to the database using the console, an error message will display. Click OK to close the error message.

**Note:** You must click OK to close the error message immediately to avoid a timeout that requires restarting the console.

3. Do the following:
   a. Expand the Archive Connections node.
   b. Right-click the archive connection and select Properties. The Edit Archive Connection: General page appears.
   c. Click Next. The New Archive Configuration page appears. Type the name of the new database server (and instance, if used).
   d. Click Finish.
4. Close and re-open the console.
5. Expand the EMC SourceOne > Organizational Policies node.
6. Right-click each policy and select Resume.
7. Expand the EMC SourceOne > Operations > Job Management node.
8. Observe that all jobs in the Jobs (Active) view are Active.

**Note:** If you stopped a daily activity which was running, the activity will resume in the next scheduled run.

Creating a custom event log monitor for all EMC SourceOne computers

Logging on to each individual computer in the EMC SourceOne system to check the event log can be time-consuming. However, you can create a custom MMC application on a single computer that allows you to view the event logs on the other computers.

Create this custom MMC application as follows.

1. On the computer on which you want to create the custom MMC application, enter the MMC command at the command prompt. A blank MMC console is created.
2. In the blank MMC console, select File > Add/Remove Snap-in.

The Add Standalone Snap-in dialog box appears.
3. From the list in the Add Standalone Snap-in dialog, select Event Viewer and click Add. The Select Computer dialog box appears.

4. In the Select Computer dialog, select either Local computer (to add the Event Viewer for the local computer) or select Another computer and browse to that computer to add the Event Viewer for a remote computer and click Finish. The Event Viewer is added to the custom console.

5. Continue to use the Add Standalone Snap-in dialog to add Event Viewers for all the computers you want to monitor.

6. When you are done, click Close to exit the Add Standalone Snap-in dialog. Then click OK to exit the Add/Remove Snap-in dialog.

7. Save the custom MMC application by selecting File > Save As and save the custom console with a unique name. You can then launch this console from the Start > Programs > Administrative Tools menu.

Email-specific: EMC SourceOne changes needed when Domino mailboxes increase from one to many

When a Domino administrator changes the number of mailbox databases used on a Domino server configuration from one to more than one after a Journal activity is run that accesses that server, these changes to the Domino server require the EMC SourceOne administrator to make corresponding changes to EMC SourceOne.

The following sections provide more details on how this Domino configuration change impacts EMC SourceOne and how to modify EMC SourceOne to account for the change.

Background on Domino mailbox configuration change

When there is a single Domino mailbox database, mail.box, EMC SourceOne creates a database named ExJournal.nsf to copy messages from mail.box so that the messages can be accessed by EMC SourceOne jobs.

When the Domino administrator increases the number of mailbox databases from one to more than one, the mail.box database remains but no new mail is delivered to it. Mail is now routed to the newly created mailboxes named mail1.box, mail2.box, and so on, up to the number of mail.box databases the Domino administrator specified.

The EMC SourceOne extension manager detects this change and creates matching databases, such as ExJournal1.nsf and ExJournal2.nsf, for each of the enumerated mailbox databases. The ExJournal.nsf database receives no more messages because the mail.box database is no longer receiving messages.

If an activity that accessed the Domino server was created before the Domino administrator created the multiple mail.box databases, that activity references the now unused ExJournal.nsf database instead of the active ExJournal1.nsf and ExJournal2.nsf databases, and new messages will not be processed.

If the ExJournal.nsf or mail.box database are deleted before EmailXender has been configured to match the changed Domino environment, the following errors are displayed in the event log when EMC SourceOne attempts to access the old mail.box:

Cannot log on to Notes mailbox
Cannot log on to the provider
Maintaining EMC SourceOne

The dispatcher thread received an error from the Job Business Component (JBC)

"EMC SourceOne modifications to be made as a result of Domino mailbox change" on page 316 describes the modifications that need to be made to EMC SourceOne to account for the changed Domino configuration.

EMC SourceOne modifications to be made as a result of Domino mailbox change

Perform the following to allow EMC SourceOne to correctly access a Domino server after the server configuration has changed from a single mail.box database to multiple mail.box databases.

1. If any Journal activities are accessing the original single Domino mailbox, mail.box, and the associated ExJournal.nsf file, allow those activities to complete so that the ExJournal.nsf file is empty of messages.

2. If required, modify all activities that formerly accessed the ExJournal.nsf database to now access the new enumerated databases, such as ExJournal1.nsf and ExJournal2.nsf and so on.
   - If you selected the Domino server as the data source for the activity the new database files will be used automatically and you will not need to change the activity.
   - If you selected one or more individual .nsf files as the data sources for the activity, you will need to remove ExJournal.nsf and add the new databases, such as ExJournal1.nsf and ExJournal2.nsf.

Optionally, the ExJournal.nsf file can be removed from the Domino server after it is empty and no longer accessed by an activity because it is no longer used.
CHAPTER 14
Troubleshooting EMC SourceOne

This section describes how to troubleshoot common or email-specific problems in an EMC SourceOne system. The following topics are included in this section:

◆ Troubleshooting content processing problems ...................................................... 318
◆ Troubleshooting EMC SourceOne server network problems .......................... 323
◆ Troubleshooting search problems ................................................................. 325
◆ Troubleshooting OWA shortcut problems (email-specific) .............................. 329
◆ Troubleshooting Journal activities with Office 365 content ............................ 331

Refer to the *EMC SourceOne for Microsoft SharePoint Administration Guide* for information about how to troubleshoot SharePoint content problems.

Refer to the *EMC SourceOne for File Systems Administration Guide* for information about how to troubleshoot file content problems.

Refer to the *EMC SourceOne Offline Access Installation and Administration Guide* for information about how to troubleshoot Offline Access problems.
Troubleshooting content processing problems

When content is not processed as you expect, the problem can occur because of problems in any of several areas. It is important to check these areas in order, because a problem in one area may cause a problem in a following area. For example, content not being archived may not be a problem with the content but may instead be a problem with the activity defined to process that content.

When troubleshooting content processing problems, perform the following checks:

♦ Check that there are no system processing problems.
♦ Check the organizational policy containing the activity defined to process the content.
♦ Check the activity defined to process the content.
♦ Check the one or more jobs generated to perform the content processing.
♦ Check one or more of the pieces of content processed.
Correcting system processing problems

Content not being processed correctly may indicate a general system problem that needs to be corrected.

Correct these problems by reviewing the same items you would review as part of your daily system maintenance:

- Review the status of all EMC SourceOne system computers, including the Workers, archive servers, and database servers.
- Review event logs on EMC SourceOne computers.
- Review available storage space on EMC SourceOne computers.
- Review status of storage volumes and searchable indexes.
- If performing email journaling, review journaling mailboxes or databases for unprocessed messages.

If you cannot determine the nature of the EMC SourceOne problem, contact your EMC representative for additional help.

Correcting organizational policy processing problems

Perform the following tasks to diagnose and correct problems with an organizational policy.

1. Select the Organizational Policies node to view the policy in the middle pane.
2. Review the Status column for the organizational policy. If required, take the corrective action specified for that state as shown in the following list.
   - **Active** - The organizational policy is active. This is the working state of an organizational policy and no corrective action is needed.
   - **Paused** - Determine who used the Pause action to suspend the organizational policy and all activities and jobs contained within the organizational policy and why. If the reason for pausing the organizational policy no longer applies, select the Resume action for that organizational policy to allow it and the contained activities and jobs to become active again.
   - **User Terminated** - Determine who used the Stop action to terminate the organizational policy and all activities and jobs contained within organizational policy and why. If the reason for terminating the organizational policy no longer applies, select the Resume action for that organizational policy to allow it and the contained activities and jobs to become active again.
3. If the organizational policy is in an active state, and the problem still exists, follow the directions in the following to section to see if the problem lies in an activity rather than in the organizational policy.
Correcting activity processing problems

Perform the following tasks to diagnose and correct problems with an activity.

1. Select the Organizational Policies node, and expand the policy in the middle pane to view the activity.

2. Review the Status column for the activity. If required, take the corrective action specified for that state as shown in the following list.

   - **Defined** — The activity has been defined but has not yet entered the Active state. This status is temporary and no corrective action is needed.

   - **Active** — The activity is active. This is the typical working status for an activity, unless the final, or only, job created by the activity is running. No corrective action is needed.

   - **Read Only** — The activity cannot be edited because the final, or only, job created by the activity is running. No corrective action is needed; the Read Only status changes when the job completes.

   - **Paused** — Determine who selected the Pause action to pause the activity and why. If the reason for pausing the activity and the associated jobs no longer applies, select the Resume action for that activity to allow the activity and the associated jobs to continue to process.

   - **User Terminated** — Determine who terminated the activity using the Stop action and why. If the reason for terminating the activity and the associated jobs no longer applies,
     perform one of the following:
     - If the activity was to run a single time, recreate the activity.
     - If the duration of the activity was recurring, select the Resume action for that activity to allow the activity and the associated jobs to continue to process.

   - **Success** — The final, or only job created by the activity completed successfully.

   - **Failure** — The final, or only job created by the activity failed. Follow the directions in “Correcting job processing problems” on page 321 to correct the job problem.

3. If the activity status indicates that there are no problems, review the definition of the activity and any rules used by the activity, to make sure they are performing the expected processing.

   - For email content, refer to “Configuring Email Management Activities” on page 341 for information about how activities are defined and refer to “Using Email Management Rules” on page 499 for information about how rules are defined.

   - For SharePoint content, refer to the EMC SourceOne for Microsoft SharePoint Administration Guide for information about defining SharePoint content activities.

   - For file content, refer to the EMC SourceOne for File Systems Administration Guide for information about defining file content activities.

4. If the activities are defined correctly and the problem still exists, follow the directions in “Correcting job processing problems” on page 321 to see if the problem lies in one of the jobs rather than in the activity.
Errors may be reported running Exchange archiving activities
Occasional errors may occur when you perform Exchange archiving activities. The errors indicate
Failed to calculate message ID or
Failed to extract MAPI Properties from MsgId
and a subset of the messages may fail to process. Specific error IDs to look for are
80040115 and 80040125.

Rerun the activity to archive any failed messages.

Shortcut activity error when a Domino compact operation in process
If a shortcut activity is launched while Domino is compacting databases, an error similar to
the following is generated.

Failed to open note. [ExShortcutJBC.exe,
ExNotesUtils.cpp(3683).CExNotesUtils::OpenNote]

Review the nightly compact schedule and adjust the timing of shortcut activities. You can also re-run activities against mail databases that failed to be shortcut.

Correcting job processing problems
Perform the following steps to diagnose and correct problems with message processing by jobs.

1. Ensure that the content processing problem is not caused by the activity.
2. List all jobs associated with the activity that had content processing problems. To view the jobs associated with a particular activity, perform the following:
   a. Expand the Operations node and select the Job Management node.
   b. Select Action > Current View > All Jobs to display all jobs regardless of their state.
   c. Select Action > Filter; the Filter dialog box appears. In the Filter dialog box:
      – Select Activity Name as the Column criteria.
      – Select Is Exactly as the Condition criteria.
      – Specify the name of the particular activity as the Value criteria.
   d. Click Add to save the filter condition.
   e. Click OK. The filter lists jobs and displays only those jobs associated with the specified activity name.
3. Review the state of the jobs listed using both the status icon in the first column of the job list and the Status field in the job information pane that appears when a job is selected. The job status icon in the job list can map to multiple similar job status values listed in the detailed job view.

The following table lists the meaning of the job status and the corrective action, if needed.

**Table 40 Job status and corrective action (page 1 of 2)**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 Active</td>
<td>The job is active and being processed on a Worker. No corrective action needed.</td>
<td></td>
</tr>
<tr>
<td>🔄 Available</td>
<td>The job was generated and is available for a Worker to select it for processing. No corrective action needed.</td>
<td></td>
</tr>
<tr>
<td>🔄 Waiting for Resource</td>
<td>The job is waiting for a Worker to become available. No corrective action needed.</td>
<td></td>
</tr>
<tr>
<td>🔄 Taken</td>
<td>The job was selected by a Worker, and the Worker is preparing to start it, but it has not started yet. No corrective action needed.</td>
<td></td>
</tr>
<tr>
<td>🔄 Completed</td>
<td>The job completed. No corrective action needed.</td>
<td></td>
</tr>
<tr>
<td>🔄 Incomplete</td>
<td>The job did not complete in the time scheduled for it to run. This may indicate that there are too few Worker Servers defined as part of your EMC SourceOne environment. Monitor how long it takes for the job to complete. If this period is too long, consider adding more Worker Servers (or more powerful servers) to your environment or otherwise improving the performance of the distributed EMC SourceOne system.</td>
<td></td>
</tr>
<tr>
<td>🔄 User Terminated</td>
<td>The job was stopped manually. Determine who stopped the job using the Stop action and why. If the reason for terminating the job no longer applies, and the activity which created the job will create another job, the next run of the activity will create a new job that can be allowed to complete.</td>
<td></td>
</tr>
<tr>
<td>🔄 Self Terminated</td>
<td>The job was instructed to terminate itself by the job dispatcher and did so successfully. If the reason for terminating the job no longer applies, and the activity which created the job will create another job, the next run of the activity will create a new job that can be allowed to complete.</td>
<td></td>
</tr>
<tr>
<td>🔄 Dispatcher Terminated</td>
<td>The job was instructed to terminate itself by the job dispatcher but could not, so the job dispatcher forcibly terminated the job. If the reason for terminating the job no longer applies, and the activity which created the job will create another job, the next run of the activity will create a new job that can be allowed to complete.</td>
<td></td>
</tr>
<tr>
<td>🔄 Expired</td>
<td>The job was never dispatched, because the job dispatcher became aware of the job after the job’s scheduled end time had passed. Reschedule the job so that it can run.</td>
<td></td>
</tr>
</tbody>
</table>
4. If jobs have performed their processing correctly and the problem still exists, follow the directions in “Correcting content processing problems” on page 323 to see if the problem lies in the content processing or archiving rather than in the jobs.

Correcting content processing problems

Perform the following steps to diagnose and correct problems with content processing.

1. Ensure that the content processing problem is not caused by the activity.
2. Ensure that the content processing problem is not caused by the job.
3. Create the job list as described in “Correcting job processing problems” on page 321.
4. Review the Failed Count column associated with each job in the list to determine if any content failed to be processed by the job. If the value is greater than 0, investigate why that content is not being processed.
5. Enable more detailed logging of the individual containers (such as folders or mailboxes) or files processed by a job, and run the jobs again. Note that up to 10 files or containers can be processed by a single job. “Using Job Logs” on page 269 describes how to enable detailed job logging.
6. Retrieve more information about why the content was not processed by reviewing archive information for the content.
   - For a Native Archive archive, review the archive folders to see if there are any errors on the folder for the content. “Configuring Archives” on page 51 describes how to use and view information about Native Archive folders.
   - For an EmailXtender 4.x archive, review the archive folder using the EmailXtender Administrator. Refer to the EMC EmailXtender Administrator’s Guide for how to view information about EmailXtender archive folders.

Troubleshooting EMC SourceOne server network problems

EMC SourceOne uses the Media Access Control (MAC) address of a computer to uniquely identify the following servers on the network.

- Worker Servers
## Troubleshooting EMC SourceOne

- **Native Archive Servers**

  If these types of servers have multiple network MAC addresses installed, the first MAC address encountered is used by EMC SourceOne.

  The following sections describe two common problems that can occur with MAC address changes and EMC SourceOne.

### Problems when network MAC address changes

When the network MAC address of an existing EMC SourceOne server changes (either physically or in a virtual environment), EMC SourceOne cannot correctly recognize that Worker Server, or Native Archive Server.

**Scenario**

For example, if you change the MAC address of a Worker Server, the EMC SourceOne console will display two entries for that server on the Configuration tab of the Server node, both with the same server name, but different Server ID values and different MAC addresses.

- The entry with the original MAC address will contain all the existing EMC SourceOne configuration data (such as what types of jobs could be processed by that Worker Server), but will have a state of Unavailable, because that MAC address is not on the network.
- The entry with the new MAC address will have a state of Available because it is on the network, but will contain none of the existing EMC SourceOne configuration data because it is treated as a new server.

**Solution**

Perform one of the following steps to correct this problem.

- If possible, set the MAC address of the new network interface to be the same as the old MAC address.
- If you cannot change the MAC address, reinstall the server as whatever type of EMC SourceOne server it was formerly, including performing all configuration you had previously performed on the server.

### Problems when there are multiple servers with the same MAC address

When the network MAC address of an existing EMC SourceOne server is duplicated so that there are two EMC SourceOne servers with the same MAC address (either physically or in a virtual environment), EMC SourceOne cannot correctly recognize that server which can cause similar problems to those described in "Problems when network MAC address changes" on page 324.

**Solution**

To correct this problem, ensure that the MAC addresses of all EMC SourceOne servers are unique.
Troubleshooting search problems

The following information will help you troubleshoot problems you may encounter when using EMC SourceOne Search to search for and retrieve messages.

◆ “Troubleshooting EMC SourceOne Search problems using logging” on page 327 describes the logging information that is available for EMC SourceOne Search components.

Connecting to Web server

This section contains information that will help you to troubleshoot problems that might occur when connecting to the Web server.

User cannot access the EMC SourceOne Search login page

The following issues will prevent a user from accessing the Search login page.

◆ The user entered the wrong URL.
◆ A Page Not Found error means that the ASP.NET 2.0 web extension is missing or prohibited.
◆ A Service Unavailable error means that a pre-installation configuration step was not completed correctly (such as setting up accounts and permissions) or that you need to restart a service.
◆ Problems exist in your environment or with network load balancing.

Authenticating users

Refer to the following section for information about troubleshooting Search login problems.

User cannot log in

The following issues prevent a user from logging into Search.

◆ The Search application Web service has been configured with the wrong URL.
◆ SSL is not configured, but the SSL checkbox was selected at installation.
◆ Login to Windows or Domino fails.
The ExSearchService.exe.log contains more information.

Selecting search folders

The information in this section will help you troubleshoot problems that you might encounter when selecting search folders.

User cannot see any folders

The There are no available folders to search error indicates one or more of the following problems.

◆ Mapped folders do not exist for the archive folders.
◆ Folder permissions were not set for the user.
The folder permissions that were set for the user are not correct for the type of search that the user is performing.

The ExSearchWebService.log contains more information.

**Searching**

Refer to the following sections for troubleshooting problems that may occur when searching.

**Errors occur while running a search**

If errors occur while a search is running, look at the following logs.

- ExJBQuery.exe.log
- Provider-specific logs, such as ExAsQuery.exe.log for the Native Archive.

**No search results**

If no search results are returned, verify the following.

- The correct search fields were used.
- The criteria entered in the search fields is correct.
- The user selected the correct search type.

**Wrong search results**

If wrong search results are returned, verify the following.

- The correct search fields were used.
- The criteria entered in the search fields is correct.
- The user selected the correct search type.
- Understand that the differences in search results may be due to the type of archive (Native Archive or EmailXtender 4.8 archive). Refer to “Searching an archive” on page 109.
- Understand that search results depend on whether the archive is full-text indexed.
- Understand that some search fields search against the database (a relational search) and other search fields search against the index (a full-text index search). The **Always search embedded messages** option also affects whether a relational search or a full-text index search is executed. Refer to the *EMC SourceOne Search User Guide* for more information.

**Working with search results**

Refer to the following sections for troubleshooting problems that may occur when working with search results.
Errors when viewing messages

If errors occur when users view messages, verify the following.

- The EMC SourceOne Retrieval Service is running.
- The Search application Web service is running.
- The native email client is installed on the user computer.
- If users cannot open Notes messages, verify that the EMC ONM Viewer is installed on user computers, in addition to the Notes client.

Errors when restoring messages

If errors occur when users restore messages, verify that the email system (Microsoft Exchange or IBM Lotus Domino) is not experiencing problems.

The ExjBRestore.exe.log file contains more information.

Errors when copying messages

If errors occur when users copy messages refer to “Troubleshooting content processing problems” on page 318.

The ExjBRestore.exe.log file contains more information.

Errors when deleting messages

If errors occur when users delete messages, determine the following.

- Which search type was used to perform the delete: Administrator or My Contributed Items.
- The archive type (Native Archive or EmailXtender 4.8 archive).

The ExjBDeleteFromArchive.exe.log file contains more information.

Troubleshooting EMC SourceOne Search problems using logging

Refer to the following sections for troubleshooting EMC SourceOne signals search problems using two types of logging.

Note: By design, search errors are displayed to the user instead of being logged to the event log, to prevent the server event log from filling up.

The EMC SourceOne Search Web Service:

- Uses standard EMC SourceOne logging and event logging
- Can use IIS logging

The EMC SourceOne Search application server uses only IIS logging.
Standard EMC SourceOne logging

Standard EMC SourceOne logging creates a log for each Search component.

Search components on EMC SourceOne Worker

The following table lists the Search components and associated log files on the EMC SourceOne Worker.

<table>
<thead>
<tr>
<th>EMC SourceOne Search component</th>
<th>Log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Web Service</td>
<td>ExSearchWebService.log</td>
</tr>
<tr>
<td>Search Service</td>
<td>ExSearchService.exe.log</td>
</tr>
<tr>
<td>Search JBC</td>
<td>ExJBQuery.exe.log</td>
</tr>
</tbody>
</table>

Search components on EMC SourceOne Native Archive Server

The following table lists the Search components and associated log files on the Native Archive.

<table>
<thead>
<tr>
<th>EMC SourceOne Search component</th>
<th>Log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Query Service</td>
<td>ExAsQuery.exe.log</td>
</tr>
<tr>
<td>ISYS Searcher</td>
<td>ExAsSrchexe.log</td>
</tr>
</tbody>
</table>

IIS logging

Perform the following procedure to configure IIS logging for the Search Web service or the Search Web application.

1. Open the web.config file on the server running the service or application you want to configure. Default locations for the web.config files are:
   - Search Web service:
     
     C:\Program Files\EMC SourceOne\Search\WebApp
   - Search Web application:
     
     C:\Program Files\EMC SourceOne\SearchWS\WebServer

2. Add or edit the following entry in the in web.config file:

   <trace enabled="true" requestLimit="100" pageOutput="false" traceMode="SortByTime" localOnly="true"/>

To view the resulting trace.axd log file, enter the URL in a Web browser:

- Search Web Service:
  
  http://localhost/ExSearch/trace.axd

- Search Application server:
  
  http://localhost/ExSearchApp/trace.axd
Troubleshooting OWA shortcut problems (email-specific)

In some cases, EMC SourceOne shortcuts do not work as expected when used with Outlook Web Access (OWA). Often, the problem is linked to a particular version of OWA.

Troubleshooting OWA shortcut retrieval problems

The following sections identify known problems when using Outlook Web Access to retrieve shortcuts created using EMC SourceOne, and provide workarounds when possible.

Users cannot retrieve OWA shortcuts after an administrator has changed the value of the Security group name field

If an administrator modifies the Security group name field on the Retrieval tab of the Retrieval dialog (accessed from the Retrieval node under the Application Configuration node in the EMC SourceOne console), the administrator must restart the Document Management Service.

Failure to restart the Document Management Service will cause OWA users to not be able to retrieve shortcuts until that service is restarted.

Users cannot retrieve shortcuts when OWA access is configured at the root URL

Users have problems retrieving shortcuts when an administrator has configured OWA access at the root URL.

If an administrator wants to provide OWA access at the root URL instead of using a virtual directory (that is, using https://email.company.com instead of https://email.company.com/exchange), the administrator must add an entry to the OWA web.config file for the ExOwaForm application on the OWA server.

Perform this by adding the following line in the <appSettings> </appSettings> section:

<add key="NoVirtualDir" value="true"/>

Users cannot retrieve shortcuts using OWA on a Macintosh computer

Users of Outlook Web Access (OWA) on a Macintosh computer cannot restore EMC SourceOne shortcuts.

Retrieving OWA shortcuts may cause error when multiple IIS Web sites used

When an EMC SourceOne system has external and internal OWA Web sites in use and shortcCutting has been enabled, the HTTP 403 error can be returned when a user attempts to resolve a shortcut message using the external OWA Web site. This is caused by the external OWA Web site not having the ExOwaForm virtual directory installed.

To workaround this problem, install shortcut support on the external Web site that is causing the error as follows.

1. Verify that you can retrieve shortcuts using OWA on the internal (existing) IIS Web site on which EMC SourceOne OWA support was installed.

2. Open the Internet Information Services (IIS) Manager application on the Exchange Back-End Server.
3. On the left pane of the IIS Manager, expand the **Web Sites** folder.

4. Within the Web Sites folder, expand the Internal Web Site which contains the ExOwaForm virtual directory.

5. Right-click the **ExOwaForm** virtual directory, select **All Tasks** from the context menu, and select **Save Configuration to a File**. The **Save Configuration to a File** dialog box appears.

6. In the **Save Configuration to a File** dialog:
   a. In the **File name** field, enter **ExOwaForm** as the name.
   b. In the **Path** field, type or browse to the location where you want to save the file and click **OK**.

   The file **ExOwaForm.xml** is created in the location you specified and the Save Configuration to a File dialog exits.

7. Right-click the external Web site on which you want to enable the ability to restore shortcuts when using OWA.

8. Select **New > Virtual Directory (from file)** from the context menu. The **Import Configuration** dialog box appears.

9. In the **Import Configuration** dialog:
   a. Specify the previously saved ExOwaForm XML file in the **File** field and click **Read File**.
   b. Select the ExOwaForm configuration listed in the Location area, and click **OK**.

   The new ExOwaForm virtual directory is created within the selected website, and the Import Configuration dialog box exits.

10. Reset the IIS services by entering the **IISRESET** command at the command line on the Exchange Back-End Server.

### Troubleshooting OWA shortcut viewing problems

The following sections identify known problems with viewing EMC SourceOne shortcuts when using Outlook Web Access, and provide workarounds when possible.

**Users cannot view shortcut messages in the reading pane when using OWA 2010**

Users cannot view shortcut messages in the reading pane when using OWA 2010.

To workaround this problem, users are to open the shortcut message to view it when using OWA 2010.

**Users cannot view shortcut meeting or appointment attachments using OWA 2007 or OWA 2010**

OWA 2007 and OWA 2010 do not support custom forms for the calendar folder, which affects EMC SourceOne shortcut processing.

When you open an appointment or meeting that has been shortcut, any attachments that are part of that appointment or meeting appear. However, because forms are not supported, those shortcut attachments do not appear. Only the shortcut stub appears.
Saving the shortcut stub to disk as an HTML file and then opening it is not always a valid workaround because the HTML in the stub may be changed by the OWA Safe HTML filtering feature, causing the link to no longer function.

The best workaround is to use Outlook to open appointments or meetings that have been shortcut.

Troubleshooting other OWA shortcut problems

The following sections identify other problems when using Outlook Web Access with EMC SourceOne shortcuts, and provide workarounds when possible.

Cannot use Previous and Next buttons to navigate shortcut messages in OWA

After opening a shortcut message in OWA, you cannot use the Previous and Next buttons to navigate to the next shortcut message. Adjacent messages which are not shortcut are not subject to this limitation.

To workaround this problem, close the open message and select the desired message to view from the list instead.

Garbled multibyte text displayed in OWA shortcut stub attachment

Under some conditions, OWA users may observe garbled multibyte character text displayed when they open a shortcut stub attachment in OWA.

If this occurs, set the browser character encoding to be Unicode (UTF-8).

Troubleshooting Journal activities with Office 365 content

When you use the Journal activity to process email messages from an Office 365 environment, errors may be written to the event log indicating a situation that needs to be corrected. This event log is on the Master Server on which the File Mover agent was installed.

Generally, these event log messages have to do with either connectivity to the source and target directories used by the SMTP journal group, or problems with the amount of disk space remaining in those directories. These event log messages are issued by the File Mover agent only when you have defined separate source directories and target folders.

Refer to the troubleshooting section in “Using the Journal Activity for Office 365 Content” on page 453 for information about how to resolve these error messages when you encounter them.

Troubleshooting User Delete issues

The following sections provide suggestions for how to troubleshoot issues with the User Delete activity.

Troubleshooting mapping folders for User Delete

If the Delete permission does not display in the Permissions tab of the Folder Properties dialog box, run the upgrade scripts for the EMC SourceOne Activity database.
Troubleshooting the Folder Conversion utility for User Delete

The following section lists common problems and solutions with using the Folder Conversion utility.

Problem

Errors during Initialization (-init) appear in the ES1NaFolderConvert.exe.log, and the utility stops processing and exits. This may be due to a database connection problem.

Solution

Rerun the Folder Conversion utility using -init.
Processing continues from where the utility left off

Problem

Errors during update of ownership appear in the ExAsAdmin.exe.log as FolderConvert command failed.

Solution

Run the utility using -rerun.
The failed FolderConvert command will be reprocessed.

Problem

Errors while the Native Archive Server is suspended. Ownership updates stop.

Solution

Ownership updates will resume when you resume the Native Archive Server using the suspend resume script.

Problem

The load on the SQL server is too high.

Solution

Run the Folder Conversion utility using -ctrl and the parameters to:
- Reduce the number of threads performing the conversion.
- Schedule the conversion in off-peak hours.

Refer to the *EMC SourceOne Email Management Administration Guide* for details about the parameters for the Folder Conversion utility.

Troubleshooting EMC SourceOne Search use with User Delete

Troubleshoot the issues described in the following sections with EMC SourceOne Search when using the User Delete activity.

Delete jobs fail

If Delete jobs fail, review the following:
- The EMC Event log for errors.
- The ExDeleteFromArchiveJBC.exe.log for information about deletes performed through Search.

**Individual items fail to be deleted**

The errors and solutions shown in the following section are displayed in either of the following locations.

- The **Failure Report** dialog box in Search.
- The detailed log file for the Delete job in the EMC SourceOne console

**Error**

Delete window expired. Items older than <X> days cannot be deleted

The item is no longer eligible for deletion based on its age.

**Solution**

Instruct users to choose items to delete that are within the date window that you defined in the **Archive deletion eligibility period** field.

**Error**

Failed to retrieve item

Either there is a problem retrieving the item from the Archive service, or the item no longer exists in the archive.

**Solution**

Verify that the Archive service is running.

**Error**

Permission denied

The user has Contributor permission but does not have Delete permission on the mapped folder.

**Solution**

Grant the user Delete permission on the mapped folder. For example, if a user has Contributor permission on both Folder1 and Folder2, but Delete permission on Folder1 only, then:

- The Delete option is still enabled in Search.
- The user can find items in both folders and select items from both folders to delete.
- Items from Folder2 fail to be deleted, with a Permission denied error reported in the **Delete Status Details** dialog box.

**Error**

Failed to delete item

A general or unexpected failure.

**Solution**

Look in the Detailed Log File, which displays more information about the error, including the failure error code and an error string if available.
If the Detailed Log File does not exist because you did not enable it, or if you need more information, look in the ExDeleteFromArchiveJBC.exe.log.

Deleted mail item still appears in search results after 24 hours

If the Delete status dialog box in Search reports that the mail item was successfully deleted, but the item is still appearing in search results after 24 hours, do as follows.

- Look in the Detailed Log File to verify that the mail item has a status of Deleted.
- Examine your Native Archive Servers that have the Archive and Index roles. Within the 24 hours after a mail item is successfully deleted, the Native Archive Server removes the message/reference from SQL, posted an update to the index, and zeroed out the item in the container (if applicable). To determine if errors were encountered during this process:
  - Look in the Event Log on your Native Archive Servers.
  - Look in the ExAsArchive.exe.log for additional error information.
CHAPTER 15
Configuring CTA Integration

This section describes the integration of EMC Cloud Tiering Appliance (CTA) with Email Management. Topics include:

- Enabling CTA integration ................................................................. 336
- Managing CTA server consoles ...................................................... 336
Configuring CTA Integration

Enabling CTA integration

You can enable the use of the EMC Cloud Tiering Appliance (CTA) console while within the EMC SourceOne console. Then use the CTA console to manage your CTA servers while within the EMC SourceOne console.

When integration is enabled, the Cloud Tiering Appliance (CTA) node is added to the list of nodes in the EMC SourceOne console.

Enable and disable the use of CTA consoles within the EMC SourceOne console using the Global Settings page of the Application Configuration node.

Managing CTA server consoles

You can add, modify or delete CTA server consoles from the list of those that can be launched from EMC SourceOne Email Management.

The following sections describe how to manage access to CTA server consoles.

Adding a CTA server console

Perform the following steps to add a CTA server console.

1. Verify that CTA integration is enabled.

2. Select the New CTA Server action in the EMC SourceOne console, or right click the Cloud Tiering Appliance (CTA) node and select New CTA Server. The New CTA Server dialog box appears.

Figure 104  New CTA Server dialog

3. In the New CTA Server dialog, enter the location of the CTA server console Web page in the Server address field. The server address that you enter is not validated as being the location of a CTA server, so ensure that you enter it accurately.

4. Optionally, enter a description for this server console in the Description field.
5. Click **Finish**.

**Note:** A maximum of 20 CTA servers can be configured at one time; attempting to configure more than 20 servers will result in an error.

The server console is added as a node under the **Cloud Tiering Appliance (CTA)** node in the EMC SourceOne console and that CTA Server console Web page appears.

![CTA Server console displayed within EMC SourceOne](image)

**Figure 105** CTA Server console displayed within EMC SourceOne
Modifying the description of a CTA server console

Modify the description of a CTA server console, but not the server address. If the specified server address has changed, delete the CTA server and add it again to the EMC SourceOne console.

Perform the following steps to modify the description of a CTA server.

1. Select the server console to be modified under the Cloud Tiering Appliance (CTA) node.

2. Select the Properties action in the EMC SourceOne console, or right-click the selected CTA console node and select Properties. The Edit CTA Server dialog box appears.

![Edit CTA Server dialog](image)

3. On the Edit CTA Server dialog box, modify the contents of the Description field.

4. Click Finish.

Deleting a CTA server console

Perform the following steps to delete a CTA server console.

1. Select the server to be deleted under the Cloud Tiering Appliance (CTA) node.

2. Select the Delete CTA Server action in the EMC SourceOne console, or right click the selected CTA console node and select Delete CTA Server. A Delete CTA Server dialog box appears that displays the following:

   Are you sure you want to delete the selected CTA server?

3. Click Yes to continue the deletion.

The CTA server console is deleted from the list of server consoles under the Cloud Tiering Appliance (CTA) node.
Part 2 Email Management Specific Information

This part contains EMC SourceOne information that applies to only email content types. The following sections in this part describe the email management-specific features of EMC SourceOne and include the following chapters.

◆ “Configuring Email Management Activities” on page 341.
◆ “PST and NSF Processing Activities” on page 397.
◆ “Shortcut Activities” on page 433.
◆ “Using Journal Activities” on page 447.
◆ “Using the Journal Activity for Office 365 Content” on page 453.
◆ “Processing Exchange Public Folder Content” on page 479.
◆ “User-Directed Archiving Activities” on page 491.
◆ “Using Email Management Rules” on page 499.
◆ “Configuring User Delete” on page 521

In addition, the following in “Part 1 Common Information” on page 13 contain sections that are email-specific:

◆ “Common and email-specific best practices” on page 241.
◆ “Maintaining EMC SourceOne” on page 277.
◆ “Troubleshooting EMC SourceOne” on page 317.

Refer to “Part 1 Common Information” on page 13 for information that is common to all content types.
This section describes how to configure and manage activities for email management in EMC SourceOne Email Management. Topics include:

- Introduction to activities ................................................................. 342
- Adding activities to an organizational policy .................................................. 347
- Activity Type .................................................................................... 347
- Data Source Types ............................................................................ 348
- Select Data Sources ........................................................................... 348
- Journaling Method ............................................................................. 362
- Group Options ................................................................................... 362
- Item Types .......................................................................................... 364
- Folders ................................................................................................. 367
- User Created Folders .......................................................................... 370
- Dates .................................................................................................. 370
- Attachments Filter ............................................................................. 373
- Message Types Filter ......................................................................... 374
- Properties ............................................................................................ 375
- Message Size Filter ........................................................................... 376
- Mapped Folder(s) .............................................................................. 377
- Shortcut Options ............................................................................... 382
- Post Processing .................................................................................. 382
- Business Components ....................................................................... 384
- Delete Options .................................................................................... 385
- Scheduling Activities ......................................................................... 386
- Select Worker Group .......................................................................... 391
- Activity Name ..................................................................................... 392
- Editing activities in an organizational policy ............................................. 392
- Controlling activities .......................................................................... 393
- Deleting activities from an organizational policy ................................... 396
Introduction to activities

A policy groups together one or more activities. An activity is a user-named definition for performing a specific type of work with EMC SourceOne, including the environment it will be performed in and when it will be performed. Activities, like policies, are defined using the EMC SourceOne console.

For example, you could create a policy called Archiving for Asia Pacific, which might include two activities: Journaling for Asia Pacific which uses the Journal activity type and Historical Archive (Japan) which uses the Archive - Historical activity type.

Prerequisites

Ensure the following prerequisites are met before creating an activity.

- Verify that the EMC SourceOne system is ready create the activity.
- Review the description of the activity type to make sure you are aware of all considerations and limitations of the activity and also review the lists in the following section.
- Review the description of the activity type to make sure you have performed any other necessary tasks before creating an activity of that type. The following are examples of such tasks:
  - Before archiving personal mail files or creating PST activities, you must create NSF groups or PST groups.
  - Before creating shortcut activities or Migrate PST activities, you must specify the universal shortcut URL in the Application Configuration node.
  - Before creating UDA activities, you must create the UDA folders.
  - Before creating Journal activities to process Microsoft Office 365 email content, you must create SMTP Journal groups.

Considerations and limitations for activities

Review the following sections to see if any of the listed considerations and limitations pertain to the activity you plan to create.

General activity considerations and limitations

If the CPU on an EMC SourceOne Worker computer is being completely consumed by a single activity, break that activity into a set of smaller activities that process separately and not completely consume the CPU. For example, rather than shortcut all messages that are older than 30 days, have several activities that shortcut these messages in smaller groups. For example, using a single activity to shortcut at one time all the email in a company that is older than 30 days could cause the CPU on a Worker to be completely consumed.
Email-specific activity considerations and limitations

Review the following email-specific considerations and limitations to see if any pertain to the activity you plan to create.

- EMC SourceOne has a limitation, identified through testing, of 140MB for archiving large embedded messages. Embedded messages below this threshold can be successfully archived.
- Email messages with attachments greater than 2 GB cannot be archived reliably.
- In environments which include Exchange 2010, Exchange converts the canonical addresses in journaled messages to SMTP addresses, causing those journaled messages to be duplicated across Exchange 2010 servers and between the journaling mailbox and the user mailboxes as follows:
  - If a message is journaled on Exchange 2010 and archived by EMC SourceOne, and then subsequently archived by a historical archiving task, the duplicate message is archived.
  - If a message is journaled, and archived, from both Exchange 2007 and Exchange 2010, the duplicate message is archived.

When duplicate messages are archived, this can result in a larger than expected archive, and can result in duplicate messages being displayed in search results.

This duplication occurs in the following environments:

- Exchange 2010 only environment
- Exchange 2010 with Exchange 2007 environment

Microsoft has released an Interim Update for this issue. Customers can request KB978871 from Microsoft, without charge, to receive the Interim Update. After you apply the Interim Update on all Exchange 2010 servers, the routes remain as canonical addresses and not SMTP addresses, so the messages will now correctly have duplicates removed across Exchange 2010 servers and between the journaling mailbox and the user mailboxes.

If you do not want to apply this fix, you can minimize the chances of duplicate archived messages by performing either Journal or Archive - Historical activities, but not both.
- Domino groups are not expanded in journaled messages.

Summary of activity types

The following section summarizes the types of activities you can create.

The activity types available for you to select are determined by the EMC SourceOne products installed:

- If EMC SourceOne for File Systems is installed, refer to the EMC SourceOne for File Systems Administration Guide for the list of activity types for processing file content.
- If EMC SourceOne for Microsoft SharePoint is installed, refer to the EMC SourceOne for Microsoft SharePoint Administration Guide for the list of activity types for processing SharePoint content.
If Email Management is installed, refer to the following list for the description of activity types for processing email content. The available activity types displayed by the EMC SourceOne console are also modified by the email platforms that are enabled.

Review, and if required modify, the list of supported mail systems in the Global Settings dialog box of the EMC SourceOne console to ensure that they match your environment.

- **Archive - Historical** — Archives items stored on a mail server.
- **Archive - Microsoft Exchange Public Folder** — Archives items stored in a Microsoft Exchange public folder.
- **Archive - Personal Mail Files** — Archives items stored in Microsoft Office Outlook PST files or IBM Lotus Notes NSF files.
  
  If you are processing Exchange PST files in a multiple forest Active Directory environment, you might need to perform the additional configuration tasks before using this PST processing activity.

- **Archive - User Directed Archive** — Archives items stored in user-directed archive folders.
- **Delete - Historical** — Deletes items from mailboxes on a mail server.
- **Delete - Microsoft Exchange Public Folder** — Deletes items from public folders on an Exchange mail server.
- **Delete - User Directed Archive** — Deletes items from user-directed archive folders.
- **Delete - User Initiated Delete** — Processes requests in user mailboxes to delete messages from the archive.

  The Delete - User Initiated Delete activity is for use in Microsoft Exchange environments only. You are not prevented from creating this activity in an IBM Lotus Domino-only environment. If you do create this activity in a Domino-only environment, the following error is recorded in the logs when the activity tries to run:

  Not implemented

- **Find - Microsoft Office Outlook .PST** — Searches, discovers, and attempts to determine ownership of Microsoft Office Outlook PST files to be processed by EMC SourceOne.

  If you are processing Exchange PST files in a multiple forest Active Directory environment, you might need to perform the additional configuration tasks before using this PST processing activity.

- **Journal** — Journals items as they are received by a Domino, Exchange, Exchange Online or SMTP mail server.

  You can:

  - Journal Exchange Online content from an Office 365 environment.
  - Allowing users to delete mail items that have been journaled.

- **Migrate - Microsoft Office Outlook .PST** — Shortcuts and moves messages to a specified folder, and optionally deletes a Microsoft Office Outlook PST file after it has been archived.
If you are processing Exchange PST files in a multiple forest Active Directory environment, you might need to perform the additional configuration tasks before using this PST processing activity.

- **Shortcut - Historical** — Replaces archived messages on a mail server with shortcuts to those messages in the EMC SourceOne Native Archive.
- **Shortcut - Microsoft Exchange Public Folder** — Replaces archived messages in Microsoft Exchange public folders with shortcuts to those messages in the EMC SourceOne Native Archive.
- **Restore Shortcuts - Microsoft Exchange Public Folder** — Restores messages that were shortcut from Exchange public folders by replacing the shortcut messages with the original messages.
- **Restore Shortcuts - Historical & User Directed Archive** — Restores messages that were shortcut by replacing the shortcut messages with the original messages.
- **Shortcut - User Directed Archive** — Replaces archived messages in user-directed archive folders with shortcuts to those messages in the EMC SourceOne Native Archive.
- **Update Shortcuts - Historical & User Directed Archive** — Updates out-of-date information about shortcuts to Microsoft Exchange messages.

**Summary of New Activity wizard pages for email activities**

This section summarizes the New Activity wizard pages for each of the Email Management activity types.

Use the New Activity wizard to create new activities. The pages that appear in the New Activity wizard depend on the activity type that you select. Not all pages appear for every activity type.

The New Activity wizard pages and activity types table lists the pages in the New Activity wizard in the order in which they are displayed by the wizard (top to bottom) for each Email Management activity.

For file archiving or SharePoint archiving activity pages, refer to either the EMC SourceOne for File Systems Administration Guide or the EMC SourceOne for Microsoft SharePoint Administration Guide.

The following table displays the New Activity wizard pages and associated activity types.
If a page is used for an activity, the word Yes occurs in the column for that activity.

### Table 43  New Activity wizard pages and activity types

<table>
<thead>
<tr>
<th>Page in New Activity wizard</th>
<th>Activity Type</th>
<th>Data Source Types</th>
<th>Journaling Method (Domino)</th>
<th>Select Data Sources</th>
<th>Group Options</th>
<th>Item Types</th>
<th>Folders</th>
<th>User Created Folders</th>
<th>Dates</th>
<th>Attachments Filter</th>
<th>Message Types Filter</th>
<th>Properties</th>
<th>Message Size Filter</th>
<th>Mapped Folder(s)</th>
<th>Shortcut Options (Exchange)</th>
<th>Post Processing</th>
<th>Business Components:</th>
<th>Delete Options</th>
<th>Schedule</th>
<th>Select Worker Group</th>
<th>Activity Name</th>
<th>Summary</th>
</tr>
</thead>
</table>
Adding activities to an organizational policy

Perform the following tasks to add an activity to an organizational policy.

1. In the EMC SourceOne console, select the Organizational Policies node.
2. In the Organizational Policies list, select the policy to which you want to add the activity.

   The New Activity wizard starts.

4. Click Next to proceed through the pages of the New Activity wizard. You can use the Back button to return to a previous page.

5. When you reach the last page of the New Activity wizard, click Finish.

   The checkboxes in the left column indicate your progress through the wizard. You cannot select them. The pages in the New Activity wizard differ depending on the type of activity you select.

Activity Type

The Activity Type page specifies the type of activity being created.

Figure 107  Activity Type — New Activity wizard

Select the type of activity to create from the displayed list.

Only one activity type can be selected for an activity. The activities available depend on the EMC SourceOne components installed.
Data Source Types

Use the Data Source Types page to specify the data source type.

![Data Source Types](image)

Figure 108  Data Source Types — New Activity wizard

Selecting the Data Source Type

Select the type of data source to be used:

- IBM Lotus Domino
- Microsoft Exchange
- Microsoft Office 365 — Only available for use with the Journal activity.
- SMTP — Only available for use with the Journal activity.

Select Data Sources

The Select Data Sources page that appears depends upon the Data Source Type selection in the Data Source Types page and the Activity Type selected in the Activity Types page.

Select Data Sources page (for most activities)

Perform the following procedure for activities to process public folder content, including:

- Archive - Microsoft Exchange Public Folder
- Delete - Microsoft Exchange Public Folder
- Shortcut - Microsoft Exchange Public Folder
- Restore Shortcuts - Microsoft Exchange Public Folder activities
Do not use the procedure for the following activities:

- Journal activity when Microsoft Office 365, or SMTP is selected as the Data Source Type
- Public folder activities:
  - Archive - Microsoft Exchange Public Folder
  - Delete - Microsoft Exchange Public Folder
  - Restore Shortcuts - Microsoft Exchange Public Folder
  - Shortcut - Microsoft Exchange Public Folder

![Figure 109 Select Data Sources (non-SMTP) — New Activity wizard](image)

You use this page to:

- Specify the Primary Mailbox mailboxes, mail servers, or an LDAP query as the source of items to process.
- Specify the Personal Archive Mailbox mailboxes, mail servers, or an LDAP query as the source of items to process.

The options available on this page depend on the type of activity previously selected.
Configuring options in the Select Data Sources page

Perform the following tasks using the Select Data Sources page.

1. Select one of the following options in the Choose By field:
   - Address Book (Exchange) or Directory (Domino).
   - Server Hierarchy.
     The first time you select the Exchange Address Book or Exchange Server Hierarchy, the Choose Profile dialog box appears:
     a. Select an Outlook profile.
     b. Click OK. The Outlook profile must be a member of the EMC SourceOne Admin group which has view-only permission in Microsoft Exchange.
     c. After the initial prompt, you are not prompted again. The profile name you select is stored in the Registry.
   - LDAP Query (not used with Journal activities).

2. Select one of the following mailboxes in the Data Source Type field:
   - Primary Mailbox
   - Personal Archive Mailboxes
     The following activities support personal archive mailbox archive.
     – Archive - Historical
     – Shortcut - Historical
     – Restore Shortcut - Historical & User Directed Archive
     – Delete - Historical
     – Update Shortcut - Historical & User Directed Archive

**Note:** Select either the Primary Mailbox or the Personal Archive Mailboxes option. If one of these options is not selected, an error message appears.
Selecting data sources using Address Book or Directory

In the **Choose By** field on the Select Data Sources page, select **Address Book (Exchange)** or **Directory (Domino)**.

![Select Data Sources](image)

**Figure 110** Address Book (Exchange)

To add groups or users to the **Group** or **User** names list, click **Add**, then select groups or users from the address book or directory.

**Note:** Select a group or use an LDAP query instead of selecting many (thousands) of individual users from the address book or directory. If you select a large number of users from the address book or directory, it will take several minutes before the users are added to the Select Data Sources dialog box.

To remove groups or users from the Group or user names, select the group or user in the list, then click **Remove**.
Selecting data sources using Server Hierarchy

In the **Choose By** field on the **Select Data Sources** page, select **Server Hierarchy**.

![Select Data Sources](image)

In the **Server Hierarchy** list, perform one of the following steps:

- For Exchange, select individual mail servers, mail storage groups, or mail stores by selecting checkboxes.
- For Domino, select individual servers.
- Select **Select All**.

**Note:** Data source refers to the mailbox database; not the archive database. Before attempting to archive the personal archive mailbox, confirm that the corresponding user’s mailbox database has been checked in the server hierarchy.

Selecting data sources using LDAP overview

If you have an LDAP (Lightweight Directory Access Protocol) or Microsoft Active Directory Services (ADS) server, you can create LDAP queries that filter messages against the directory services schema in addition to or in place of the mail system’s address book. This approach may be faster or more effective than using an Exchange or Domino address book.

EMC SourceOne does not support groups or distribution lists when performing LDAP or ADS-based filtering, unless the group or distribution list has a mail account or the RFC 822 mail account attribute assigned to it.
Selecting a data source using LDAP procedure

Perform the following steps to select a data source using LDAP.

1. In the **Choose By** field on the **Select Data Sources** page, select **LDAP** (not available for Journal activities).

2. Specify the LDAP server to be used, as follows:
   - In the **Select Server** field, select the LDAP server to use.
   - If the server you want to use is not displayed, specify and use a new LDAP server.

3. Specify whether the LDAP server is to make use of Microsoft ADSI by selecting the **Use Microsoft ADSI** option.

   The **Use Microsoft ADSI option** is enabled or disabled by default based upon the server displayed in the **Select Server** field:
   - If the server had enabled the **Server supports Microsoft ADSI search** option, the **Use Microsoft ADSI** option will be selected by default on the **Data Sources** dialog box.
   - If the server had not enabled the **Server supports Microsoft ADSI search** option, the **Use Microsoft ADSI** option will not be selected by default on the **Data Sources** dialog box.
   - If the Use Microsoft ADSI option appears gray in color, this indicates that the LDAP server was defined prior to the installation of Email Management 6.8 SP2 or later.

4. In the **Query** field, enter the search filter portion of the query.

   An LDAP query is limited to 2000 characters.

5. To test your query, click **Execute**.
Results of the query and any error messages are displayed in the **Test Results** area.

6. **Select one of the following mailboxes in the **Data Source Type** field:**
   - Primary Mailbox
   - Personal Archive Mailboxes

   **Note:** Do not select both the Primary Mailbox and the Personal Archive Mailboxes options simultaneously. If both options are selected, an error message appears.

---

### Specifying a new LDAP server in Exchange

Perform the following procedure to specify a new LDAP server.

1. **In the **Select Data Sources** page of the **New Activity** wizard:**
   a. **In the Choose By field on the Select Data Sources page, select LDAP.** This is not available for **Journal** activities.
   b. Click **New.**

   The **LDAP Server Configuration** dialog box appears.

   ![LDAP Server Configuration](image)

   **Figure 113** LDAP server configuration

2. **In the Server Configuration field,** enter the unique name to refer to the LDAP server. Use this name in your LDAP search syntax later on. It can contain letters, numbers, and spaces (maximum 250 characters).

3. **In the Server Host/IP field,** enter the computer name or the IP address of the domain controller that contains the users you want to view, or use the Global Catalog server.

   The maximum number of characters for this field is 250.

4. **In the Server Port field,** leave the default port value of 389 unless you use an alternate port for LDAP services on the ADS or LDAP server.

   Valid port values are integers in the range 1 - 999999. To reset the Server Port value to 389, click **Use Default.**
5. If the LDAP or ADS server supports Active Directory Service Interface (ADSI) search, select the **Server supports Microsoft ADSI search** option. The value of this option controls whether you can select to use the ADSI search capability with EMC SourceOne.

6. If the LDAP or ADS server requires a secure sockets layer connection (SSL), select the **Server requires a secure connection (SSL)** option. When this option is selected, the LDAP port changes to the default secure LDAP port value of 636 for Active Directory.

7. Choose whether to require logging on to the server. Enter the Domain\Windows login of the domain controller you are querying against in the **Account name** and **Password** fields.

   The maximum number of characters for the **Account name** field is 250. The maximum number of characters for the **Password** field is 250.

8. Specify the location in which the LDAP search begins, using the **Search base** field.

   Enter the domain information based on the ADS primary domain controller (PDC) computer name using the following format:
   
   dc=subdomain,dc=domain,dc=com
   
   For example, if the name of the PDC is AcmePDC.Acme.com, enter the following:
   
   dc=AcmePDC,dc=acme,dc=com
   
   The maximum number of characters is 250.

9. Click **OK** to save your changes and to close the **LDAP Server Configuration** dialog box.
Specifying a new LDAP server in Domino

Perform the following procedure to specify a new LDAP server.

1. In the Select Data Sources page of the New Activity wizard:
   a. In the Choose By field on the Select Data Sources page, select LDAP. This is not available for Journal activities.
   b. Click New.

   The LDAP Server Configuration dialog box appears.

   

   ![Figure 114: LDAP server configuration](image)

   2. In the Server Configuration field, enter the unique name to refer to the LDAP server. Use this name in your LDAP search syntax later on. It can contain letters, numbers, and spaces (maximum 250 characters).

   3. In the Server Host/IP field, enter the computer name or IP address of the computer running the LDAP server. If multiple Domino servers are running the LDAP task, enter the computer name or IP address of the Domino Hub server.

      The maximum number of characters for this field is 250.

   4. In the Server Port field, leave the default port value of 389 unless you use an alternate port for LDAP services on the ADS or LDAP server.

      Valid port values are integers in the range 1 - 999999. To reset the Server Port value to 389, click Use Default.

   5. If the LDAP or ADS server supports Active Directory Service Interface (ADSI) search, select the Server supports Microsoft ADSI search option. The value of this option controls whether you can select to use the ADSI search capability with EMC SourceOne.

   6. If the LDAP or ADS server requires a secure sockets layer connection (SSL), select the Server requires a secure connection (SSL) option. When this option is selected, the LDAP port changes to the default secure LDAP port value.
7. Choose whether to require logging on to the server. If you are using LDAP with Domino, you may have anonymous LDAP access set up. Clear the **Server requires login?** checkbox and leave the **Account name** and **Password** fields empty unless you specifically restricted access on the Domino LDAP servers. If you want to require logging on to the server, enter the Domino user account, not the Windows login, in the **Account name** and **Password** fields.

The maximum number of characters for the **Account name** field is 250. The maximum number of characters for the **Password** field is 250.

8. Specify the location in which the LDAP search begins, using the **Search base** field.

   Leave the **Search Base** field blank, or enter the name of the Domino server directory, `names.nsf`.

   The maximum number of characters is 250.

9. Click **OK** to save your changes and to close the **LDAP Server Configuration** dialog box.

**LDAP query syntax**

The syntax that you use to create LDAP filters is very specific and uses common LDAP query syntax.

Refer to the examples outlined in the following sections.

For more information about LDAP search syntax, refer to the RFC 1650 and RFC 2252 specifications at:

http://ldapman.org/ldap_rfcs.html

---

**Note:** EMC SourceOne does not support groups or distribution lists when performing LDAP or ADS-based filtering, unless the group or distribution list has a mail account or the RFC 822 mail account attribute assigned to it. In addition, while the objectclass person may be the one you use most often, you can also use other objectclasses if they are associated with a mail account.

The number of results returned and the time allotted to return them is based on the actual LDAP server settings.

For Exchange, these settings are on the Active Directory server.

**LDAP query syntax for finding users based on common names**

The following example displays how to find users with common names that begin with A.

```
(&(objectclass=person)(cn=a*))
```

On the same server, you could find users with common names beginning with any letter from A through M using the following syntax:

```
(&(objectclass=person)(cn=m))
```

**LDAP query syntax for finding users based on organization**

The following example displays how to find users who are members of the Engineering organization.

```
(&(objectclass=person)(o=Engineering))
```
On the same server, you could find users who are not members of either the Engineering or Accounting organizations using the following syntax:

\((\& (objectclass=person) \neg (\text{o=Engineering} \text{o=Accounting}))\)

**Select Data Sources page for Journal activities for SMTP email**

Use this variant of the Select Data Sources page with the Journal activity when SMTP is selected as the Data Source.

![Journal Select Data Sources page](image)

**Figure 115** Journal Select Data Sources page

Use the Select Data Sources page to specify the locations of the SMTP drop directories that journaling will use as a source.

Perform the following steps.

1. Click Browse.

2. In the Browse For Folder dialog box, browse to and select an SMTP drop directory. Click OK to close the dialog box.
   - The UNC Path field displays the path you specified.
   - The maximum number of characters is 256.

3. Click Add.
   - The path of the SMTP drop directory appears in the list.

4. To specify additional drop directories, repeat steps 1 through 3.
Select Data Sources page for Journal activities for Microsoft Office 365 email

Use this variant of the Select Data Sources page with the Journal activity when Microsoft Office 365 is selected as the Data Source.

![Select Data Sources page](image)

**Figure 116** Journal Select Data Sources page

On the Select Data Sources page, select one of the previously defined SMTP journaling groups to use as the data source for this journaling activity, and click Next. The Business Components page appears.

If no SMTP journaling group is defined, the following error message appears:

At least one SMTP Journaling Group must be created before configuring an activity of this type.

If this message occurs, cancel creating the activity and create an SMTP Journaling Group to be used with this activity.

Select Data Sources page (for Public Folder activities)

This section describes the Select Data Sources page for Public Folder activities. Perform the following steps.

1. Use this variant of the Select Data Sources page with the activities which process Exchange public folder content, including:
   - Archive - Microsoft Exchange Public Folder
   - Delete - Microsoft Exchange Public Folder
   - Shortcut - Microsoft Exchange Public Folder
   - Restore Shortcuts - Microsoft Exchange Public Folder activities
2. On the **Select Data Sources** page, **Public Folder** is the only available option in the Choose by field and cannot be changed. Within the area below the Choose by field, select the public folders to process as follows:

- Select the Exchange public folder content to be processed by selecting the box next to each public folder name containing that content.

Initially, only the top-level public folders are displayed. If these folders contain other folders, you can expand the folder to display the subfolders by clicking the plus sign (+) next to the public folder. After expansion, you can hide the subfolders by clicking the minus (-) sign next to the parent folder.

Only the selected folders will be processed.

- Select the **Select All** option to cause all folders and subfolders to be selected. To cause all folders and subfolders to not be selected, clear the **Select All** option.

- Select the **Subfolders** option in the Include area to cause all subfolders contained in the selected folders to be processed without individually marking each subfolder. By default this option is selected and subfolders of selected folders are processed.

- Select the **Read items** option in the Include area to have read items processed. To exclude read items from being processed, unselect this option. By default this option is selected and read items are processed.

- Select the **Unread items** option in the Include area to have unread items processed. To exclude unread items from being processed, unselect this option. By default this option is selected and unread items are processed.
Client archive support for Domino archive

The Domino administrator can set the client archive policy. Also, the Notes client can set their own archive setting if a policy was not set previously by the Administrator. In either case, for SourceOne to be able to access the archive database, it must be created on a Domino server and linked to the Archive folder in the mailbox.

Requirements

The following conditions must be met to support the processing of attached Archive databases.

- The Archive database cannot be a Local database
- The Archive database must reside on a Domino server
- The Archive database must be accessible (not offline or unreachable)
- The Archive Profile document must exist
- The Archive Profile document must have the following set:
  - ArchiveLocation = “Server”
  - ArchiveServer = <Domino Server name>
  - ArchivePrivatePolicyList
- Available client Archive Settings
  - ArchivePath = <Path on Server>, usually archive\a_admin.nsf

**Note:** The ArchivePath can remain blank in the Archive Profile.

- ArchLastRunDestDBs is used if the Archive Profile exists, but does not contain an entry in ArchivePath and the ArchivePrivatePolicyList contains no entries. This value contains the Domino server and archive database that was last used, so that value is returned.
- Domino/Notes supports the Archive Profile

**Note:** To view the archive profile, use a tool such as NotesPeek to open the database and view the database profiles.

Configure Domino Archiving

Refer to the Domino Notes documentation to configure Domino or Notes Archiving.
Journaling Method

The Journaling Method page allows you to select the method for journaling and appears for the Journal activity if you selected IBM Lotus Domino on the Data Source Types page.

![New Activity: Journal](image)

**Figure 118** Journaling Method — New Activity wizard (Domino)

Specifying how to Journal Information from the IBM Lotus Domino server

Select one of the following options:

- Use EMC SourceOne extension manager
- Use IBM Lotus Domino native journaling

Set the **Journal Recipients** field to Enabled if using Domino native journaling

Considerations for Over Quota Error reports

Over Quota Error reports sent by Domino are handled differently depending on which type of processing you select.

Over Quota Error reports are processed when you use Domino native journaling.

Over Quota Error reports are not processed when you use SourceOne journaling.

Over Quota Error reports are processed when you use an Archive activity, if you select Reports in the Item Types page for that activity.

Group Options

Use the Group Options page of the New Activity wizard to select options for the PST or NSF groups used by the activity.
**Note:** Before you create PST activities, you must create PST groups. Before you create NSF activities, you must create NSF groups.

![Figure 119 Group Options (PST) — New Activity wizard](image)

### Specifying processing options for PST or NSF groups

Perform the following steps to specify processing options.

1. In the **Process locations/PST/NSF in the following states** field, select the state of items you want to process

   - For **Archive - Personal Mail Files** activities and **Migrate PST** activities, the states correspond to the states of PST files in PST groups, or the states of NSF files in NSF groups.
   - For **Find PST** activities, the states correspond to source computer states in PST groups.

The following table describes the Relationship between group options and source computer/file states.

<table>
<thead>
<tr>
<th>Group options in PST/NSF activity</th>
<th>Source computer/file state in PST/NSF group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Locations/Files</td>
<td>All states</td>
<td>The activity will process all source computers or files, regardless of their state.</td>
</tr>
</tbody>
</table>
Table 44  Relationship between group options and source computer/file states (page 2 of 2)

<table>
<thead>
<tr>
<th>Group options in PST/NSF activity</th>
<th>Source computer/file state in PST/NSF group</th>
<th>Description</th>
</tr>
</thead>
</table>
| All Locations/Files Except Completed | Complete | The activity will:  
  • Skip any source computer or file in a Complete state.  
  • Only process source computers or files in a New or Failed state. |
| Only Failed Locations/Files | Failed | The activity will process only those source computers or files in a Failed state. |
| Only Unprocessed Locations/Files | New | The activity will process only those source computers or files marked New. |

2. In the **Select the group to use for this activity** field, select the PST groups or NSF groups you want to process.

**Item Types**

The **Item Types** page is used to select the type of email items to be processed by the activity, such as email messages, meeting requests, or appointments.

In EMC SourceOne, not all mail system documents are considered to be messages. Specifically, calendar, contact and task entries are not messages. Only those documents that are sent over the network between individuals are considered to be messages, including common email messages, task requests, meeting requests, and delivery receipts.
Not all activities support the same set of item types. For example:

- Exchange activities support different item types than Domino activities.
- Shortcut activities support only email message and calendar item types.
  For example, the Shortcut - Microsoft Exchange Public Folder activity only supports shortcutting of Appointment, Email Message, and Meeting item types.
- The Migrate - Microsoft Office Outlook PST supports only the email message item type.

Considerations and limitations

Be aware of the following considerations and limitations.

- A Delete activity that uses the Use all date option will remove recurring calendar items, because the date is not used as part of the selection criteria. This works as designed and is expected behavior.

To prevent recurring calendar items from being deleted, specify a date before today's date.

- When using Exchange activities:
  - The message class for the Appointment item type is IPM.Appointment. It has no recipients, and it exists in the calendar folder.
  - The Meeting item type has two Message Classes:
    - IPM.Appointment — Contains recipients, and it exists in calendar folder.
    - IPM.Schedule — Contains recipients, and it exists in any folder except Calendar.
  - EMC SourceOne does not support shortcutting the IPM.Document.Outlook. File.ics item type. EMC SourceOne does not treat this item type as an appointment or meeting. This item type is created when a user drags an .ics iCalendar format file into a user-defined folder in Outlook.
- When using Domino activities:
• Email Management does not intentionally archive a Tracking Request. However, some Tracking Requests may be archived if you select the Other option. In this case, there is no guarantee that all Tracking Requests will be archived.

• Messages and calendar entries can be shortcut. Notices (Task and ToDo notices) cannot be shortcut.

### Specifying the types of items to process

Perform the following procedure to specify the types of items to process.

1. Perform one of the following steps:
   • To select all item types, select the Select All checkbox (default).
   • To specify individual item types, clear the Select All checkbox, then select the checkbox of each item type you want.

   The item types that are available depend on the activity and mail system.

2. For archive activities only, perform one of the following steps:
   • To process messages again, select Reprocess items.
   • To not process messages again, clear Reprocess items.

   **Note:** This option applies only to SourceOne archived messages, not to EmailXtender archived messages.

3. For Shortcut activities only, perform one of the following steps:
   • To shortcut only previously archived items, select Process only previously archived items.
   • To shortcut items regardless of whether they have been previously archived, clear Process only previously archived items.

### Shortcutting only previously archived items

The Item Types page contains the Process only previously archived items checkbox.

• When the checkbox is selected, only those messages that have already been archived (and not modified or already shortcut) are shortcut.

For example, after you archive items and perform a backup of the archive, run shortcut activities with this checkbox selected.

The Shortcut - Historical activity looks for previously archived items only in the mapped folder that you specify for the activity. The Shortcut - User Directed Archive activity looks for previously archived items only in the UDA folder that you specify for the activity. Shortcut activities do not look through the entire archive for previously archived items.
When the checkbox is cleared, the activity will shortcut all the messages specified in the shortcut activity settings. If the job finds messages that are not archived, then those messages will be archived to the mapped folder specified in the activity and then they will be shortcut.

The Process only previously archived items checkbox is available for Shortcut - Historical and Shortcut UDA activities for Domino and Exchange.

Reprocessing messages based on archive date

The Reprocess items checkbox is used for disaster recovery. When you select it, a new Archive date option is added to the Dates page.

For example, assume you create an activity to archive mail based on a received date older than 3 months, and you run the activity on 5/20/2010. The activity archives mail received on 2/20/2010 and also messages received on 2/13/2010 that were not archived from previous archive runs. A system failure occurs on 5/21/2010 before the next archive run. To recover, run an archive activity with both Reprocess items and Archive date selected, and specify after 5/20/2010 to reprocess only those messages archived by the activity that ran on 5/20/2010. Messages received on 2/20/2010 and 2/13/2010 will be reprocessed.

The Reprocess items checkbox is available for Archive - Historical and Archive - UDA Archive for Domino and Exchange.

Note: When you recover Exchange messages by using an Archive activity with the Reprocess items checkbox selected, the MAPI properties that were set when the messages were originally archived are not updated. This behavior is by design, so that the reprocessed messages do not trigger a cache synchronization in Outlook. For journaling, recovery involves restoring the deleted retention items, which will be processed the next time journaling runs. Using the Reprocess items checkbox on messages in a Personal or Community folder will restore the users' references to the messages if the message was previously archived and subsequently deleted by those users.

Folders

Use the Folders page of the New Activity wizard to select the folders to process.
Configuring Email Management Activities

Considerations and limitations

- For the Archive - Personal Mail Files activity and the Migrate - Microsoft Office Outlook PST activity, the Folders page lists an additional selection option of Top Level Folder. If you select Top Level Folder, then items in the root folder are processed.

- For Shortcut activities, the Drafts folder is not selected by default. Do not shortcut drafts. If you shortcut drafts, then users will have to use EMC SourceOne Search to restore the drafts to their mailboxes before editing.
For Shortcut activities involving IBM Lotus Domino, EMC SourceOne does not shortcut any Notes documents that are in the Trash folder (soft deleted).

For the Restore Shortcuts activity, the Folders page lists two additional selections: User Defined and User Directed Archive. If you select User Defined, then all user-defined folders are included in the Restore Shortcut activity. If you select User Directed Archive, then all user-directed archive folders are included in the Restore Shortcuts activity. You cannot select individual user-defined folders or individual user-directed archive folders for a Restore Shortcuts activity.

If UDA folders are included in the Restore Shortcuts activity, then the UDA parent folder will be skipped during processing.

An activity can process the items in a Notes private folder if you select the All Documents or Mail Threads views on the Folders page. If you select only User Defined folders, then the activity cannot process items in a Notes private folder.

For Restore Shortcuts activities involving IBM Lotus Domino, restore to a folder or the database, not to a view. Although the EMC SourceOne console allows it, restoring Domino messages to a view could result in messages not being properly restored to the selected view. This occurs because a view is constructed by formulas, which use information that may not be available in the restored message, resulting in the message not being restored in the selected view.

Any records in the user-directed archiving (UDA) folders of a Notes client will also display in the All Documents and Mail Threads views. If you create a Delete - Historical activity and include these two views, the Delete - Historical activity will delete items from your UDA folders, even though the activity was not a Delete - User Directed Archive activity.

**Specifying the mailbox folders to process**

Perform the following procedure to specify the mailbox folders to process.

1. Perform one of the following:
   - To select all folders, select the Select All checkbox (default).
   - To specify individual folders, clear the Select All checkbox, then select the checkbox of each folder you want.

2. Select or clear the Include checkboxes:
   - **Subfolders** — Selected by default for Shortcut and Archive - Historical activities. Select to process items in the subfolders associated with the selected folders (Exchange).

   **Note:** For Domino Restore Shortcuts activities, all subfolders are included by default. For all other Domino activities, subfolders are not included.

   - **Read Items** — Selected by default for Shortcut and Archive - Historical activities. Select to process items that have been opened.

   - **Unread Items** — Selected by default for Archive - Historical activities. Select to process items that have not been opened.
- **Deleted retention/soft deleted item** — Not available for Delete - Historical activities and Archive - Personal Mail Files activities. Select to process items in the Trash folder (Domino) or items in the Exchange Dumpster (Microsoft).

**User Created Folders**

Use the User Created Folders page of the New Activity wizard to select folders for the activity to process.

**Considerations and limitations**

Activities can process folders that a user creates at the root of the mailbox, and can process any subfolders below that top-level user-created folder.

Activities cannot process folders that a user creates as subfolders under a standard mailbox folder.

Example 1 — Assume an Outlook user creates a folder called My Project under Mailbox - <name> at the same level as standard Outlook folders. Activities will be able to process the My Project folder as a user-created folder.

Example 2 — Assume an Outlook user creates a folder called My Project as a subfolder under the standard Inbox folder. Activities will not be able to process the My Project folder as a user-created folder.

**Specifying a user created folder**

Select one of the following options to specify a user created folder to process.

- Include all user created folders.
- Include specified user created folders:
  a. Type the name of the user created folder.
  b. Click Add.
  c. Repeat this step for each folder that you want to add.

**Dates**

Use the Dates page of the New Activity wizard to select the dates to use for the activity.

*Note:* For the Delete - User Initiated Delete activity, specify dates using the Archive deletion eligibility period option in the Global Settings dialog box.
For Archive activities, if you selected the Reprocess items option on the Item Types page, then the Dates page displays an additional option: Archived date. The Archived date option is available for Archive - Historical and Archive - UDA Archive for Domino and Exchange.

Specifying the date range and date property of items to process

Perform the following procedure to specify the date range and date property of items to process.

1. Select one of the following options:
   - Use all
If you select this option, then the options in the **Based upon** section become unavailable.

- **Dated**
  a. In the first field, select one of the following options: **after**, **before** (default), or **between**.
  b. In the first date field, click the down-arrow, then select a date from the calendar (default = today). For the **between** option, this date is the start of the date range.
  c. For the **between** option, specify the end of the date range in the second date field.

- **Aged**
  2. If you selected the **Dated** option or the **Aged** option, select one of the following to specify which date property to use:
     - **Received date**
     - **Modified date**
     - **Archived date** — Available for Archive activities if you selected the **Reprocess items** option on the **Item Types** page

### Processing items based on their age

Refer to the following sections to process items based on their age.

#### Older than/Newer than

Perform the following steps to process items based on their age.

1. Select **Aged**.
2. Select one of the following options in the first field.
   - **Older than**
   - **Newer than**
3. Specify the amount of time in the second field.
4. Select the unit of time in the third field.

#### Between

Use a sliding date range to process items based on their age.

1. Select **Aged**.
2. Select **Between** in the first field.
3. To specify the start of the age range:
   a. Specify the amount of time in the second field.
   b. Select the unit of time in the third field.
4. To specify the end of the age range:
a. Specify the amount of time in the fourth field.
b. Select the unit of time in the fifth field.

**Effect of Use all option on deletion of recurring calendar items**

A Delete activity that uses the **Use all** date option removes recurring calendar items, because the date is not used as part of the selection criteria. This works as designed and is expected behavior.

To prevent recurring calendar items from being deleted, specify a date before today's date.

**Attachments Filter**

Use the **Attachments Filter** page of the **New Activity** wizard to select the kinds of attachments to filter for the activity.

![Attachments Filter](image)

**Figure 126** Attachments Filter — New Activity wizard

**Specifying the file extensions of attachments to exclude from processing**

1. Perform the following.
   a. Type the file name extension you want to exclude, for example, `.txt`.
   b. Click **Add**.

2. To process only those items that have attachments, select the **Only items with attachments** option. The **Only items with attachments** option is only displayed on the **Attachments Filter** page for the following activities that create shortcuts:
   - **Migrate - Microsoft Office Outlook .PST**
   - **Shortcut - Historical**
   - **Shortcut - Microsoft Exchange Public Folder**
   - **Shortcut - User Directed Archive**

Process message attachments differently by using, or not using, this option:
• To shortcut all attachments, select the **Only items with attachments** option.
• To shortcut all attachments with some exceptions, select the **Only items with attachments** option and enter those attachment file extensions, such as PDF, to be excluded in the Enter attachment file extensions to exclude area on this page.
• To not shortcut any attachments, select nothing on the **Attachments Filter** page.

### Message Types Filter

Use the **Message Types Filter** page of the **New Activity** wizard to specify the message types to include or exclude from processing.

![Message Types Filter - New Activity wizard](image)

**Figure 127** Message Types Filter — New Activity wizard

#### Specifying message types to include or exclude from processing

Perform the following steps to specify message types to include or exclude from processing.

1. In the list box, select one of the following options:
   - **Include**
   - **Exclude** (default)

2. Enter the message type (IPM. message class). The following table lists the message classes.

<table>
<thead>
<tr>
<th>Message Class</th>
<th>Description (item type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ipm.activity</td>
<td>Activity</td>
</tr>
<tr>
<td>ipm.appointment</td>
<td>Appointment</td>
</tr>
<tr>
<td>ipm.contact</td>
<td>Contact</td>
</tr>
<tr>
<td>ipm.document</td>
<td>Document</td>
</tr>
</tbody>
</table>
Properties

Use the **Properties** page of the **New Activity** wizard to specify the settings and folders for user-directed archiving.

<table>
<thead>
<tr>
<th>Message Class</th>
<th>Description (item type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ipm.note</td>
<td>Note</td>
</tr>
<tr>
<td>ipm.post</td>
<td>Post</td>
</tr>
<tr>
<td>ipm.schedule</td>
<td>Schedule</td>
</tr>
<tr>
<td>ipm.stickynote</td>
<td>Sticky note</td>
</tr>
<tr>
<td>ipm.task</td>
<td>Task</td>
</tr>
<tr>
<td>ipm.taskrequest</td>
<td>Task request</td>
</tr>
<tr>
<td>report.ipm.note</td>
<td>Other type of report</td>
</tr>
<tr>
<td>report.ipm.note.dr</td>
<td>Delivery report</td>
</tr>
<tr>
<td>report.ipm.note.ipnrn</td>
<td>Read receipt report</td>
</tr>
</tbody>
</table>

**Table 45 Message classes (IPM.) (page 2 of 2)**

**Specifying the settings and folders for user-directed archiving**

Use the following procedure to specify the settings and folders for user-directed archiving.

1. In the **Archive type** field, select the type of user-directed archive you want to create:
   - **Community** - Users can see other users’ mail in these UDA folders. Use for collaboration and sharing.
   - **Personal** - Users can see only their own mail in these UDA folders. Use for non-compliant mail.

2. Perform one of the following steps:
• To create a parent folder in the user’s mailbox in which to place the UDA folders:
  a. Select the **Parent Folder Required** checkbox (default).
  b. In the **Parent Folder** field, type or select a name for the parent folder. The default name is **User Archive Folders**. The maximum number of characters is 64.

Names that you type are added to the list box, so that you can select them when you create other UDA activities later.

• To create the UDA folders without creating a parent folder, clear the **Parent Folder Required** checkbox.

3. In the **Mapped Folders** list, select the folders in which to archive user-directed items.

The **Mapped Folders** list displays only those folders that match the archive type you selected in step 1.

The UDA Archive activity will create folders of the same names in the mailboxes of the users you selected in the **Select Data Sources** page earlier in the **New Activity** wizard. These users must have **Contributor** permission on the folders that you select in the **Mapped Folders** list.

### Message Size Filter

Use the **Message Size Filter** page of the **New Activity** wizard to specify the minimum size and maximum size of messages to process using the activity.

**Note:** The message sizes are approximate and could vary by a few kilobytes. For Domino or Notes, filtering messages based on size is approximate, not exact. The size calculation could vary by a few kilobytes (KB), especially for a Delete activity.
Specifying the minimum size and maximum size of messages to process

Perform the following procedure to specify the minimum size and maximum size of messages to process.

1. To specify a minimum message size, enter a value in the **Include messages that are greater than _KB** field (default = 0):
2. To specify a maximum message size:
   a. Select the **Include messages that are less than _MB** checkbox.
   b. Enter a value in KB.

**Mapped Folder(s)**

Use the **Mapped Folder(s)** page to select the mapped folders used by an activity.

One of several **Mapped Folder(s)** pages appears, depending on the activity being created or modified. Each of these pages is described in the following topics.

**Mapped Folders page for Shortcut - Historical activity**

Use the **Mapped Folders** page for the **Shortcut - Historical** activity to specify in which mapped folders to look for the archived messages to be shortcut. In some cases, you can also specify the mapped folder to archive messages that have not already been archived prior to their being shortcut. This page is also used by the **Shortcut - Microsoft Exchange Public Folder** activity.
1. Add one or more mapped folders in which to search for the archived messages to be shortcut by clicking Add.

   The **Mapped Folder Selection** dialog box appears.

2. If required, modify the list of mapped folders.

   The list of mapped folders will be processed by the activity from the top to the bottom.

   - To change the order of processing, select the mapped folder to reorder in the list, and then click the up-arrow or down-arrow to the right of the list to move the mapped folder higher or lower in the list.

   - To remove a mapped folder from the list, select the mapped folder, and click Remove.

3. If the **Process only previously archived items** option was not selected on the **Item Types** page, use the lower mapped folder area on the **Mapped Folders** page to select the mapped folder where messages are to be archived that were not archived previously.

   If the **Process only previously archived items** option was selected on the **Item Types** page, the lower mapped folder area is not valid and so is not displayed on the **Mapped Folders** page.

   **Note:** For User Delete to work on mail items shortcut using the Shortcut - Historical activity, you must select a Personal or Community mapped folder on the Mapped Folder page of the Activity wizard.

4. Select **Organization** folders for **Shortcut - Historical** activities if you do not want to allow users to delete the archived mail items.
Using the Mapped Folder Selection dialog box

The **Mapped Folder Selection** dialog box is launched by the **Mapped Folders** page of the **Shortcut - Historical** or the **Shortcut - Microsoft Exchange Public Folder** activity.

Perform the following tasks using the **Mapped Folder Selection** dialog box to select one or more mapped folders to add to the list of mapped folders.

![Figure 131 Mapped Folder Selection dialog box](image)

1. In the **Mapped Folder Selection** dialog box, select the checkbox next to the one or more mapped folders in which the activity is to look for archived messages to be shortcut.
   
   To select all mapped folders in the list, click **Select All**.

2. When complete, click **OK**. The **Mapped Folder Selection** dialog box exits and the updated list appears on the **Mapped Folders** page.

**Mapped Folders page for Shortcut - Microsoft Exchange Public Folder activity**

Use the **Mapped Folders** page for the **Shortcut - Microsoft Exchange Public Folder** activity to specify in which mapped folders to look for the archived messages to be shortcut. In some cases, you can also specify the mapped folder to archive messages that have not already been archived prior to their being shortcut. This page is also used by the **Shortcut - Historical** activity.
Perform the following steps to use the Mapped Folders page when creating an activity.

1. Add one or more mapped folders in which to search for the archived messages to be shortcut by clicking Add. The Mapped Folder Selection dialog box appears.

2. If required, modify the list of mapped folders you created.
   The list of mapped folders will be processed by the activity from the top to the bottom.
   - To change the order of processing, select the mapped folder you want to reorder in the list, and then click the up-arrow or down-arrow to the right of the list to move the mapped folder up or down in the list.
   - To remove a mapped folder from the list, select the mapped folder, and click Remove.

3. If the Process only previously archived items option was not selected on the Item Types page, use the lower mapped folder area on the Mapped Folders page to select the mapped folder where messages are to be archived that have not already been archived.

   If the Process only previously archived items option was selected on the Item Types page, the lower mapped folder area is not valid and so is not displayed on the Mapped Folders page.
**Mapped Folder page for Migrate - Microsoft Office Outlook .PST activity**

Use the **Mapped Folder** page for the **Migrate - Microsoft Office Outlook .PST** activity to specify into which mapped folder to archive messages that have been shortcut from the PST file.

![Figure 133 Mapped Folder — Migrate — Microsoft Office Outlook PST activity](image)

Select the one mapped folder from those listed.

**Mapped Folders page for Delete - User Initiated Delete activity**

Use the **Mapped Folders** page with the **Delete - User Initiated Delete** activity to specify one or more Personal or Community mapped folders from which to delete messages, based on the delete requests in user mailboxes.

![Figure 134 Mapped Folders — Delete-User Initiated Delete activity](image)
Shortcut Options

Use the Shortcut Options page of the New Activity wizard to specify options for Exchange shortcuts.

![Shortcut Options](image)

**Figure 135** Shortcut Options — New Activity wizard

Specifying options for shortcutting messages

Perform the following procedure to specify options for shortcutting messages.

1. In the Shortcut Language field, select the language for the replacement text that will display in shortcut stubs.

2. To shortcut message bodies, select the Include message body checkbox.

   **Note:** This option applies to email message types only. By design for calendar items, inline attachments and bodies are not shortcut, but attachments are shortcut.

3. To shortcut inline images, select the Shortcut inline images greater than _KB checkbox, then enter a threshold value for image size.

4. For the Update Shortcuts - Historical & User Directed Archive activity only, to update EmailXtender 4.x shortcuts, select the Update EmailXtender 4.x shortcuts checkbox.

Post Processing

Use the Post Processing page of the New Activity wizard to specify the actions to perform on PST files or NSF files after archiving or shortcutting.

The Post Processing page appears for the following activity types:

- Archive - Personal Mail Files
- Migrate - Microsoft Office Outlook PST
Specifying the actions to perform on PST files or NSF files after archiving or shortcutting

Perform the following steps.

1. Select one of the following options:
   - **Delete files** - If you select this option, then a warning message appears: Not all data may be archived because this activity does not support all item types supported by mail files. This activity only processes email messages, so deleting the PST or NSF file could result in the loss of any other data types in the mail file.
   - **Keep files**

2. If you selected the **Keep files** option:
   a. To specify the destination of the PST files or NSF files, perform one of the following steps:
      - To move the files to another location, select the **Move to the following location** checkbox, click the **Browse** button, and specify the location.
      - To keep the files in their current location, clear the **Move to the following location** checkbox (default).
   b. To specify whether the files are to be read-only, perform one of the following steps:
      - To make the files read-only, select the **Mark read-only** checkbox.
      - To retain the current permissions on the files, clear the **Mark read-only** checkbox (default).
Business Components

Use the Business Components page of the New Activity wizard to select the business components, such as the Address Rules business component, to use to process content, and specify the order in which to use those components.

When multiple business components are configured as part of an activity, the order in which those business components process content appears on the Activity Summary page.

Selecting and ordering components

Perform the following tasks to select the components you want to use to process content, and specify the order in which to use those components.

1. Select the business components you want to use for this activity.
   The available components depend on the type of activity you selected and on which components you have registered. The Address Rules component is always registered.
2. Clear the checkboxes of the components you do not want to use for this activity.
3. Specify the sequence in which you want the selected business components to be used. Select a component, then click the up-arrow button or down-arrow button to move the component in the list.
Specify Filtering Rules

If you selected Address Rules in the Select Components page of the New Activity wizard, then the Specify Filtering Rules page appears.

For User Delete to work on mail items archived using the Journal, Archive - Historical, or Archive - Personal Mail Files activities, you must select Personal or Community mapped folders as targets for the Copy messages that do not match any rule option on the Specify Filtering Rules page and in the Rule wizard.

Note: Use Organization folders for these activities to not allow users to delete the archived mail items.

Delete Options

Use the Delete Options page to determine how content that has not been archived is handled during the processing of the delete activity.

- If you select the Verify archive before delete option, and the Delete activity encounters content that has not been archived, then the activity does not delete the message and does not archive the message.
- If you do not select the Verify archive before delete option, and the Delete activity encounters content that has not been archived, the content is deleted without being first archived.

The Delete Options page appears for the following activities:

- Delete - Historical
- Delete - Microsoft Exchange Public Folders
- Delete - User Directed Archive
Configuring Email Management Activities

Figure 139  Delete Options — New Activity wizard

Note: Both Exchange and Domino support deleting recurring calendar items that are out of date.

Specifying whether to verify archival before deleting messages

Perform one of the following steps.

- To verify archival, select Verify archive before delete.
- To delete messages without verifying whether they have been archived, clear Verify archive before delete.

Scheduling Activities

Use the Schedule page of the New Activity wizard to schedule the activity. The Schedule page appears for all activity types, except the Journal activity.
Considerations for rescheduling activities

When you reschedule an activity that runs according to a specified recurring schedule, as specified using the Recurrence pattern option on the Schedule page, or when you edit a Journal activity, that automatically runs on a daily basis, the scheduling of those activities changes as follows.

- For all activities except Journal:

  If the schedule for an activity is changed by the user, that activity will then run at the newly scheduled time, which may result in the activity running later the same day.

  **Note:** If the activity has parent jobs that are running, then the changes to the schedule will not take effect until the following day.

- For Journal activities only:

  Journal activities cannot be scheduled by the user. The schedule for a Journal activity parent job is reset whenever the Journal activity is changed to be the time of day that the Journal activity was last edited. The child jobs that perform the journaling will continue to run.

  **Note:** If the activity has parent jobs that are running, then the changes to the schedule will not take effect until the following day.

If rules used by the Journal activity are changed, the modified rules will be used by any new child jobs created by the Journal parent job. This means that the modified rules associated with a Journal activity will be used when the next Journal child job executes.
Configuring Email Management Activities

Other considerations

Avoid scheduling Delete - User Initiated Delete activities when other activities are scheduled, or when data is being disposed from the Native Archive.

Scheduling an activity

The sections below include information about the options that you can configure when scheduling an activity.

Start Date

In the Start Date field, select the date that the activity is to start. Click the down-arrow, then select the start date from the calendar.

Start Time

In the Start Time field, select the time that the activity is to start. Click the down-arrow, then select one of the following options:

- To start the activity as soon as possible, select As soon as possible (default).
- To specify a time, select the time from the list.

Duration

In the Duration field, select one of the following options:

- Select the number of hours the activity is allowed to run (default = 1 hour).
- Select 1 day.
- Select Run to completion.

Recurrence Pattern

In the Recurrence Pattern area, specify an interval.

Specifying a one-time occurrence

To specify a one-time occurrence, select Once (default).

Journal activities with an occurrence of Once generate child jobs that run every 5 minutes, which is normal behavior.

Specifying a daily occurrence

Perform the following steps to specify a daily occurrence.

1. Select Daily from the list box.
2. Select Every_day(s). Specify the number of days between occurrences of the activity (default = 1 day).

Note: To run the activity on weekdays, specify a Weekly occurrence and select only weekdays.
Specifying a weekly occurrence
Perform the following steps to specify a weekly occurrence.
1. Select **Weekly** from the list box.
2. In the **Every _week(s) on** field, specify the number of weeks between occurrences.
3. To specify the day of the week on which the activity is to occur, select one or more check boxes.

Specifying a monthly occurrence
Perform the following steps to specify a monthly occurrence.
1. Select **Monthly** from the list box.
2. Perform one of the following steps:
• Select the **Day of every month(s)**. In the first field, specify the day of the month on which you want the activity to occur. Valid values are 1 through 31. In the second field, select the number of months between occurrences. Valid values are 1, 2, 3, 4, 6, and 12.

• Select **The _ _ of every month(s)**. In the first field, select the week (first, second, third, fourth, or last). In the second field, select the day of the week. In the third field, specify the number of months between occurrences. Valid values are 1, 2, 3, 4, 6, and 12.

![Figure 143 Schedule — Recur Monthly — New Activity wizard](image)

**Range of recurrence**

In the **Range of recurrence** area, select one of the following options:

- **No end date** - The activity will first occur on the start date and time you specified. The activity will reoccur according to the information you specified in the Recurrence area.

- **End by** - The activity will first occur on the start date and time you specified. The activity will reoccur according to the information you specified in the Recurrence Pattern area, until the end date you specify in this option. Click the down-arrow, then select an end date from the calendar.
Select Worker Group

When creating an activity, the SourceOne administrator can choose to constrain the execution of the activity to specified Worker group or to all Workers.

Perform the following steps to specify a Worker group for an activity.

1. Click the checkbox to select **Select Worker Group**.
2. Select **Specify the worker group for this activity**.
3. Click to select the Worker group from the list.

After clicking Next, if the selected Worker group does not have a Worker assigned, a **Worker Group Members** warning dialog box appears:

No worker is selected for this worker group. Would you like to proceed?

Click **Yes** to continue the process and the Worker group for this activity does not have a Worker.

Click **No** to return to the **Select Worker Group** window to choose Workers for the Worker group.
Activity Name

Use the Activity Name page of the New Activity wizard to select a name and possibly detailed logging for an activity. The Activity Name page appears for all activity types.

Perform these steps to specify a name for the activity.

1. In the Name field, enter a name for the new activity.

2. Not available for Journal activities. To collect detailed information about message processing by activities, select the Enabled Detailed Logging checkbox.

Editing activities in an organizational policy

The Activity Type or Activity Name properties cannot be edited. Perform the following procedure to edit other properties of an activity.

1. In the EMC SourceOne console, select the Organizational Policies node.

2. In the Organizational Policies area:
   a. Expand the organizational policy that contains the activity you want to edit.
   b. Select the activity you want to edit.

3. To edit a specific property:
a. Click the link for that property in the activity summary. A dialog box appears, which corresponds to the page in the New Activity wizard that contains the property.

![Activity summary example](image)

**Figure 146** Activity summary example

b. Edit the property, as described in the topic for the corresponding New Activity wizard page. If the displayed page has dependencies on another page in the activity, a Next button appears at the bottom of the page.

c. Click Next and make any other required changes on the page that appears.

4. To review all properties using the Edit Activity wizard:

   a. Select Action > Edit Activity.

      The Edit Activity wizard starts.

   b. Click Next until you reach the page containing the property that you want to edit.

   c. Edit the property, as described in the topic for the corresponding New Activity wizard page.

   d. Click Next until you reach the last page of the Edit Activity wizard, then click Finish.

**Controlling activities**

Control an activity and its jobs by using the Stop, Pause, and Resume actions.

The action applied to an activity also applies to the activity's jobs. To control multiple jobs, control the activity associated with those jobs.

The status of an activity is derived from the status of the activity's jobs. For example, if any jobs associated with a run once activity fail, then the status of the activity will be shown as failed.
About activity status and actions

The actions available for each activity status depend on the recurrence pattern specified in the activity's schedule.

Run once

The following figure displays the actions for a run-once activity:

![Activity actions and status run once](image)

**Figure 147** Activity actions and status run once
Periodic

The following figure displays the actions for a periodic activity.

Figure 148  Activity actions and status - periodic
Pausing activities

Perform the following steps to pause an activity in an organizational policy.
1. In the EMC SourceOne console, select the Organizational Policies node.
2. In the Organizational Policies area:
   a. Expand the organizational policy that contains the activity you want to pause.
   b. Select the activity.

In the Organizational Policies area, the status of the activity changes from Active to Paused.

Resuming paused activities

Perform these steps to resume a paused activity.
1. Select the activity.
2. Select Action > Resume.

Stopping activities

Perform these tasks to stop an activity in an organizational policy.
1. In the EMC SourceOne console, select the Organizational Policies node.
2. In the Organizational Policies area:
   a. Expand the organizational policy that contains the activity you want to stop.
   b. Select the activity.
3. Select Action > Stop.

In the Organizational Policies area, the status of the activity changes from Active to User Terminated.

You can resume a User Terminated activity if the activity has a periodic schedule:
1. Select the activity.
2. Select Action > Resume.

Deleting activities from an organizational policy

Perform the following procedure to delete an activity.
1. In the EMC SourceOne console, select the Organizational Policies node.
2. In the Organizational Policies area, select the activity you want to delete.
3. Select Action > Delete Activity.
4. At the following prompt, click Yes.

Are you sure you want to delete the selected activity?
CHAPTER 17
PST and NSF Processing Activities

This section describes how to perform processing activities for Exchange PST files and Domino NSF files using EMC SourceOne. Topics include:

- PST processing activities ................................................................. 398
- NSF processing activities ............................................................... 420
PST processing activities

This section describes how to process groups of Exchange PST files.

If you are processing PST files in a multiple forest Active Directory environment, you may need to perform the additional configuration tasks described in “Planning and Initializing Content Processing”.

Introduction to PST activities

This section describes PST file groups and how you use them to prepare for PST activities.

What are PST groups?

Use PST groups to organize and simplify the management of source computers and PST files in preparation for PST activities.

You can:

◆ Search for source computers based on an LDAP query and add the results to a PST group.
◆ Browse for source computers and shares and add the results to a PST group.
◆ Manually remove source computers and shares from a PST group.
◆ Inspect the status of source computers since the last processing occurred.
◆ Use PST groups as input to PST activities.
◆ List the PST files discovered in a Find - Microsoft Office Outlook PST activity.
◆ Remove individual PST files from the PST group.

PST management checklist

To manage PST files, ensure the following tasks are performed.

1. Create PST groups.
2. Specify source computers or shares.
3. Perform one or both of the following steps:
   • Create a Find - Microsoft Office Outlook PST activity to search for PST files on source computers in specified PST groups.
   • Add PST files manually to PST groups.
4. Perform actions on the discovered PST files, if required:
   • Assign owner
   • Specify password for password-protected PSTs
5. Remove the PST files that you do not want to process.
6. Set states of source computers to indicate which PST files to process, if required.
7. Create an Archive - Personal Mail Files activity to archive PSTs or a Migrate - Microsoft Office Outlook PST activity to shortcut PSTs.
How ownership is determined for PST files

When you discover PST files using the Find - Microsoft Office Outlook PST activity, EMC SourceOne attempts to automatically assign an owner to the PST files located.

The following is the method EMC SourceOne uses to assign an owner to a PST file after the PST file has been located.

1. EMC SourceOne determines if a Sent Items folder is present in the PST file. This folder can be the folder created by Outlook or a folder created by the user with any of the following names:
   - Sent Items (English)
   - Éléments envoyés (French)
   - Gesendete Objekte (German)
   - invia mail (Italian)
   - Elementos enviados (Spanish)

2. If the Sent Items folder (or one of the previously listed language variants) is present, EMC SourceOne determines which email address sent most of the messages found in this folder and marks this email address as being the owner of the PST file.

3. If the Sent Items folder is not found, EMC SourceOne attempts to determine the owner by evaluating the folder path in which the PST file was located as follows:
   a. EMC SourceOne evaluates the folder path in which the PST file was located to determine if it contains the following string:

      \Documents and Settings\user-name\file-name.pst

      **Note:** This parsing will only function correctly if the folder string Documents and Settings is spelled correctly in English, although the string is not case-sensitive.

      The folder path does not have to indicate the Microsoft Windows Documents and Settings folder. The PST files could also be located in a subdirectory of a network share with that same name, such as the following, and still be processed correctly:

      \\corpshare\users\documents and settings\jsmith\archivel.pst
      \\corpshare\users\documents and settings\mjones\myemail.pst

   b. If the Documents and Settings folder path is found, EMC SourceOne searches the Active Directory for the **user-name** portion of the path.

   c. If the **user-name** string matches a user in Active Directory, EMC SourceOne marks that user as the owner of the PST file.

If EMC SourceOne cannot determine an owner for a PST file using this method, you must manually assign an owner.
Viewing list of PST groups

To view a list of existing PST groups (if any), in the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.

![Figure 149  PST groups](image)

Refreshing a PST group view

To update the list of PST management groups and view the latest changes, press F5 or click **Refresh**. The list may take a few moments to refresh.
Viewing list of source computers in a PST group

Perform the following steps to view the list of source computers in a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select a group.
3. Select the **Source Computers** tab.

![Source Computers tab](image)

**Figure 150  Source Computers tab**
Viewing list of PST files in a PST group

Perform the following steps to view the list of PST files in a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select a group.
3. Select the **PST Items** tab.

![Figure 151 PST Items tab](image)

Adjusting PST list when display limit is reached

By default, up to 1,000 PST files are displayed in the **PST Items** tab.

If the number of PST files exceeds the maximum rows specified for the **PST Items** tab, the following message and links appears at the top of the PST list:

*Your search has returned more rows than can be displayed. Apply a filter or adjust the maximum number of rows to limit the number of rows.*

To change the maximum number of PST files displayed, click the maximum number of rows link.

To filter the PST list, click the filter link.

Customizing the view for PST groups

The following sections describe how to customize the view for PST groups.

Specifying maximum number of PST files to display

The default maximum number of PST files to display in the PST Items tab is 1,000.

Perform the following steps to change the maximum.
1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.

2. Select a group.

3. Select the **PST Items** tab.

4. Select any item in the list. If there are no items, populate the list.

5. Select **Action > Maximum Rows Displayed**.

6. Enter the maximum number of rows to display, in the range 1 to 99,999.

7. Click **OK**.

**Figure 152** Maximum Rows Displayed dialog box
Adding or removing columns

Perform the following steps to add or remove columns.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the center pane, perform one of the following steps:
   - To add or remove columns from the **PST Groups** list, select any group in the list.
   - To add or move columns from the **Source Computers** tab, select any source computer in the list.
   - To add or remove columns from the **PST Items** tab, select any PST in the list.
3. Select **Action > View > Add/Remove Columns**.
   The **Choose Columns** dialog box appears.

![Choose Columns dialog box — PST Items](image)

Changing the order of columns

Perform the following steps to change the order of columns.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. Drag the column header left or right to a new location. Red arrows indicate where you can drop the column header.
Changing sort order in a column

The direction of the triangle in a column header indicates the direction of sort for that column.

- Up — Ascending (alphabetical)
- Down — Descending

Perform the following steps to toggle between ascending and descending sort order in a column.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > PST Groups node.
2. Click the header of the column you want to toggle.

Grouping by column

In the Source Computers tab or the PST Items tab, you can organize the display of source computers or PST files based on a specific column.

Perform the following steps to group source computers or PST files by column.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > PST Groups node.
2. Select a group.
3. Select the Source Computers tab or the PST Items tab.
4. Select Action > Enable Grouping.
5. Drag-and-drop the column to the indicated area above the source computers list or PST list.

![Drag a column header here to group by that column](image)

**Figure 154** Group by column prompt

The source computers or PST files are now grouped under expandable rows, similar to a tree pane.

Filtering the PST list

To refine the PST list displayed in the PST Items tab, you can create a filter.

Perform the following steps to filter the list of PST files.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > PST Groups node.
2. Select a group.
3. Select the PST Items tab.
4. Select **Action > Filter**.
   
The **Filter** dialog box appears.

5. In the **Column** field, select the name of the column that you want to filter.
6. In the **Condition** field, select the condition to apply to the column’s values.
   
The conditions depend on the data type of the column you selected in step 5.
7. In the **Value** field, enter a value for the column and the condition.
   
   Depending on the condition you selected in step 6, the **Value** field may not be available.
8. Click **Add**.
   
The new criterion appears in the list.
9. To add another criterion to the list, repeat step 5 through step 8.
   
   Each line in the filter is joined with the other lines through an AND search.

   You can use the same column more than one time in a filter. For example, you could use the Last Processed column twice to specify a date-time range.

10. To remove entries from the criteria list, perform one of the following steps:
   
   • Click **Clear All**.
   
   • Select the line in the list that you want to remove, then click **Remove**.
11. To edit a selected entry in the filter:
   a. Select the entry in the criteria list.
   b. Click Edit. The Edit Filter Criteria dialog box appears. Modify the portion of the filter entry and click OK.
12. Click OK to close the Filter dialog box.

Specifying conditions for string data
The following list describes the possible conditions available for columns that display string data.

◆ Is exactly — Includes all of the string specified in the Value field.
◆ Contains — Includes part or all of the string you specify in the Value field.
◆ Does not contain — Does not include part or all of the string you specify in the Value field.
◆ Is Empty — Does not contain any data.
   The Value field is unavailable for this condition.
◆ Is Not Empty — Contains any data.
   The Value field is unavailable for this condition.

Specifying conditions for boolean data
For Boolean data (such as Has Password, Password Assigned, and Read Only), specify the following.

◆ One condition is available — Is Equal To
◆ Two values are available — True and False

Specifying conditions for states
For state data, specify the following.

◆ One condition is available — Is Equal To
◆ Select a state in the Value field

Specifying conditions for time data
Filter PST files by specifying a date or date range, and the time, using the conditions described in the following list.

◆ On Or Before — Select this condition to specify a less than or equals (\(\leq\)) date-time.
   For example, selecting this condition for the Last Modified column will filter PST files that were last modified on or before a certain date.
   Select a date from the calendar and a time from the time picker.
   The Value field fills in automatically with the date and time you selected.
◆ On Or After — Select this condition to specify a “greater than or equals” \((\geq)\) date-time.
For example, selecting this condition for the Last Modified column will filter PST files that were last modified on or after a certain date. Select a date from the calendar and a time from the time picker. The Value field fills in automatically with the date and time you selected.

- **Is Empty** — Select this condition to test that the column is blank. The Value field is unavailable for this condition.

- **Is Not Empty** — Select this condition to test that the column is not blank. The Value field is unavailable for this condition.

**Note:** The default date and time is that of the local computer.

You can use combinations of datetime conditions in a filter. To filter jobs that were created between two dates, use the same datetime column twice. One time with the On or after condition and one time with the On or before condition.

The following example filters PST files that were last processed between May 5, 2007 and August 22, 2007:

```
Last Processed On or after 05/05/2007
Last Processed On or before 08/22/2007
```
Adding a PST group

Perform the following steps to add a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. Select **Action > New Group**.
3. In the **New Group** wizard:
   a. In the **Name** field, enter a name for the new group.
   b. In the **Description** field, enter a description for the new group.
4. Click **Finish** to close the **New Group** dialog box.

   ![New Group dialog box](image)

   **Figure 156** New Group dialog box

   The name of the new group is listed in the **PST Groups** pane.

Deleting a PST group

Deleting a PST group does not permanently remove source computers and PST files from the system. Only the PST group is deleted, because the source computers and PST files could belong to another PST group.

Perform the following steps to delete a PST management group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group you want to delete.
3. Select **Action > Delete Group**.
Viewing and editing properties of a PST group

Perform the following steps to the view properties of a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group whose properties you want to view.
3. Select **Action > Properties**. The **Group** dialog box appears and displays the name of the group and an optional description of the group.

![Group Properties dialog box](image)

4. You can edit the **Description** field. You cannot edit the **Name** field.
5. Click **OK** to close the dialog box.

Managing source computers and shares in a PST group

The following section describes how to manage source computers and shares in a PST group.

Adding a source computer or share to a PST group

Perform the following steps to add a source computer to a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group to which you want to add a source computer.
3. Select **Action > Add Source Computers**.
   The **Group Data Sources** dialog box appears.
Figure 158 Group Data Sources dialog box

4. Perform one of the following steps:
   - Specify source computers by UNC path.
   - Specify source computers by using an LDAP query.


**Specifying source computers by UNC path**

Perform the following procedure to specify source computers by UNC path.

1. Open the **Group Data Sources** dialog box.
2. In the **Select machines by** field, select **UNC Path**.

![Group Data Sources dialog box — UNC path](image)

3. Click **Browse**.
4. In the **Browse for Folder** dialog box, locate and select the computer, shared drive, or shared folder and then click **OK**.

   **Note**: Always select the computer, shared drive, or shared folder through the network (My Network Places) and not the local folder path.

   The **Search Path** field displays the selected UNC path.
5. Click **Add** to add the UNC path to the list.
6. Repeat step 3 through step 5 for each UNC path you want to add.
7. Click **OK**.

   The UNC paths are listed in the **Source Computers** tab of the PST group.
Specifying source computers by LDAP query

Perform the following steps to specify source computers by LDAP query.

1. Open the Group Data Sources dialog box.
2. In the Select machines by field, select LDAP Query.

![Group Data Sources dialog box — LDAP query](image)

3. Perform one of the following steps:
   - If the directory server you specified is configured to contain identities, select the Directory server contains identities to improve query performance.
   - If the directory server you specified is not configured to contain identities, clear the Directory server contains identities (default).

**Note:** This option does not apply to Domino servers or to LDAP queries executed locally using the Execute or Test buttons. In those cases, the option is ignored without error or user notification.

4. After you run the LDAP query, at the bottom of the dialog box:
   a. Select the source computers in the list that you want to add to the PST group.
   b. Click OK.

The selected source computers are listed in the Source Computers tab of the PST group.
Removing a source computer from a PST group

**Note:** Removing a source computer from a PST group does not remove the PST files that were discovered on that source computer from the group. The PST files remain in the group, even if you run another Find PST activity against the group. You must manually remove each PST file from the group.

Perform the following procedure to remove a source computer from a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group containing the source computer you want to remove.
3. In the **Source Computers** tab, select the source computer you want to remove.
4. Select **Action > Remove**.

Moving a source computer to another PST group

**Note:** Moving a source computer from one PST group to another does not move the associated PST files. The PST files remain in the group, until you run another Find PST activity against the group.

Perform the following steps to move a source computer to another PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group containing the source computers you want to move.
3. In the **Source Computers** tab, select the source computers you want to move.
4. Select **Action > Move to Group**.

![Figure 161 Group Select dialog box](image)

Figure 161  Group Select dialog box

5. Select the group to which you want to move the source computers.
6. Click **OK**.
Changing the state of a source computer

The following information describes how to change the state of a source computer.

About source computer states

A source computer's state indicates the state the source computer was in the last time a PST activity ran against that source computer.

The source computer state determines whether that source computer will be processed during a PST activity.

In the Group Options page of a PST activity, you specify the state of items to process. These options are related to source computer states in PST groups.

![Group Options page — PST activity]

Figure 162 Group Options page — PST activity
The following table displays the relationship between source computer states in PST groups and the Group Options page in Find PST activities.

**Table 46  Source computer states and group options - Find PST activities**

<table>
<thead>
<tr>
<th>Source computer state in PST Group</th>
<th>Group options in Find PST activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All states</td>
<td>All Locations</td>
<td>The PST activity will process all source computers, regardless of the source computer state.</td>
</tr>
</tbody>
</table>
| Complete                           | All Locations Except Completed      | The Find PST activity will:  
- Skip any source computer in a Complete state.  
- Only process source computers in a New or Failed state. |
| Failed                             | Only Failed Locations               | The Find PST activity will process only those source computers in a Failed state. |
| New                                | Only Unprocessed Locations          | The Find PST activity will process only those source computers marked New. |

To process only certain source computers during a Find PST activity, change the state of the source computers.

**Changing the state of a source computer procedure**

Perform the following steps to change the state of a source computer.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group containing the source computer.
3. In the **Source Computers** tab, select the source computer.
4. Select **Action > Change State**.

Select one of the following options on the **Change State** submenu.

**Table 47  Change State submenu**

<table>
<thead>
<tr>
<th>Option</th>
<th>Changes source computer state to</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Complete</td>
<td>Completed</td>
</tr>
<tr>
<td>To Failed</td>
<td>Failed</td>
</tr>
<tr>
<td>To Reset</td>
<td>New</td>
</tr>
</tbody>
</table>
Managing PST files in a PST group

The following sections describe how to manage PST files in a PST file group.

Adding a PST file to a PST group

Use either of the following methods to add PST files to a PST group.

- Find PST files:
  - Add source computers or shares.
  - Create a Find - Microsoft Outlook PST activity.
- Manually add PST files, as described in this section.

**Note:** PST files must reside in shared folders to which the EMC SourceOne administrator has access.

The following automatic processing occurs on discovered PST files, but does not occur on PST files that are added manually:

- Detection of ownership
- Determination of password protection

Adding a PST file manually to a PST group

Perform the following procedure to add a PST file manually to a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the PST Groups list, select the group.
3. Select **Action > Add PST**.
4. Click **Yes** to continue when the following appears:
   
   Automatic detection of password and ownership attributes is not performed when manually adding a PST file to a group. PST files that do not have an owner assigned will not be archived. Do you wish to proceed?
5. In the **Open** dialog box:
   a. Browse to the location of the PST file.
   b. Select the PST file. You can select more than one.
   c. Click **Open**.
   The selected PST files are listed in the **PST Items** tab.

Removing a PST File from a PST group

Perform the following steps to remove a PST file from a PST group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group containing the PST files you want to remove.
3. In the **PST Items** tab, select the PST files you want to remove.

4. Select **Action > Remove**.

**Moving a PST file to another PST group**

Perform the following steps to move a PST file from one PST group to another.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.

2. In the **PST Groups** list, select the group containing the PST files you want to move.

3. In the **PST Items** tab, select the PST files.

4. Select **Action > Move to Group**. The **Group Select** dialog box appears.

5. Using the **Group Select** dialog box, select the group to which you want to move the PST files.

6. Click **OK**. The **Group Select** dialog box closes and the files are moved to the new group.

**Assigning an owner to a PST file**

The Owner column indicates one of the following.

- The anticipated owner discovered by a Find PST activity.
- The owner you selected from the Exchange address book.
- The owner you specified manually (as described in this section).

If ownership has not been determined:

- The Owner column is blank.
- The PST file will not be archived.
- You can specify an owner.
Associating a PST file with a mailbox

Perform the following steps to associate a PST file with a mailbox.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.
2. In the **PST Groups** list, select the group containing the PST file.
3. In the **PST Items** tab, select the PST file. You can select more than one file.
4. Select **Action > Assign Owner**.

   The **Assign Owner** dialog box appears.

5. Perform one of the following steps:
   - To assign ownership using the address book:
     a. Select **Assign from Address Book**.
     b. Click **Choose Owner**.
     c. Select the owner from the address book.
   - To assign ownership manually:
     a. Select **Assign Manually**.
     b. In the **Display Name** field, enter the display name of the owner (maximum 150 characters).
     c. In the **SMTP Address** field, enter the SMTP address of the owner.
6. Click **OK**. The **Owner** column updates for the selected PST file.

Specifying the password for a password-protected PST file

If a PST file is password-protected (the value in the **Password Protected** column is True), you can manually specify the password that was already assigned to the PST.
Perform the following procedure to specify the password already assigned to a PST file.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > PST Groups** node.

2. In the **PST Groups** list, select the group containing the PST file.

3. In the **PST Items** tab, select the PST file. You can select more than one file.

4. Select **Action > Set Password**. The **Assign PST Password** dialog box appears.

5. In the **New Password** field, enter the password that was already assigned to the PST file. Do not specify a new password. The characters display as asterisks.

6. In the **Verify Password** field, re-enter the password.

7. Click **OK**. The password is stored in the database in encrypted form.

---

**NSF processing activities**

This section describes how to process groups of Domino NSF files.

**What are NSF groups?**

Use NSF groups to organize and simplify the management of source computers and NSF files in preparation for NSF activities.

You can:

- Search for source computers based on an LDAP query and add the results to an NSF group.
- Browse for source computers and shares and add the results to an NSF group.
- Manually remove source computers and shares from an NSF group.
- Inspect the status of source computers since the last processing occurred.
- Use NSF groups as input to NSF activities.
- Remove individual NSF files from the NSF group.

**NSF management checklist**

Ensure the following steps are performed to manage NSF files.
1. Create NSF groups.
2. Add NSF files manually to NSF groups.
3. Assign owners to the NSF files, if required.
4. Remove the NSF files that you do not want to process.
5. Create an Archive - Personal Mail Files activity to archive NSF files.

## Viewing list of NSF groups

This section provides an overview of the NSF Groups area.

To view a list of existing NSF groups (if any), in the EMC SourceOne console, expand the EMC SourceOne > Operations > NSF Groups node.

![NSF groups](image)

**Figure 166** NSF groups

### Refreshing an NSF group view

To update the list of NSF management groups and view the latest changes, press F5 or click Refresh. The list may take a few moments to refresh.
Viewing list of NSF files in an NSF group

Perform the following steps to view the list of NSF files in an NSF group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.

2. In the **NSF Groups** list, select a group.

   The **NSF Items** area lists the NSF files in the selected NSF group.

![NSF Items](image)

**Figure 167** NSF Items

Adjusting NSF list when display limit is reached

By default, up to 1,000 NSF files are displayed in the NSF Items tab.

If the number of NSF files exceeds the maximum rows specified for the NSF Items tab, a message and links appear at the top of the NSF list.

![Message](image)

**Figure 168** NSF Items tab — Links to properties and filter

- To change the maximum number of NSF files displayed, click the maximum number of rows link.
- To filter the NSF list, click the filter link.
Customizing the view for NSF groups

The following sections describe how to customize the view for NSF groups.

Specifying maximum number of NSF files to display

The default maximum number of NSF files to display in the NSF Items tab is 1,000.

Perform the following steps to change the maximum number of NSF files.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. Select a group.
3. Select the **NSF Items** tab.
4. Select any item in the list.
5. Select **Action > Maximum Rows Displayed**.

![Maximum Rows Displayed dialog box](image)

6. Enter the maximum number of rows to display, in the range 1 to 99,999.
7. Click **OK**.

Adding or removing columns

Perform the following procedure to add or remove columns.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. In the center pane, perform one of the following steps:
   - To add or remove columns from the **NSF Groups** list, select any group in the list.
   - To add or remove columns from the **NSF Items** tab, select any NSF in the list.
3. Select **Action > View > Add/Remove Columns**.
   
   The **Choose Columns** dialog box appears.
Changing the order of columns

Perform the following steps to change the order of columns.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. Drag the column header left or right to a new location. Red arrows indicate where you can drop the column header.

Changing sort order in a column

The direction of the triangle in a column header indicates the direction of sort for that column.

- **Up** — Ascending (alphabetical)
- **Down** — Descending

Perform these steps to toggle between ascending and descending sort order in a column.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. Click the header of the column you want to toggle.

Grouping by column

In the **NSF Items** area, you can organize the display of NSF files based on a specific column.

Perform the following procedure to group NSF files by column.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. Select a group.
3. Select any item in the **NSF Items** area.
4. Select **Action > Enable Grouping**.

![Choose Columns dialog box example](image)
5. Drag-and-drop the column to the indicated area above the NSF list.

![Drag a column header here to group by that column.]

Figure 171  Group by column prompt

The NSF files are now grouped under expandable rows, similar to a tree pane.

Filtering the NSF list

To refine the NSF list displayed in the NSF Items tab, you can create a filter. Perform the following steps to filter the list of NSF files.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > NSF Groups node.
2. Select a group.
3. In the NSF Items area, select any item.

![Filter dialog box]

Figure 172  Filter dialog box

5. In the Column field, select the name of the column that you want to filter.
6. In the Condition field, select the condition to apply to the column’s values.

The conditions depend on the data type of the column you selected in the Column field.

7. In the Value field, enter a value for the column and the condition.

Depending on the condition you selected in the Condition field, the Value field may not be available.
8. Click Add.
The new criterion appears in the list.

9. To add another criterion to the list, repeat step 5 through step 8.

   Each line in the filter is joined with the other lines by an AND search.

   You can use the same column more than one time in a filter. For example, you could use the Last Processed column twice to specify a date-time range.

10. To remove entries from the criteria list, perform one of the following steps:

   • Click Clear All.
   • Select the line in the list that you want to remove, then click Remove.

11. To edit a selected entry in the filter:

   a. Select the entry in the criteria list.
   
   b. Click Edit. The Edit Filter Criteria dialog box appears. Modify the portion of the filter entry and click OK.

12. Click OK to close the Filter dialog box.

Specifying conditions for string data

The following list describes the conditions available for columns that display string data.

◆ Is exactly — Includes all of the string you specify in the Value field.

◆ Contains — Includes part or all of the string you specify in the Value field.

◆ Does not contain — Does not include part or all of the string you specify in the Value field.

◆ Is Empty — Does not contain any data. The Value field is unavailable for this condition.

◆ Is Not Empty — Contains any data. The Value field is unavailable for this condition.

Specifying conditions for boolean data

For Boolean data, such as Has Password, Password Assigned, and Read Only, specify the following.

◆ One condition is available: Is Equal To.

◆ Two values are available: True and False.

Specifying conditions for states

For state data, specify the following.

◆ One condition is available — Is Equal To.

◆ Select a state in the Value field.

Specifying conditions for time data

You can filter NSF files by specifying a date or date range, and the time, using the conditions described in the following list:

◆ On Or Before — Select this condition to specify a less than or equals (\(\leq\)) date-time.
For example, selecting this condition for the Last Modified column will filter NSF files that were last modified on or before a certain date.

Select a date from the calendar and a time from the time picker.

The Value field fills in automatically with the date and time you selected.

- On Or After — Select this condition to specify a greater than or equals (>=) date-time. For example, selecting this condition for the Last Modified column will filter NSF files that were last modified on or after a certain date.

Select a date from the calendar and a time from the time picker.

The Value field fills in automatically with the date and time you selected.

- Is Empty — Select this condition to test that the column is blank.

The Value field is unavailable for this condition.

- Is Not Empty — Select this condition to test that the column is not blank.

The Value field is unavailable for this condition.

Note: The default date and time is that of the local computer.

You can use combinations of datetime conditions in a filter.

To filter jobs that were created between two dates, use the same datetime column twice. One time with the On or after condition and one time with the On or before condition.

The following example filters NSF files that were last processed between May 5, 2007 and August 22, 2007:

| Last Processed On or after | 05/05/2007 |
| Last Processed On or before | 08/22/2007 |

Adding an NSF group

Perform the following procedure to add an NSF group.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > NSF Groups node.


3. In the New Group wizard:
   a. In the Name field, enter a name for the new group.
   b. In the Description field, enter a description for the new group.
4. Click Finish to close the New Group dialog box.

The name of the new group is listed in the NSF Groups pane.

Deleting an NSF group

Deleting an NSF group does not permanently remove NSF files from the system. Only the NSF group is deleted, because the NSF files could belong to another NSF group.

Perform the following steps to delete an NSF management group.

1. In the EMC SourceOne console, expand the EMC SourceOne > Operations > NSF Groups node.
2. In the NSF Groups list, select the group you want to delete.
Viewing and editing properties of an NSF group

Perform the following steps to view properties of an NSF group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. In the **NSF Groups** list, select the group whose properties you want to view.
3. Select **Action > Properties**. The **Group** dialog box appears and displays the name of the group and an optional description of the group.

![Figure 174 Group Properties dialog box](image)

4. You can edit the **Description** field. You cannot edit the **Name** field.
5. Click **OK** to close the dialog box.

Managing NSF files in an NSF group

The following sections describe how to manage NSF files in an NSF file group.

Adding an NSF file to an NSF group

**Note:** NSF files must reside in shared folders to which the EMC SourceOne administrator has access.

Perform the following procedure to add an NSF file manually to an NSF group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. In the **NSF Groups** list, select the group.
3. Select **Action > Add NSF**.
4. Click **Yes** to continue when the following appears:

   Automatic detection of password and ownership attributes is not performed when manually adding an NSF file to a group. NSF files that do not have an owner assigned will not be archived. Do you wish to proceed?
5. In the **Open** dialog box:
   a. Browse to the location of the NSF file.
   b. Select the NSF file. You can select more than one.
   c. Click **Open**.

The selected NSF files are listed in the **NSF Items** area.

### Removing an NSF File from an NSF group

Perform the following procedure to remove an NSF file from an NSF group.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. In the **NSF Groups** list, select the group containing the NSF files you want to remove.
3. In the **NSF Items** area, select the NSF files you want to remove.
4. Select **Action > Remove**.

### Moving an NSF file to another NSF group

Perform the following steps to move an NSF file from one NSF group to another.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. In the **NSF Groups** list, select the group containing the NSF files you want to move.
3. In the **NSF Items** area, select the NSF files.
4. Select **Action > Move to Group**. The **Group Select** dialog box appears.

![Group Select dialog box](image)

**Figure 175** Group Select dialog box

5. Using the **Group Select** dialog box, select the group to which you want to move the NSF files.
6. Click **OK**. The **Group Select** dialog box closes and the files are moved to the new group.
Assigning an owner to an NSF file

The Owner column indicates one of the following.

- The owner you selected from the Domino address book
- The owner you specified manually (as described in this section)

If ownership has not been determined:

- The Owner column is blank.
- The NSF file will not be archived.
- You can specify an owner.

Associating an NSF file with an owner

Perform these steps to associate an NSF file with an owner.

1. In the EMC SourceOne console, expand the **EMC SourceOne > Operations > NSF Groups** node.
2. In the **NSF Groups** list, select the group containing the NSF file.
3. In the **NSF Items** area, select the NSF file. You can select more than one file.
4. Select **Action > Assign Owner**.

The **Assign Owner** dialog box appears.

![Assign Owner dialog box](image)

Figure 176 Assign Owner dialog box — NSF

5. Perform one of the following steps.

   - To assign ownership using the address book:
     a. Select **Assign from Domino Directory**.
     b. Click **Choose Owner**.
     c. Select the owner from the address book.
   
   - To assign ownership manually:
PST and NSF Processing Activities

a. Select Assign Manually.

b. In the Display Name field, enter the display name of the owner (maximum 150 characters).

c. In the SMTP Address field, enter the SMTP address of the owner.

6. Click OK.

The Owner column updates for the selected NSF file.
CHAPTER 18
Shortcut Activities

This section describes shortcuts and shortcut activities in EMC SourceOne Email Management. Topics include:

◆ Introduction to shortcuts................................................................. 434
◆ Considerations and limitations when using shortcuts..................... 438
◆ Prerequisites for shortcutting messages......................................... 439
◆ Customizing shortcut replacement text.......................................... 439
◆ Shortcut - Historical activity ......................................................... 444
◆ Update Shortcuts - Historical & User Directed Archive activity...... 444
◆ Restore Shortcuts - Historical & User Directed Archive activity ...... 445

For information about shortcuts and Exchange Public Folders, refer to “Processing Exchange Public Folder Content” on page 479.
Shortcut Activities

**Introduction to shortcuts**

Email Management can be used to create, restore, and update different types of email message shortcuts.

You create shortcuts to save space on the email server by replacing the email message with a small file that points to the original email message that has been archived by Email Management.

**Summary of activities used to manage shortcuts**

Use different activities to process different types of email message shortcuts as shown in the following table.

<table>
<thead>
<tr>
<th>Content</th>
<th>Shortcut activities used</th>
</tr>
</thead>
</table>
| Email archived using the Archive - Historical activity | • Shortcut - Historical  
• Restore Shortcuts - Historical and User Directed Archive  
• Update Shortcuts - Historical and User Directed Archive |
| Email archived in Exchange Public folders using the Archive - Microsoft Exchange Public Folders activity | • Shortcut - Microsoft Exchange Public Folders  
• Restore Shortcuts - Microsoft Exchange Public Folders |
| Email archived using the Archive - User Directed Archive activity | • Shortcut - User Directed Archive  
• Restore Shortcuts - Historical and User Directed Archive  
• Update Shortcuts - Historical and User Directed Archive |
| Email stored in a .PST file that has been migrated and archived. | • Migrate - Microsoft Office Outlook .PST |

**What happens to the contents of a shortcut message?**

A stub replaces the contents of a shortcut message.

Depending on the mail server (Domino or Exchange), and the activity options selected, short-cutting replaces the body of the shortcut message, or the attachments, or both. The stub may consist of explanatory text only, or explanatory text and links to attachments.

For details on the replacement text that appears in stubs, refer to the following sections.

You can customize the replacement text.
Domino/Notes

For Notes messages, the message body and attachments are extracted from the mail document. The mail document is converted to an empty shell containing replacement text.

- The default replacement text for the message body is:
  This Notes message has been converted as a shortcut.

- The default replacement text for an attachment is:
  This attachment of the Notes message has been converted as a shortcut. Please open the message to view the attachment.

Domino/Notes message bodies and attachments are always shortcut and replaced with explanatory text.

Exchange, Outlook and mobile devices

EMC SourceOne Mobile Services software and Web Services software support the resolution of shortcuts for users accessing them using the universal URL.

This includes:

- Mobile device users
- Outlook Web Access users in environments in which EMC SourceOne Extensions for OWA Support software is not installed on the Exchange server.
- Outlook users in environments in which the EMC SourceOne Offline Access software is not installed on their client computers.

Exchange mail users and mobile users can double-click shortcuts in their mailboxes to retrieve the full messages from the EMC SourceOne archive. The message is retrieved through the Retrieval server.

**Note:** When restoring shortcuts using mobile devices, both EMC SourceOne and the mobile device have filtering settings that can be applied. A mobile device will synchronize only those items that meet its own filter settings.

Outlook and EMC SourceOne Offline Access

The user experience in Outlook depends on whether you install the EMC SourceOne Offline Access software on user computers.

- If you install Offline Access on user computers, then the user experience is seamless. Shortcut messages and attachments display unchanged in the Outlook preview pane. You can also configure Offline Access to cache messages and attachments locally so that Outlook users can retrieve them offline.

Refer to:
Shortcut Activities

- The *EMC SourceOne Offline Access Administration and Installation Guide* for information about installing the Offline Access client.
- The *EMC SourceOne Email Management Offline Access User Guide* for information about the user interface.

If you do not install Offline Access on user computers, then:

- If you choose to shortcut the message body, the message body will be replaced by explanatory text.
- Attachments are converted to HTML stubs, which link to the attachments.

![Test Case 261](image)

Figure 177  Shortcut message body and attachment displayed in Outlook (without Offline Access) example

**Note:** The View original message as a web page link does not display messages in rich formatted content, nor does it display inline images. In an Exchange environment, delegate users cannot use the universal URL to resolve shortcuts in the delegate mailbox. Delegate users can use Offline Access to resolve the shortcut.
Considerations for mobile devices used with Exchange

Consider the following information.

For mobile devices used with Exchange:

- Users must log on using the full Windows logon name, including the domain.

![Figure 178 Mobile device logon screen](image)

For a shortcut message, the screen displays the following replacement text.

![Figure 179 Shortcut message displayed in mobile device (Exchange)](image)

- When a mobile device user opens a shortcut message, the message is retrieved and stored in the user’s mailbox. The user sees both the shortcut stub and the message in his mailbox.

**Note:** The View original message as a web page link does not display messages in rich formatted content, nor does it display inline images.

### Shortcutting messages

Perform the following steps to shortcut messages.

1. Install the prerequisite software.
2. Enable and configure the Universal URL used for shortcut activities and for retrieval. This step is required for Exchange.
3. Customize the default replacement text for message bodies and attachments. This step is optional.
4. Create and run an activity which creates shortcuts.

To update existing shortcuts in Exchange environments, create an Update Shortcuts - Historical & User Directed Archive activity.
Shortcuts Activities

How do I restore shortcut messages to the email server?

In an Exchange environment where you have not installed Offline Access software on user computers, users can restore one shortcut message at a time by clicking the **Restore original message to the e-mail server** link in the message stub.

To restore many messages at one time, system administrators can use the Restore Shortcuts - Historical & User Directed Archive activity.

Users and administrators can also restore messages by using Search. Refer to the *EMC SourceOne Search User Guide*.

Considerations and limitations when using shortcuts

- Do not shortcut draft messages. If you shortcut drafts, then users will have to use EMC SourceOne Search to restore the drafts to their mailboxes before editing.

- When messages in the Notes trash folder are archived, running a Shortcut activity does not process any items in the trash folder. However, the Restore Shortcut activity will process some items with failures. This is because the Shortcut activity did not process any items, so there are no items to restore.

- Shortcut Public Folder email messages do not return a universal URL (UURL) link when you use Outlook Web Access.

- By design, for calendar items:
  - Inline attachments and bodies are not shortcut.
  - Attachments are shortcut.

- By design, messages that contain a virus are not shortcut. If a shortcut activity is run against a message containing a virus, the following error occurs:

  *Shortcut failed*

- In Exchange mail environments:
  - The EMC SourceOne shortcut icon does not appear for digitally signed and encrypted Exchange messages.
  - Forwarded messages or replies that are shortcut will display the Outlook forward/reply icons instead of the EMC SourceOne shortcut icon. This is a design limitation of Outlook. The forward/reply icons are always used instead of custom icons.
Prerequisites for shortcutting messages

Before creating activities to shortcut messages, update message shortcuts, or restore message shortcuts, complete the following prerequisites.

- If you are creating shortcuts on an Exchange mail server, perform the following:
  - Configure the URL used for shortcut retrieval.
  - Enable the universal URL option and specify the URL used for shortcut retrieval before you create Shortcut or Update Shortcut activities. If the universal URL option is enabled but the URL is not configured, then the following error message appears when you try to create Shortcut or Update activities:
    
    No ‘External URL’ has been configured.
    An ‘External URL’ must be set in the Application Configuration node before creating an activity of this type.

- Verify that there is sufficient mailbox space for restoring shortcuts.

Restoring shortcuts to full mailboxes causes problems. When a mailbox containing shortcut messages is close to exceeding the assigned size limit, shortcut messages can be restored to that mailbox causing it to exceed the size limit. This results in the user receiving error messages and no longer being able to send or receive messages using that mailbox.

When a mailbox containing shortcuts is close to exceeding the size limit, the limit is to either be increased or the user or administrator is to not restore any shortcuts to the mailbox until the mailbox has more free space.

Customizing shortcut replacement text

Customize the replacement text displayed in shortcut stubs by editing the LanguageResources table in the database with the default installed name of ES1Activity.

About the LanguageResources table

The first ten rows in the LanguageResources table contain the default replacement text displayed in shortcut stubs as shown in the following figure.

<table>
<thead>
<tr>
<th>LangID</th>
<th>ApplicationID</th>
<th>ResourceID</th>
<th>ReplacingString</th>
</tr>
</thead>
<tbody>
<tr>
<td>002</td>
<td>30</td>
<td>1</td>
<td>This note/message has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>002</td>
<td>30</td>
<td>2</td>
<td>This attachment of the note/message has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>4</td>
<td>This attachment of the note/message has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>5</td>
<td>This exchange message has been converted as a shortcut.</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>6</td>
<td>This attachment of the exchange message has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>7</td>
<td>This attachment of the note has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>8</td>
<td>This attachment of the note has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>9</td>
<td>This attachment of the note has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>10</td>
<td>This attachment of the note has been converted as a shortcut. Please open the message to view...</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>11</td>
<td>OA Diagnostic Tool</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>2</td>
<td>Messaging</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>3</td>
<td>Mailbox Archive</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>4</td>
<td>Mailbox Shortcut</td>
</tr>
<tr>
<td>001</td>
<td>30</td>
<td>5</td>
<td>Mailbox Delete</td>
</tr>
</tbody>
</table>

Figure 180  LanguageResources table
- The LangID column contains the Microsoft locale ID (LCID) for the language.
- The ApplicationID column identifies the application using the string. Do not edit this column.
- The ResourceID column identifies the mail system (Domino or Exchange) and usage for the string (body or attachment replacement). Do not edit this column.
  - The ResourceString column contains the replacement text that you can edit. For EMC SourceOne, replacement text is HTML. For Exchange, the HTML replacement text may contain links so that users can access the message body and attachments of the shortcut message.

The following table describes each entry in the LanguageResources table used for shortcut replacement text.

Table 49 Default replacement text - LanguageResources table (page 1 of 2)

<table>
<thead>
<tr>
<th>ResourceID column</th>
<th>Default replacement text displayed in stubs</th>
<th>Mail environment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>This notes message has been converted as a shortcut.</td>
<td>Domino/Notes EmailXtender 4.8</td>
<td>Plain text. Replaces shortcut message body.</td>
</tr>
<tr>
<td>2</td>
<td>This attachment of the notes message has been converted as a shortcut. Please open the message to view the attachment.</td>
<td></td>
<td>Plain text. Replaces shortcut attachment.</td>
</tr>
<tr>
<td>3</td>
<td>&lt;html&gt;&lt;body&gt;This notes message has been converted as a shortcut.&lt;/body&gt;&lt;/html&gt;</td>
<td>Domino/Notes EMC SourceOne</td>
<td>HTML. Replaces shortcut message body.</td>
</tr>
<tr>
<td>4</td>
<td>&lt;html&gt;&lt;body&gt;This attachment of the notes message has been converted as a shortcut. Please open the message to view the attachment.&lt;/body&gt;&lt;/html&gt;</td>
<td></td>
<td>HTML. Replaces shortcut attachment.</td>
</tr>
<tr>
<td>5</td>
<td>This exchange message has been converted as a shortcut.</td>
<td>Exchange/Outlook EmailXtender 4.8</td>
<td>Plain text. Replaces shortcut message body.</td>
</tr>
<tr>
<td>6</td>
<td>This attachment of the exchange message has been converted as a shortcut. Please open the message to view the attachment.</td>
<td></td>
<td>Plain text. Replaces shortcut attachment.</td>
</tr>
<tr>
<td>7</td>
<td>Refer to “Default replacement text for Outlook” on page 441.</td>
<td>Exchange/Outlook EMC SourceOne</td>
<td>HTML. Replaces shortcut message body if the Shortcut message body option is selected when the Shortcut activity is created.</td>
</tr>
</tbody>
</table>
Default replacement text for Outlook

The following section outlines the default replacement text for Outlook.

The HTML for ResourceID 7 and ResourceID 9 includes the “Download the original message” link.

<table>
<thead>
<tr>
<th>ResourceID column</th>
<th>Default replacement text displayed in stubs</th>
<th>Mail environment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Refer to “Default replacement text for mobile devices (Exchange)” on page 442.</td>
<td>Exchange/mobile devices EMC SourceOne</td>
<td>HTML. Replaces shortcut message body if the Shortcut message body option is selected when the Shortcut activity is created.</td>
</tr>
<tr>
<td>9</td>
<td>Refer to “Default replacement text for Outlook” on page 441.</td>
<td>Exchange/Outlook EMC SourceOne</td>
<td>HTML. Replaces shortcut message body if the Shortcut message body option is selected when the Shortcut activity is created.</td>
</tr>
<tr>
<td>10</td>
<td>Refer to “Default replacement text for mobile devices (Exchange)” on page 442.</td>
<td>Exchange/mobile devices EMC SourceOne</td>
<td>HTML. Replaces shortcut message body if the Shortcut message body option is selected when the Shortcut activity is created.</td>
</tr>
</tbody>
</table>

Default replacement text for Outlook

The following section outlines the default replacement text for Outlook.

The HTML for ResourceID 7 and ResourceID 9 includes the “Download the original message” link.

<table>
<thead>
<tr>
<th>ResourceID 7:</th>
</tr>
</thead>
</table>
| <html> <head><meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> <meta http-equiv="Content-Language" content="en-us" /> 
<title>EMC SourceOne Shortcut Information</title> </head> <body> <div style="border-top-style: solid; border-bottom-style: solid; background-color: #C3DAF9; border-top-width:2px; border-bottom-width:2px"> 
<b><font face="Tahoma" size="2" color="#003C87">EMC SourceOne</font></b></div> |

Figure 181 Download the original message link

When a user clicks this link, the user can log in, if not already logged in, and save the shortcut message to a specified location. With this link, a user can save and view a shortcut message without restoring it to the mailbox. This can be useful when a shortcut message is encrypted, because without this option a user cannot see the shortcut encrypted message unless the message is restored to the mailbox first.

ResourceID 7:
Shortcut Activities

This message has been converted to a shortcut by EMC SourceOne to save server space.

View original message as a web page:

Restore original message to the e-mail server:

Download the original message:

ResourceID 9:

In an Exchange environment, mobile devices use ResourceIDs 8 and 10 in the LanguageResources table.

ResourceID 8:

Default replacement text for mobile devices (Exchange)

In an Exchange environment, mobile devices use ResourceIDs 8 and 10 in the LanguageResources table.
Customizing replacement text for shortcuts procedure

Perform the following steps to customize replacement text.

1. On the SQL Server, start SQL Server Manager.
2. In the left pane, expand the ES1Activity database node.
3. Expand the Tables node.
4. Right-click the LanguageResource table, then select Open Table.
5. Edit the HTML text for your mail environment and archiving product.
Shortcut - Historical activity

Use the **Shortcut - Historical** activity to create shortcuts from messages, or optionally to archive messages and then create shortcuts of those messages.

You can also use the **Shortcut - Historical** activity to shortcut journaled content.

Improvements in using Shortcut - Historical activity to shortcut journaled content

In versions of Email Management before 6.8 SP1, the **Shortcut - Historical** activity created shortcuts only from content that had been archived using the **Archive - Historical** or the **Shortcut - Historical** activities. This meant that Exchange or Domino content that had been archived using the Journal activity had to be shortcut by performing the following steps:

1. Use the **Journal** activity to archive the content.
2. Use the **Archive - Historical** activity to archive the same content as the **Journal** activity had already archived.
3. Use the **Shortcut - Historical** activity with the **Process only previously archived items** option selected on the **Item Types** page to shortcut the content that had been processed by the **Archive - Historical** activity in the specified mapped folder.
4. If the content had been archived into several mapped folders, create a **Shortcut - Historical** activity to shortcut the content in each mapped folder.

In the **Mapped Folders** page of the **Shortcut - Historical** activity you shortcut Journal content without using the **Archive - Historical** activity, as follows:

1. Use the **Journal** activity to store the content.
2. Use the **Shortcut - Historical** activity with the **Process only previously archived items** option selected on the **Item Types** page to shortcut the content that had been processed by the **Journal** activity.

   This activity allows you to specify multiple mapped folders if needed and so only one **Shortcut - Historical** activity is needed to specify all mapped folders that contain the content to be shortcut.

   Additionally, you can select the processing order of the mapped folders to optimize the performance of the activity.

Update Shortcuts - Historical & User Directed Archive activity

The Update Shortcuts - Historical & User Directed Archive activity is available in an Exchange environment.

Use the Update Shortcuts - Historical & User Directed Archive activity to:

- Update replacement text used in the message body stubs of shortcuts.
- Update replacement text used in the attachment stubs of shortcuts.
- Upgrade EmailXtender 4.8 SP1 shortcuts to EMC SourceOne shortcuts.

The Update Shortcuts - Historical & User Directed Archive activity also updates shortcuts in user-directed archiving (UDA) folders.
Restore Shortcuts - Historical & User Directed Archive activity

Use the Restore Shortcuts - Historical & User Directed Archive activity to restore shortcut messages from the archive to the email server.

The Restore Shortcuts activity processes EmailXtender 4.81 and Email Management shortcuts in the folder in which the shortcuts are found. If the shortcut was moved out of the folder from which the message was originally archived, then the message is restored into the folder in which the shortcut was found.

Changes made to the shortcut's subject or body are not retained during the restore. However, if the user placed flags, categories, or reminders on the shortcut, those changes are retained when the message is restored.

Recipients are not restored or changed, because they are not altered when the message is shortcut.
Shortcut Activities
CHAPTER 19
Using Journal Activities

This section describes how to configure and use the Journal activity to process content from various environments. Topics include:

◆ Using Journal activities with different content types ........................................... 448
◆ Using Journal activities with Microsoft Exchange  .............................................. 448
Using Journal activities with different content types

Email Management supports journaling of content from multiple sources. You can use a Journal activity to process content from the following.

- IBM Lotus Domino
  Select IBM Lotus Domino on the Activity Types page and then continue using the New Activity wizard.

  **Note**: Due to an issue with IBM Lotus Domino Native Journaling, Email Management cannot capture all the owners of a journaled message because the Domino mail server is not expanding groups on journaled messages.

  If this occurs, install and use EMC SourceOne Journaling instead of Domino Native Journaling as follows.
  1. Install and configure the EMC SourceOne Extensions for Domino.
  2. Select the **Use EMC SourceOne extension manager** option instead of the **Use IBM Lotus Domino native journaling** option on the **Journaling Method** page of the EMC SourceOne activity wizard.

- Microsoft Exchange
  You can perform both Exchange standard and premium journaling with Email Management, however you need to configure them differently.
  After configuration, you select Microsoft Exchange on the Activity Types page and then continue using the New Activity wizard.

- Microsoft Exchange Online
  You need to perform some configuration before journaling data from Microsoft Exchange Online.
  One configured, select Microsoft Office 365 on the Activity Types page and then continue using the New Activity wizard.

- SMTP mail servers
  Select SMTP on the Activity Types page and then continue using the New Activity wizard.

Using Journal activities with Microsoft Exchange

You can perform both Exchange standard and premium journaling with Email Management, however you must configure them differently.

Differences between Microsoft Exchange premium and standard journaling


The following are definitions of the two types of journaling:
◆ Standard journaling — Standard journaling is configured on a mailbox database. It enables the Journaling agent to journal all messages sent to and from mailboxes located on a specific mailbox database. To journal all messages to and from all recipients and senders, you must configure journaling on all mailbox databases on all Mailbox servers in the organization.

◆ Premium journaling — Premium journaling enables the Journaling agent to perform more granular journaling by using journal rules. Instead of journaling all mailboxes residing on a mailbox database, you can configure journal rules to match your organization’s needs by journaling individual recipients or members of distribution groups. You must have an Exchange Enterprise client access license (CAL) to use premium journaling.

When you enable standard journaling on a mailbox database, this information is saved in Active Directory and is read by the Journaling agent. Similarly, journal rules configured with premium journaling are also saved in Active Directory and applied by the Journaling agent.

Note: Although it is possible to perform Exchange premium or standard journaling using an SMTP mailbox instead of an Exchange mailbox, it is not recommended when used with Email Management due to limitations with that type of message.

Using Microsoft Exchange premium journaling with EMC SourceOne

You can use Microsoft Exchange premium journaling with Email Management. This capability is described in the following sections.

Summary of using EMC SourceOne with Exchange premium journaling

To configure Email Management to use Exchange premium journaling, you need to configure both Email Management and Exchange premium journaling by performing the following tasks.

1. Create and initiate a Journal activity with the Exchange data source type selected. The Journal activity will process the messages delivered by premium journaling.

Until premium journaling is enabled, the Journal activity will not have any content to process.

2. Define and enable premium journaling from Exchange to the Journal activity.

Do not enable premium journaling until the Journal activity is ready to process those messages; this will help avoid overloading the mailbox that is receiving the Exchange journaling reports.

Configuring an EMC SourceOne Journal activity to use Exchange premium journaling

Perform the following steps to configure a Journal activity to use Exchange premium journaling.

1. Create a new Journal activity using the EMC SourceOne console by specifying Journal as the activity type on the Activity Type page.

2. Specify Microsoft Exchange as the kind of data to journal using the Data Source Type page.
3. Specify the mailbox that will receive the premium journaling reports from the Exchange server using the Select Data Sources page.

4. When you specify the premium journaling mailbox, The EMC SourceOne console displays an error about specifying a non-journaling mailbox:

   The following non-journaling mailboxes have been selected for this journal activity: mailbox names
   Would you like to remove these selections?

5. This error is acceptable for premium journaling, and you are to specify No in response to the error dialog box. This error is not acceptable for standard journaling.

6. Finish creating the activity.

   Until premium journaling is enabled from the Exchange server, no email content will be processed by the **Journal** activity.

Configuring Exchange premium journaling for use with EMC SourceOne

In the Exchange Management console, perform the following steps to configure Exchange premium journaling for use with a **Journal** activity.

1. In the console navigation tree, select the **Hub Transport** node under the **Organization Configuration** node.

2. In the **Actions** pane, click **New Journal Rule**. The **New Journal Rule** dialog box appears.

   ![Figure 182 Premium journaling New Journal Rule page](image)

3. Enter a rule name in the **Rule name** field.

4. Enter the email address to which the journal reports are to be sent in the **Send Journal reports to e-mail address** field. This is the mailbox from which Email Management will receive and process the journal reports.

5. Verify that the **Scope** is set to the **Global - all messages** option. This is the default.
6. Verify that the **Enable Rule** option is selected. This is the default.
7. Verify that you have the necessary licenses mentioned on the **New Journal Rule** page.
8. Click **New**. The **Completion** page appears.
9. Click **Finish**. The new rule is enabled and displayed on **Journaling** tab.

### Using Microsoft Exchange standard journaling with EMC SourceOne

You can use Microsoft Exchange standard journaling with Email Management. This capability is described in the following sections.

**Summary of using EMC SourceOne with Exchange standard journaling**

Perform the following steps to configure Microsoft Exchange standard journaling for use with a **Journal** activity.

1. Configure Microsoft Exchange standard journaling for use with the **Journal** activity.
2. Configure a **Journal** activity for use with Exchange standard journaling.

**Configuring Exchange standard journaling for use with the Journal activity**

Perform the following procedure to configure Microsoft Exchange standard journaling for use with the **Journal** activity.

1. In the Exchange Management console, select and expand the **Server Configuration** node and then select **Mailbox** under it.
2. Select the **Database Management** tab. Right-click the mailbox for which you want to set up standard journaling and select **Properties**. The **Properties** page appears.

![Figure 183 Mailbox properties page defining standard journal recipient](image)

3. Select the **General** tab. Select the **Journal Recipient** option and click the **Browse** button to select the mailbox to use for standard journaling.
4. Confirm your selections by clicking OK. Standard journaling is now enabled.

Configuring a Journal activity for use with Exchange standard journaling

Perform the following procedure to configure a Journal activity to use Exchange standard journaling.

1. Create a new Journal activity using the EMC SourceOne console by specifying Journal as the activity type on the Activity Type page.
2. Specify Microsoft Exchange as the kind of data to journal using the Data Source Type page.
3. Specify the mailbox that will receive the standard journaling reports from the Exchange server using the Select Data Sources page.
4. Finish creating the activity.

Until standard journaling is enabled from the Exchange server, no email content will be processed by the Journal activity.
CHAPTER 20
Using the Journal Activity for Office 365 Content

This section describes how to configure and use the Journal activity to process Exchange Online messages from an Office 365 environment. Topics include:

- Overview of using Journal activity with Office 365 content ........................................ 454
- Journaling for Office 365 content configuration sequence ......................................... 457
- Configuring SMTP support for Office 365 journaling .............................................. 457
- Using the Journal activity to process Office 365 messages ....................................... 459
- Configuring Exchange Online premium journaling ................................................ 467
- Maintaining and Troubleshooting Office 365 journaling ....................................... 469
- Modifying EMC SourceOne Search behavior for use with Office 365 content ...... 473
Overview of using Journal activity with Office 365 content

Email Management allows you to journal content locally that is stored in Exchange Online, using Microsoft Office 365 and Exchange 2010.

Advantages of having a local journal of your cloud data

There are several advantages to having a local Email Management journal of the data you have in the Microsoft Office 365 cloud.

- You can use EMC SourceOne tools to process that local data, including using Discovery Manager for legal discovery or using Email Supervisor for email supervision.
- You can ensure that your local data is retained and disposed of according to any corporate rules for data retention and disposal.
- You have a local copy of your data if the cloud service you are using is unavailable for some reason.

Considerations when journaling email content from an Office 365 environment

The full capabilities of Email Management are not available for email content processed from Microsoft Office 365 using the Journal activity. The following are considerations for content journaled from Microsoft Office 365.

- Shortcutting of email content is not available.
- Use of EMC SourceOne Offline Access is not available.
- Historical archiving or historical deletion of email content is not available.
- User-directed archiving of email content is not available.
- EMC SourceOne journals Office 365 email content as MIME messages. You can control how users can open and restore this content within EMC SourceOne Search.
- All types of Office 365 email content, other than meeting requests, are placed in the Native Archive by the Journal activity as email message item types, including task requests. Meeting requests are placed in the Native Archive as meeting request item types.

This has the following implications for searching this content using Search, EDiscovery Manager, or Kazeon eDiscovery:

- If you are searching email content (other than meeting requests) journaled from an Office 365 environment, you must search for that content as an email message (because that is how it was archived) and not as the content type appearing in Outlook, such as a task request.
- Meeting requests can be searched for as meeting requests.
- Searches of Office 365 email messages may return task request results as well as email message results when displayed by the Search clients.
Anti-virus software is to exclude the Office 365 email processing directories. Running anti-virus software on the contents of these directories may cause problems with Email Management processing. These directories are:

- Any source folder used by the EMC SourceOne File Mover agent. This is typically the SMTP drop directory used by IIS.
- Any target folder used by the File Mover agent. These folders are defined by the administrator.
- The Journaling issues folder used by the File Mover agent. This folder is defined by the administrator.

**Architectural overview of using the Journal activity for Microsoft Office 365**

The following is an architectural overview of how the Email Management Journal activity processes Exchange Online content from a Microsoft Office 365 environment. The following is the sequence of actions that result in an Office 365 email message being stored in the Native Archive.

1. Exchange Online premium journaling is configured to send journal reports of all messages to one or more local (on-premise) folders. A journal report is an SMTP message generated by Exchange Online from the original message that includes the original message as an attachment.

   The local folders are on one or more computers on which Microsoft Internet Information Services (IIS) and the Microsoft SMTP service are installed and on which the SMTP service is configured to receive messages from premium journaling.

2. The File Mover agent takes messages from these local locations, (the source folders) and moves them to target folders to be processed by the Journal activity for Microsoft Office 365 content.

3. The Journal activity processes messages from the target folders and places them in the Native Archive. If the messages cannot be placed in the Native Archive, they are placed in the Journaling issues folder for analysis and possibly reprocessing.

The following figure illustrates the process:
Considerations when moving existing archived or journaled content to Office 365

The following are some considerations when migrating archived or journaled content from an existing on-premise mail server to an Office 365 Exchange Online server.

- Review whether Email Management or EmailXtender shortcuts were created for content in the on-site mail server. If so, those shortcuts are to be restored prior to moving the content to Microsoft Office 365.
- Review the restrictions on journaling of Microsoft Office 365 content to ensure a smooth migration to the Microsoft Office 365 environment from a local mail server environment.

EMC SourceOne support for processing email content in a hybrid environment

EMC SourceOne supports using the Journal activity to process email content from a hybrid Microsoft Office 365 environment.

The following sections describe what a hybrid deployment is, and any special considerations in using a hybrid deployment with Email Management.
What is a hybrid deployment of Office 365?

A hybrid deployment of Microsoft Office 365 occurs when you maintain mailboxes in your on-premise Exchange server organization, and you also maintain mailboxes in the cloud using Exchange Online.

Considerations in using EMC SourceOne with a hybrid deployment of Office 365

When using an Email Management Journal activity to process Office 365 email content in a hybrid environment, be aware of the following considerations.

- Journal activity processing of content from Office 365 differs from processing of content from an on-premise Exchange server.
- Content that is journaled from mailboxes in the on-premise Exchange organization, using the Journal activity with the Exchange data source type, can duplicate content that is journaled from mailboxes in the cloud-based Office 365 environment, using the Journal activity with the Microsoft Office 365 data source type. This is because on-premise messages are received as native Exchange messages, and the Office 365 messages are received as Exchange journal reports using SMTP.

Journaling for Office 365 content configuration sequence

Before you can journal messages from a Microsoft Office 365 environment using Email Management, perform the following steps.

1. Configure the components required to use the Journal activity with the Microsoft Office 365 data source type.
2. Create and initiate a Journal activity with the Microsoft Office 365 data source type selected. The Journal activity will process the messages delivered by premium journaling.
3. Enable premium journaling from Exchange Online to the Journal activity.

Do not enable premium journaling until the Journal activity is ready to process those messages.

Configuring SMTP support for Office 365 journaling

SMTP support must be configured before running the Journal activity with the Microsoft Office 365 data source type.

SMTP support is required on whatever computer has the Internet Information Services (IIS) installed and is hosting the source directories accessed by the File Mover agent.

Installing the SMTP service

If the SMTP service is not already installed, you must install the SMTP service. The SMTP service is configured using the IIS Manager.

Perform the following steps to install the SMTP service using IIS 7.

1. In the Control Panel applet in the Features view, select Add Features.
2. Select **SMTP Server** from the list and click **Install**. This installs the IIS Manager, which you then use to install the SMTP service.

### Configuring SMTP email delivery

Specify how SMTP email will be delivered to Email Management using the SMTP Virtual Server node of the Internet Information Services (IIS) Manager. The IIS Manager is used to configure SMTP.

Specify the following for SMTP email delivery to Email Management:

- Limit the number of connections to the SMTP server to 10 using the Limit number of connections to field. You set this value on the General tab of the Default SMTP Virtual Server Properties dialog box.

- Set the connection time-out value to 10 minutes using the Connection time-out (minutes) field. You set this value on the General tab of the Default SMTP Virtual Server Properties dialog box.

- Set the authentication for the SMTP server.
  
  Select the Access tab of the Default SMTP Virtual Server Properties dialog box and specify the authentication to be used in your environment.

- Verify that the Enable drop directory quota option is not selected on the Properties page of the Default SMTP Virtual server page node in the IIS Manager. If this option is selected, the performance of the journaling of Exchange Online messages may be significantly degraded.

![Enable drop directory quota option on the IIS Properties page](image)

**Figure 185** Enable drop directory quota option on the IIS Properties page

- Optionally, you can enable logging by selecting the Enable logging field and selecting W3C Extended Log File Format as the log format on the General tab of the Default SMTP Virtual Server Properties dialog box.

  If you enable logging, you also need to set the log file folder by clicking Properties to launch the Logging Properties dialog box, and then specifying the folder in the Log file directory field.
Using the Journal activity to process Office 365 messages

This section describes how to configure and use the Journal activity to process Office 365 messages.

Planning and selecting the processing folders

Before you use the EMC SourceOne console to create and run a Journal activity to process Microsoft Office 365 content, you need to select the folders that will be used by the EMC SourceOne File Mover agent in the processing. These folders will be used when you create the SMTP journaling group used by the Journal activity.

Select the following folders:

◆ Select the one or more source folders — Select one or more source folders to contain the SMTP journal reports that have been sent from Exchange Online. Typically, these are the SMTP drop directories used by IIS.

The File Mover agent takes files from the source folders and places them in the target folders.

◆ Select one or more target folders — Select one or more target folders to contain the SMTP journal reports moved by the File Mover agent.

The Journal activity processes the content found in the target folders. When the Journal activity runs, a separate job is created for each target folder defined as part of the group. Using multiple target directories allows Email Management to process higher volumes of messages more efficiently because a larger number of jobs are being used.

In environments where a low volume of messages are journaled, you can opt to not use target folders and instead use the source folders as both the source and target, however, this is not generally recommended.

◆ Select a Journaling issues folder — Select a Journaling issues folder to contain any unsuccessfully processed messages. All unsuccessfully processed messages from any of the defined target folders are directed to a single Journaling issues folder to make identification and reprocessing of these messages easier.

Creating an SMTP Journaling Group

Before using the Journal activity with Office 365 email content, you must define an SMTP journaling group. Any existing SMTP journaling groups appear under the SMTP Journaling Groups folder of the Operations node in the EMC SourceOne console.
Using the Journal Activity for Office 365 Content

Perform the following steps to create an SMTP journaling group.

1. Select SMTP Journaling Groups under the Operations node of the EMC SourceOne console and select the New Group action. The General page of the New SMTP Journaling Group wizard appears.

2. Enter the name of the new group in the Name field and a description in the Description field.

3. Enter the folder location for messages that were not successfully processed in the Journaling issues folder field.

4. Click Next.

The Sources page of the New SMTP Journaling Group wizard appears.

Figure 186  SMTP Journaling Groups location in the EMC SourceOne console

Figure 187  General page of the New SMTP Journaling Group wizard
5. Enter the name of the one or more source folders to be used for the SMTP journaling group in the Source Folder field and click Add. Alternatively, click Browse to browse to the one or more folders to be used as the source, and then click Add. When done adding source folders, click Next.

The source folder is the location where Exchange journal report messages are copied by premium journaling. The File Mover agent then moves these messages to the one or more target directories, if they are enabled. These are to be the one or more source folder locations.
The Targets page of the New SMTP Journaling Group wizard appears.

![New SMTP Journaling Group Targets Page](image)

**Figure 189** Targets page of the New SMTP Journaling Group wizard

6. Use the **Use target folders** option to select whether to use separate target and source folders, or to use the source folders as both the source and target folders.

   - Select **Use target folders** to have separate source and target folders and to enable the definition of the target folders. This is the default and more commonly used setting.
   
   - Do not select **Use target folders** to have source folders used as both the source and the target folders.

Normally, use separate source and target folders, but in small installations with a low volume of messages to journal, combining them to use a single set of folders can be useful.

7. If the **Use target folders** option is selected perform the following:

   a. Enter the name of the one or more target folders to be used for the SMTP journaling group in the **Target Folder** field and click **Add**. Alternatively, click **Browse** to browse to the folders to be used as targets, and then click **Add**.

      There is a processing job created for each target folder defined for a journal activity. Increasing the number of target folders specified in the SMTP journaling group increases the number of jobs that can simultaneously process messages, which can improve journaling performance.

   b. Use the **Poll time (secs)** field to specify how often (in seconds) the agent checks the source folders for SMTP .eml message files to be moved to a target folder. Files with the .eml extension are typically SMTP message files.

      By default, this value is set to 300 seconds (5 minutes). You can modify this value to be any number of seconds between 60 and 3600, inclusive.
c. Use the **Move delay (secs)** field to specify the number of seconds an SMTP .eml message file must be in the source folder before it is eligible to be moved to a target folder. A file is allowed to age for a period to permit it to be entirely copied into the source folder before it is moved to the target folder.

By default, this value is set to 600 seconds (10 minutes). You can modify this value to be any number of seconds between 60 and 3600, inclusive.

If the **Use target folders** option is not selected, no options other than **Finish** are available.

8. Click **Finish**.

The new SMTP journaling group appears on the SMTP Journaling Groups page, and under the SMTP Journaling Groups node.

### Modifying SMTP Journaling Groups

Perform the following steps to modify an SMTP Journaling Group.

1. Select the SMTP Journaling Group to be modified under the SMTP Journaling Groups node under the Operations node.
2. Select the **Properties** action. The SMTP Journaling Group Properties dialog box appears.
3. Modify the general, source folder or target folder properties.

### Modifying General properties of SMTP Journaling Groups

Perform the following procedure to modify the general properties of an SMTP Journaling Group.

1. Select the **General** tab of the SMTP Journaling Group Properties dialog box.

![Figure 190 General tab of the SMTP Journaling Group Properties dialog box](image)

2. Modify one or more of the following:
   - Modify the name of the group by editing the value in the **Name** field.
Using the Journal Activity for Office 365 Content

- Modify the description of the group by editing the value in the Description field.
- Change the Journaling issues folder, either by editing the value in the Journaling issues folder field, or by clicking the Browse button and navigating to a new folder.

3. When you have completed the modifications, click OK.

Modifying Source properties of SMTP Journaling Groups

Perform the following steps to modify the source folder properties of an SMTP journaling group.

1. Select the Sources tab of the SMTP Journaling Group Properties dialog box.

![Figure 191 Sources tab of the SMTP Journaling Group Properties dialog box](image)

2. Add source folders to, or remove source folders from, this group as follows:
   - To add a source folder to the group, enter the path to the folder in the Source Folder field, or click Browse to browse to that folder.
   - To remove a source folder from the group, select the source folder from the list, and click Remove.

3. When you have completed the modifications, click OK.

Modifying Target properties of SMTP Journaling Groups

Perform the following steps to modify the target folder properties of an SMTP journaling group.

1. Select the Targets tab of the SMTP Journaling Group Properties dialog box, and perform any of the following modifications:
Summary of creating a Journal activity for Office 365 email content

The following is a summary of how to use the Journal activity to archive Exchange Online messages from a Microsoft Office 365 environment.

1. Add a target folder to the group by entering the path to the folder in the Target Folder field, or clicking Browse to browse to that folder.

2. Remove a target folder from the group by selecting the target folder from the list, and clicking Remove.

3. Modify the value of the Poll time field to specify how often the agent polls the source folders for SMTP .eml message files to be moved to a target folder. You can modify this value to be any number of seconds between 60 and 3600, inclusive.

4. Modify the value of the Move delay field to modify how long an SMTP .eml message file must be in the source folder before it is eligible to be moved to a target folder. You can modify this value to be any number of seconds between 60 and 3600, inclusive.

2. When you have completed the modifications, click OK.
Perform the following procedure to create a Journal activity to process Office 365 email content.

1. Select the **Organizational Policy** to which you want to add the new activity and select **Action > New Activity** to create the new activity. The **Activity Type** page appears.

2. Select **Journal** as the activity type and click **Next**. The **Data Source Types** page appears.

3. On the **Data Source Types** page, select Microsoft Office 365 as the data source type and click **Next**. The **Select Data Sources** page appears.
Configuring Exchange Online premium journaling 467

Using the Journal Activity for Office 365 Content

Figure 194 Journal Select Data Sources page

4. On the Select Data Sources page, select one of the previously defined SMTP journaling groups to use as the data source for this journaling activity, and click Next. The Attachments Filter page appears.

If no SMTP journaling group is defined, the following message appears:

At least one SMTP Journaling Group must be created before configuring an activity of this type.

If the SMTP journaling group must exist message appears, cancel creating the activity, create an SMTP Journaling group to be used with this activity, and then create the activity again specifying the SMTP Journaling group.

5. On the Attachments Filter page, select which attachments to exclude from processing. By default, no attachments are excluded. When done, click Next. The Business Components page appears.

6. On the Business Components page, select the business components to use with this activity. By default only the Address Rules business component is available. Click Next. If the Address Rules business component was selected, the Specify Filter Rules page appears.

7. Use the Specify Filter Rules page to define one or more rules.

When done specifying address rules, click Next. The Activity Name page appears.

8. Use the Activity Name page to create a name for this activity using the Name field. Click Finish after providing a name. The activity is now complete and ready to execute.

Configuring Exchange Online premium journaling

Exchange Online premium journaling must be enabled to transfer messages from the Office 365 environment to the Email Management source folder.
Perform the following steps to enable premium journaling with Exchange Online.

1. Using a Web browser supported by Microsoft Online Services, open Microsoft Online Services, and select **Admin**. The **Admin Overview** page appears.

   **Note:** If required, contact your Microsoft Online Services administrator for the URL, account name and password you need to access Microsoft Online Services.

2. On the **Admin Overview** page, select **Manage** under the Exchange Online heading. The **Mailboxes** page appears.

3. On the **Mailboxes** page, under the **Users & Groups** heading, select **Mail Control**. The **Mail Control** page appears.

4. On the **Mail Control** page, select **Journaling**. The **Journal Rules** page appears.

5. On the **Journal Rules** page, select **New**. The **New Journal Rule** page appears.

![Figure 195 New Journal Rule page in Microsoft Online Services](image)

6. On the **New Journal Rule** page, create the new journal rule as follows:
   - Set the **If this message is sent to or from** field, to the **Apply to all messages** option.
   - Set the **Journal the following messages** field to the **All messages** option.
   - Set the **Send Journal reports** field to be the email address that will deliver the journal reports to the local Exchange 2010 server.
   - Set the **Name of Rule** field to be the name of this rule.

7. Select **Save**.

When you save the rule, you may be prompted to configure an email address to receive undeliverable messages. Do not configure such an email address as it will interfere with the processing to be done by the **Journal** activity.

You can also use Exchange premium journaling with Exchange rather than Exchange Online.
Maintaining and Troubleshooting Office 365 journaling

The following topics will help you maintain the Office 365 journaling portion of your Email Management system and troubleshoot problems you may encounter.

Office 365 journaling event log messages and corrective actions

When you use the Journal activity to process email messages from an Office 365 environment, errors may be written to the event log indicating a situation that needs to be corrected. This event log is on the Master Server on which the File Mover agent was installed.

Generally, these event log messages have to do with either connectivity to the source and target directories used by the SMTP journal group, or problems with the amount of disk space remaining in those directories. These event log messages are issued by the File Mover agent only when you have defined separate source directories and target folders.

If you have not defined these folders as being separate, the EMC SourceOne File Mover agent is not active and does not monitor the source folders for any errors. In this case, the only error you may encounter is if the source folder cannot be accessed by the Journal activity. When this occurs, the Journal activity signals the following message to the event log on the Worker computer running the activity:

Cannot enumerate folder

Source folder is offline

The following sections include the full event log message and the resolution for the error.

Full event log message

EX_E_FAIL_SRC_FOLDER_OFFLINE, Source Folder is offline. Cannot move messages from source to target. Insufficient privileges or unable to access Source folder source-folder-name. Moving of files will resume once the source folder is accessible again.

Description and resolution

Indicates that the named source folder defined in the SMTP journal group used by this activity cannot be accessed by the EMC SourceOne File Mover agent.

Review the privileges needed to access this folder and also review the network connection to this folder from the Master computer. This problem may correct itself with no intervention if it is due to a temporary network problem.

When a previously inaccessible source folder can be accessed, the following message is sent to the event log:

EX_E_INFO_SRC_FOLDER_ONLINE, Source Folder source-folder-name is back online.
Insufficient privileges or unable to access target folder

The following sections include the full event log message, the resolution for the error, and additional information about the required privileges for the agent.

Full event log message

EX_E_FAIL_TARGET_OFFLINE, Insufficient privileges or unable to access Target folder target-folder-name.

Description and resolution

Indicates that the named target folder defined in the SMTP journal group used by this activity cannot be accessed by the EMC SourceOne File Mover agent.

Review the privileges needed to access this folder and also review the network connection to this folder from the Master computer. This problem may correct itself if it is due to a temporary network problem.

When a previously inaccessible target folder can be accessed, the following message is sent to the event log:

EX_E_INFO_TARGET_ONLINE, Target Folder target-folder-name is back online.

Additional information about required privileges for the agent

By default, the ES1MoverAgent service runs using the EMC SourceOne primary service account, and so that account on the Master Server must have full access (read, write and delete) to the source folders (the IIS drop directories) and target folders the agent will access. Alternatively, the optional EMC SourceOne Master Services service account can be used. The Master Services service account must also have full access to the source and target folders.

For additional considerations refer to the EMC SourceOne Email Management Installation Guide.

All target folders are offline or not accessible

The following sections include the full event log message and the resolution for the error.

Full event log message

EX_E_FAIL_ALL_TARGETS_OFFLINE, All target folders are Offline or not accessible. Unable to move any messages. Moving of files will resume when at least one target folder is accessible again.

Description and resolution

Indicates that none of the target folders defined in the SMTP journal group used by this activity can be accessed by the File Mover agent.

Review the privileges needed to access these folders and also review the network connection to these folders from the Master computer. This problem may correct itself if it is due to a temporary network problem.

When a previously inaccessible target folder can be accessed, the following message is sent to the event log:

EX_E_INFO_TARGET_ONLINE, Target Folder target-folder-name is back online.
Target folder has insufficient disk space

The following sections include the full event log message and the resolution for the error.

Full event log message

EX_E_FAIL_TARGET_NO_DSK_SPACE, Target folder target-folder-name has insufficient disk space or below the minimum free space threshold. Cannot move messages to this target folder. Moving of files to this target folder will resume once the space is available again.

Description and resolution

Indicates that the named target folder used by this activity does not have sufficient space and so the File Mover agent cannot move messages from the source folder to this target folder. However, the Journal activity can continue to process. EMC SourceOne requires that there be a minimum of 1 GB of disk space free on each target folder.

To resolve this issue, create more than 1 GB of free space for the named target folder. Alternatively, run the activity again using a different target folder that is on a disk with more available space.

When a previously full target folder has 1 GB of space available again, the following message is sent to the event log, and file movement will resume:

EX_I_INFO_TARGET_HAS_DSK_SPACE, Target Folder target-folder-name now has available disk space. Processing will now resume to this location.

All target folders are below the free disk threshold

The following sections include the full event log message and the resolution for the error.

Full event log message

EX_E_FAIL_ALL_TARGETS_NO_SPACE, All target folders are below the free disk threshold. Unable to move any messages. Moving of files will resume when at least one target folder has free disk space available again.

Description and resolution

Indicates that all target folders defined in the SMTP journal group used by this activity do not have sufficient space and so the File Mover agent cannot move messages from the source folder to any of the target folders; however, the Journal activity can continue to process. EMC SourceOne requires that there be a minimum of 1 GB of disk space free on each target folder.

To resolve this issue, create more than 1 GB of free space for each folder. Alternatively, run the activity again using different target folders that are on a disk with more available space.

When a previously full target folder has 1 GB of space available again, the following message is sent to the event log, and file movement will resume:

EX_I_INFO_TARGET_HAS_DSK_SPACE, Target Folder target-folder-name now has available disk space. Processing will now resume to this location.
Failed to create a configuration manager

The following sections include the event log error for the File Mover agent configuration manager and the resolution for that message.

**Full event log message**

EX_E_FAILED_CREATE_CONFIGMGR, Failed to create a configuration manager, unable to start move threads.

**Description and resolution**

Indicates that there is a problem on the Master computer that is preventing the File Mover agent configuration manager from being created. Typically this would occur when there are low resources available on the computer.

Review the available resources on the computer and correct any problems, perhaps by rebooting the computer.

Reprocessing Office 365 Exchange journal reports

When you use the Journal activity to process either Office 365 content or SMTP content, that content is received as an SMTP message. In some cases, Email Management cannot process those SMTP messages and so places them into a different folder for manual reprocessing.

**Overview of reprocessing Office 365 Exchange journal reports**

When Microsoft Office 365 is selected as the data source type for a Journal activity, that content is received by the Journal activity as an Exchange Online journal report, which is a type of SMTP message.

In some cases, the Journal activity may not be able to process the Exchange journal report message. When this occurs, the message is placed in the Journal issues folder specified in the SMTP Journaling group defined for this activity.

The message is moved to the Journal issues folder so that:

- The message is not continually being processed by Email Management.
- The message is more easily found by the administrator for manual reprocessing.

In many cases, reprocessing the reports or messages corrects the problem, because many problems are temporary.

**Causes for journaling report messages to not be processed**

Reasons an Exchange journal report may not be processed include the following.

- There is a problem with the format of the Exchange journal report.
- The Exchange journal report cannot be separated into its components using the Email Management unpacker.
- The Exchange journal report cannot be placed in the Native Archive for some reason, such as there being a network problem.
- One or more data source directories had a network connection problem and could not be accessed by Email Management.
One or more Email Management servers failed during processing, possibly because of operating system problems.

**Journal report processing procedure**

In many cases, reprocessing Exchange journal reports corrects the problem with the report and allows it to be journaled.

Perform the following steps to reprocess Exchange Online journal reports.

1. Browse to the Journaling issues folder defined in the SMTP journaling group for that Journal activity.

   **Note:** A single Journaling issues folder is used when Microsoft Office 365 is selected for this activity as opposed to possibly several Baddir directories, one for each Drop directory, when SMTP is selected as the data source for the Journal activity.

2. Select one or more journal reports in the **Journaling issues** folder and move them to one or more of the data source directories that you specified for this activity for reprocessing.

If a journal report is not processed after several attempts, record any event log messages about processing that journal report, and contact EMC Software Support for assistance.

**Improving Office 365 journaling performance by increasing target folders used**

If needed, you may be able to increase the performance of a Journaling activity processing Office 365 content by increasing the number of target folders used by the Journal activity. One processing job is created for each defined target folder for that activity, so to have more messages processed simultaneously, increase the number of target folders in use.

**Modifying EMC SourceOne Search behavior for use with Office 365 content**

You may want to modify how EMC SourceOne Search handles Office 365 email content by using the **Web Search** dialog box from the Application Configuration node of the EMC SourceOne console.

**Controlling how email content is restored**

Control whether email content can be restored from Search using the **Enable restore to mailbox** option in the EMC SourceOne console. You access the **Enable restore to mailbox** option from the Client Settings tab of the **Web Search** dialog box that is launched from the Application Configuration node of the EMC SourceOne console.

- Select the **Enable restore to mailbox** option to allow messages to be restored to their mailbox by Search. This is the default for this option and is the behavior seen in previous versions of Search.
**Note:** When using the Journal activity with Office 365 content, it is recommended that you do not select the Enable restore to mailbox option. Not selecting this option will prevent users from attempting to restore locally archived content to their Office 365 mailboxes, and possibly receiving errors in the process.

When selected the **Restore** option is available for the **Administrator, My Items, My Contributed Items,** and **All Items** search types.

- Do not select the **Enable restore to mailbox** option to not allow messages to be restored to their mailbox.

When this option is disabled, the restore capability is removed and disabled for all search types in Search as follows:

- The **Restore** tool bar button is removed.
- The **Restore** context menu item on the search results grid is disabled.

This is the recommended setting when using the Journal activity with Office 365 content.

---

**Controlling how SMTP email content is opened**

Control how users can open email content using the Enable open SMTP/MIME messages in native format option.

Access this option using the **Server Settings** tab of the **Web Search** dialog box that is launched from the **Application Configuration** node of the EMC SourceOne console.

- To not have messages opened in their native format, do not select the **Enable open SMTP/MIME messages in native format** option. This is the default.
In this case, when a EMC SourceOne Search user logs in using their Microsoft Windows or IBM Lotus Domino credentials and double clicks on a .eml message, the .eml message is converted to the user’s logged-in environment message type, (.msg or .onm), before it is delivered to the user for download.

- To allow SMTP MIME messages to be opened in their native mail format by Search, select the **Enable open SMTP/MIME messages in native format** option.

This option may provide a better user experience than having the messages converted, if all user clients can be configured.

![Figure 197  Server Settings tab of the Web Search dialog box](image)

When this setting is enabled, SMTP messages are not converted before they are returned to the user. The native .eml message is downloaded when a user double-clicks on the .eml message.

Enabling this option only affects SMTP message types. Domino messages are still converted to a Exchange .msg message if the user logs in with Windows credentials and double-clicks a Domino message. Likewise, if the user logs in using Domino credentials and double-clicks an Exchange message, that message would be converted to a Domino .onm message.

Because Search cannot determine if the user’s machine will be able to properly open the .eml file delivered to the user's Web browser, the user must have configured an application to open files with the .eml file type. Both Outlook Express and Outlook can be configured to open .eml files.

**SMTP MIME message processing enhanced**

SMTP MIME message processing has been enhanced to better handle unknown attachment types, but requires a hotfix to process these files in all cases.
Background

In previous versions of Email Management, when SMTP journaling encountered a MIME message with an attachment which did not have a file name specified in the MIME header, it labeled that attachment as unknown.

This caused the following problems:

- Unknown MIME attachment types could not be opened from the Search preview pane.
- When a MIME message (.eml) message was converted to an Exchange message and exported to a PST file, the attachment name remained labeled as Unknown in the exported message, and so could not be opened because no application was associated with it.

MIME processing enhancement

MIME parsing handles MIME message parts which do not have attachment names. Email Management maps MIME types to file extensions to create attachment names. This allows end users to open attachments from the Search preview pane and open messages exported to a PST file.

Install the Hotfix to ensure that MIME messages are archived correctly when using SMTP journaling

In some cases, messages in MIME format may not be archived correctly by using Email Management SMTP journaling, including Microsoft Office 365 journaling. This results in some messages not displaying embedded images when they are retrieved from the archive.

**Note:** Journaling SMTP MIME messages includes journaling messages from all SMTP sources, including but not limited to, Exchange servers, Domino servers, Office 365 servers, SMTP routers, or processing MIME messages placed in drop directories.

Configuring email clients to open .eml files

Newer versions of Microsoft Outlook, such as Outlook 2010, can open .eml files by default. Older version of Outlook, such as Outlook 2007 may require the use of the /eml switch when opening the file, as follows.

```bash
Outlook.exe /eml message.eml
```

For example, Outlook 2007 (with a minimum of SP2) requires the following change to the Registry to open .eml files.

1. Open the Registry and browse to the following location:

   ```plaintext
   [HKEY_CLASSES_ROOT\Microsoft Internet Mail Message\shell\open\command]
   ```
2. Modify the Default key to cause Outlook to be used to open .eml files rather than Outlook Express.

   Change the value that indicates Outlook Express is to open .eml files:

   "%ProgramFiles%\Outlook Express\msimn.exe" /eml:%1

   To indicate that Outlook 2007 is to open .eml files:

   "%ProgramFiles%\Microsoft Office\Office12\OUTLOOK.EXE" /eml "%1"

3. Exit the Registry.
Using the Journal Activity for Office 365 Content
CHAPTER 21
Processing Exchange Public Folder Content

This section describes how to configure and use the activities for processing Exchange public folder content. Topics include:

✦ Overview of using Microsoft Exchange public folder activities.......................... 480
✦ Configuring public folder archiving and shortcutting............................................ 481
✦ Creating an Archive - Microsoft Exchange Public Folder activity ......................... 483
✦ Creating a Shortcut - Microsoft Exchange Public Folder activity .......................... 485
✦ Creating a Restore Shortcuts - Microsoft Exchange Public Folder activity .......... 486
✦ Summary of creating a Delete - Microsoft Exchange Public Folder activity .......... 487
Overview of using Microsoft Exchange public folder activities

Email Management provides activities that allow you to archive, shortcut, restore shortcut and delete content from Exchange public folders as described in the following sections.

Public folder activities summary

Use the following activities to process content in Microsoft Exchange public folders.

- Use the Archive - Microsoft Exchange Public Folder activity to archive content within Exchange public folders.
- Use the Shortcut - Microsoft Exchange Public Folder activity to shortcut content within Exchange public folders.
- Use the Restore Shortcuts - Microsoft Exchange Public Folder activity to restore shortcut content within Exchange public folders.
- Use the Delete - Microsoft Exchange Public Folder activity to delete content within Exchange public folders.

Advantages of public folder processing

Processing public folder content with Email Management has the following advantages.

- Add public folder content to the other content you archive, shortcut, restore shortcuts, and delete with Email Management.
- If you have existing public folder content that had been archived and shortcut using EmailXtender, you can now use Email Management to perform similar processing of public folder content. This may make it easier to migrate from EmailXtender to Email Management without losing any existing capabilities.

Restrictions and considerations when processing public folder content

Email Management supports processing of public folders differently than EmailXtender. Specifically:

- There is no activity to update shortcuts for public folder content.
- The EMC SourceOne primary service account must have owner rights to the public folders to be processed by the public folder activities.
- Email Management does not archive or shortcut public folder content that was archived or shortcut by EmailXtender.

This means that if an Email Management archive or shortcut activity, including those for public folders, specifies on the Item Type page that content is to be reprocessed using the Reprocess items for archive activities or the Process only previously archived items for shortcut activities, that content will not be archived or shortcut if it is EmailXtender content.
Configuring public folder archiving and shortcutting

Before archiving and shortcutting public folder content, plan how best to structure the mapped folders and permissions in Email Management to reflect the structure and permissions associated with your public folders, as described in the following sections.

Public Folder activities require EMCSourceOne MAPI profile on EMC SourceOne console

Public folder activities require that the EMC SourceOne console user have a MAPI profile with the following name configured for their mailbox:

EMCSourceOne

Attempting to create public folder activities without this profile causes the following error to be issued by the EMC SourceOne console:

Failed to validate changes.

To associate this MAPI profile with the EMC SourceOne console user, you can perform either of the following:

◆ Install and use the EMC SourceOne console on an EMC SourceOne Worker Server which already has this MAPI profile defined for the administrator.

◆ Modify the administrator’s MAPI profile name on the computer that is not an EMC SourceOne Worker computer then log in to the local Outlook client using the new profile. Now the administrator can use the EMC SourceOne console to create and manage public folder activities.

Planning mapped folder structure with public folders

Before archiving and shortcutting public folder content, plan the structure of the mapped folders in the archive as follows.

◆ Analyze the structure of the public folders from which you plan to archive and shortcut the content.

◆ Review the structure of your public folders and determine how many mapped folders to use for the public folder content.

If you have many public folders and you want to create multiple mapped folders for that content, you may want to create a worksheet detailing how the content of each public folder is placed in each mapped folder.

◆ If Exchange public folders are administered separately from EMC SourceOne, coordinate the proposed mapped folder structure for the archived content with the Exchange administrator to identify any potential problems.

◆ Review the permissions on the public folders and the mapped folders.
Planning mapped folder permissions use with public folders

Before archiving and shortcutting public folder content, plan the permissions associated with the mapped folders in the archive as follows.

◆ Analyze the permissions on the public folders from which you plan to archive and shortcut and determine if you need similar or different permissions on the mapped folders in the archive.

◆ Determine how much access you want to allow users, or groups of users, to each of the mapped folders in the archive. If you have different permissions on different public folders, you may need to take that into account when creating the mapped folders to contain that public folder content.

◆ If Exchange public folders are administered separately from Email Management, discuss the proposed mapped folder permissions for the archived content with the Exchange administrator to identify any potential problems.

If the Exchange administrator manages permissions on individual public folders, not setting the permissions correctly on the corresponding mapped folders could possibly result in problems with the local public folder permissions policies.

◆ Verify that all users who will be accessing archived or shortcut public folder content have a minimum of the following permissions on the Exchange public folders they will be accessing:
  • Read: Full Details
  • Write: Edit all
  • Delete Items: None
  • Other: Folder visible

![Microsoft Exchange Public Folder Properties dialog box](image)
If you have Email Management, EmailXtender, and Offline Access in your environment, and users need to retrieve EmailXtender-created shortcuts in public folders, ensure that Offline Access users have Read All permission on the mapped folders associated with the EmailXtender archive.

Review the structure of the public folders and the mapped folders.

Creating an Archive - Microsoft Exchange Public Folder activity

The following is a summary of how to use the Archive - Microsoft Exchange Public Folder activity to archive content in Exchange public folders.

Perform the following steps to create an Archive - Microsoft Exchange Public Folder activity.

1. Create one or more mapped folders to contain the archived public folder content. In order to completely create an Archive - Microsoft Exchange Public Folder activity, you must specify one or more mapped folders to contain the archived content.

   Review any plans you previously made for creating the mapped folders.

2. Select the Organizational Policy to which you want to add the new activity and select Action > New Activity to create new activity. The Activity Type page appears.

3. On the Activity Type page, select the type of activity to create and click Next. The Select Data Sources page appears.

4. On the Select Data Sources page, select the Exchange public folder content to be processed.

   When you have completed selecting the folders containing the content to process, click Next. The Item Types page appears.
5. On the **Item Types** page, select which Exchange item types you want to archive using the **Item Types** page. Select them individually or select all item types by clicking **Select All**.

Optionally, select the **Reprocess items** option to cause the selected item types that have already been processed to be processed again. Typically, this option is used in a disaster recovery situation.

Click **Next** when you have selected the item types to be archived. The **Dates** page appears.

6. On the **Dates** page, select the date range of the messages you want to archive from the public folders.

Click **Next** when you have selected the date range of the messages to be archived. The **Attachments Filter** page appears.

7. On the **Attachments Filter** page, select the attachment options you want to use when archiving from public folders.

Click **Next** when you have selected the attachment options for the messages to be archived. The **Message Types Filter** page appears.

8. On the **Message Types Filter** page, select the types of messages to include or exclude.

Click **Next** when you have selected the filters to select the message types to be archived from the public folders. The **Message Size Filter** page appears.

9. On the **Message Size Filter** page, specify the size of the content to be archived and click **Next**. The **Business Components** page appears.

10. On the **Business Components** page, select the business components you want to enable. By default, the Address Rules business component is enabled. Click **Next** when done. If Address Rules are selected, the **Specify Filtering Rules** page appears, if not, the **Schedule** page appears.

11. On the **Specify Filtering Rules** page, specify the rules to use to process the public folder content.

Click **Next** when you have specified the rules options. The **Schedule** page appears.

12. On the **Schedule** page, select when you want the Archive - Microsoft Exchange Public Folder activity to run, and how often you want it to repeat.

Click **Next** when you have scheduled the activity. The **Activity Name** page appears.

13. On the **Activity Name** page, enter a name for the activity in the **Name** field. If you want to enable detailed logging, select **Enable Detailed Logging**.

Click **Finish** and the activity is complete and ready to execute.

The results pane lists the new activity below the policy to which it belongs. The status of the new activity is set to **Active**.
Creating a Shortcut - Microsoft Exchange Public Folder activity

To shortcut content in Exchange public folders, create and run a Shortcut - Microsoft Exchange Public Folder activity using the EMC SourceOne console. If the content you indicate to be shortcut has not already been archived, it will be archived before being shortcut.

Note: Content that is automatically archived by the Shortcut - Microsoft Exchange Public Folder activity will not make use of address rules. To use address rules when archiving public folder content, you must use the Archive - Microsoft Exchange Public Folder activity to archive the content.

The following is a summary of how to use the Shortcut - Microsoft Exchange Public Folder activity to shortcut content in Exchange public folders. Refer to “Common and email-specific best practices” on page 241 for information about how best to deploy shortcuts in an organization.

Perform the following steps to create a Shortcut - Microsoft Exchange Public Folder activity.

1. Verify that there are one or more mapped folders containing the archived public folder content.

   In order to completely create a Shortcut - Microsoft Exchange Public Folder activity, you must specify one or more mapped folders that contain the archived content to be shortcut.

   Review any plans previously made for the mapped folders.

2. Verify that an external URL has been configured using the Application Configuration node. An external URL is required before creating a Shortcut - Microsoft Exchange Public Folder activity.

3. Select the Organizational Policy to which you want to add the new activity and select Action > New Activity to create new activity. The Activity Type page appears.

4. On the Activity Type page, select Shortcut - Microsoft Exchange Public Folders as the type of activity to create and click Next. The Select Data Sources page appears.

5. On the Select Data Sources page, select the Exchange public folder content to be processed.

   When you have completed selecting the folders containing the content to process, click Next. The Item Types page appears.

6. On the Item Types page, select which Exchange item types you want to shortcut.

   • You can select the item types individually by clicking in the selection box next to each, or select all item types using the Select All option.

   • Select the Process only previously archived items option to only shortcut those item types that have previously been archived.

Note that the item types you can shortcut are a subset of those you can archive; only the following are supported for shortcutting:

• Appointments
• Email Messages
• Meetings

Click Next when you have selected the item types to be shortcut. The Dates page appears.

7. On the Dates page, select the dates of the messages you want to shortcut from public folders.

Click Next when you have selected the date range of the messages to be shortcut. The Attachments Filter page appears.

8. On the Attachments Filter page, select the attachment options you want to use when shortcutting from public folders.

Click Next when you have selected the attachment options for the messages to be shortcut. The Message Size Filter page appears.

9. On the Message Size Filter page, select the size of messages to include in, or exclude from, the shortcutting process.

Click Next when you have selected the Message Size Filter options for the messages to be shortcut. The Mapped Folder page appears.

10. On the Mapped Folder page, select the mapped folder in which to shortcut messages.

Click Next. The Shortcut Options page appears.

11. On the Shortcut Options page, select the options for the shortcuts to be created.

Click Next when you have selected the Shortcut Options. The Schedule page appears.

12. On the Schedule page, select how often and when the Shortcut - Microsoft Exchange Public Folder activity is to run.

Click Next when you have selected the Schedule options. The Activity Name page appears.

13. On the Activity Name page, select the name for this activity and select whether to enable detailed logging as follows:

• In the Name field, enter a name for the new activity.
• To collect detailed information about message processing by activities, select the Enable Detailed Logging option.

14. Click Finish.

The results pane lists the new activity below the policy to which it belongs. The status of the new activity is set to Active.

Creating a Restore Shortcuts - Microsoft Exchange Public Folder activity

The following is a summary of how an administrator can use the Restore Shortcuts - Microsoft Exchange Public Folder activity to restore shortcut content in Exchange public folders.
Administrators typically use the **Restore Shortcuts - Microsoft Exchange Public Folder** activity to restore large numbers of shortcuts in multiple public folders. If installed, EMC SourceOne Offline Access can also be used by administrators or end users to restore individual shortcuts in Exchange public folders.

Perform the following steps to create a **Restore Shortcuts - Microsoft Exchange Public Folder** activity.

1. Select the **Organizational Policy** to which you want to add the new activity and select **Action > New Activity** to create new activity. The **Activity Type** page appears.

2. Verify that an external URL has been configured using the **Application Configuration** node. An external URL is required before creating a **Restore Shortcuts - Microsoft Exchange Public Folder** activity.

3. On the **Activity Type** page, select **Restore Shortcuts - Microsoft Exchange Public Folders** as the type of activity to create and click **Next**. The **Select Data Sources** page appears.

4. On the **Select Data Sources** page, select the Exchange public folders that contains the shortcuts to be restored. Click **Next** and the **Dates** page appears.

5. On the **Dates** page, select the dates of the shortcut messages you want to restore from the public folders. Click **Next** when you have selected the date range, and the **Schedule** page appears.

6. On the **Schedule** page, select how often and when the **Restore Shortcuts - Microsoft Exchange Public Folder** activity is to run.

   Click **Next** when you have selected the Schedule options. The **Activity Name** page appears.

7. On the **Activity Name** page, select the name for this activity and select whether to enable detailed logging as follows:
   - In the **Name** field, enter a name for the new activity.
   - To collect detailed information about message processing by activities, select the **Enable Detailed Logging** option.

   Refer to “Using Job Logs” for more information about job logging.

8. Click **Finish**.

The results pane lists the new activity below the policy to which it belongs. The status of the new activity is set to **Active**.

---

**Summary of creating a Delete - Microsoft Exchange Public Folder activity**

The following is a summary of how to use the **Delete - Microsoft Exchange Public Folder** activity to delete content in Exchange public folders.

Perform the following steps to create a **Delete - Microsoft Exchange Public Folder** activity, perform the following.

1. Select the **Organizational Policy** to which you want to add the new activity and select **Action > New Activity** to create new activity. The **Activity Type** page appears.
2. On the Activity Type page, select **Delete - Microsoft Exchange Public Folders** as the type of activity to create and click **Next**. The Select Data Sources page appears.

3. On the Select Data Sources page, select the Exchange public folders that contains the content to be deleted.

   Click **Next** and the Item Types page appears.

4. On the Item Types page, select which item types you want to delete. You can select them individually, or select all item types by clicking **Select All**.

   Optionally, select the **Reprocess items** option to cause the selected item types that have already been processed to be processed again. Typically, this option is used in a disaster recovery situation.

   Click **Next** when you have selected the item types to be deleted. The Dates page appears.

5. On the Dates page, select the dates of the messages you want to delete from the public folders. Click **Next** when you have selected the date range, and the Attachments Filter page appears.

6. On the Attachments Filter page, select the attachment options you want to use when deleting content from public folders.

   Click **Next** when you have selected the attachment options. The Message Types Filter page appears.

7. On the Message Types Filter page, select the types of messages to include or exclude from deletion.

   Click **Next** when you have selected the Message Types Filter options for the messages to be deleted. The Message Size Filter page appears.

8. On the Message Size Filter page, select the size of messages to include in, or exclude from, the deletion process.

   Click **Next** when you have selected the Message Size Filter options for the messages to be deleted. The Delete Options page appears.

9. On the Delete Options page, select the whether to verify that content has been archived before it is deleted.

   Click **Next** when you have completed using the Delete Options page. The Schedule page appears.

10. On the Schedule page, select how often and when the **Delete - Microsoft Exchange Public Folder** activity is to run.

    Click **Next** when you have selected the Schedule options. The Activity Name page appears.

11. On the Activity Name page, select the name for this activity and select whether to enable detailed logging as follows:

    In the Name field, enter a name for the new activity.

    To collect detailed information about message processing by activities, select the **Enable Detailed Logging** option.

12. Click **Finish**.
The results pane lists the new activity below the policy to which it belongs. The status of the new activity is set to **Active**.
Processing Exchange Public Folder Content
CHAPTER 22
User-Directed Archiving Activities

This section describes how to configure and use user-directed archiving (UDA) with EMC SourceOne. Topics include:

◆ About UDA support ........................................................................................................... 492
◆ Introduction .................................................................................................................... 493
◆ Main steps to configure user-directed archiving ........................................................... 494
◆ Configuring community archive or personal archive ................................................. 495
◆ Considerations and limitations .................................................................................. 496
◆ Archive - User Directed Archive activity ................................................................. 497
◆ Delete - User Directed Archive activity ................................................................. 498
◆ Shortcut - User Directed Archive activity ................................................................. 498
User-Directed Archiving Activities

About UDA support

The following sections list what is supported and not supported when using User-directed archiving (UDA).

Supported capabilities

User-directed archiving (UDA) supports the following.

- UDA folders configured with a parent folder
- UDA folders configured without a parent folder
  For Domino/Notes, UDA folders configured without a parent folder will exist at the same level as user-defined folders.
- One level of UDA folders — For every mapped folder specified in the UDA Archive activity, there will be one UDA folder created in the user's mailbox with the same name as the mapped folder.
  - If a parent folder is specified when the activity is created, the UDA folders will be child folders of the parent folder.
  - Subfolders created by the user in UDA folders will be processed. Messages are archived from user created child folders.
- Renaming — If the UDA folder in the user's mailbox is renamed, a subsequent UDA Archive activity will rename the folder to the same name as the mapped folder.
  For example:
  1. A UDA Archive activity specifies a mapped folder named Accounting, which is in the parent folder named User Archive Folders. This folder hierarchy is created in the user's mailbox when the activity runs.
  2. The user adds messages to the Accounting folder in his mailbox, but also changes the name of the Accounting folder to Banking.
  3. A subsequent UDA Archive activity is run against the user's mailbox.
  4. The UDA Archive activity discovers the folder name has changed, and will change the name of the folder from Banking back to Accounting.
- Archiving shortcuts that users move to UDA folders — The original message is retrieved, behind the scenes, and archived to the UDA mapped folder.

Unsupported capabilities

UDA does not support the following.

- Archiving messages in the parent (root) folder. An error is logged if there are messages being processed in the parent (root) folder during the UDA Archive activity.
- UDA folders are not disabled, as they are in EmailXtender 4.8 SP1, when the UDA Archive activity does not include a folder that has already been created in the user's mailbox. If the user places messages in folders that are not specified in the UDA Archive activity, the messages will not be archived.
Introduction

The following section is organized as follows:
◆ “What is user-directed archiving?” on page 493.
◆ “Uses and benefits of UDA” on page 493.
◆ “UDA folders” on page 493.
◆ “Messages and shortcuts can be placed in UDA folders” on page 493.
◆ “Searching UDA folders” on page 494.

What is user-directed archiving?

With user-directed archiving (UDA), a mail user or mail application can direct messages to a specific folder in EMC SourceOne for archiving.

Users place messages in the UDA folders in their mailboxes. UDA Archive activities archive the messages from the UDA folders in user mailboxes to the corresponding EMC SourceOne mapped folders.

**Note:** User-directed archiving is optional.

Uses and benefits of UDA

The uses and benefits of user-directed archiving include the following.
◆ Personal archive for personal mail and storage management.
◆ Community archive for collaboration and retention.
◆ Reduced need for individual PST/NSF files.
◆ Faster search results by selecting targeted archive folders.
◆ Reduced costs with a smaller archive containing only relevant data.

UDA folders

Archive folders in user mailboxes are called UDA folders. They are created by UDA Archive activities. UDA folders correspond to EMC SourceOne mapped folders that you map to archive folders, in the same way that you map folders for journaling, historical archiving, and PST/NSF archiving.

As with other mapped folders, for each mapped folder used for UDA you can configure:
◆ Retention to control content disposition (specified on archive folders).
◆ Rights to enable certain users to direct mail to and search mail in a particular folder (specified on mapped folders).

Messages and shortcuts can be placed in UDA folders

Users can move messages or shortcuts to UDA folders.
Searching UDA folders

To perform searches of archived messages in UDA folders use EMC SourceOne Search.

Main steps to configure user-directed archiving

Configure user-directed archiving by performing the steps in the following sections.

Create archive folders

Perform the following steps to create archive folders.
1. Connect the archive to EMC SourceOne.
2. In the archive, create archive folders for UDA.

Map and configure a mapped folder

Perform the following steps to map and configure a mapped folder.
1. Create an EMC SourceOne mapped folder of the same type (Personal or Community) as the type of user-directed archiving that you want to perform.
2. Map the Personal or Community folder to an archive folder that you created for UDA in the archive.
3. Specify the users and groups allowed to search the Personal or Community folder.
4. For each user and group, specify Contributor permission on the Personal or Community folder.

Create UDA folders in user mailboxes

Create a UDA Archive activity, which will create the corresponding empty UDA folders in user mailboxes.

You can specify that the UDA folders be created under a parent folder.
User-Directed Archiving Activities

Configuring community archive or personal archive

This section describes how to configure community archive or personal archive.

About community archive and personal archive

UDA has two usage models and are described in the following sections.

When you create a UDA Archive activity, you choose whether to archive user messages to a Community mapped folder or a Personal mapped folder.

Community archive

A UDA community archive is used for collaboration and sharing, and to retain shared items for the required amount of time. When a user puts a message into a UDA community folder, anyone in the To or From field who has access to that UDA folder can see content archived into this folder, regardless of whether he archived it, and will be able to search for that message.

Note: To see new UDA folders that were created while Notes was open, users must reopen the mailbox.

Notes users are to drag and drop (or CTRL + drag and drop) to copy messages into a UDA folder instead of using copy and paste. Copying and pasting creates a new message, not a copy.

Refer to “Configuring Email Management Activities” on page 341.

Create an activity to process UDA folders in user mailboxes

After users copy messages and shortcuts to the UDA folders in their mailboxes, create another UDA Archive activity to archive the messages and shortcuts.

Refer to “Configuring Email Management Activities” on page 341.

Figure 201  Example: UDA folders in Notes Mailbox
User-Directed Archiving Activities

Personal archive

A UDA personal archive is used for personal messages and for storage management. When a user puts a message into a UDA personal folder, only that person will be able to search for the message (other than Administrators). Users can see only what they archived into this folder. None of the recipients, except for the sender and the person who put the message in the UDA folder, will be able to search for that message.

If another user puts the same message into the personal folder, then both users will be able to search for the message.

The messages are still single-instanced in the UDA folder.

Users can delete items from UDA personal archives.

Best practices for UDA folders

Best practice is to minimize the number of UDA folders.

For community archiving, you can configure multiple UDA Community folders based on retention policies (for example, 1 Year, 3 Year, 5 Year, and 10 Year).

Considerations and limitations

- User display names cannot include any @ signs. The @ sign in an address is used to determine whether it is an SMTP address or some other address. UDA folders will not be created for users whose display name contains an @ sign.

- The name of the optional parent folder that you specify must be unique. Do not use the name of an existing folder in Outlook or Notes.

- The Parent Folder Name field defaults to User Archive Folders.

If you choose to use a parent folder, and the name in the Parent Folder Name field does not match an existing parent folder, then EMC SourceOne will create a new set of UDA folders under the name shown, instead of processing the UDA folders you intended.

If the selected user UDA folders already exist under the old parent folder, then the selected user UDA folders will be moved to the new parent folder.

- You can use UDA archive activities to create multiple parent folders for organizational purposes. For example, you could create a Personal Archive parent folder with one activity, and a Corporate Archive parent folder with another activity.

Because the UDA archiving activity does not rename UDA parent folders that already exist in Outlook, discourage users from renaming UDA parent folders in Outlook. Assume a user renames a UDA parent folder in Outlook (for example, from User Archive Folders to My Archive Folders).

If you run another UDA archiving activity using the original parent folder name User Directed Folders, the activity does not rename My Archive Folders to User Archive Folders. The user will see two UDA parent folders in Outlook.

- When you create a UDA Archiving activity, typically you will select the Use all option on the Dates page in the New Activity wizard. The assumption is that users want those messages archived regardless of the date.
User-Directed Archiving Activities

- Domino/Notes: Any records in the user-directed archiving (UDA) folders of a Notes client will also display in the All Documents and Mail Threads views. If you create a Delete - Historical activity and include these two views, the Delete - Historical activity will delete items from your UDA folders, even though the activity was not a Delete - User Directed Archive activity.

- Domino/Notes: The EMC SourceOne account requires the following permissions on all user mail files:
  - If you implement UDA, then the EMC SourceOne account must have Manager rights.
  - If you do not implement UDA, then the EMC SourceOne account needs Editor rights with the ability to delete records.

- Domino/Notes: Because EMC SourceOne programmatically adds the UDA folders to the mail user’s database, it is necessary to sign the UDA folders and to add the user who will be running UDA Archiving activities to the Execution Control List for Notes. Perform this in one of two ways:
  - Set up a policy in Domino and add the user to the Administrative ECL on the server. Users can manually refresh their local ECL or have the ECL pushed down to them.
  - When the Execution Security Alert appears for the first time, users can select the Start trusting the signer to execute this action option, and Notes will automatically add the correct user and permissions to the users' local ECL.

---

**Archive - User Directed Archive activity**

Use the Archive - User Directed Archive activity to perform the following.

- Create UDA folders in users’ mailboxes.
- Archive the items that users place in their UDA folders to Community or Personal folders.
Delete - User Directed Archive activity

Use the Delete - User Directed Archive activity to delete items from UDA Community or Personal folders.

Shortcut - User Directed Archive activity

Use the Shortcut - User Directed Archive activity to shortcut items in UDA Community or Personal folders.
CHAPTER 23
Using Email Management Rules

This section describes how to use rules with email management activities in EMC SourceOne. Topics include:

◆ Rule concepts ....................................................................................................... 500
◆ Best practices for using rules ................................................................................ 501
◆ Creating rules........................................................................................................ 504
◆ Archiving messages which do not match any rules................................................. 519
◆ Editing rules .......................................................................................................... 519
◆ Copying and pasting rules ..................................................................................... 519
◆ Deleting rules........................................................................................................ 520
Rule concepts

Before using rules within activities, review the concepts described in the following sections.

Overview of rules

Create rules within activities to cause messages to be archived into mapped folders. Messages which match the rule criteria are stored in the mapped folder assigned to that rule. For example, a rule can place all messages from John Smith into a mapped folder called SmithArchive. The criteria you can use to match a message to a rule includes one or more of the following:

- Email addresses or distribution lists (groups) that were part of the message
- Words that occur in the message subject
- The owner of the message
- Custom metadata that has been added to the message or message address

If a message matches multiple rules, that message will be copied into the folder associated with each rule that it matches. Also, if multiple rules all specify the same folder, any message matching any of those rules will be archived in that folder.

If a message does not match any of the rules you have defined, the message will not be archived. If you want all messages to be archived, you can specify that messages which do not match any rule will be archived as well by specifying the Copy messages that do not match any rule to option on the Specify Filtering Rules page of the activity wizard.

Overview of rule criteria

When you create or modify a rule you need to create or modify the criteria associated with the rule. These criteria include one or more of the following.

- The mapped folder that will store the messages matching the rule conditions.
- The name of the rule and the conditions associated with the rule.
- The email addresses, if specified, contained within the rule conditions.
- The external mail domains, if specified, contained within the rule conditions.
- The message owners, if specified, contained within the rule conditions.
- The keywords, if specified, contained within the rule conditions.
- The custom metadata, if specified, contained within the rule conditions.
Using metadata as rule criteria

EMC SourceOne address rules can be used with applications that assign custom metadata to email messages.

You can use rule criteria to specify whether the value of the metadata field equals, contains, or does not contain the metadata field you specify. For example, you can specify that messages with the department metadata field set equal to a value of 1234 are to match the rule.

Using the message owner as rule criteria

Messages archived by EMC SourceOne have one or more owners associated with them. Select the Owned by people rule criteria to specify that a rule is to match messages based on message ownership.

Select the one or more owners using the Data Sources dialog box.

A message may have one or more message owners. Message ownership is determined by which activity was used to archive the message as follows:

- **Journal** activity — The message owner is any email address that the message was received from, or sent to, including Cc and Bcc recipients.
- **Archive - Historical** and **Archive - User Directed Archive** activities — The one or more mailboxes to be archived are analyzed by EMC SourceOne and one or more owners are automatically assigned to messages in those mailboxes based on the results of the analysis.
- **Archive - Personal Mail Files** — The one or more Microsoft Outlook .PST files or IBM Lotus Notes .NSF files to be archived are analyzed and EMC SourceOne attempts to automatically assign one or more owners to messages in those files based on the results of the analysis. If owners cannot be assigned, the administrator must assign ownership.

Best practices for using rules

The following sections describe best practices for using rules. Review this information prior to using rules.

Enable the use of address rules

Normally, select the **Address Rules** component on the **Business Components** page of the activity wizard. The **Address Rules** component determines which messages are to be archived and where to archive those messages. If the **Address Rules** component is not selected, messages are not archived and that data is lost.

The only time to not select the **Address Rules** component is when you:

- Have installed and selected another component that will archive the messages.
- Do not want the messages to be archived.

If you do not select the **Address Rules** component on the **Business Components** page of the activity wizard, the **Address Rules Undefined** dialog box appears.
Figure 203  Address Rules Undefined dialog box

To continue to create or modify the activity, perform one of the following:

- To continue without selecting the Address Rules component, and potentially not archive messages, select the I have read this warning and understand the implications option and click Continue.
- To dismiss this dialog box and return to the Business Components page where you can select the Address Rules component, click Cancel.

Keep message rules simple

When you define a rule, that rule can have one or more conditions associated with it. If you define multiple conditions for a rule, only messages matching all of those conditions are archived by that rule.

If a message meets only some of the conditions of the rule, the message is not archived by that rule.

To make rule processing as simple and maintainable as possible, try to have as few conditions as possible defined for each rule.

Review address rules component position when multiple business components are defined

Business components process messages sequentially from top to bottom in the order listed on the Business Components page. By default, only the Address Rules component is listed, but other business components can be installed.

If multiple business components are available in your EMC SourceOne installation, verify that the Address Rules component occurs after any business component that changes the messages to be processed by the rules.

The Address Rules component must occur last in the processing list to ensure that messages are archived by EMC SourceOne.

Archive messages that do not match any other rule

You can select an option to archive messages that are not collected by any other rule by selecting the Copy messages that do not match any rule to option on the Specify Filtering Rules page. When this option is selected, all messages are archived, including those messages rejected by some rules.

**Note:** When this option is not selected, messages which do not match a rule are not archived.
This option is useful for verifying that all the other rules you have defined are collecting all the messages you intended, as it will only archive those messages that the other rules do not archive.

**Use a directory service to specify many addresses in a rule**

When creating a rule with a large number of addresses, using a directory service may perform better than using a Microsoft Exchange or Lotus Domino address book, especially when specifying many users, for example, more than 4,000, for a rule.

If you have a Lightweight Directory Access Protocol (LDAP) or Microsoft Active Directory Services (ADS) server, you can configure rules that filter messages against the directory services schema in addition to or in place of the mail system address book or directory.

**Be aware of rule processing of email addresses and distribution lists or groups**

When a distribution list or group is entered into rules containing certain conditions, that distribution list or group is expanded so that all members of that list are considered part of the rule. This occurs with rules containing the following conditions.

- From people or distribution list
- From people or group
- To people or distribution list
- To people or group
- To or From people or distribution list
- To or From people or group

Periodically, the EMC SourceOne Address Cache service (ExAddressCacheService.exe) checks to see if new rules have been added to the system. The EMC SourceOne Address Cache service also reviews and updates (if required) existing rules and email addresses used by rules one time a day (at 2 am by default). The review and update process is also performed for all addresses in a rule whenever that rule is modified.

The EMC SourceOne Address Cache service reviews the following information and updates it when necessary:

- Updates a distribution list or group used by a rule if the list has had one or more email addresses added or removed.

- Updates the name portion, for example John Smith, of an email address used by a rule if that name has changed. This applies both to single email addresses and email addresses within distribution lists or groups.

- Updates the address portion, for example, JSmith@example.com, of an email address used by a rule if that address has changed. This applies both to single email addresses and email addresses within distribution lists or groups.

Any jobs that start while the EMC SourceOne Address Cache service has the database tables locked for update will be retried three times. If none of these attempts are successful, the job fails to start and that event is logged. If a job is executing when a rule that affects it is changed or added, that rule will not be used until the next time that job executes.
Use the Owned by people rule criteria to match all messages sent to an Exchange user and archived using historical archiving

If an Exchange mailbox has been archived using the Archive - Historical or the Archive - Personal Mail File activities, use the Owned by people rule criteria (specifying the Exchange mailbox you want to archive as the owner) to ensure that the rule criteria matches all mail sent to the owner of that mailbox.

If you do not use the Owned by people rule criteria, messages sent to that user using the BCC field will not be captured. For example, if you use the To people or distribution list member(s) rule criteria, messages sent to that user where that user is listed on the BCC field will not be matched by the rule and so will not be archived.

Remove users from rules when they are removed from the mail system

Rules can contain the names of users, groups or distribution lists used in Domino or Exchange mail systems. When such a user, group, or distribution list has been removed from the Exchange or Domino mail system, they must also be manually removed from any rules that specify them.

Rules that contain users, groups, or distribution lists that no longer exist are invalid and are to be modified or deleted.

Do not use Domino group SMTP aliases in rules

If domain aliasing is enabled on the Domino server, and an EMC SourceOne rule specifies an alias SMTP group, messages sent to or from that alias SMTP group will not be processed by the rule.

Do not use Domino group SMTP aliases in rules.

Creating rules

Create rules to select which messages are to be archived by activities.

Note: If the Copy messages that do not match any rule to option on the Specify Filtering Rules page is not selected, messages which do not match a rule are not archived.

Perform the following tasks to create a rule.

1. If not already done, enable the use of rules for the activity by selecting the Address Rules component on the Business Components page of the activity wizard.
The Business Components page lists all components that are available in your system. By default only the Address Rules component is available.

2. If multiple components are listed on the Business Components page, verify that the Address Rules component is listed below any component that would change the messages to be processed by the rule. Components process messages in the order they are listed, from top to bottom.

3. If you need to change the position of one or more components in the list on the Business Components page:
   a. Select the component to be moved.
   b. Click the up-arrow to move the component higher in the list. Click the down-arrow to move the component lower in the list.
4. When the components are ordered correctly, click Next. The Specify Filtering Rules page appears.

Figure 205 Specify Filtering Rules page in the activity wizard

The Specify Filtering Rules page displays the names of the rules, if any, that are defined for the activity. On this page you can:

- Click **New Rule** to create a new rule to archive messages. The Specify Rule Target Folder page appears.
- Select **Copy messages that do not match any rule** to cause messages which do not match any rule to be archived.
- Click **Edit** to edit a rule.
- Click **Copy** to copy a rule and **Paste** to paste a rule you have previously copied.
- Click **Delete** to delete a rule.
Rule Specify Rule Target Folder page

Each rule must specify a mapped folder in which to place messages which match the rule. The mapped folder must exist before the rule is created.

Specify this mapped folder using the Specify Rule Target Folder page of the Rule wizard as follows.

1. Click Next on the Specify Filtering Rules page. The Specify Rule Target Folder page appears.

2. Review the list of folders displayed and select the folder in which you want to store messages matching the rule by clicking that folder name.

3. Click Next to continue defining the rule. The Specify Rule Criteria page appears and is described in the next section.
Rule Specify Rule Criteria page

Use the Specify Rule Criteria page of the Rule wizard to specify the conditions associated with a rule. If the conditions are met by a message, that message is archived in the folder associated with the rule. If you select multiple conditions for a rule, all the conditions must be met for a message to be archived into the folder associated with that rule.

![Rule Specify Rule Criteria page in the rule wizard](image)

**Figure 207** Specify Rule Criteria page in the rule wizard

Perform the following steps to specify the conditions associated with a rule using the Specify Rule Criteria page.

1. Enter a name for the rule you are creating in the Name of rule field.
2. Decide whether to use rule criteria or not.
   - If you do not specify any conditions and click Finish, all messages will be placed in the folder that you specified and the Specify Filtering Rules page appears.
   - If you specify one or more conditions, only messages matching all those conditions will be placed in the folder you specified. To specify those conditions, continue to step 3.
3. Select one or more conditions from the list by selecting the option box next to the condition. For example, select the **Directly From distribution list** condition.

The condition name can vary depending on the mail system selected. If the mail system is Domino, the term group is used in the condition name. If the mail system is Exchange, the term distribution list is used in the condition name.

Note that if you select multiple conditions for a rule, all the conditions must be met by a message for it to match the rule.

The following table lists the possible conditions you can select and it's coinciding message:

**Table 50 Description of rule conditions (page 1 of 2)**

<table>
<thead>
<tr>
<th>Condition name</th>
<th>Matching message must</th>
</tr>
</thead>
<tbody>
<tr>
<td>From people or group member(s)</td>
<td>Be from the specified email address, the specified email distribution list or email group, or the email address of any member of the specified distribution list or group.</td>
</tr>
<tr>
<td>From people or distribution list member(s)</td>
<td></td>
</tr>
<tr>
<td>To people or group member(s)</td>
<td>Be to the specified email address, the specified email distribution list or email group, or the email address of any member of the specified distribution list or group. This includes being a To, CC, or BCC recipient.</td>
</tr>
<tr>
<td>To people or distribution list member(s)</td>
<td></td>
</tr>
<tr>
<td>To or From people or group member(s)</td>
<td>Be to or from the specified email address, the specified email distribution list or email group, or the email address of any member of the specified distribution list or group. This includes being a To, CC, or BCC recipient.</td>
</tr>
<tr>
<td>To or From people or distribution list member(s)</td>
<td></td>
</tr>
<tr>
<td>Directly From distribution list</td>
<td>Be from the specified distribution list only. The email addresses of the members of the distribution list are not considered by the rule. Note that Notes users cannot send email from a group.</td>
</tr>
<tr>
<td>Directly To group</td>
<td>Be to the specified distribution list or group email address only. The email addresses of the members of the distribution list or group are not considered by the rule. This includes having the group or distribution list being a To, CC, or BCC recipient.</td>
</tr>
<tr>
<td>Directly To distribution list</td>
<td></td>
</tr>
<tr>
<td>Directly To or From group</td>
<td>Be to or from the specified distribution list address only. The email addresses of the members of the distribution list are not considered by the rule. This includes having the distribution list being a To, CC, or BCC recipient. Note that Notes users cannot send email from a group.</td>
</tr>
<tr>
<td>Directly To or From distribution list</td>
<td></td>
</tr>
<tr>
<td>From specific external domain</td>
<td>Be from an email address with an email address domain matching the external domain specified. For example, if the domain example.com is specified, email sent from <a href="mailto:Smith@example.com">Smith@example.com</a> or <a href="mailto:jones@example.com">jones@example.com</a> will match the rule.</td>
</tr>
<tr>
<td>To specific external domain</td>
<td>Be to an email address with an email address domain matching the external domain specified. For example, if the domain example.com is specified, email sent to <a href="mailto:Smith@example.com">Smith@example.com</a> or <a href="mailto:jones@example.com">jones@example.com</a> will match the rule.</td>
</tr>
<tr>
<td>To or From specific external domain</td>
<td>Be to or from an email address with an email address domain matching the external domain specified. For example, if the domain example.com is specified, email sent to or from <a href="mailto:Smith@example.com">Smith@example.com</a> or sent to or from <a href="mailto:jones@example.com">jones@example.com</a> will match the rule.</td>
</tr>
</tbody>
</table>
Table 50 Description of rule conditions (page 2 of 2)

<table>
<thead>
<tr>
<th>Condition name</th>
<th>Matching message must</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owned by people</td>
<td>Be owned by one or more of the email addresses listed in the rule criteria.</td>
</tr>
<tr>
<td>With specific words in the subject</td>
<td>Contain the specified word or words in the subject portion of the message.</td>
</tr>
<tr>
<td>Messages with custom metadata</td>
<td>Contain a metadata field that meets the condition and value specified in the rule criteria.</td>
</tr>
</tbody>
</table>

4. Click the underlined variable portion of the condition to change it from a variable to an actual value, such as an email address or distribution list. When you click the underlined variable portion, one of the following dialog boxes appears to change the variable to an actual value:

- If the condition variable is people, people or group, people or distribution list, distribution list, or group, the Data Sources dialog box appears. For example, click the distribution list variable in the Directly From distribution list condition to select an actual distribution list from the mail server to match in the rule.

- If the condition variable is specific external domain, the Select Mail Domain dialog box appears. For example, click the specific external domain variable in the To or From specific external domain condition to select an actual mail domain to match in the rule.

- If the condition variable is specific words, the Select Keywords dialog box appears. For example, click the specific words variable in the With specific words in the subject condition to select the actual words to match in the rule.

- If the condition variable is custom metadata, the Custom Metadata dialog box appears. For example, click custom metadata in the Messages with custom metadata condition to select the metadata to match in the rule.
Rule wizard Data Sources dialog box

Use the Rule wizard Data Sources dialog box to select the email addresses for the rule. This dialog box is also used to select email addresses for message owners.

![Initial rule wizard Data Sources dialog box](image)

**Figure 208** Initial rule wizard Data Sources dialog box

Select an option in the Choose by field to specify how to select your email address for the rule criteria.

After you select the data source, the Data Sources dialog box is updated differently, depending on which option you selected:

- Select Address Book to use an Exchange mail server address book to locate an email address. This option is only available for Exchange mail servers. The Data Source page for Exchange address books appears.
- Select Directory to use a Domino mail server directory to locate an email address. This option is only available for Domino mail servers. The Data Source page for Domino directories appears.
- Select SMTP Addresses to specify an external SMTP address. The Data Source page for SMTP addresses appears.
- Select LDAP in the Choose by field to use an LDAP query to locate an email address. The Data Source page for using LDAP queries to find email addresses appears.
Exchange address book Data Sources dialog box

When the Data Source page for Exchange address books appears, perform the following tasks.

![Exchange Address Book dialog box](image)

1. Select the email address or distribution list you want to associate with the rule and click OK.

   The Specify Rule Criteria page appears with your selected email address or distribution list inserted into the previously selected rule.

2. Continue to specify the rule by defining a folder for the rule.

Domino directory Data Sources dialog box

When the Data Source page for Domino directories appears, the list of available directories appear. Using this dialog box, perform the following tasks.

1. Select the directory to use from the list displayed and click Add. The Select Users dialog box appears.

![Domino directory Select Users dialog box](image)
2. Select the email addresses to add and then click **Addresses** to add them to the Recipients list for the rule.
   - To remove an email address from the **Recipients** list, select the email address and click **Remove**.
   - To remove all the email addresses from the list, click **Remove All**.
   - To search for an email address in the selected directory, enter the initial text of that address in the **Starts with** field.

3. When you are finished creating the list of email addresses, click **OK**.

4. Assuming you click **OK**, the **Specify Rule Criteria** page appears with your selected email address or group inserted into the previously selected rule.

5. Continue to specify the rule by defining a folder for the rule.

**SMTP addresses Data Sources dialog box**

When the Data Source page for SMTP addresses appears, perform the following.

![Figure 211 Rules Data Sources dialog box for SMTP Addresses](image)

1. Enter the external SMTP address in the **Enter SMTP Address** field and click **Add**.
   - To remove an address from the list of addresses, select the address and click **Remove**.

   To modify an address on the list, select the address and click **Edit**. The **Edit SMTP Address** dialog box appears. In the **Edit SMTP Address** dialog box, modify the address and then click **OK**. The modified address is now displayed in the list on the **Data Source** page for SMTP addresses.

![Figure 212 Edit SMTP Address dialog box](image)
2. When you are done creating the list of email addresses, click **OK**.

3. Assuming you click **OK**, the **Specify Rule Criteria** page appears with your selected email address or distribution list inserted into the previously selected rule.

4. Continue to specify the rule by defining a folder for the rule.

**LDAP Data Sources dialog box**

When the Data Source page for LDAP queries for email addresses appears, define an LDAP query to locate an email address for a rule as follows.

![Figure 213 Rules Data Sources dialog box for LDAP](image)

1. Select the LDAP server to use in the **Select Server** field.

   If the server to use is not listed, add it to the list by clicking **New**. The **LDAP Server Configuration** dialog box appears.

2. Specify whether your LDAP directory server contains identity information. Perform one of the following steps:

   - If in an Exchange environment where the directory server you specified contains identity information, select the **Directory server contains identities** to improve LDAP query performance.
   - If in a Domino environment, or if in an Exchange environment where the directory server you specified is not configured to contain identities, clear the **Directory server contains identities** (default).

**Note:** This option does not apply to Domino servers or to LDAP queries executed locally using the Execute or Test buttons. In those cases, the option is ignored without error or user notification.

When this option is selected for Exchange, Active Directory Service Interface (ADSI) is used to access the information.
3. Specify the LDAP query to use to get the email address in the Query field.

![LDAP Server Configuration](image)

4. Click Execute to run the query. The results are displayed in the Test Results area.

If the correct email address results, click OK to use the query in the rule. Otherwise, change the query and run it again until you get the results you require and then click OK.

5. The Specify Rule Criteria page appears with your selected email address inserted into the previously selected rule.

6. Continue to specify the rule by defining a folder for the rule.

**Rule Select Mail Domains dialog box**

Use the Select Mail Domains dialog box to specify the one or more external mail domains to match in a rule. An external mail domain is a mail domain that is not a company-internal mail domain. For example, Example.com is an external domain and can be used with the Select Mail Domains dialog box, but QATest.Example.com is an internal domain and is to not be used.

Perform the following procedure to add, modify, or remove an external mail domain from the list of domains matched by a rule.

![Select Mail Domains](image)

**Figure 214 Rules Select Mail Domains dialog box**
1. Perform one or more of the following tasks:
   • If you are adding a domain, enter the domain to add to the rule, such as example.com, in the **Enter mail domain** field and click **Add**.
   • If you are modifying a domain, select the domain to modify, click **Edit**, and make the needed modifications.
   • If you are removing a domain, select the domain to remove and click **Remove**.

2. Click **OK** to complete adding, modifying, or removing mail domains to the rule condition.

3. Continue to specify the rule by defining a folder for the rule.

**Rule Select Keywords dialog box**

Use the Select Keywords dialog box to specify the one or more keywords to match in a rule. Perform the following procedure to add, modify, or remove a keyword from the list of keywords matched by a rule.

1. Perform one or more of the following tasks:
   • If you are adding a keyword, enter the keyword to add to the rule in the **Enter keyword** field and click **Add**.
   • If you are modifying a keyword, select the keyword to modify, click **Edit**, and make the needed modifications.
   • If you are removing a keyword, select the keyword to remove and click **Remove**.

2. Click **OK** to complete adding, modifying, or removing keywords to the rule condition.

3. Continue to specify the rule by defining a folder for the rule.
Rule Custom Metadata dialog box

When you use the Messages with custom metadata rule condition, you specify the message metadata to match using the Custom Metadata dialog box.

![Custom Metadata dialog box](image)

**Figure 216** Rules Custom Metadata dialog box

Adding a message metadata field to a rule criteria

Perform the following steps to add a metadata field and value to a rule criteria.

1. Enter, or if available select, the name of the metadata field in the **Field name** field.
2. Select the condition in the **Condition** field that the metadata value must meet to match the rule. The following list describes the possible conditions and their descriptions.
   - **Equals** — The metadata field value in the message must equal the value in the rule to match the rule.
   - **Contains** — The metadata field value in the message must contain the value in the rule to match the rule.
   - **Does not Contain** — The metadata field value in the message must not contain the value in the rule to match the rule.
3. Enter the value of the metadata in the **Value** field.
4. Click **Add**.
5. Repeat the previous steps for as many fields as you need to add.
6. Click **OK** to complete adding metadata field and values.
7. Continue to specify the rule by defining a folder for the rule.
Using Email Management Rules

**Editing a message metadata field on a rule criteria**

Perform the following steps to modify a metadata field, condition, or value in a rule criteria.

1. Select the metadata field and value from the list.
2. Click **Edit**. The **Edit Metadata** dialog box appears.

![Edit Metadata dialog box](image)

**Figure 217** Edit Metadata dialog box

3. Modify the field name, condition or value and then click **OK**. The **Edit Metadata** dialog box closes and the modified metadata field, condition and value are displayed.
4. Repeat the previous steps for as many fields as you need to change.
5. Click **OK** to complete modifying metadata field and values.

Continue to specify the rule by defining a folder for the rule.

**Removing a message metadata field from a rule criteria**

Perform the following steps to remove a message metadata field and value from a rule criteria.

1. Select the metadata field and value from the list on the **Custom Metadata** dialog box.
2. Click **Remove**.
3. Repeat the previous steps for as many fields as you need to remove.
4. Click **OK** to complete removing metadata field and values.
5. Continue to specify the rule by defining a folder for the rule.
Archiving messages which do not match any rules

Perform the following steps to archive messages which do not match any rules to a folder.

1. On the Specify Filtering Rule pages, select the Copy messages that do not match any rule to option.
2. Click Browse. The Select Folder dialog box appears.

3. Select a folder from those listed to contain the messages.
4. Click OK to use the selected folder.

Editing rules

You can edit a rule after it has been created. You use rules to select which messages are to be archived by activities.

Perform the following procedure to edit a rule.

1. Open the Specify Filtering Rules page in the Rule wizard.
2. Select the rule you want to edit from the list of rules.
3. Click Edit.
4. You are allowed to change all the criteria of the rule that you set when you were creating the rule.

Copying and pasting rules

You can copy and paste rules within an activity or between activities, but the rules must be used with the same mail system. You cannot copy rules between Exchange-based activities and Domino-based activities.

Perform the following procedure to copy and paste a rule.
Using Email Management Rules

1. Open the **Specify Filtering Rules** page in the **Rule** wizard.
2. Select the rule you want to copy.
3. Click **Copy**.
4. The rule is copied to the Windows clipboard.
5. Paste the rule as follows:
   - If you are pasting the rule into the same activity, click **Paste**.
   - If you are pasting the rule into a different activity, browse to the **Specify Filtering Rules** page for that activity and click **Paste**.

   **Note:** A rule that is copied and pasted as a new rule is not linked in any way to the rule from which it was copied. Changes to the original rule will not be reflected in the copied rule.

   If the pasted rule has the same name as an existing rule, the name of the new rule will have the text **Copy of** as a prefix. If multiple copies of the same rule name are pasted into the same activity, the names will have the text **Copy (number) of** as a prefix.

![Example of rule names created by copying and pasting](image)

**Deleting rules**

Perform the following tasks to delete a rule.

1. Select the rule to delete on the **Specify Filtering Rules** page of the activity wizard.
2. Click **Delete**.
CHAPTER 24
Configuring User Delete

This section describes how to configure and use the User Delete feature. Topics include:

◆ Introduction to User Delete ................................................................................... 522
◆ Considerations and limitations - User Delete ......................................................... 524
◆ How User Delete works in the mail client ............................................................... 526
◆ How User Delete works in SourceOne Search......................................................... 527
◆ User Delete configuration...................................................................................... 529
◆ Using the Folder Conversion utility ........................................................................ 531
◆ Configuring index throttling for User Delete ........................................................... 536
◆ Configuring mapped folders for User Delete .......................................................... 538
◆ Configuring Workers for User Delete ...................................................................... 539
◆ Disabling external address resolution in IBM Lotus Domino................................... 539
◆ Configuring SourceOne Search for User Delete ...................................................... 540
◆ Configuring Journal activities for User Delete ....................................................... 542
◆ Configuring archive and shortcut activities for User Delete .................................... 543
◆ Configuring the Delete - User Initiated Delete activity ............................................ 544
◆ Troubleshooting the address cache for User Delete ............................................... 545
◆ Viewing detailed job logs for User Delete............................................................... 546
Introduction to User Delete

This section introduces User Delete.

In previous releases of EMC SourceOne:

- Users could not delete their mail items from the Native Archive through the mail client.
- Users could delete their mail items from the Native Archive through SourceOne Search, if those mail items had been archived to a Personal or a Community mapped folder using User-Directed Archiving (UDA).

Users can delete their email items from the Native Archive through the mail client (Microsoft Outlook) or Search if the mail items were archived to a Personal or a Community mapped folder using:

- Journal, Archive - Historical, or Archive - Personal Mail Files activities
- User-Directed Archiving (UDA)
Overview: How User Delete works

The following diagram illustrates how User Delete works in Outlook and in SourceOne Search.

**Figure 220** Overview: How User Delete works
Considerations and limitations - User Delete

Refer to the following sections for considerations and limitations.

Mail clients

Consider the following information.

- User Delete supports Microsoft Outlook thick clients.
- User Delete does not support OWA, IBM Lotus Notes, iNotes, Android, iPhone, Blackberry or other handheld devices.

Note: IBM Lotus Notes users can delete archived mail items through Search.

Microsoft Exchange/Outlook

Consider the following information.

- User Delete does not support the deletion of archived mail items from user PSTs, shared folders, or public folders.

Archives

Consider the following information.

- User Delete supports the Native Archive only.
- User Delete does not support EmailXtender archives.

Mapped folders

Consider the following information.

- For Journal, Archive - Historical, Archive - Personal Mail Files activities:
  - User Delete works only on mail items archived in SourceOne Personal or Community mapped folders, and only if users have the new Delete permission on those folders. For Search, Contributor permission is also required.
  - User Delete does not work on mail items archived in SourceOne Organization mapped folders.
  - A Folder Conversion utility is provided to convert Organization mapped folders to Personal or Community mapped folders.
- User Delete works on mail items that were previously archived in SourceOne Personal or Community mapped folders through User-Directed Archiving if users have both Contributor permission and the new Delete permission on those folders.
- User Delete does not work on mail items in SourceOne Legal Hold folders.
Deleting messages under retention

If a user tries to delete a message that is under retention, all references to the message are removed from SQL and from the index. However, the message is not deleted from the volume:

Cannot delete message(s) from storage in Volume <volume name>, the volume is under retention.

Journaling

Consider the following information.

- To support journaling to Personal or Community mapped folders, the Journal activity now distinguishes internal recipients from external recipients. Only internal recipients are promoted to owners when you journal to a Personal or Community mapped folder.
- Initialize the address cache before you create the first Journal activity to a Personal or Community folder.

User Delete operation

Consider the following information.

- User Delete operations on user mailboxes through mail clients are asynchronous. After items are deleted from user mailboxes, they may still appear in search results for some time.

It may take up to 24 hours for a User Delete operation on the archive to complete after either of the following actions:

- The User Initiated Delete Activity is run from the archive console to process delete requests in user mailboxes.
- The user deletes the item from SourceOne Search.

- User Delete operations remove actual mail items from the archive only when no other users have ownership references to the deleted item. A user merely removes his reference to an item and SourceOne removes the item only when no user references remain on an item.

Delegate deletes

Deletion of archived mail items by delegates is not supported in the mail client or in SourceOne Search.

User Delete can result in orphaned shortcuts

There is no mechanism to clean up orphaned shortcuts caused by the use of User Delete. Users can still retrieve the item using the shortcut if the item still exists in the archive.

This is the case for items in a:

- Personal Folder — If at least one reference still exists
- Community Folder — Always
Configuring User Delete

How User Delete works in the mail client

The following sections describe how User Delete works in the mail client.

Introduction

With EMC SourceOne Offline Access installed and with User Delete enabled, when a user deletes a mail item from their Outlook mailbox, they have the option to delete the corresponding archived mail item.

If a user chooses not to delete the mail item from the archive through the mail client at that time, they can perform either of the following steps later:

- Move the mail item from the Deleted Items folder to another mailbox folder, and then delete the item again, this time choosing to delete the item from the archive.
- Use SourceOne Search to delete the mail item from the archive.

Main steps

Ensure that the following steps are performed.

1. In the mail client, the user selects mail items to delete. For the detailed user procedure, refer to the EMC SourceOne Offline Access User Guide.

2. The Delete - User Initiated Delete activity and the User Delete job process, deletes requests in the mailboxes.
   - The Delete - User Initiated Delete activity (created by the SourceOne administrator) passes the delete requests found in a user’s mailbox to the User Delete job on the Worker.
   - Then the delete requests are removed from the user’s mailbox.

3. The Native Archive removes ownership and deletes mail items.

   The Native Archive uses the delete requests passed to it from the Delete - User Initiated Delete activity and User Delete job to:
   - Remove the user’s ownership from each mail item.
   - And, if this is the last user to have ownership on the mail item, remove the mail item from the archive.

Specifically:

- The mail item metadata is deleted from the SourceOne Archive database.
- For each mail item eligible to be deleted from the archive, an entry is created in a Delete Transaction File.
- Later, the delete transactions are processed asynchronously. This process is optimized to delete as many items from the same container as possible. As a result, mail items requested to be deleted may still appear in SourceOne Search results for up to 24 hours.
Configuring User Delete

Note: The steps outlined apply to deletion from a Personal Folder. The message is retained in the archive even after a user deletes the last reference to the message in the Community Folder. The user's reference is removed so that the user is no longer able to search for the message using the My Contributed Items search type.

How User Delete works in SourceOne Search

The following sections describe how User Delete works in SourceOne Search.

Introduction

A Search user can delete a mail item from the archive if all of the following conditions are true.

◆ The mail items were journaled or archived to a Personal or Community folder.
◆ The user selected the My Contributed Items search type.
◆ The user has Delete permission on the folders containing the mail items that he wants to delete.

Prerequisites

User prerequisites include the following:

◆ Search type — To delete items from the archive through SourceOne Search, a user must select the My Contributed Items search type.
◆ Deleting duplicates — Duplicate mail items are not deleted from the archive automatically. To delete duplicate mail items from the archive, the duplicate items must be displayed in search results for selection and deletion by the user.

To display duplicates in search results, users must clear the Remove duplicate items from search results checkbox in the Options dialog box.
Considerations and limitations

The following are considerations and limitations.

- Availability of Delete options — For the Delete toolbar button and the Delete right-click menu option to be available in Search, a user must have Delete permission on at least one Personal or Community mapped folder.

Search does not show or hide menu items on a per mapped folder basis. For example, if a user has Contributor access to two mapped folders, but has Delete access to only one of those folders, then:

- The Delete option is accessible.
- The user can start a Delete job for mail items in both mapped folders, but:
  - The mail items in the mapped folder for which the user does not have delete permission will fail to be deleted.
  - The failure is reported in the Delete Status Details dialog box as a permission denied error.

- Delete Status dialog box — The Delete Status dialog box displays an informational message to the user. Even after a Delete job is reported as complete, the mail items are not immediately removed from the archive or indexes. These mail items could display in new search results until the backend fully completes the removal. Depending upon the system load, it could take anywhere between minutes and hours before the mail items are completely removed.

  Deletions occur faster if:
  - Volumes are open.
  - The searches are SQL searches.
  - The system is not under load.

  Deletions take longer if:
  - Volumes are closed.
  - The searches are full-text-index searches.
  - The system is under load.
Main steps

Ensure that the following steps are performed.

1. In Search, the user selects mail items to delete from the archive.
   
   To delete a mail item from the archive through SourceOne Search, a user must select the **My Contributed Items** search type.
   
   For details, refer to the *EMC SourceOne Search User Guide*.

2. The Delete job on the Worker processes the deletions for Search.

   The Delete job on the Worker processes the deletions that were initiated from Search.

   **Note:** The Delete - User Initiated Delete activity and the User Delete job are not involved in deletions made through Search.

3. The Native Archive removes ownership and deletes mail items.

User Delete configuration

Use the following procedures to configure User Delete.

Configuring common settings for User Delete

Perform the following steps to configure common settings for User Delete.

1. Configure index throttling.

2. Specify a date range using the Archive deletion eligibility period option in the **Global Settings** dialog box.
   
   This date range applies to user deletes performed through the mail client and through SourceOne Search.

3. To convert existing Organization folders to Personal or Community folders, and to update ownership on the archived mail items, run the **Folder Conversion** utility.
   
   User Delete works on mail items archived to Personal or Community folders, not Organization folders.

4. Create **Personal** or **Community** mapped folders to use in **Journal**, **Archive - Historical**, **Archive - Personal Mail Files**, and **User-Directed Archiving (UDA)** activities.

   To support User Delete, these activities must archive to **Personal** or **Community** mapped folders, not **Organization** folders.
5. Grant users permissions on **Personal** and **Community** folders.
   - To delete archived mail items through Search, users must have **Contributor** permission and **Delete** permission.
   - To delete archived mail items through the mail client, users must have **Delete** permission.

   **Note:** The Delete permission is also required on pre-existing Personal and Community folders used for User-Directed Archiving (UDA) so that users can delete UDA content through Search.

6. Before creating the first **Journal** activity that archives to a **Personal** or **Community** mapped folder:
   - For IBM Lotus Domino, disable external address resolution.
   - Initialize the address cache.

7. Continue to the other User Delete configuration procedures.

**Configuring User Delete through the Outlook mail client**

Perform the following steps to allow users to delete mail items through the Outlook mail client.

1. Complete the common User Delete configuration steps.
2. Verify that users have **Delete** permission on **Personal** and **Community** mapped folders.
3. Create **Journal** activities to archive to **Personal** or **Community** mapped folders.
4. After mail is journaled to **Personal** or **Community** folders, or after you run the **Folder Conversion** utility on **Organization** folders containing journaled mail items, you must create Historical Archive or UDA Archive activities against user mailboxes to archive mail into **Personal** or **Community** folders. This step is required to add the SourceOne MsgID to mail that was previously journaled.

   **Note:** Users will not be able to delete items through the mail client (Outlook) if the items were archived using the Archive - Personal Mail Files activity. PST deletions are not supported in the mail client.

5. Configure SourceOne Workers to run **Delete - User Initiated Delete** jobs.
7. Configure Offline Access GPO to enable User Delete.
8. Create **Delete - User Initiated Delete** activities to process delete requests in user mailboxes.

**Configuring User Delete through EMC SourceOne Search**

Perform the following steps to allow users to delete mail through EMC SourceOne Search.

1. Complete the common User Delete configuration steps.
2. Verify that users have **Contributor** and **Delete** permissions on **Personal** and **Community** mapped folders.

3. Create **Journal, Archive - Historical**, or **Archive - Personal Mail Files** activities to archive mail items into **Personal** or **Community** mapped folders.

4. Configure one or more EMC SourceOne Workers to run User Delete jobs.

5. (Optional) Enable detailed logging.

---

**Using the Folder Conversion utility**

This section describes how to use the Folder Conversion utility.

**Folder Conversion utility introduction**

The User Delete feature works only on mail items that are archived in Personal or Community mapped folders, not in Organization mapped folders.

Before users can delete mail items that are already archived in Organization mapped folders, you must use the Folder Conversion utility to convert those Organization folders to Personal or Community mapped folders.

**When to use the utility**

Run the Folder Conversion utility before enabling User Delete for the mail client.

**Where to run the utility**

Run the Folder Conversion utility on an EMC SourceOne Worker.

**What the utility does**

The Folder Conversion utility performs the following.

- Triggers a synchronization of the address cache, and waits for the cache to be ready before continuing.
- Converts Organization mapped folders to Personal or Community mapped folders.
- Works with the ExAsAdmin service to update ownership on mail items to contributor ownership, as in User-Directed Archiving (UDA).
  - The cache of internal addresses is used to assign ownership to messages. Only internal recipients are marked as owners of messages. This ensures that a message is deleted from the archive only when all of the internal owners have deleted the message.
  - Existing owners remain on each mail item so that the mail items can be found in Search through Administrator or My Items searches while the folder is being converted.
- Reports on the progress of the conversion.
- Cleans up database entries after the conversion completes.

You can:
Start or stop the conversion. You can stop a conversion, then resume it later. The utility will continue from where it left off, and skip mail items it has already processed.

Increase or decrease the load.

Schedule the conversion.

**Considerations and limitations - Folder Conversion utility**

The following are considerations and limitations.

- Run the Folder Conversion utility only when the system is not under heavy load.
- The type of the mapped folder is converted at the beginning of the conversion. The folder is available for other EMC SourceOne activities such as ingestion (Journaling or Archiving). Change or add user permissions (Contributor and Delete) only after the folder conversion is done.

While the Folder Conversion utility is running:

- The following SourceOne processing is supported:
  - Administrator searches
  - User searches of the My Items type
  - Shortcut retrievals
  - Administrator retrievals
- The following EMC SourceOne processing is not supported:
  - User searches of the My Contributed Items type. These searches will have partial results until UDA ownership is established on all documents. The SourceOne administrator can decide whether to allow these searches.
  - Archive folder disposition or document deletes. If disposition or deletes occur, they may result in errors logged by the Folder Conversion utility.
  - Activities using the Organization mapped folder that is being converted.
- If you convert an Organization mapped folder that contains archived files, then you will not be able to create a File Restore activity to retrieve the archived files from the resulting Personal or Community mapped folder. The File Restore activity displays only Organization mapped folders for you to select, not Personal or Community mapped folders.

**Prerequisites - Folder Conversion utility**

Review the following prerequisites.

- Use the EMC SourceOne console to disable disposition or change the scheduling of disposition so that it does not conflict with the folder conversion.
- Before starting a folder conversion, you must stop all activities that use the Organization mapped folder you want to convert. If you pause activities instead of stopping them, then the resumed activities will not pick up the new folder information, and newly archived mail items will not be searchable using a My Contributed Items search. Use the EMC SourceOne console to stop the activities.
Configuring and scheduling folder conversion

(Optional) Before you convert folders, perform any combination of the following configurations.

- Specify the load by increasing or decreasing the number of threads (throttling).
- Specify the duration of the conversion in hours.
- Specify a day and time on which to run the utility.

Configuring and scheduling folder conversion procedure

Perform the following steps to configure and schedule folder conversion.

1. Use the Control (-ctrl) parameter and specify the name of the SourceOne archive connection. To view the name of the archive connection, select the Archive Connections node in the EMC SourceOne console.

2. To specify the number of threads, use the Threads (-threads) parameter and specify an integer in the range 1 to 10. The default is 10 threads.

3. To specify the duration of the conversion in hours, use the Duration (-duration) parameter and specify an integer in the range 1 to 24. The default duration is 24 hours.

4. To specify a schedule, use the following parameters:
   - Use the Start Time (-starttime) parameter and specify a start time in the range 00:00 to 23:59. The default start time is 00:00.
   - Use the Day Of The Week (-dow) parameter and specify one of the following days of the week:
     - sun
     - mon
     - tue
     - wed
     - thu
     - fri
     - sat
   
   The default is all days.

Usage

```
ES1NaFolderConvert  -ctrl <archive connection name> -threads <1-10> -duration <1-24> -starttime <00:00 - 23:59> -dow "<"sun,mon,tue,wed,thu,fri,sat">"
```

Example

The following example configures folder conversions for an archive connection named SourceOneArchive to use 4 threads, last a maximum of 6 hours, and start on Monday at 1:00 AM:

```
ES1NaFolderConvert  -ctrl SourceOneArchive -threads 4 -duration 6 -starttime 01:00 -dow mon
```
5. After configuring and scheduling the folder conversion, specify a folder to convert.

Starting a folder conversion

Perform the following steps to start a folder conversion, in a single command line.

1. Use the Initialize (-init) parameter and specify the name of the Organization mapped folder to convert.

2. (Optional) Use the Type (-type) parameter and specify the type of mapped folder (Personal or Community) to which you want to convert.

   If you do not specify a type of folder, the default is Personal.

```
ES1NaFolderConvert -init <mapped folder name> -type <personal or community>
```

The -init parameter triggers a synchronization of user addresses. The utility waits for the synchronization to complete before it starts the folder conversion.

Stopping a folder conversion

Perform one of the following to stop a folder conversion.

- To stop a folder conversion while the Initialize (-init) step is synchronizing the address cache, press q to return to the command line prompt.

- To stop folder conversions that have been scheduled or after the address cache has synchronized, use one of the following commands:

```
ES1NaFolderConvert -ctrl <archive connection name> -threads 0
```

Or:

```
ES1NaFolderConvert -ctrl <archive connection name> -duration 0
```

Restarting a folder conversion

If the ExAsAdmin service is stopped or suspended during a folder conversion, the conversion may not complete when the ExAsAdmin service resumes.

To restart the processing of an in-progress folder conversion, use the Rerun (-rerun) parameter and specify the name of the Organization mapped folder that was in the process of being converted:

```
ExNaFolderConvert -rerun <mapped folder name>
```

Reporting the status of the conversion

To see the status of the folder conversion, use the Status (-stat) parameter and specify the name of the Organization mapped folder that you are converting.

```
ES1NaFolderConvert -stat <mapped folder name>
```
Cleaning up the database after folder conversion

To clean the database after converting a folder, use the Clean (-clean) parameter and specify the name of the Organization mapped folder that you converted.

```
ESINaFolderConvert -clean <mapped folder name>
```

Folder Conversion utility parameters summary

The following are the parameters used with the Folder Conversion utility.

- `-ctrl` — Specifies the name of the SourceOne archive connection. Use with the `-threads`, `-duration`, `-starttime`, and `-dow` parameters to configure the load, duration, and schedule of folder conversions.

- `-threads` — Specifies the load (number of threads) for the conversion, in the range 1 to 10. Used with the `-ctrl` parameter.

- `-duration` — Specifies the maximum time a conversion is to take, in the range 1 to 24 (hours). Used with the `-ctrl` parameter.

- `-starttime` — Specifies the start time of the conversion, in the range 00:00 to 23:59. Used with the `-ctrl` parameter.

- `-dow` — Specifies the day of the week on which to start the conversion: sun, mon, tue, wed, thu, fri, or sat. Used with the `-ctrl` parameter.

- `-init` — Starts the conversion of the specified Organization mapped folder.

- `-type` — Specifies the type of mapped folder (personal or community) to which to convert the Organization folder. Used with the `-init` parameter. If the folder type is not specified, then the default folder type is Personal.

- `-rerun` — Resumes the conversion of the specified folder.

- `-stat` — Reports the status of the conversion in-progress for the specified folder.

- `-clean` — Cleans the database after the conversion of the specified folder.

After folder conversion

After the conversion of the Organization folder completes, perform the following.

- Verify permissions on the converted folder.

- If the contents of the converted folder were originally archived through Journal activities, and if you want to allow users to delete the contents through the mail client (Outlook), then you must run Historical Archive or UDA Archive activities against those user mailboxes. This step is required to add the SourceOne MsgID to mail that was previously journaled. This step is not required for users to be able to delete archived mail items through SourceOne Search.
Verify permissions on the converted folder

Verify that the converted folder, now a Personal or Community folder, has the correct permissions.

1. In the EMC SourceOne console, go to Mapped Folders > Action > New Folder to display the properties of the converted folder.

2. On the Permissions tab:
   a. Clear the Owner checkbox.
   b. Select the Delete permission.
   c. If you want users to be able to search for and delete archived mail items from Search, also select the Contributor permission.

Configuring index throttling for User Delete

The follow sections describe how to configure index throttling for User Delete.
Introduction

Processing delete requests affects the performance of the Native Archive Servers. You can control the number of resources allocated to various index operations, including the processing of delete requests. This index control capability also referred to as index throttling.

Best practices

If you are deploying User Delete to a large number of users, follow these guidelines.

◆ If you are using a single Native Archive Index server to handle several types of index operations, limit the number of resources used to process delete requests. To perform this, specify a small value in the Delete field in Index server properties.

◆ Ideally, add one or more Native Archive Index servers to process only delete requests.

Procedure

Perform the following procedure to control the resources allocated to processing delete requests.

1. Display the properties of the Native Archive Index server that you want to use to process delete requests.

![Figure 221 Native Archive Server properties - Index tab](image)

The **Component limit per index action** area contains the following fields which control the maximum number of processes per index operation:

- **Add** — The number of processes allocated to adding indexes. Default = 4.
- **Delete** — The number of processes allocated to delete requests. Default = 2.
Configuring User Delete

• **Repair** — The number of processes allocated to index refresh and rebuild operations. Default = 2.

• **Update** — The number of processes allocated to index updates. Default = 4.

2. To modify the **Delete** value, enter an integer in the range 0 - 4.

   A value of 0 means that this index server will not process any delete requests. A warning message appears if you enter 0.

   Changes are applied after the service restarts or refreshes.

3. Click **OK** to save your changes.

**Configuring mapped folders for User Delete**

The following sections describe how to configure mapped folders for User Delete.

**Use Personal or Community folders**

To support User Delete, the use of Personal and Community mapped folders has been extended beyond User-Directed Archiving (UDA) activities to Journal, Archive - Historical, Archive - Personal Mail Files, and Shortcut - Historical activities. For those four activities, User Delete works only on mail items that are archived to Personal or Community mapped folders, not Organization mapped folders.

---

**Note:** If you want users to be able to delete mail items from existing Organization mapped folders, you must use the Folder Conversion utility to convert those Organization mapped folders to Personal or Community mapped folders.

**Assign Contributor and Delete permissions**

The Delete permission is now required on Personal and Community mapped folders for users to be able to perform User-Directed Archiving (UDA) deletes in Search. Previously, users only needed Contributor permission on those folders to perform UDA deletes in Search.

The database update scripts add the Delete permission to existing Personal or Community mapped folders for which the user already has Contributor permission. However, for Personal or Community folders created after the update, you must add the Delete permission for each user manually.

**To delete archived mail items through SourceOne Search**

In addition to Contributor permission, the Delete permission is required on Personal or Community mapped folders to allow users to delete mail items that were archived through the following.

- Journal, Archive - Historical, and Archive - Personal Mail Files activities.
- User-Directed Archiving (UDA). In previous versions of EMC SourceOne, users only needed Contributor permission on those folders to perform UDA deletes in Search.
To delete archived mail items through the mail client

Users need the Delete permission on Personal mapped folders. Users do not need Contributor permission on mapped folders unless they will also be deleting archived items through SourceOne Search.

Procedure

Refer to “Configuring Mapped Folders” on page 125 for detailed procedures.

Configuring Workers for User Delete

This section describes how to configure Workers for User Delete.

Specifying a file share for detailed job logs

If you plan to generate detailed job logs for SourceOne jobs, specify a file share for the logs when you install Worker Services. Refer to the section on Installing Worker Services software in the EMC SourceOne Email Management Installation Guide.

Configuring jobs for User Delete

Configure the following jobs for User Delete on SourceOne Workers.

- For the Delete - User Initiated Delete activity to process delete requests in user mailboxes, you must configure a Worker to run Delete - User Initiated Delete jobs.
- For User Delete to work in SourceOne Search, you must configure a Worker to run Delete jobs. The Delete job is the same one already used for Administrator deletes in SourceOne Search.

Disabling external address resolution in IBM Lotus Domino

This section discusses disabling external address resolution.

Introduction

When you journal to Personal or Community mapped folders, SourceOne determines message ownership to be the internal users only, based on each user's email addresses in his Person document. By default, Domino performs external address resolution. To avoid journaling messages that do not have the internal user set as the owner, disable the external address resolution feature in Domino.

When you disable external address resolution, all incoming mail from external domains have to match the user's default email address in Domino. Any other permutations are not resolved by Domino, and are not delivered. For example, if a user's default email address in Domino is john.smith@company.com, and an email from an external domain is addressed to a valid alternate such as jsmith@company.com, the email from the external domain is not journaled.
Disabling external address resolution

Perform the following steps to disable external address resolution.

1. In Lotus Domino Administrator, open the Configuration Settings document.
2. Click the Router/SMTP - Basics tab.
3. For the Address lookup setting, select the Fullname only option.
4. Save the changes.

Configuring SourceOne Search for User Delete

This section discusses configuring SourceOne Search for User Delete.

Enabling/disabling detailed logging

Unlike SourceOne trace logs, the detailed job logs are not overwritten and do not have verbosity settings.

Perform the following procedure to enable or disable detailed logging for delete operations performed through SourceOne Search.

1. In the EMC SourceOne console, expand the Application Configuration node.
2. Double-click the Web Search node.
   The Web Search dialog box appears.
3. Click the Server Settings tab.
4. Perform one of the following steps:
   - To enable detailed logging, select the Enable detailed logging for deletions checkbox
   - To disable detailed logging, clear the Enable detailed logging for deletions checkbox. By default, detailed logging is disabled.
The change affects new Delete jobs, not Delete jobs that are already running.

![Web Search properties - Server Settings tab](image)

**Figure 222** Web Search properties - Server Settings tab

**Specifying a date range**

Specify a date range using the Archive deletion eligibility period option in the Global Settings dialog box.

This date range applies to deletes performed through the mail client and through Search.
Configuring Journal activities for User Delete

This section describes how to configure Journal activities for User Delete.

Introduction

In previous versions of EMC SourceOne, you had to journal content into Organization mapped folders. Journaling added internal and external recipients as owners on a mail item.

To support user deletions of journaled mail items:

- You must journal to Personal or Community mapped folders, not Organization mapped folders. When you create a Journal activity, you must select Personal or Community mapped folders as target folders in the Rule wizard.

  **Note:** You can use Organization folders for journaling if you do not want to allow users to delete the archived mail items.

- When you journal to a Personal or Community mapped folder, only internal recipients are marked as owners of mail items. This change ensures that a mail item is deleted from the archive only when all of the internal owners have deleted the mail item. If the recipient's email address is found in the cache of internal addresses, journaling adds the user as an owner on the mail item. Recipients not found in the address cache are considered external recipients and are not added as owners on the mail item.

Prerequisite

Before you create the first Journal activity to a Personal or Community mapped folder, you must initialize the address cache to synchronize all mail users with SourceOne. If you do not initialize the address cache and wait for synchronization to complete, then you are not able to save that Journal activity.

If the address cache has not been initialized, then the following error message appears when you try to create the first Journal activity to a Personal or Community folder:

The rule is invalid for the following reasons: Unable to archive to a Personal or Community folder until a Mail User sync has been completed. Please start a Mail User sync via the Global settings page under Application Configuration, wait for the sync to complete and then try again.

Procedure

To create Journal activities, refer to “Configuring Email Management Activities” on page 341.
Configuring archive and shortcut activities for User Delete

The following sections describe how to configure archive and shortcut activities for User Delete.

About ownership and mapped folder types

Archive-Historical, Archive-Personal Mail Files, and Shortcut-Historical activities recognize the type of mapped folder specified as a target, and add the ownership.

- If the target is an Organization mapped folder, then the ownership is added.
- If the target is a Personal or Community mapped folder, then the ownership is added.

Archive activities

For User Delete to work on mail items archived using the Archive-Historical or Archive-Personal Mail Files activities, you must select Personal or Community mapped folders as targets in the Rule wizard.

**Note:** User Delete through the mail client (Outlook) does not support PST deletion. Users will not be able to delete items through the mail client that were archived using the Archive - Personal Mail Files activity.

You can use Organization folders for these archive activities if you do not want to allow users to delete the archived mail items.

Shortcut-Historical activity

For User Delete to work on mail items shortcut using the Shortcut-Historical activity, you must select a Personal or Community mapped folder on the Mapped Folder page of the Activity wizard.

**Note:** Select Organization folders for Shortcut-Historical activities to dis-allow users from deleting archived mail items.

Procedure

To create activities, refer to “Configuring Email Management Activities” on page 341.
Configuring the Delete - User Initiated Delete activity

This section describes how to configure the Delete - User Initiated Delete activity.

Introduction

The Delete - User Initiated Delete activity performs the following.

◆ Processes the delete requests in user mailboxes that were created when users chose to delete mail items from the archive.
◆ Passes the information to the Native Archive for further processing.
◆ Removes the delete requests from the user mailboxes.

Note: The Delete - User Initiated Delete activity is not involved in user deletes initiated from Search.

Prerequisites

In the EMC SourceOne console, perform the following.

◆ Configure a Worker to process Delete - User Initiated Delete jobs.
◆ Specify a date range using the Archive deletion eligibility period option in the Global Settings dialog box.

Best practices

Processing delete requests affects system performance. To minimize this impact, follow these guidelines when you create a Delete - User Initiated Delete activity.

◆ Avoid scheduling Delete - User Initiated Delete activities when other activities are scheduled, or when data is being disposed from the Native Archive.
◆ In the Archive deletion eligibility period option in the Global Settings dialog box, specify a narrow date window. Doing so limits the number of volumes, indexes, and database partitions that are affected.

Procedure

To create a Delete - User Initiated Delete activity, refer to “Configuring Email Management Activities” on page 341.

Detailed job logs for User Delete activities

If you select the Enable Detailed Logging checkbox when you create a User Delete activity, then when the activity runs, it will log the following.

◆ The configuration of the activity.
◆ The mail items deleted from the archive.
Troubleshooting the address cache for User Delete

This section describes how to troubleshoot the address cache for User Delete.

Two EMC SourceOne components use a cache of internal addresses to determine internal recipients for ownership of mail items:

- Journal activities that archive to a Personal or Community mapped folder
- The Folder Conversion utility

Until the cache of internal addresses builds successfully, those Journal jobs will fail and the Folder Conversion utility will wait.

To troubleshoot problems with this address cache, look at the Event log that displays informational and error messages for the Address Resolution service.

Successful

If the Address Resolution service successfully updates the list of users in memory, then an informational message appears in the Event log.

![Successful update message](image)

The information includes the number of users loaded into memory and the amount of time it took to perform the load.

Low memory error

Address Resolution Service is allowed to consume up to 60% of the system memory, although it is expected to use a much lower percentage. If the Address Resolution service does not have enough memory to update the list of users, then a low memory error message appears in the Event log.

![Low memory message](image)

To resolve this problem, perform one or both of the following steps:

- Evaluate the processes running on the server. If one or more processes are consuming an abnormally large amount of memory, stop or restart those processes.
- Increase system memory.
Refresh error

If the Address Resolution service encounters other errors when it tries to update the list of users in memory, then an error message appears in the Event log.

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors were encountered during refresh run. Next refresh run attempt will be 50 minutes later or whenever a refresh is triggered through the database. (0x86044205)</td>
</tr>
</tbody>
</table>

Figure 225  Refresh error message

The Address resolution service will try to update the user list again in 5 minutes.

Viewing detailed job logs for User Delete

This section describes the detailed job logs for User Delete.

Prerequisites

Review the following prerequisites.

- The location of the detailed log files is specified during installation of the EMC SourceOne Worker Server software.
- Enable detailed job logging.

Accessing detailed job logs

Perform the following procedure to access detailed job logs for User Delete.

1. In the EMC SourceOne console, select Operations > Job Management.
2. Select the Delete job in the job list.
3. At the bottom of the preview pane, click the link to the detailed job log.
Understanding detailed job logs

A log file with a unique filename is created for each Delete - User Initiated Delete job or Delete job.

The detailed log contains the following information:

- Job information:
  - The name of the user that initiated the delete
  - Date and time
  - Activity, task, and job IDs
  - Summary (number of items processed, succeeded, and failed)

- Details for each item:
  - Item identification: Subject, Date, EntryID, mapped folder (business folder)
  - Status:
    - Successfully deleted: UDA ownership has been removed, which results in removal of the mail item from the archive after the last owner is removed.
    - Failed to be deleted.
    - Not found: If ownership was not found on a folder, then the job log does not report success nor failure, because ownership did not exist.

Maintaining detailed job logs

You must manually delete old job logs. Unlike SourceOne trace logs, the detailed job logs are not overwritten. SourceOne does not clean up old job log files automatically.
Configuring User Delete
This section defines the terms used to describe EMC SourceOne and other related products. Text appearing in blue indicates a link to another term defined in the glossary.

**SYMBOLS, FILE EXTENSIONS**

- `.emcmf` See "EMC Message Format (EMCMF)."
- `.eml file` See "SMTP."
- `.emx file` See "volume."
- `.nsf file` See "IBM Lotus Domino database."
- `.pst file` See "Microsoft Exchange Personal Folder."

**A**

- **activity** An activity defines a specific type of work to be performed by EMC SourceOne, including the environment it will be performed in and when it will be performed. For example, Archive Email, Shortcut Email, and Archive Email are all activities.

  An activity component uses the information defined by the activity to create one or more jobs that actually perform the work. Activities are grouped in the EMC SourceOne console using policies. See also "policy."

- **administrative service** A service used by the Native Archive. This service runs on each server that is part of the Native Archive to announce the startup of the server and to inform other Native Archive Servers that this server is running. The Administrative service can also process commands. See also "Native Archive."

- **administrator search** A type of search where certain users can search for and view all messages (even those of all other users) in the mail archive.

- **archive folder** Contains volumes and indexes in the message archive. Archive folders are organized using automatically-created monthly folders.

**B**

- **Bcc journaling** A kind of Exchange journaling with the ability to capture Bcc recipient information. When Bcc journaling is enabled, Exchange captures all recipients (including Bcc recipients) that are known at the originating server.

  If this recipient list includes hidden distribution lists, query-based distribution lists, or distribution lists that are expanded on another server, the recipients for these lists will not be included in the journaled mail. See also "journaling."

**C**

- **container file** See "volume."
Glossary

**CTA**  
See "EMC Cloud Tiering Appliance (CTA)."

**D**  
**Data Access Component (DAC)**  
Mechanism by which all services and COM objects within EMC SourceOne communicate with the EMC SourceOne database. The DAC resides on Worker Servers and on the computer that hosts the EMC SourceOne console.

**data source**  
The location from which EMC SourceOne collects messages or to which EMC SourceOne archives messages. A journaling mailbox on an Exchange mail server is an example of a data source.

**Database Source Name (DSN)**  
A named connection to a database. Typically used with ODBC.

**developer**  
A person who customizes an EMC SourceOne system using documented interfaces, scripts, and interfaces.

**direct read**  
A DiskXtender setting whereby files that have been purged from the extended drive are read directly from the media rather than being copied back to the extended drive when requested. See also "DiskXtender."

**DiskXtender**  
An EMC product that allows you to “extend” the capacity of the EmailXtender storage drive by automatically writing .emx files to other storage media.

**E**  
**email administrator**  
A person who implements policies in the messaging system, such as maintaining and supporting email messaging services for a large community of users. An Exchange administrator or a Domino administrator are examples of email administrators.

**EMC Centera**  
A line of disk-based storage devices deployed on a Redundant Array of Independent Nodes (RAIN). EmailXtender can write files to EMC Centera through DiskXtender.

**EMC Cloud Tiering Appliance (CTA)**  
EMC product that provides policy-based file tiering, archiving, and migration. CTA was formerly known as EMC File Management Appliance (FMA). You can launch the CTA console within the EMC SourceOne console.

**EMC EmailXtender 4.8**  
An application for archiving and shortcutting email messages. EmailXtender 4.8 archives can be accessed using EMC SourceOne.

**EMC EmailXtender 4.8 User Cache**  
An add-on product for EmailXtender that allows users to retrieve shortcut messages while not connected to the network.

**EMC SourceOne**  
An enterprise-level solution that collects, organizes, retains, and retrieves email messages and attachments from Exchange and Domino mail servers as well as from other sources. You can use EMC SourceOne to reduce the space required for your mail servers or to comply with legal requirements for archiving email messages.

EMC SourceOne stores email messages and attachments in the Native Archive. You can also use Discovery Manager with EMC SourceOne.
<table>
<thead>
<tr>
<th><strong>EMC SourceOne administrator</strong></th>
<th>A person who installs, configures and manages an EMC SourceOne system. Configuration and management is primarily done using the EMC SourceOne console. See also &quot;EMC SourceOne console.&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EMC SourceOne Discovery Manager</strong></td>
<td>Discovery Manager is an EMC product for the discovery of email in archiving environments in response to legal or regulatory notice or corporate policy complaint. Discovery Manager, built around a legal matter metaphor, is a separate, chargeable application option to EMC SourceOne. See also &quot;EMC SourceOne.&quot;</td>
</tr>
<tr>
<td><strong>EMC SourceOne console</strong></td>
<td>A graphical user interface that allows the EMC SourceOne administrator to configure and manage an EMC SourceOne system. The EMC SourceOne console is implemented as a Microsoft Management Console (MMC) snap-in. See also &quot;Microsoft Management Console (MMC).&quot;</td>
</tr>
<tr>
<td><strong>EMC SourceOne File Mover agent</strong></td>
<td>Component of EMC SourceOne that moves Microsoft Office 365 journal report files to be used by the Journal activity. See also &quot;Microsoft Office 365.&quot;</td>
</tr>
<tr>
<td><strong>EMC SourceOne Offline Access</strong></td>
<td>An additional EMC SourceOne product that allows users to retrieve shortcut messages while not connected to the network.</td>
</tr>
<tr>
<td><strong>EMC Message Format (EMCMF)</strong></td>
<td>A message format created by EMC for common use by applications that deal with email messages, such as EMC SourceOne. EMCMF was created as a single message format that can contain existing message formats, such as Microsoft Exchange .msg files, IBM Lotus Notes .onm files, and RFC SMTP or MIME .eml files.</td>
</tr>
<tr>
<td><strong>email user</strong></td>
<td>A person who views, composes and manages their messages using an email client, such as Outlook or Notes. The email user may select messages for their personal archive and delegate access to their personal archives to other users if the mail server supports it.</td>
</tr>
<tr>
<td><strong>envelope journaling</strong></td>
<td>A kind of Exchange journaling that includes all the information in message-only journaling and Bcc journaling. Additionally, it includes transport envelope information (P1 message headers) about the recipients who actually received the message, including Bcc recipients, recipients from distribution groups, and recipients who received the message as a result of transport forwarding rules. Envelope journaling is available with Exchange 2003 and Exchange 2007. See also &quot;message-only journaling.&quot; See also &quot;Bcc journaling.&quot;</td>
</tr>
<tr>
<td><strong>Exchange Dumpster</strong></td>
<td>Microsoft Outlook moves items (E-mail Message, Appointment, Meetings, Contact, Task) into a location known as the Exchange Dumpster when a user either: * Deletes an item from the Deleted Items folder. * Performs a shift-delete after selecting an item. * Changes an item (moves original version to Exchange Dumpster). * Accepts an appointment or a meeting. For Microsoft Exchange versions before Server 2010, Outlook moves items into a view stored per a folder known as Dumpster 1.0.</td>
</tr>
</tbody>
</table>
For Exchange Server 2010 and later, Outlook moves items to a Recoverable Items folder, located within the Non-IPM subtree (hidden section) of the user’s mailbox known as Dumpster 2.0. The Recoverable Items folder contains subfolders as described in the following list:

- **Deletion** - Stores items in this folder when a user either:
  - Deletes an item from the Deleted Items folder.
  - Performs a shift-delete after selecting an item.
- **Versions** - This folder contains the original version of a changed item, including accepted appointment or meeting items.
- **Purges** - If a user purges an item when using Recover Deleted Items, the item moves from the Deletions folder to the Purges folder.

**extended drive**
In DiskXtender, an NTFS volume (such as a hard drive or the EmailXtender storage drive) or partitioned part of a hard drive for which DiskXtender provides file migration services by moving files to media and fetching files from media according to the parameters you set. See also “DiskXtender.”

**F**

**folder**
Contains all volumes and indexes. Folders can be archive folders in a message archive or mapped folders that are virtual folders which map to archive folders. See also "archive folder." See also "mapped folder."

**FMA**
See "EMC Cloud Tiering Appliance (CTA).”

**full-text indexing**
An index of all available text within the header, message, or attachment of an email. Indexes are created to allow fast searching of the Native Archive. See also “Native Archive.”

**I**

**index server**
One or more servers, called Native Archive Servers, performing the indexing role within the Native Archive. This server is used to index archived messages. This includes content scraping, creating content caches, distributing content to indexes, indexing, re-indexing, and disposing of indexes. See also "Native Archive." See also "Native Archive Server.”

**IBM Lotus Domino database**
Stores Domino information, such as email messages. This database exists as a file with the .nsf extension. The Domino journaling utility automatically creates an .nsf file as a mailbox connector when it is installed. If users create private .nsf mail databases, you can use EMC SourceOne to archive messages from them.

**J**

**job**
The scheduled instance of an activity. For example, a user of the EMC SourceOne console creates a Domino shortcut activity to run every night of the week at 11:00 PM. At the end of 7 days, there would have been 7 jobs created and executed by this activity, assuming only one job was created for each run. See also “activity.”
### job dispatcher
A process on the Worker computer that registers the Worker computer with the activity database and scans the Job table in the activity database for work. The job dispatcher compares the job types of scheduled jobs against all registered activity components to determine if there is a activity component capable of executing the jobs. If a registered activity component is found, the job dispatcher locks the job and transfers execution to the activity component. See also "Worker."

### job scheduler
Service that creates and schedules jobs from activities. The job scheduler is responsible for checking the status of Worker Servers and rescheduling jobs if a Worker or job fails. See also "Worker."

### journaling
Is the ability to copy, in real-time, messages received and delivered by a mail server. EMC SourceOne allows you to use the Journal activity to journal messages from an Exchange mail server, a Domino mail server, or both. After the messages have been journaled they can then be archived, shortcut, or searched. See also "activity."

### journaling issues folder
Contains any unsuccessfully processed messages from any of the target folders defined as part of the associated SMTP Journaling Group. The journaling issues folder is used by the Journal activity to process email content from an Office 365 environment. See also "SMTP journaling group."

### journal report
An SMTP message generated by Exchange Online from the original message that includes the original message as an attachment. Journal reports are used to pass messages from an Office 365 Exchange server to Email Management.

### M

### mail router
See "mail server."

### mail server
A mail server is an application that receives incoming email from local users and remote senders and forwards outgoing email for delivery. A computer dedicated to such an application can also be called a mail server. Microsoft Exchange, IBM Lotus Domino, and sendmail are mail server applications.

### mail transfer agent (MTA)
See "mail server."

### mapped folder
Virtual folders which are associated with archive folders. See also "archive folder."

### Messaging Application Program Interface (MAPI)
A Microsoft Windows program interface that EMC SourceOne uses to access address books and to retrieve messages from Exchange mail servers.

### message archive server
One or more servers performing the message archive role within the Native Archive. These servers, called Native Archive Servers, are used to archive messages. This includes journaling, historical archiving (mailboxes, PST files and NSF files) and user-directed archiving. See also "Native Archive." See also "Native Archive Server."

### message ingestion
The process of bringing a message into the EMC SourceOne system. Message ingestion includes retrieving the message, processing the message, applying any applicable rules to the message, and then archiving the message, unless the rules determine otherwise. Messages can be ingested from multiple sources, including Exchange, Domino, or SMTP mail servers, or instant message proxy servers.

### message-only journaling
See "journaling."
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>message store</td>
<td>A message store contains the mailboxes for a mail server. An Exchange message store is referred to as a mailbox store. A Domino message store is referred to as a mail database. See also &quot;mail server.&quot;</td>
</tr>
<tr>
<td>metadata</td>
<td>Metadata is information about data, such as when the data was modified, security associated with the data and so on.</td>
</tr>
<tr>
<td>Microsoft Exchange</td>
<td>Stores Microsoft Exchange content in an external file. You can use EMC SourceOne to archive messages from .pst files.</td>
</tr>
<tr>
<td>Personal Folder</td>
<td>Extensible common presentation service for managing applications used by administrators to manage Workers, activities and so on. The EMC SourceOne console is implemented as an MMC snap-in. See also &quot;EMC SourceOne console.&quot;</td>
</tr>
<tr>
<td>Microsoft Management</td>
<td>A cloud-based implementation of Exchange (Exchange Online) and SharePoint (SharePoint online). Email Management can journal email content from Office 365.</td>
</tr>
<tr>
<td>Console (MMC)</td>
<td></td>
</tr>
<tr>
<td>Microsoft Office 365</td>
<td></td>
</tr>
<tr>
<td>Microsoft SharePoint</td>
<td>Subfolders within the archive folders. Monthly folders are created by the archiving process to organize the archived content and associated full-text indexes by month. See also &quot;archive folder.&quot;</td>
</tr>
<tr>
<td>archiving</td>
<td></td>
</tr>
<tr>
<td>monthly folder</td>
<td></td>
</tr>
<tr>
<td>Native Archive</td>
<td>A horizontally scalable archive that includes the data store, message database and full-text indexes. The Native Archive can be configured to allow separate roles to be performed on one or more separate computers. These roles are: message archive server, index server, search server, and retrieval server. These computers are referred to as Native Archive Servers. See also &quot;message archive server.&quot; See also &quot;index server.&quot; See also &quot;search server.&quot; See also &quot;retrieval server.&quot; See also &quot;Native Archive Server.&quot;</td>
</tr>
<tr>
<td>Native Archive Server</td>
<td>A computer used to perform a computing role within the Native Archive. See also &quot;Native Archive.&quot;</td>
</tr>
<tr>
<td>Office 365</td>
<td>See &quot;Microsoft Office 365.&quot;</td>
</tr>
<tr>
<td>Offline Access</td>
<td>See &quot;EMC SourceOne Offline Access.&quot;</td>
</tr>
<tr>
<td>policy</td>
<td>A logical grouping of one or more related activities in the EMC SourceOne console. See also &quot;activity.&quot;</td>
</tr>
<tr>
<td>real-time journaling</td>
<td>See &quot;journaling.&quot;</td>
</tr>
</tbody>
</table>
**retention period**
A folder-level setting that allows you to track how long volumes exist in the EmailXtender system. They are designed to help you to meet legal retention requirements by preventing you from deleting volumes before the specified amount of time has passed. See also "volume."

**retrieval server**
One or more servers, called Native Archive Servers, performing the retrieval role within the Native Archive. This server is used to retrieve archived messages. See also "Native Archive." See also "Native Archive Server."

**rules**
Criteria you configure to organize email archives and to control which messages EmailXtender archives. Rules are hierarchical, and can be nested up to three levels deep. After rules are defined, rules can be shared by multiple activities. See also "Native Archive."

**search server**
One or more servers, called Native Archive Servers, performing the search role within the Native Archive. This server is used to search archived messages. See also "Native Archive." See also "Native Archive Server."

**SharePoint archiving**
The type of archiving used to store content from a Microsoft SharePoint server. This archiving is performed in EMC SourceOne using the SharePoint archiving activity.

**SharePoint External BLOB Storage (EBS)**
SharePoint External BLOB Storage (EBS) is an optional storage management feature that automatically stores BLOB content in the Native Archive instead of in the SharePoint SQL Server. See also "Native Archive."

**SharePoint Search**
SharePoint users can search for SharePoint content that was archived in the SourceOne Native Archive, even if the original SharePoint site no longer exists. Users access this search through the SharePoint Search portal.

**shortcut**
Pointers that are placed on the mail server to copies of messages that are archived in EmailXtender.

**SMTP**
Abbreviation for Simple Mail Transport Protocol. Messages sent using this protocol are typically in MIME (Multipurpose Internet Mail Extensions) format and as files typically have the .eml file name extension. Email Management can process SMTP messages.

**SMTP journaling group**
A defined set of folders used by the Journal activity when processing Microsoft Office 365 email content. See also "Microsoft Office 365."

**task**
A task is used by the activity component to specify configuration information for a job, such as the schedule, based on a specific activity. A task generates one or more jobs. A task cannot be configured from the user interface.

**user-directed archiving**
A type of archiving that allows a mail user or mail application to direct messages to a specific folder in EMC SourceOne for archiving.
Glossary

V

volume  Flat, portable files of a configurable size containing archived messages organized by month. Also called container files or .emx files.

W

Worker  A networked computer that can perform one or more EMC SourceOne jobs. There can be any number of Workers. A Worker can also be configured to run specific jobs.